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The Tutorial like no other
If some of the terms used below are not clear, please see Conventions used in this user guide.

Only mSupply®'s basic features are covered in the Tutorial; its many enhanced features are covered in depth in 
appropriate chapters in the User Guide.

mSupply Explained
This chart shows the common steps in most pharmaceutical supply processes. (Of course, the manufacturing step only 
applies to manufacturers!)

mSupply work flow diagram
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mSupply® runs best with a screen resolution of 1024 or 768 or greater. If 
you have your screen set to 950 x 850 or lower, some windows will not fit 
on the screen. To change screen resolution:
Windows: Right click anywhere on the desktop, select Properties > 
Settings , and make the necessary changes.
Macintosh: Choose Apple > System Preferences… then click on the 
Displays icon and set a new resolution

The two most common transaction types in mSupply® are the supplier invoice (si) and the customer invoice (ci) . 
These transactions record stock purchases from suppliers, and stock supplies to customers. mSupply® records a full 
audit trail by only allowing stock adjustments by way of a transaction. Therefore, given an opening balance of stock for 
the year, mSupply® can show a series of transactions that result in the recorded closing stock.

Of course, there is much more to it than that, but these two transactions are the core of the system.

Note that mSupply® has dozens of preference settings (File>Preferences) which change the behaviour of many aspects
of the software. If you have customised Preferences from their default settings, some aspects of this tutorial may not be 
as stated below. To work through the tutorial, we recommend you start with a fresh copy of the example data to ensure 
the Preferences are set correctly.

Before starting the tutorial, you will need to have installed mSupply®, and opened the example database. If you haven't 
done so, see Installation

Opening the example data file
You will have two icons on your desktop - double-click the Start mSupply icon.

If you are opening mSupply® for the first time, the program should automatically open the example data file.
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The full path to the data file is displayed, along with other useful statistical information by clicking on Menu >Help:

If you have already been using mSupply® and have another data file open, but would like to open the example data file 
for use with this tutorial, then you can use the mSupply® menu File > Open data file… to open the example data file. 
In Windows, by default the example data folder is stored inside c:/mSupply/database/; navigate to the location and 
open the data file. 
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If you have chosen a different location from the one suggested by the 
installer, the example folder will be in your chosen location.

A password entry window is presented as mSupply® opens up a data file. The message panel informs the user that the 
example data base is in use.
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The “User 1” (pass= “user1”) entry should be highlighted, but if it is not, it should be selected. Enter “user1” (without 
the quotes) at 2.Enter your password.

The Choose store …. . drop-down list will display General, and the Choose login mode … drop-down list will display
Store - these should not be changed. Click the OK button. After you have logged on, the Navigator screen appears:

The Navigator

Overview
The mSupply® Navigator provides access to most of the functions you will be using regularly in mSupply®. You will 
learn that many of these functions may also be opened with shortcut key sequences from the various Menu items, and 
once you have gained some experience, you may find it quicker to use the shortcuts.
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The Navigator always opens at the Customers screen in Store mode, shown 
above, or the Patients screen in Dispensary mode, shown below:
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Displayed along the top of the screen are four items of information:

• the mode selected at logon (store or dispensary),
• the store in which you are working - for most users, “General”,
• the active data file,
• the user currently logged on.

Immediately below this, there are six large icons, Customers or Patients, Suppliers ……. Admin .“ Click on the icon 
appropriate to the task you are performing, and you will be presented with a panel displaying annotated icons listing the 
available functions and procedures; these are in turn selected either by clicking on the icon of your choice with the 
mouse, or by advancing through the icons with the right or left arrow keys and pressing the Enter key. You will be 
using the Items panel of the Navigator in the next step in the tutorial, and as the same procedures are common to all 
panels, you will quickly become familiar with them.

The bottom right area of the Navigator screen is available for displaying your own logo - the logo of “Acme Medical 
Supplies” is displayed in our example. The placing of your logo is performed by choosing File > Preferences > Logo. 
You can also read how to do it here.

Creating and viewing items

Creating a new item
For this section of the tutorial, we are going to add two new items to our mSupply® database. From the Navigator's 
opening screen, click on Item, the 3rd of the large icons near the top of the screen
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and the following screen appears:

• Click on the New item icon
• You are presented with a window with a number of fields to enter:
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Continue to use the Tab key for the rest of the tutorial when you need to 
advance to the next field.

Below is a list of fields and the text to be entered into each field. Use the Tab key to advance from field to field or, using
the mouse, click on the field you want to edit.

Type: The default entry normal is shown in the drop-down list, and should not be changed.

Item code: Enter amo500c then press the Tab key to advance to the next field.

Item name: Enter Amoxycillin 500mg tab/cap then press the Tab key to advance to the next field

Units: “None” is displayed by default. The options are: unit, ea (for each), gm and ml.

Price list: Click in the box so a check appears in it. This means that when we export a price list, the price for this item 
will be included.

Shelf location: Enter a3. Amoxycillin is stored on shelf 3 in the “a” section of our imaginary store. Note that “A” is 
interpreted differently from “a”, so it is recommended to be consistent and use either all upper case or all lower case 
letters for entering shelf locations.

Preferred pack size: Enter 100. This means we want a 100 unit pack to be our standard for comparing prices of this 
item.

Category: If a list of categories has been defined, this field allows the item which is being added to be placed in its 
appropriate category.

Normal stock, Critical stock, Essential drug, ATC category, DDD value, DDD factor, Weight, Non stock item, 
Default customer: For this tutorial, ignore these fields and leave them blank.

Click the OK & Next button to add this item to mSupply®. The window's fields will clear allowing you to add a further
item.
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If you have no more items to add, click the OK button to add only the item 
just added and exit. If you accidentally click OK & Next and then want to 
exit, just click the Cancel button. The Amoxycillin 500mg tab/cap would 
still be entered, as it was saved when you pressed the OK & Next button.

Proceed to add a further item with the following details:

Note that if you make a mistake, you can click in a field and edit the value.

Field Enter…. 

Item code “amo125s” 

Item name “Amoxycillin 125mg/5ml syrup” 

Units “mL” 

Price list check the check box. 

Shelf location enter “a7”. 

Preferred pack size enter “60”. 
Click OK now that you have added the item, then click Cancel to exit the window.

Congratulations! You have now added 2 items to our example data file. Let's go and see how to find them.

Viewing item details
Click on Show items from the Navigator's Item screen.
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You will be presented with a window to find items:

• Type “a” into the text entry area, then click the Find button.
• A list of all the items whose name or code starts with “a” is shown.

• We will choose the Amoxycillin 250mg tabs/caps - an item that was already in the example data file. To choose the item, double-
click anywhere on its line in the window.

• You will now be presented with a window that displays a lot of information about “Amoxycillin 250mg tab/caps”. From this 
window you can see stock on hand, view and edit supplier quotations, view usage for this item for the last 24 months, view 
backorders, view, add and edit notes for this item. Phew!
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• At this stage, we only want to know how to view the information. For an explanation of all the information displayed see Item 
Edit - General Options

• When you have finished viewing the information, click the OK button to return to the list of items.
• If you want to view a different item, you can double-click its line. Otherwise click the X button in the top right corner (on 

Windows) or the top left corner (on a Mac) to exit to the Navigator.

Customers, Suppliers, and Contacts

Adding a Customer or Supplier
For this tutorial example, we will first add a new supplier, then add a new customer.

Adding a Supplier

From the Navigator's opening screen, click on the 2nd of the large icons, Suppliers , near the top of the screen, and then 
click on New Supplier from the Navigator screen that appears. You will be presented with this window to enter the 
details:
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You can now enter the details for your new Supplier.

Field What to do…. 

Code Enter “Acmep” to identify the Supplier (Acme 
Pharmaceuticals). 
You need to choose a unique code for each name.
 Try to choose a logical system, as the code is used to look 
up the Supplier (or Customer) when you are entering 
invoice data.
 (for example, try to start the code with at least the first 
three letters of the Supplier name) 

Charge to Enter “Acmep” again. This field is only used when 
exporting data to an
 accounting program - this code must match the code
 you use for the supplier in your accounting program. 

Name Enter “Acme Pharmaceuticals” - the name of our supplier. 

Master ID Ignore for now 

Category 

Customer check box Leave this box unchecked, as we are entering a new 
Supplier. 

Supplier check box As you chose “new supplier” this box is already checked. 

Manufacturer Leave unchecked 

Benchmark Leave unchecked 

Contact 

Email, Web site etc. Fill in with the appropriate details 

Status 

Hold checkbox If this box is checked for supplier or customer, that 
particular supplier or customer can neither supply nor be 
supplied with items. 
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Preferred checkbox Leave unchecked 

Price Category This applies to customers. It is possible to assign multiple 
sell prices to customers. Leave it set to “A”. 

Supplier details 

Currency The field is automatically filled in with “Nrs”
(=Nepali rupees - the default currency in our example 
data).
 This is the currency that this supplier will use to bill us. 

Margin Enter “10”. Items purchased from this supplier will have a 
10% 
margin added to calculate the selling price. 

Freight factor Enter “1”. Acme Pharmaceuticals does not charge any 
freight to us.
Their prices are “CIF”(Cost, Insurance & Freight to named
port). This field is only used for comparing quotations 
from suppliers 
- it is not used for actual invoices. 

Other 

Category 1-6 Ignore for now 

Custom 1-3 Ignore for now 

Flag Ignore for now 

Comment You can enter a brief note here (Ignore it for now) 

Print invoices Ignore for now 

Address 

Address, Main & Postal address. You can complete these with appropriate values. 
If you are satisfied with the details, click OK . You will be returned to the mSupply® startup screen.

Adding a Customer

From the Navigator's opening screen, click on the 1st of the large icons, Customers, near the top of the screen, and then 
click on “New Customer” from the Navigator screen that appears. You will be presented with a window similar to the 
New Supplier one above to enter the details:

Fill in the fields as follows:

Field What to do 

Code Enter “bluec” 

Charge to Enter “bluec” 

Name Enter “Blue Cross Hospital” - the name of our customer. 

Master ID Ignore for now 

Category 

Customer check box As you chose “new customer” this box is already checked. 

Supplier check box Leave this box unchecked, as we are not entering a new 
Supplier. 

Manufacturer, Benchmark check boxes Leave these unchecked too 

Status 

Hold checkbox If this box is checked for supplier or customer,
 that particular supplier or customer can neither supply nor 
be supplied with items. 

Price Category This applies to customers. It is possible to assign multiple 
sell prices to customers. Leave it set to “A”. 

Contact 

email, web site, etc. You can complete these with appropriate values. 
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For information on the Normal - Fuzzy slider, see Editing a Customer, 
Supplier or Manufacturer

Other 

Category 1-6 Ignore for now 

Custom 1-3 Ignore for now 

Flag Ignore for now 

Comment You can enter a brief note here (Ignore it for now) 

Print invoices Ignore for now 

Addresses 

Address, Main, Postal and Shipping address. You can complete these with appropriate values. 
Click the OK button to save the details and exit the window.

Editing a Customer or Supplier
Let's now look up “Acme Pharmaceuticals”

• Choose Show suppliers … from the Navigator's Supplier screen. You are presented with a window to enter as much of the 
Supplier name or the code as you know. 

For this tutorial, just click the Find button - you will get a full list of all suppliers. 
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• Double-click the “Acme Pharmaceuticals” entry in the list. You will be shown a window the same as you used to enter “Acme 
Pharmaceuticals” as a new supplier.

43



• Note the window has “Tabs” down the left side in the sidebar: “General”,”Invoices“, “Backorders”, “Quotes” and “Notes”, etc. 
Let's add a note for Acme pharmaceuticals:

• Click on the “Notes” tab.

• Click on the New Note button. Today's date is entered automatically and highlighted. Click inside the Note Entry field.
• Enter “This is a test note” then click the OK button.
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Don't know a precise location? Using Google Maps find the desired 
location and place the cursor on it. Right click and select What's here from 
the drop down list. The geographical co-ordinates are displayed at the top 
of the screen. These should be noted and copied to the appropriate Lat and 
Long fields in mSupply®

• The first line of your note text will appear in the list of notes.
• Click OK to exit viewing/editing the supplier, then click OK again to exit the list of suppliers.

Viewing location in Google maps
If the precise geographical location of the supplier or customer is known, the Lat and Long fields can be completed in 
the Photo tab. Entries are made in these fields thus:

• decimal degrees, and not degrees, minutes and seconds
• in the Lat field, locations south of the Equator are entered as negative - i.e. the number is preceded by a '-' sign
• in the Long field, locations west of the Prime meridian are entered as negative - i.e. the number is preceded by a '-' sign

In our example, the location of the imaginary Acme Pharmaceuticals is on Chetrapati in Kathmandu. Click on the 
Google Maps button to display a map of the vicinity, with the precise location pinpointed by a green arrow.
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Enter incoming goods (a supplier invoice)
In some countries an invoice for incoming goods is referred to as a “bill”- we use “supplier invoice” to mean the same 
thing.

Let's suppose we have just received a shipment containing two items from Acme Pharmaceuticals, and we want to enter 
these goods into stock. The invoice looks like this:

<div align="center">

From: Acme PharmaceuticalsBill no.:A939 
Item Quan Pack Batch Expiry Price Extension 

Amoxycillin 
Caps 250mg 

1000 100 b93333 31/12/2015 344 344,000.00

Cotrimoxazole 
240mg/5mL 
susp 

65 60 bb23d 31/10/2015 21 1,365.00

Cotrimoxazole 
240mg/5mL 
susp 

100 60 bb22d 31/01/2016 21 2,100.00

Total: 347,465.00

</div>
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Choose Supplier > New invoice from the menu or navigator. 

The cursor will be positioned in the Name field. Type “a” and then press the tab key. If there is only one supplier whose 
name starts with “a”, the details will automatically be filled in.

In our case the supplier “Arbuckle distribution” was already present, so you are presented with a window listing the 
suppliers starting with “a”. Double-click the line containing “Acme Pharmaceuticals” to choose them for this invoice. 
The insertion point will jump to the Their ref. field.

Type “A939” into the Their ref. field. Press the Tab key to advance to the Comment field.

In the Comment field you can type a comment or information to identify the invoice.

Note that the margin is showing as 10 percent (the percentage that will be added to your cost price to obtain the selling 
price).
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Click the New line button to add the first invoice line. You will be presented with the window for adding invoice lines.

• The cursor will be positioned in the Item field. Type “a”, then press the Tab key. You will be presented with a window listing all 
items whose name starts with “a”. Double-click the “Amoxycillin 250mg tab/cap” entry to choose it. The cursor will now be 
positioned in the “Quantity” field.

• Enter the number of packs received in the Quantity field: “1000” (Note that this is the number of packs, not the total quantity of 
capsules). Press Tab to advance to the next field.

• Enter the pack size: “100.” Press Tab to advance to the next field.
• The cursor will now be in the location field. Ignore this for now and press Tab again.
• You can also ignore the Volume per pack field and press Tab to keep going.
• Enter the batch number: “b93333.” Press Tab to advance to the next field.
• Enter the expiry date: “31/12/2014” (Presuming you have dates set up to enter as dd/mm/yy. If your dates are set to the USA's 

mm/dd/yy format, enter “12/31/14”). You only have to enter 2 digits for the year, as long as the year is in the range 1961 to 2060. 
Dates outside this range must have the year entered as four digits. Press Tab to advance to the next field.

• In the “Invoice line cost” field enter the pack cost price: “344”
• The table shown in the picture at the bottom appears if you have Show previous purchases checked in your preferences. It will 

show purchases you have made of this item in the past.

As we have another line to add, click the OK and Next button. The entry is recorded, and the window is now blank to 
accept your second invoice line.

• Enter “c” into the item name field and press tab. In the list of items showing, you will find “Cotrimoxazole 240mg/5mL susp”. 
Double-click the entry.

• Enter the remaining invoice details for “Cotrimoxazole 240mg/5mL susp”:
• num units: “65”
• pack size: “60” (Note that it is better to record the actual volume of most packs, unless the volume is not important- for example 

with an eye-drop, where you could record the pack as “1”)
• batch: “bb23d”
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• expiry: “31/12/2013”
• price: “21.00” (You can just enter “21”)

Click the OK & Next button to save the details and start to enter another item.

Now enter the third item on the supplier invoice from the example invoice from Acme Pharmaceuticals example invoice
above.

When you have finished, click the OK button to take you back to the main list of invoices.

Our invoice will now have 3 items added to it. The invoice total should read “347,465”, and should appear like this:

If you have made a mistake, click on the relevant line , which will now be highlighted; double-clicking on it allows you 
to edit it. You will be shown the line details again, and you can then make corrections and click the OK button to save 
your changes. There are 3 icons in the lower left corner of the invoice window.
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1. This allows you to rearrange the order in which the lines are shown on the invoice
2. Here you can make a note of anything relevant to this invoice
3. This will copy the details of the invoice to the clipboard

Now click the OK button. As long as you have left the “print” check box (bottom right corner) checked, you will be 
asked if you want to print the invoice (you may do so). Note that when you print, you are shown two windows. The first
window is the page setup for your printer, the second window allows you to specify how many copies to print, etc. (The
second window also has “preview” check box, where you can preview the print job).

As this invoice is a “supplier invoice” it has been “confirmed” when you clicked the OK button in the invoice entry 
window. You can view and edit the invoice details until the invoice is finalised. Note that if you issue some of the stock 
you have just entered to a customer, some fields relating to that stock will no longer be edit-able.

NOTE - As of mSupply® v190, a more precise alternative for entering received goods has been implemented. See 
Viewing and editing supplier invoices created via Goods Receipts

Enter outgoing goods (a customer invoice)
Now let's suppose we have just received an order as follows:

<div align="center">

From: Blue Cross Hospital 
Order number: PO882 

Delivery: Express courier please 
Item Quan 

Amoxycillin 250mg tab/caps 10,000 

Cotrimoxazole 240mg/5mL susp 120 

</div>
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Choose New Invoice from the Customer menu, and the following window appears:

Type “b” into the Name field, and press the Tab key. You will be presented with a list of customers whose name starts 
with “b”. Double-click the “Blue Cross Hospital” entry to select it.

• In the Their ref field enter “PO882”.
• In the Comment field enter “This afternoon by courier”
• Click the New line button to add a line to the invoice. You are presented with the “Add item” window.

Enter the following details:

• Type “a” into the Name field then press the Tab key. In the list you are presented with, double-click the “Amoxycillin 250mg 
tab/cap” entry.
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• You will see that a list of available stock has appeared in the window, and the cursor has moved to the Line number field. Enter 
“2” to choose line 2. (The list is sorted so batches with the shortest expiry date are at the top - usually you would choose the 
shortest expiry batch, but today we're being different!).

• Quantity field - the line we have chosen has a pack size of “100”, so we need to enter a quantity of “100” to make a total of 
10,000

Click the OK & next button to add the second line of the order.
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This time enter “c” and press the tab key. Double-click the “Cotrimoxazole 240mg/5mL susp” entry. The window will 
close and the list of available batches and quantities will be completed.

Note that in the list of available stock, the second line we entered from “Acme pharmaceuticals” is now at the top of the
list - this is because the list is sorted so that the item with the shortest expiry date comes to the top of the list.

Line 1 is selected, despite the fact that there is insufficient stock of line 1 to meet the order of 120. Nevertheless, you 
should enter “120” in the Quantity field, press Tab, and the following message will appear:

For this tutorial, choose Distribute (which is likely to be your normal choice), and the necessary stock to complete the 
order will be drawn from another batch/other batches, starting with the batch which will be the first to expire. There will
be occasions, however, when you wish to override this automatic means of distribution, and in this event you would 
select Try Again and manually select the batches from which you wish to meet the order.

Click the OK & Next button

Because the invoice has not been confirmed, the “available” amount for the line has been reduced, but the “total stc” 
(total stock) is still showing as “100”. mSupply® includes these lines in the list so you can see stock that has been 
allocated to an invoice but has not yet left your store. You can then edit the other invoice if stock is urgently needed on 
the current invoice.

Click OK as we are finished entering lines. You will be returned to the main Customer invoice window.
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At the bottom right of the invoice you will see the invoice total.

• As the customer has requested an express courier, we will charge them Rs200 for the service (Rs = “rupees” the currency in our 
tutorial). At the bottom of the window you will see the Other charges field:

• There, enter “Courier charge” and press the Tab key
• In the “amount” field enter “200” and press the Tab key. The new total should be “37,020.00”

Now we are ready to print a packing slip. Make sure that Print is checked in the bottom right corner, and click OK; a 
window appears displaying your print options:

We want to print a packing slip, so the default settings suit our purpose. You will notice the packing slip printed has a 
column where you can write down the actual quantity packed.
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Confirming the invoice:
Let's suppose the order was successfully packed according to the packing slip, and you now want to confirm the order 
and print an invoice to pack with the goods. (We're in a hurry - the express courier is on her way!)

First, we need to look up the invoice. Here's an easy way to look up the last invoice you have entered:

• Choose Show invoices.. from the Customer menu.
• If you know the invoice number (printed on the packing slip) you can enter it. To bring a list of the most recent invoices, you enter

the number of invoices to view. As we know the invoice we want is the last one to be entered, we just type “1” and click OK - you
will be taken straight to the invoice.

Click the Confirm truck icon, 

and today's date will appear in the Confirm date field. Click OK to confirm you want to proceed.

The invoice is confirmed, and you are given the opportunity to print an invoice.

Entering Quotations
mSupply® allows you to keep a record of prices that suppliers have quoted to you. Let's assume that you have just 
received 2 quotations for Amoxycillin 250mg capsules; one of the companies has used US dollars for their quotation, 
and the other has used British pounds, so before entering the details of the quotations, it is necessary that both of these 
currencies are recognised. To achieve this, choose the menu item Special > Currencies, and this window appears:

55



Click on the New button, and a window appears which allows you to enter another currency:

Enter “USD” in the Currency field; in the Rate field you should enter the number of units of the default currency - in 
this case Nepali Rupees - equivalent to 1 US dollar; at the time of compiling this tutorial, the rate was 71.74 N.Rs. to 
US $1, so “71.74” is entered in the Rate field. Click on the OK button, and repeat the exercise for British pounds, the 
rate presently being 116.36.

Once you have performed this, the Currencies window should look like this:
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We're now ready to proceed.

To enter a quotation:

1. Choose Items > Show items
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2. Type “Amox” then press Enter.
3. Double-click the “Amoxycillin 250mg caps” entry from the list.
4. The item view window, on the left, has vertical content list (General, Usage, Quotes). Click the Quotes line.
5. Click the “New Quote” button.
6. Note that the item is entered for us. We need to choose a supplier and enter their price details.
7. Enter “Arb” in the supplier field and press tab. Arbuckle distribution is automatically chosen. They have quoted in US dollars, so 

choose “USD” from the currency menu.
8. Their price is US $3.50 per 100 capsules, so enter “3.5” in the price field and “100” in the pack size field.
9. Click OK to save the entry
10. Now click “new quote” again and enter the following details:

<div align="center">

Supplier Gold Medical Supplies

Currency Sterling [GBP] 

Price 20.00 

Pack size 1000 

</div>

Click OK when you are done.

Now we can see the list of quotes, which should look like this:

Notice how the adjusted price takes into account differences in pack size and currency, so you can easily compare 
suppliers.

Thanks for working through the tutorial. We hope you learnt something useful, and now feel confident to start using 
mSupply®!

Where to now?

• Use the example database to experiment with different commands as you read about them in the user guide.
• Have a “dummy run” at starting a new data file and using it.
• Return to our main documentation page at http://www.docs.msupply.org.nz
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Previous: Logging in Next: Working with lists

Items
An item in mSupply® is usually a product that you purchase and supply. However, there are also other types of items:

• A service item has no stock, but can still be added to customer invoices and charged for. Service item examples are a freight 
charge, a consultation fee, an express delivery fee, etc.

• A cross reference item points to another item, so that when it is chosen in a list, it is substituted with the item to which it refers. 
This allows you to have items in your system that are referred to by trade name, but are only issued according to their generic 
name.

Managing items is mostly done from the Item menu. This menu also contains commands for managing lists related to 
items such as accounts, drug interactions and units.

For how to add a new item, see Adding a New item

The Item Menu
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Show items....
Use this command for editing or viewing just about any information about an item

First you are presented with a window asking you to enter either as much of the item code or name as you know:
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To do a “contains” search, use the wildcard character '@'; e.g. entering 
“@250” will find all items with “250” anywhere in their name.

Click the Find button or press “return” when you want to proceed. If only one item was found its details are displayed, 
otherwise you will be shown a list of matching choices. An item is considered to have been matched if its name or item 
code starts with the characters entered.

The Complex find button gives you access to a more powerful query editor where you can find a very specific set of 
items. A tutorial on using the query editor is to be found here.

If you want a list of all items, leave the search field blank and click the Find button.

Double-click the item in the list that you want to view.
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The Items list view
New item: Click this button to enter the details of a new item you are adding to your inventory. You can find out how to
do this here

Report: Click this button to open a report editor window where you can design a report. The report will use the 
currently displayed records (not the highlighted records).

Set values: A flag is a quick way of identifying a group of items for use in a report.
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* You can set and remove flags for multiple items at the same time. To do so, hold down the control key (command key 
on Mac) and click on the lines you wish to flag. They will become highlighted. Then click the “set flags” button. You 
will be shown a window like this:

We recommend you use a single character (or two) as the flag.

If you choose Append to existing flags, any items with existing flags will have the new flag added to the end of the 
flag. If you choose Replace existing flags, then the selected items will have their flags cleared. Note that you can clear 
all flags for all items by selecting all items (control - A) then leaving the Set flag to. field blank, clicking “Replace 
existing flags”, and then clicking the OK button.

Find: Clicking this button displays the Find window, the same as if you had chosen Items > Show items.

Order by: Clicking this button will bring up the standard Order by window, where you can choose fields by which to 
sort the displayed items

Print: Click this button to print the items currently displayed in a list.

Modify: Click this button to show details for the first record that is highlighted. Clicking the OK and Next button in 
the item details window will jump to the next highlighted record. To select multiple records, hold down the control key 
(command on Mac) while you click on the records you wish to select.
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Duplicate: Click this button to create a new item with the same details as the selected item. A message box like the one 
below will appear. Click on button Duplicate to confirm creating the item. Note that the only difference you will see 
between the existing item and the newly created item is the name of the new item contains the text '(copy)'. 
  
 Note that for recording and audit purposes a Log event is created when an item is duplicated. For more information on 
log events see The Log 
 
 Customise list: Clicking this button will show a window where you can choose which fields from the items table are 
shown in the list view. See Working with lists.

The Item Details Window
The item details window displays a vertical list down the left side. Click on the appropriate item to view particular 
information about an item.

If you make changes that you don't want to save, you can click Cancel . Note however that changes you have made to 
quotes, notes and backorders will be saved, even if you click Cancel .
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To change an item code, you must click on the lock icon first, and then 
enter the new code in the field.

Item Edit - General options
Item name: You cannot edit the item name directly. Rather, click on the lock icon next to the item name, and enter a 
new name in the window that appears. Note that you should never change the name of an item to a completely different 
item here. As of version 1.5 of mSupply®, historical records will still record the original name, but invoices in process 
will pick up the new name when you edit an invoice line.

Item code: This is the code assigned to the item. 

Units: Choose the unit you use for this item. It is useful to distinguish items you issue by pack (eg eye drops) from 
items you issue by volume (eg oral liquids)

What are those lock icons?: Before you can edit an item's name,code or units, you need to click the small padlock icon
to the left of the field. If you have sufficient user permissions to edit the field, you will then be able to change the field 
contents. If not, you will be alerted. You assign user permissions for each user by choosing File>Edit users

Department: You can assign each item to a department by choosing from the list of departments here. To set up 
departments, use the Show departments… command in the item menu.

Category: Provided that you have defined item categories, the appropriate category should be selected using the drop 
down list which displays your defined categories. The use of item categories is explained under Item categories.

Interaction group: Here you can choose the interaction group for the item. You can set up interaction groups by 
choosing File > manage drug interaction groups and you will find more information here.
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You can find a hidden item by choosing Items > Show items and clicking 
the Advanced Find button (To show all items you need to enter a query 
like: * item name * is not equal to * zzz ) (unless you have a lot of items 
named “zzz”

Item Flag: The item flag field is designed for bulk editing, where you use the list view to update many items at once. 
However, you can enter or edit an individual item's flag(s) here. See The list view above for more info.

Catalogue code: Frequently organisations may apply a second code to an item - e.g. one for auditing purposes, in 
addition to one for general use. This field allows the entry of such a code.. Provided the Include catalogue code for 
each item box is checked under Preferences > Misc, a report on Catalogue codes may be produced.

Hold: do not issue: If this box is checked, the item will not be available to be issued on invoices. It will still appear in 
lists, but you will get a warning if you choose it when issuing stock, and will be required to choose a different item. 
Note that this applies to all batches of the item; should you wish to hold selected batches only, you should choose Stock
from the options list on the left, and in the Hold column, check the box for the particular batch/batches to be held.

Issue in builds only: Checking this box will mean that the item cannot be issued on customer invoices- it may only be 
used in manufacturing. This is to stop someone accidentally issuing a raw material on a customer invoice (for example, 
items which by law can not be sold in an unprocessed state).

Hide in this store: Checking this box will result in the item not being shown in the store you are currently logged into 
in the future. This is only applicable to sites running virtual stores.

Allow pack to one conversion:

Convert pack to one when receiving: If this box is checked, when you receive items the pack size will automatically 
be converted to “1”. This is primarily for use in dispensary mode, but may be useful in other situations too.

* For example: say you receive 50 x 100 boxes of paracetamol tablets, but you issue variable amounts of paracetmol 
tablets on invoices. If this option is checked, as you receive the stock on a supplier invoice, it will be converted to 5000 
(quantity) x 1 (pack size). You will now be able to issue any quantity you like. The cost and sell price are automatically 
adjusted for the new quantity.

Shelf Location: Type as much of the location (ie the first few characters) or code as you know, then press the Tab key. 
If only one location code matches your entry it will be filled in automatically, otherwise you will be shown a standard 
choice list like this:
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mSupply® always stores volumes as m3 (cubic metres), but you can enter 
a volume as millilitres (mL), litres (L) also.

Select the location you want by double-clicking a line or by clicking once on the line and then clicking OK

Note that each batch of stock can have its own shelf location. When you receive items into stock, they will be given the 
shelf location you enter here unless a different location is chosen.

Bulk Shelf Location: Similar to shelf location but it is used to store bulk quantities of goods/items. You can enter a 
code here (up to 20 characters) to identify the place where the item is stored.

Preferred pack size: This is the default pack size that will be chosen when receiving new goods or adding an item to a 
purchase order. It will also be used for comparison of quotations from suppliers (i.e. the adjusted price used when 
comparing quotations is the price if all quotes for for the pack size defined here.

Restricted to Here you can choose from a list of Location types. For example, all cool store locations could have been 
given a type of “cool” and then if the item you are editing should be kept in a cool store, choose that type here, and you 
will only be able to receive that item into a cool store location.

Volume per pack: If you are using available volume tracking in your warehouse, then fill in the default volume for one 
pack of the preferred packsize of the item here.

<div align="center">

You enter Value displayed mSupply® stores 

30ml 30ml 0.00003 m3 

1500L 1.5 m3 1.5 m3 
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600 L 600 L 0.6 m3 

1500 ml 1.5 L 0.0015 m3 

</div>

Outer pack size: This field is for entering the number of items present in one pack (outer).

Outer pack volume: Here you can enter a volume for a standard outer pack. This may be different to an exact multiple 
of the volume per pack you entered above, as outer packs may have their own packing. (For example, vaccine packs 
may come in an insulated container.)

Weight per pack: This field is for entering the weight of a pack of the preferred packsize in kg.

Store: The store which you are using is displayed here; most users will be using a single store and this paragraph is not 
relevant. For users managing more than one store, the desired store may be selected from the drop down menu. For 
users having access to all stores, and wishing to work with the cumulative data from them all, the display will show 
“Supervisor - All stores”. Should there be a number of stores accessible, click on the the magnifier in the lower right to 
display them, and select accordingly.

Such users may also access a single store should they so wish.

Pricing option:

Default margin: This is the margin that will be applied to this item on supplier invoices to calculate the selling price. 
Note that if a supplier margin is also set, there is a setting in the Preferences > Invoices 1 that determines which margin
will be used. Note also that if a default selling price is set, this price will take priority and be used rather than the 

68



margin.

Default sell price of preferred pack size: Only enter a price here if you want a fixed selling price for this item. Enter 
the price for one unit (eg 1 capsule or 1 gm). A price entered here will override any margins you have specified for 
either the supplier or the item.

Price editable when issuing: Check this box to enable this feature

Full description: This field may be used for entering a fuller description of the item should the item name alone be 
insufficient.

VEN Category: Options available presently are:

• Not assigned 
• Vital stock
• Essential stock 
• Non-essential stock

The appropriate box should be checked.

Stock Category: Options available presently are:

• Normal stock 
• Critical stock 
• On Essential Drugs list

The appropriate box should be checked.

Custom fields: These are 7 fields available for users to store information appropriate to their operation;their default 
names are user_field_1, user_field_2, etc.., but these labels may easily be edited to more descriptive ones as 
required..These fields may be queried when performing a search or producing a custom report.

Field types:

• Fields 1,2,3 & 6 are text fields
• Field 5 is a numerical field
• Fields 4 & 7 are boolean - True/False (Yes /No) entry.

To set the names of the user fields, choose File > Preferences and click on the Misc option in the left hand list.

Buttons in the item details window

Delete: Provided that an item has no transactions, quotes, order lines or backorder lines, it can be deleted, and this 
button performs that action.

Once you have received stock for an item, it cannot be deleted. You can delete an item immediately after you have 
created it or imported it. Note that if you have imported an item and stock, you can delete it, and it's associated stock 
will be deleted too (but not once it has been used in a transaction such as an invoice or build).

OK & Next: Saves changes, exits the window, then brings up the next item in the item list. If you did not have an item 
list open, or if you have reached the last item in the list, you will be returned to the list or the initial menus, depending 
on your starting point.

Cancel: Exits the window without saving changes. (Note that changes to other information you have made such as 
editing a backorder, adding a quote etc. will be saved).

OK: Saves changes then exits the window.

The Misc(ellaneous) tab
This window has settings for:

4. cautionary warnings used when dispensing medicines
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5. accounts used when exporting transaction information
6. SMS (text) messaging
7. Price list
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Warnings: Warnings which apply to this item are chosen from a standard list. This list is set up using the Special > 
Warnings menu.

Use the Add button to add a warning for the item. This will open the below window where you can choose the warning 
from a list. Double click on the warning you want to use. You may also add new warnings to the list by clicking the new
button.
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A warning's text may only be edited by choosing Warnings from the 
Special menu

To delete a warning, click on its line then click the Delete button.

When an item has more than one warning, the warning that has priority will be automatically printed on the label. You 
can add other warnings as part of the label directions if required.

To give a warning priority, double-click its line in the list and check the Priority box:
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Accounts: You can set the general ledger account to be used for exporting purchase and supply transactions involving 
this item here.

To set each account enter a portion of the account description or code and press the Tab key. You will be shown a 
standard choice list if more than one account matches what you typed.

SMS settings: These settings concern the item and SMS messages from mobile phones.

SMS code: This is the code that will be entered in an SMS to refer to the item. Keep the code short and unique! If you 
change this code you must notify all the users who send SMS messages to mSupply about the new code, otherwise they 
will not know how to refer to this item in their SMS messages. Because of this, you can only change this item after you 
'unlock' the padlock next to it by clicking on it. When you unlock the padlock you will be shown a warning that SMS 
users must be told about the new code.

SMS pack size: The pack size to use to convert the pack size quantities entered in an SMS message into item quantities. 
You must enter a value greater than or equal to 1 for this if you have entered an SMS code. Otherwise this field is 
ignored.

Price list:

On price list: If this is checked the item will appear in a price list when it is created (select Reports > Price list in the 
mSupply navigator).

Indicative price: This is the price that will be displayed for the item in the price list. Enter the price in local currency.

Report pack: This is the pack size which the indicative price refers to and which will be displayed in the price list.

The Usage tab
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The Usage tab allows you to view the item usage per month for the previous 24 months. This information is very useful 
for quickly spotting a trend in usage for a particular item.

Below the list of usage for each month there is a popup menu to choose from 1 to 24 months. After choosing a value the
average usage and the standard deviation for the period in question will be shown.

Show Graph button: Clicking this button shows the same information in a graphical format.
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Refresh usage button: This button allows you to update the usage with transactions that were added since you opened 
the window (this applies to multi-user mode). It also allows you to show the usage with or without build transctions 
included in the totals, depending on whether or not the include builds checkbox is checked.

The Stock tab
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If you have turned on any of the custom stock fields in store preferences 
they will be displayed as columns (between the Supplier and Manufacturer 
columns) in the list of stock lines on this tab and the information you 
entered for these fields when the stock was received will be shown in the 
appropriate cells.

The “Stock” window shows the lines of stock for this item together with the stock on hand. mSupply® will calculate 
how many days this stock will last, based on your usage over a number of months - you can specify how many months.

Show zero lines: This button will show all the lines that are still in your data file, but which have no stock on hand. If 
you can think of a use for this information, please let us know! When you click the button the button title changes to 
“hide zero lines”, which allows you to get back to the info you really wanted.

Splitting: There may be occasions when you need to split your stock- e.g. if you are moving it, say, from a store to a 
dispensary or clinic, or when you are repacking some stock; select the line to be split, and click on the Split icon to 
show a window allowing you to enter the quantity to be split, the new location, and - if applicable - the new pack size.

In the example shown, 2 packs of 1,000 Erythromycin tablets are being transferred to a new location, and the `outer' of 
1,000 ( actually 10 x100 shrink wrapped together) is being opened to yield 10 individual packs of 100.

Update sell prices: Clicking on this icon will update the selling prices of the highlighted line(s). mSupply® will use the
figure entered in the Default sell price of preferred packsize field in the General tab, which must show the updated 
price before this will take effect. If you make use of the Default margin field, and you update this figure, then Supply®
will calculate the updated sell price using it. Note that mSupply® looks first in the Default sell price … field, and any 
figure entered there takes precedence.
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Labels: Clicking this button will print shelf labels for the highlighted batch(es). The shelf label includes the location, 
the item name and code, and the batch and expiry. Here's a (bad) example 

Show related invoices

Highlight a line then click on this button to display a list of transactions which used this particular line.

Consolidate

You can consolidate (join 2 batches together) if they have

• The same batch #
• The same expiry
• The same pack size
• Are at the same location. If 2 batches you want to consolidate are at different locations, use the split button to move one of the 

batches to the location of the other batch, then consolidate. In the warehouse this is what you would have had to do anyhow!

1. Hold down the control key (command on Mac)
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2. Click on the two lines you want to consolidate
3. Click consolidate
4. If the two batches are at different locations you'll be warned and asked if you want to continue.
5. You're shown this window
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•
6. Choose which batch to keep.
7. Click OK

An example:
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• Before: 

• After: 

Other information on the stock details page

Stock

Minimum stock: The minimum stock you wish to keep on hand. Note that you do not need to enter a quantity here for 
mSupply®'s ordering system to work. In fact, it is better in most cases to leave this number set to zero. This field should
only be filled in if you absolutely must keep a minimum on hand. For example, if you stock naloxone for narcotic over 
dosage reduction, and even if you only use 1 vial every year, you have decided you need to keep five vials on hand, you
would enter “5” as the minimum quantity for naloxone.

Stock on hand: The total stock of this item on hand.

Stock on order: The total quantity of stock of this item on order from suppliers

Non-stock items

If this is a non-stock item, you can check this check box. If there is one, you can specify the default customer for the 
item, otherwise leave this box blank. For more on this topic see Non-stock items

Months Cover

You can use this calculator to estimate the time left until the stock of this item runs out. The values which appear 
estimating the time it takes to use the stock on hand (and on order) are calculated from the average usage of the last few 
months. You can choose the number (from 1 to 24) of months used to calculate this in the drop down list. 
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You can also exclude stock that will expire soon. Enter a number of months and any stock that expires before your 
chosen time frame will be excluded from the calculation. 

If you would like to know how much stock to order so that you have enough for the next few months, enter the number 
of months you would like stock for. After entering or changing any or all of these values, click Calculate to see the 
results.

Editing a stock line
To edit the cost price and selling price for an item line, double-click the line you wish to edit. Note that only users in the
level 1 or level 2 access groups are permitted to edit stock lines.

The Item stock line details window is displayed:

The Stock lines > General tab

This tab shows the details of a stock line.It also gives you total and available quantity of that stock line.

Hold checkbox: To hold a batch check the Hold check-box. Once an item is held, it cannot be issued. It will still appear
in the available stock window, but held lines will have a check box in the hold column, and if a user attempts to issue 
the line they will be informed that the line is on hold. Note that the Hold: do not issue option in the General options 
takes precedence, and if that option is checked, then no stock may be issued, regardless of batch.

The Stock lines > Ledger tab

This tab shows a list of supplier and customer invoices for the item batch being viewed. You can use this window to 
view immediately the list of customers who have been supplied with this particular batch.

83



The Stock lines > Status tab (Vaccine vial monitoring)

A window appears with 4 columns:

• Date
• VVM status
• Entered by
• Comment 

There are two buttons:

• New
• Delete. 

This has been specifically designed to use the Vaccine Vial Monitoring (VVM) feature. All vaccines requiring cold 
storage bear a VVM label which registers cumulative heat exposure over time; the combined effects of heat and time 
cause the inner square of the label to darken gradually and irreversibly. A comprehensive description of VVM is 
available in the WHO's pdf document accessible here.

Batches of vaccines should have their status VVM labels regularly checked, and assigned to the relevant status; 
Clicking on the New button allows the details to be recorded.
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Should a batch of vaccines have the status 3 (or 4), the Hold checkbox under the General tab should be checked.

The Stock lines > Reference Documents tab

The standard Document Management window appears. See Reference documents for more information on the use of 
such documents.
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The Ledger tab

The item Ledger tab lists all the transactions for the item in question for the period selected according to the choice 
available in the Show drop down list.
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The default is to show all transactions, but in the example displayed, Customer transactions has been chosen.

Filtering the ledger list: 

Two drop down lists are available:

You can use the Show…. drop-down list to show:

• All transactions
• Only supplier transactions
• Only customer transactions
• Inventory adjustments
• Repacks
• Transactions whose status is `New'
• Transactions whose status is `Suggested'
• Transactions whose status is `New or suggested'
• Transactions for just one name (click on a transaction line for the name you are interested in)
• Transactions for one particular item line. This will show the supplier invoice on which the item line was received, and all 

subsequent issues of that item line to customers.
• Same batch as selected - this will show all the supplier invoice on which the batch was received, and all subsequent issues of that 

batch to customers. This can be useful for tracing a particular batch of medicines.

The other drop down list allows selection from a variety of periods during which transactions occurred.

Tip: Clicking on the column headings of the transaction list will sort the list by the information in that column. The 
column header will be underlined to show by which column the list is sorted.

Note: If the cost price column is blank, this is because the current user does not have permission to view cost prices. 
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(This option can be turned on or off for each user from the “File > edit users…” menu item).

If you want to view an invoice for one of the displayed lines, simply double-click the line you are interested in. The 
invoice (or payment, as the case may be) will be shown in a new window.

Print

Clicking this button will give you the following printing choices:

• the information currently displayed in the window
• a complete ledger from the start of your year
• stock movement for a specific period or between two dates of your choice
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The Quotes tab

A quotation is a record of a price you have been given by a supplier. For each item you can have multiple quotes 
recorded, reflecting different prices you have been quoted from different suppliers, or even different prices from the one
supplier for different pack sizes.

When you come to compare quotes, there are several factors that need to be taken into account. By entering the 
information in mSupply® you are able to find the best price once these factors have been taken into account, and you 
build a history of quotations from each supplier.

The date until which the quote is valid is displayed, and you can choose to display all quotes, or currently valid quotes.

There may be occasions when a supplier has quoted for an item from two or more manufacturers, and in such cases, the 

89



manufacturer's name will appear in the column headed Manufacturer .

Cost: Cost is the price for that pack size in your local currency, taking into account the freight factor and the exchange 
rate.

Adjusted cost: Adjusted cost is the price for your “preferred pack size” you have entered for that item. This second 
price allows for a direct comparison between suppliers. Note that if you change the “preferred pack” for an item, all 
your quotes will be updated to reflect the new pack size.

Comparing quotes:: Click “Adj cost” heading in the list of quotes to bring the cheapest quote to the top of the list.

Add a new quote

Click the “new quote” button. The quotes input window will open

• Type as much of the supplier code as you know, then press the Tab key- you will be presented with a list of suppliers if there is 
more than one to choose from.

• Enter the price and the pack size in the currency you have been quoted.
• Note that the currency and freight factor are filled in with the information you have entered for the supplier.
• If the supplier has quoted in a different currency to the supplier's default currency, you can change the currency for this quotation 

from the drop-down list on the right.
• The freight factor is the factor you need to add to the supplier's prices to account for delivery costs. If your supplier includes these 

costs in the quoted price (i.e. prices are “CIF”), the freight factor for the supplier should be set to “1”. If your supplier adds freight
that amounts to about 15% of the invoice price, set the freight factor to 1.15.

Strip pack: This check box allows easy identification of quotes that are for strip/blister packed items (as opposed to 
“loose” items).

Preferred: This check box allows you to identify one (or more) suppliers as the preferred supplier for the item. One of 
the ordering methods uses the “preferred” check box to indicate which items should be considered for ordering from a 
particular supplier. See Ordering from suppliers for more details.

Supplier code: If you are using electronic invoice transfer, you must use this field to record the code for the item that 
this supplier uses on their electronic invoices.

Supplier bar code: Here you can record the bar code identifier for this product.

Price Break: Enter the quantity that generates a price break along with the percentage discount that will apply once this
quantity is reached.
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Freight: Enter the value for the preferred pack (outer pack) and the freight for that pack provided by the supplier.

Click OK to accept the details, or cancel if you decide not to add a quote for this item.

To modify a quote:

Double-click the line you want to edit.

In the window that appears you can change the date, the supplier, the price, the pack size, the Strip check box, or the 
Preferred check box.

To delete a quote: 

• Click on the quote line you wish to delete
• Click the Delete quote button
• Confirm that you want to proceed

The Backorders tab

You can view the backorders for an item here. To edit a backorder, double-click the line you wish to edit.
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To add a new backorder for this item, click the New backorder button. This window will be shown:

• Enter part of the customer name, then press Tab to search for the customer.
• Enter the order date, quantity and any comment, then click OK to save the new backorder entry.

To delete a backorder, click the line you wish to delete, then click the Delete backorder button.

The total stock on backorder is shown below the list.

The Notes tab
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You can add and edit notes for an item here.

Click the New note button to add a note. A note can be up to 32,000 characters.

The date on which you are entering the note is already completed, and in the main panel you should type in the wording
of the note itself. In the lower left of the window is a drop-down list offering various choices concerning the displaying 
of the note on screen; it may appear as an alert when this item is issued on a customer invoice, received on a supplier 
invoice, or, if all is chosen, it will display for both customer and supplier invoices.

You may also set the background colour of the note, but as the text is always black, dark colours should be avoided. A 
further option allows you to have one or more audible `beeps' sound when the note is displayed. Each note will display 
according to the attributes set for it, independently of other notes defined for the same item.

Subsequently, when the item is selected (depending on the specified display settings), the note will appear on screen; be 
aware that the note does not disappear automatically - you must close it/them manually.

To edit a note, double-click the note in the list you want to edit.

The Reconcile tab
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This may not be showing if you do not have a registration for mSupply® 
that enables manufacturing, or the buttons may be dimmed so you can not 
make entries if your user permissions do not allow you to view Bills of 
Materials.

Clicking the Reconcile button will give a summary of usage.

It is useful for checking mSupply® is working as it should be! If you get an error here it is most likely due to your using
mSupply® when a power failure occurred. In multi-user versions we are able to provide you with a log file that will 
allow you to incorporate transactions entered even if a power failure has occurred. In normal use, with a UPS, 
mSupply® will automatically save data and you will not see an error here.

The Bill of Materials tab
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Here you can specify a Bill of Materials for the item if it is a manufactured item. Once you have done so, and have 
checked the Use a Bill of Materials to manufacture this item check box, when you enter a new build, it can be 
automatically filled out with the correct materials (ingredients) and the correct quantities for the total to be 
manufactured.

Use a bill of materials to manufacture this item: If this check box (1) is not checked, the bill of materials (if one has 
been entered) will not be used when manufacturing builds.

New ingredient: This button(2) allows you to add items to the bill of materials.

You will be shown a window like this:

Enter the start of the item name or code then press the Tab key. If only one matching entry is found, you can then enter 
the quantity. otherwise you will be shown a list of matching items. Double-click the item you wish to use.

Click the OK button when you have finished, and the item will be added to the bill of materials for the item you are 
editing.

Note: (3) Be careful to enter quantities corresponding to the units you have specified for the item.

Delete ingredient: To delete an ingredient, first click on the ingredient you wish to delete so that it is highlighted, then 
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click this button.

Print: This button allows you to print the bill of materials that is displayed.

Quantity of finished product this bill of materials is for: This is the total quantity of this item that will be produced 
by the bill of materials that is entered for the item. Be careful to set this quantity and the units correctly.

Manufacture Method: This panel may be used to record the steps in the manufacturing process. When you are entering
a build you have the option to print the manufacture method along with the build ingredient list. For more information 
see Building (Manufacturing) Items

The Purchase Orders Tab

• The Show drop down list beside allows filtering the display of Purchase Orders according to their status - All, Suggested, etc. - 
• If you double-click a row the Purchase order will be opened in a new window.

The Order Options tab
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Never order this item: If you have items that are “one-offs” or have been discontinued, use this check box to stop them
appearing in orders.

Hold: do not receive: If this check-box is checked, you can not receive this item. This can be useful if you have 
changed to using a different item, and you do not want people to accidentally use the redundant item.

Expiry date required on receive: When this is checked, you will be unable to receive this item unless an expiry date is
entered for it. Therefore it is best to check this box for items that will always have an expiry date such as oral medicines
and to leave it unchecked for items that will never have an expiry date such as surgical instruments.

• You will be warned if you try to add or edit an item on a goods receipt or a supplier invoice that has no expiry date entered. Also, 
you will not be able to finalise a goods receipt that contains items which have no expiry date entered.

The Dispensing tab
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Default directions

A feature of mSupply® which can reduce the time taken to dispense a prescription is its use of abbreviated patient 
directions, which allows the entry of a short sequence of characters that expand to meaningful text. This is where you 
can set an item's default directions which will be used at the time of dispensing. When there is more than one entry, 
priority is given to the direction that is ranked at no.1 under Priority, and it will be automatically suggested for the item
when you dispense it. Further information on the use of abbreviations will be found in the section Dispensing, 
Abbreviations

In cases where multiple abbreviated directions have been defined, the required one(s) will be available from a drop-
down list when dispensing the item. Note that even if you set up default directions, you can override these at the time of
dispensing, either with longhand text or by editing the abbreviation that has been entered.

Warning: If you choose to use this option be very careful to:

• Inform other users that default directions have been entered.
• Ensure the directions are appropriate. 
• Check each prescription dispensed, and change the directions if the prescription has different directions to the default set.
• Update the default directions if you change any of the abbreviations.

Add button: Click this button to show a window where you can add directions. You can enter any combination of 
directions and text. (Abbreviations are managed by choosing Special > Abbreviations)

Delete button: Click a line, then click this button to delete directions you no longer need, or if you have made an error.

Picture, Instructions and Purpose

These fields provide default information to be used with the Patient medication records system.

Item Picture: You can drag and drop or past a picture into this field. Common file formats such as JPG and PNG are 
accepted.

When you add a picture, the size is shown to the left- we suggest pictures are less than 200KB each.

To clear a picture, click on the field and paste it.

Purpose: Enter the purpose of the medication here. This will be available to add to patient medication records
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Instructions: Enter the medication instructions here. For example, you might want to explain about sensitivity to 
sunlight with long term use, or that certain foods should be avoided. This will be available to add to patient medication 
records. Note this is separate to the medication warnings system, which will print on dispensing labels.

Other fields

Warn if user tries to issue more than field: You can enter a number here and have the user warned if they try to 
dispense more than this quantity.

The Reporting tab

ATC Category: This field is intended for the ATC code. The use of ATC codes and DDD values is discussed in detail 
here.

DDD value: The DDD value is the defined daily dose of the item. For example, doxycycline's DDD value is 100mg., 
while that of Amoxycillin is 1g. DDDs are a means of quantifying the issue of medicines by doses rather than by the 
raw number of units dispensed.

DDD factor: Defined Daily Dose factor- this is the number of units of the item that make up the DDD value. In the 
case of amoxycillin 250mg capsules the DDD factor is 4, while amoxycillin 500mg capsules have a factor of 2. For 
Doxycycline 100mg tablets the DDD factor is 1

ABC category: This option allows you to mark items that are commonly used and then report on only those items. For 
Reports using this category, see Items and Stock reports

Price List

On Price list: If this box is checked, this item will be included when a price list is produced.

Indicative price: The price for the item that will be used when you produce a price list

Report pack: The pack size for the item that will be used when you produce a price list

The Log Tab
mSupply® maintains a record of any changes to an item's details - name, code or units. The log window displays a list 
of such changes, under the headings:

• Date
• Time
• User and Event
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Only users who have Admin privileges may access this feature. See 
Managing Users

The CST (Customer Stocktakes) tab
CST is short for Customer stocktakes, and selecting this item shows the stocktakes featuring this item,

• Choose a date range from the drop-down list to show custom stocktakes within that range.
• Double-click a row to view the customer stocktake in question.

The Stores tab

Selecting this item shows the stores where this item is visible, and allows these stores to be set to Active using the 
checkbox.
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If the Active checkbox is unchecked, the item will not be visible when logged in to that store

Note that

1. you can only change the visibility of an item for the store you're logged in to.
2. you can not make an item invisible in a store if it has stock on hand in that store.

Making an invisible item visible

Once an item has been made invisible it will no longer show up in your items list when performing a normal find items 
task. To make an item visible when finding items untick the Exclude hidden items box:

The items list will now display any hidden items and you will be able to able to reactivate the item in the store tab.

Previous: Working with lists Next: Adding items
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Adding a New item
From Item > New item use this command to add details of a new item to be included in your stock list. (It is not for 
adding actual stock- just details of the item).

Note:: Don't be put off by the number of fields appearing on this window! mSupply will operate satisfactorily after 
entries have been made in just two fields - Item code and Item name . All the other fields can be regarded as optional 
extras, some or all of which you may use when you start using mSupply®, at some later date, or not at all. mSupply® is
a very versatile package! Descriptions of all the entry fields, however, are included in this section.

This is the entry screen:

Type: This field defaults to normal , which you will use routinely; the other options are service and cross reference.

The service option allows entry of items which have no physical stock, for example, a consultancy fee; the service 
option will appear only if it has been set in the mSupply Preferences. When entering a service item you only the 
following fields will be shown:
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The cost price field is used for when you buy a service, such as getting an oxygen cylinder refilled. The sell price is the 
price you charge when selling the service. Neither field is compulsory.

The cross reference entry should be used to enter the commonly used name of an item when it differs from the listed 
name. In Nepal, for example, paracetamol tablets are frequently referred to as cetamol , and the cross reference entry 
would have this appearance:

Item code, Item name: Appropriate entries must be made in these two fields.

Here are some suggestions for making a consistent system. (You may ignore these suggestions, as it is not necessary to 
know or remember item codes while using mSupply®).

• The code field should start with the first three letters of the item's name - e.g. 'asp' for aspirin tablets.
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• The item name should not be the trade name of the item, and should start with the most obvious and broadest description.
• e.g. “Brody forceps” should be entered as “forceps, brody”. “Aqueous iodine” should be entered as “iodine, aqueous”

If you think the item should appear in the published price list, then check the appropriate box.

Units: The drop down list allows you to choose the appropriate units for the new item ; mSupply comes with a limited 
list of pre-defined units, but it is recommended that users define their own list. You will find more information here.

Price list: If this box is checked, this item will be included when you produce price lists.

Preferred pack size: This is the standard pack size that you use for comparing quotes from suppliers.

Category: Choose a category from the list. Item categories are set up using the menu command Item > Show item 
categories… You will find more information oncategories here.

Shelf location: Type as much of the location (ie the first few text characters) or code as you know, then press the Tab 
key. If only one location code matches your entry it will be filled in automatically, otherwise you will be shown a 
standard choice list like this:

Select the location you want by double-clicking a line or by clicking once on the line and then clicking OK

Normal stock: For practically all new entries this box should be checked; at a later date should the item be removed 
from your formulary, for instance, you would remove the check from this box.

Critical stock: Should it be a requirement that you must never be out of stock of this item , this box should be checked.

Essential drug: Check this box if the item is on your Essential Drugs List

ATC Category: This field is intended for the ATC code which is discussed here. Other systems of coding/categorising 
may also be used.

DDD value: The Defined Daily Dose for this item. This is a text field, so you can enter the units as well (e.g. “1g” or 
“250mg”)

DDD factor: The DDD for this item divided by the strength (eg if the “DDD” is 1000mg, and the strength is “125mg”, 
you would enter “8”)

Weight: You have the option of making an entry in this field, if appropriate..

Non stock item: If applicable, this box should be checked.
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Be careful not to get mixed up between 
levels of category and categories themselves 
here!

OK: Pressing OK will accept the details and allow you to add another item.

If you don't want to add more items, press Cancel. Items previously added are still saved - just the details showing on 
the screen are not saved.

Previous: Understanding Items Next: Item categories 

Item categories
Item categories are a great way of grouping your items. This enables you, for example, to report on specific groups of 
products by filtering by item category. This can be extremely helpful. mSupply provides 4 different categories (called 
category 1, category 2 and category 3 and VEN for you to use. Category 2 and 3 are normal categories but 1 is a bit 
special - it's hierarchical and has 3 levels (level 1, 2 and 3. Level 1 is the top level, level 3 is the bottom). VEN refers to 
the WHO categories of Vital, Essential and Nonessential.

Category 1 categories
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Selecting Show Item Categories from the Item menu opens the window appearing below, showing all the category 1 
categories in their 3 levels by default (Note that the 3 “None” categories are default categories and cannot be renamed 
or removed):  In the screenshot you can see that “6.Antiinfectives” is a top level (level 1) category 3 category. It has 3 
level 2 child categories: “6.1 Antiinfectives, anthelmintics”, “6.2 Antiinfectives, antiamoebic/antigiardics” and “6.3 
Antiinfectives, antibacterials”. And level 2 category “6.2 Antiinfectives, antiamoebic/antigiardics” has a single level 3 
category “Antileprosy medicines”.

Clicking on any of the categories will show you which items are assigned to that category in the panel on the right hand 
side of the screenshot.

Adding category 1 categories

To add a category at level 1, 2 or 3, click on another category at the same level you want the new one to be, click on the 
Add button (or the Add child button if you want the new category to be a child of the category you selected) shown in 
the screenshot and the new level will appear at the bottom of the categories pane called “Click to edit” and already 
selected. Click on it once and type the category's name. When you're done click outside the category and that's it!

Editing category 1 categories

Renaming a category is simple. Click once on the category you want to rename to select it then click on it again to edit 
the name: the category will become a text box and you can type the new name. When you've finished editing the name, 
simply click outside the textbox (but inside the category pane) and the new name will be saved.
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Changing the parent of a category is almost as simple. You simply click on the category once to select it then click on it 
again, drag it onto its new parent (or a sibling of the new parent) and let go of the mouse button. Two things to note 
here:

8. You can only move a category to a position at the same level. If it's a level 3 category then you can only drop it onto a level 2 
category or another level 3 category. If you drag a level 3 category onto a level 1 category nothing will happen. For example: in 
the screenshot you could drag category “6.1 Antiinfectives, anthelmintics” onto category “1. Anaesthetics” or onto category “4.2 
Antidotes, specific” and it would move (to become a child of category “1. Anaesthetics” or “4. Antidotes”). But if you dragged it 
onto category “6.2.3 Antileprosy medicines” it would not move (this is a level 3 category, 1 level below “6.1 Antiinfectives, 
anthelmintics” so the move is not allowed).

9. If you move a category which has any child categories, all the child categories will be moved too. For example: in the screenshot 
you could drag category “6.1 Antiinfectives, anthelmintics” onto category “4.2 Antidotes, specific” and it would move to become
a child of category “4. Antidotes”. It's child (“6.1.3 Antischistosomals…”) would remain its child and become a grandchild of 
“4.2 Antidotes, specific”.

Deleting category 1 categories

This is the simplest of all. Select the category you want to delete by clicking on it and then click on the Delete button. 
After confirming you want to delete the category it will be deleted. mSupply will not allow you to delete categories that 
have items assigned to them - it will warn you that you have to remove the items from the category first. See the 
Assigning items to categories section below for details on how to do this.

Category 2 and 3 categories
Category 2 and 3 categories are simpler - they are not hierarchical. To view the category 2 or 3 item categories select 
Show Item Categories from the Item menu and change the Show drop down list at the top of the window to “Category 
2” or “Category 3” and the window will change to look like the screenshot below:
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The window shows a list of the existing categories of this type.

Save sort order button: The sort order of the categories is the order they will appear in the list when you are assigning 
items to the categories (see the Assigning items to categories section below) or when you're selecting them in a filter 
e.g. for a report. You can drag the categories up and down the list to give them the order you want them to appear in. 
When you are happy with the order, click on the Save sort order button and the order will be saved.

New button: Clicking on this will take you to the edit category window shown below:

Simply type the name of the category shown in the Item category textbox and click on the OK button to create the new 
category

If you double click on a category in the list you will also be taken to the edit category window where you can edit the 
category's name, see which items have been assigned to the category, delete the category (click on the Delete button).

VEN Categories
mSupply allows you to categorise items according to the World Health Organisation categories of:

Vital - medicines are potentially lifesaving, have significant withdrawal side effects (making regular supply 
mandatory), or are crucial to providing basic health services.

Essential - medicines are effective against less severe but nevertheless significant forms of illness but are not absolutely
vital to providing basic health care.

Nonessential - medicines are used for minor or self-limited illnesses, are of questionable efficacy, or have a 
comparatively high cost for a marginal therapeutic advantage.
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You can use these categories to make purchasing decisions using reports such as the Suggest Order Quantities report.

Assigning items to categories
Once you have set up the categories, all items can be assigned to their appropriate category. This is performed on the 
Item details window under the General tab (get here from File > Show items, click on the Find button and double click 
on the item you want to add to a category):
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To assign the item to a category 2 or category 3 category, select the correct category from the Category2 or Category 3 
drop down lists.

To assign the item to a category 1 category click on the magnifying glass next to the Category box. The following 
window will open:
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You can assign an item to a category 1, 2 and 
3 category at the same time.

Note that, if the item is already assigned to a category then that category is highlighted in the list. Simply select the 
level 3 (bottom level) category you want to assign the item to and click on the OK button. Note that if you want to 
remove the item from all category 1 categories, select the level 3 “None” category in the list.

Previous: Adding items Next: Items - Master lists 

Updated: Version 3.1

Item master lists
Master lists are standard lists of items you would supply to wards, clinics, etc. on a regular basis. Once set up, a master 
lists can be assigned to customers or Virtual stores, and then used to support Stock Control including imprest orders. 
Master Lists are useful to stores which have a number of customers or virtual stores that they supply whose lists of 
stock items are either identical or very similar.

Clicking on Show item master lists from the Item menu (or on the Show master lists icon in the Item section of the 
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navigator) displays this window:

Adding a master list
Click on the Add Master List icon and you are presented with a window allowing entry of the name of the list in the 
Description field, e.g. Health Posts - Standard List, and any note can be added in the Note field.
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and then populating the list with the required items by clicking the Add Item icon.
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On entering the first few characters of the item to be ordered, the (by now!) familiar list will appear from which the 
desired item is selected by double clicking.

If the imprest system is used in your organisation, the quantity is entered in the Imprest Quantity field. If the imprest 
system is not being used, no entry is required in this field.

If a price for the item is being accounted for in your organisation, the price is entered in the Price field. If the price 
system is not being used, no entry is required in this field.

In our example, a number of master lists have been created. A sample Health Posts - Standard List master 
list is shown below.
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Sorting: Clicking on any of the column headings allows you to sort the list according to that heading; you also have the
ability to click on an item in the list, and drag it to a new position; once the list is sorted to meet your requirements, you 
can click on the Save Sort Order icon, and mSupply® will retain the list in the order in which you have set it, and 
display it in that order next time it is accessed.

Copy to clipboard: The master list is copied to the clipboard when this button is clicked so that you can paste it into 
other applications on your computer e.g. a word processor or spreadsheet application.

Import item list: You can import a list of items created elsewhere e.g. an accounting application or a spreadsheet. The 
file to be imported must be tab delimited and may contain the item code, item description, imprest quantity and price for
each record. Records in the file are, of course, separated by a carriage return and linefeed.

For example:

code item imprest quantity price 

amo250t amoxycillin 250mg tab 800 0.1 

amo500t amoxycillin 500mg tab 300 0.2 
Note that:

• The item code must match an existing item code,
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• The item name is for information purposes only and is not actually imported (you can leave a blank column in it's place if you 
like)

• The imprest quantity and price can be left blank

Clicking on the Import item list icon takes you to a prompt:

after which you can select the file:
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And then the import preview dialogue box is displayed:
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On this screen you use the Next and Previous buttons to move through the records and see what details will be imported 
for each. The First line contains column headers tells mSupply® whether to ignore the first record in the import file 
(checked = ignore first line of file). The first record in the import file often contains headers describing the fields in 
each record, not actual data.

The Remove quote characters on import checkbox, if checked, tells mSupply® to strip all “ characters from the data. 
This is recommended. In fact, this option can be selected anyway without detriment to the import.

Note that if a mistake is made, the import process can be repeated without deleting the faulty data. The new import will 
not be appended to the old data, it will overwrite the old data.

Clicking the Import now button executes the import with the settings you made and takes you back to the master list 
screen with the imported items now showing in your master list.

The Cancel button also takes you back to the master list screen but, obviously, does not execute the import.

Editing imprest quantities or price: If you click once on the row you wish to edit, and then click on the imprest 
quantity or price, it becomes editable. Enter the new value, and you can then use the <tab> key to advance to editing the
next imprest quantity or price field.

The In use by tab: Under this tab you'll find the list of customers who have been assigned to this master group (i.e. are 
using this master list).

Deleting a master list
From the Item Master lists window, selecting the Delete Master List icon allows you to delete a list which is no longer 
required. This action has significant consequences for any customers who are users of the list. So to prevent 
accidental deletion, this action cannot be completed until any customers who are users of it have their association
with it removed.

Duplicate a Master list
Should you wish to create a Master list which is very similar to an existing one, click on this icon, and a new Master list
entitled ` Duplicate of ….. .' is created; this can then be edited and renamed to suit your requirements.
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Assigning a list to a customer
To assign a list to a customer, the customer's details need to be on screen; Choose Customer > Show customers , or 
using the Navigator, select Show customers , and double click the entry required on the Names list

Once the desired customer's Edit Customer/Supplier window appears click on the Item Lists tab. 

Buttons in the Item Lists section:

• Add Master list: From the list of master lists which have been created, double click on the name of the desired list.
• Add Local list: This serves to cater, for example, for the situation where a patient with a rare disease requiring medicines not 

normally stocked, collects these medicines from the local Health Centre. In this example, a patient attending London Dispensary 
requires tetracosactide, and so a local list (London local) has been created with a single entry, tetracosactide

•
• Copy from Master list: This feature would normally be used where a specific customer's drug needs differ to a minor degree 

from the drugs listed in one of the Master lists, or under the Imprest system where the stock levels are different from those defined
on a Master list; first click on the Add Master list icon, select the appropriate Master list, add it, and it will appear under Favourite 
lists. With that list highlighted, click on the Copy from Master icon, and a new entry appears displaying the name of the Master list
followed by `(local)'. The Master list may then be deleted, and the local copy modified and renamed as appropriate.

• Delete list: Two distinct functions are performed, depending on whether a Master list or a Local list is selected

119



You can only add items to a local list. If there 
are no buttons visible above the item list, it is 
because you don't have any local lists for this 
customer (or if you do, you haven't clicked 
on that local list to highlight it first)

When operating multiple stores in mSupply, 
you can sometimes have difficulty with item 
visibility: an item might be on a master list 
for a particular customer but if the item is not 
visible in the store you are logged into when 
using the list, then the item will not appear. 
To avoid this problem, you can set a 
preference (see here for details) to have the 
visibility of items on lists altered to match 
the visibility of the name for which the lists 
are made.

10. if applied to a Master list of which the present customer is a member, it has the effect of removing that list from this customer's 
Favourites. The Master list remains in mSupply.

11. If applied to a Local list, it allows deletion of the list, but only after all the items have been removed from the list by making use 
of the Delete Lines feature.

• Add item: Once you have selected a list, this allows you to add an item to that list.

• Printing: 
• Before printing, choose either Sort by Group or Sort by department 
• Choose whether to send to Excel® or your printer.
• Click Generate

Items

Note that these icons appear only when a local list is selected; for obvious reasons, Master lists cannot be edited here:

Add Item Self explanatory! Allows you to add required lines to the local list.

Delete lines Lines may be deleted, either singly or, by selecting multiple lines, several lines may be deleted together.

Save sort order . Allows you to save the list according to how you have sorted it.

Information button: 
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Edit favourite lists: The attributes of a list are set by double clicking on the name of the list shown under Favourite 
Lists : this window is displayed:
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If you use location types it will help you if they are defined before the locations that 
belong to them otherwise they won't be available to select when defining a location - 
and you'll have to go back later and edit the locations. What a waste of time! So this 
section explains location types first and goes on to explain about locations.

The options should be checked as appropriate.

Web orders: It should be stressed that for users whose customers place their orders using mSupply Customer web 
service, the Ordering List for Web box must be checked.

Previous: Item categories Next: 

Locations and Location types
Keeping track of where items are in your store is an important part of good warehouse practice. You don't want to have 
to go hunting through your whole store for an item, wasting time and energy when mSupply can tell you exactly where 
it is!

Locations in mSupply are the places you store items. Locations can have types (e.g. normal, cold, bulk…) to help you 
categorise them, you can define parent/child relationships between locations to help you manage them effectively and 
you can even create a line drawing plan of the location to pictorially show the layout of your store.

Location types
Location types give you the ability to categorise your locations. They can be used for reporting on a group of locations, 
but also to restrict the locations that can be used for a particular item. For setting the location type for an item, see Item 
basics

Choose Item > Show location types to define or show a list of available location types.
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The window that appears allows you to define the criteria for the various types of location in your store - e.g. the 
permitted temperature range, whether location must be dark, etc.

Adding a location type
Click on New , and the window that appears allows you to enter a name for the storage type, and the permitted 
conditions pertaining to that storage type.:

In the above example, a storage type “Refrigerator” has been defined, the permitted range of temperature being 2o C - 

8o C.

Having defined your storage types, the Show location types window might look like this:
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It is worth emphasising that the list does not show the actual store locations, but the types of locations.

Editing a location type
Should you wish to edit the details of any location type, double click on it in the list and change the details in the 
window which appears.

Locations

Viewing locations
To view the locations you have defined choose Item > Show locations and you will see a list of location codes and 
descriptions:
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From this window you can view, edit and remove locations and their details - this is the 'location management' window. 
Here are the various functions of the window:

New location icon: Click this to add a location (see 'Adding a location' below).

Print icon: Click this to print the list of locations displayed in the window (see 'Printing the locations list' below).

Show warehouse icon: Click this to see a graphical representation of your warehouse. This representation shows all the
layouts of the individual locations that you have created in the layout tab when adding a location (see 'Adding a 
location' below).
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Search location: Enter some text in the text field and the list is updated as you type to show only the locations whose 
code or description starts with the text you have entered. 

view and edit a location's details: Double click on a location in the list - see 'Viewing and editing a location' below. 
All the details are editable. See the 'Adding a location' section below for the meaning of the individual details.

Adding a location
Before you can associate an item with a specific location (e.g. Shelf D4, Refrigerator 2, etc.) you must define the 
locations in mSupply. To add a new location, click on the New location icon in the View locations window shown 
above. You will be shown the following window, where you can enter the details of the new location:

Code: This is how you refer to the location in mSupply and, for example, what you will select when you set an item's 
location. 

Description: This is a description of the location e.g. “Top shelf of refrigerator 3” or “3rd shelf up in rack E” to help 
you identify it or remember something important about it. You will only see this in the list of locations shown above.

General tab

Under this tab, you enter the location's main details:

Location Type: Select one from the location types you have already entered (see Location types section above).

• Each item can have a Restricted Location Type set, and then you will only be able to store that item in that location:
• You can set the location type for an item by viewing the item's general tab, and choosing the type from the drop-down list:
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•

Parent: Select one from the locations already entered in mSupply. This is the location to which the location you are 
adding belongs. Like location type, this is for descriptive purposes and does not have any functional effect in mSupply.

Summary: Checking this means that the location is a summary location only and cannot be used for storing items. This 
is normally checked for all locations that are parents of others.

Comment: You can note anything you need to remember or indicate to others in here. It is only visible if you view the 
location's details (Item > Show locations, double click on the item in the list) later.

Total volume: The total volume of goods that you can store at the location. Volumes are stored in cubic metres [m3] but
other volumes e.g. litres (l) may also be entered, provided the appropriate unit is entered following the number e.g. 5l 
for 5 litres. See the entry Volume per pack in Item edit - General options. Note that whatever you enter will be 

converted to and displayed in m3.

Knowing the volume of a location is important if, for example, you are replenishing your stock of vaccines, and you 
need to know if there is enough space available in the refrigerator in which you store vaccines to accommodate a new 
order (obviously, you would also need to know the volume of the vaccines that you are ordering).

Priority: This is used when printing a picking slip. Setting a priority for a location will override the default alphabetical
ordering of shelf locations in a picking list. A location with a lower priority number will be printed before a location 
with a higher priority number. All locations with 0 priority are counted as having no priority and will be printed after all 
locations with a priority in alphabetical order.

Hold: If this is checked then goods in this location cannot be issued to customers. Goods can be put into the location 
but they cannot be issued. You could use this as a simple way of providing a permanent or temporary quarantine 
location.

Layout tab

Under this tab you can create a graphical plan view of the location in your store. This is useful for helping people to 
quickly locate any given location and presenting a graphical layout of your whole store. Locations are drawn as either 
rectangles (for which you enter the top left coordinate and the lengths of the 2 sides) or polygons (for which you enter a 
number of sequential coordinates which are connected with straight lines). Here's what the various input items mean for
a rectangle, the rest we'll show you by the way of an example:
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So, as an example, the coordinates are entered as above in the appropriate boxes, then the Draw button is clicked to 
produce the following display under the layout tab:

134



This has created a picture of location main1. This is the whole store or warehouse. You can't see the settings but this 
location will have no parent and will have its Summary checkbox checked (no items can be located here - it's just a 
summary location for descriptive purposes).

In our imaginary warehouse we have a set of open racking which is 'L'-shaped. We want to draw it in the warehouse so 
we create the location, call it 'sub1' and set its parent as Main1. If this set of shelves also has other locations in it we 
would also check its Summary checkbox. 

To draw this location we click on the Layout tab and select Polygon as the object type. Click on the Add button to add a 
coordinate and then overwrite the zeros in the X and Y columns to give the correct coordinates. If you make a mistake, 
click on the set of coordinates in the list that is wrong and click on the Delete button to delete it. When all six co-
ordinates have been entered, click on the Draw button to produce the layout displayed below:
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You can do this same thing for all locations so that anyone can easily locate them in your store.

Viewing and Editing a location
As you already know from above, to view all the locations you have defined select Item > Show locations. To view and 
edit the details of a particular location, double click on that location in this list. You will be shown the following 
window:
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General tab

This is the same as the General tab for adding a location (see the 'Adding a location' section above) except that its 
details are filled in with the details of the location you selected. To edit the details simply overwrite the current value 
with a new value or select another option as appropriate.

Layout tab

This is the same as the Layout tab for adding a location (see the 'Adding a location' section above) except that the 
current graphical representation of the location is displayed (if you've already created one). You can edit the plan view 
of the location if required by changing, adding or deleting co-ordinates.
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Stock Tab

The Stock tab shows a list of existing stock lines stored in that particular location. A lot of information regarding the 
stock is displayed in the list and, as with most mSupply lists, it can be sorted on any column by clicking on the column 
heading:

If you want to know more information about any particular batch in the list, simply double click it and you'll be shown 
another window with lots of information about the batch, arranged in four tabs:
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Deleting a location
To delete location you select Item > Show locations to view the list of locations, double click on the location you want 
to delete (as if you wanted to view all its details) and then click on the Delete button at the bottom of the window. If you
confirm the deletion, the location is removed.

Merging two locations
If you want to remove a location from further use in mSupply (for example, you might have accidentally double-entered
a location) this command can be used.

When you Choose Item > Merge two locations , this window is shown:
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Use extreme caution! This operation will 
affect all historical records of the location 
you delete. They will be moved to the 
location you are keeping. The operation can 
only be undone by reverting to a backup 
copy of your data file.

In the window displayed enter the location to keep, and then the location to merge. When you have checked that the 
information is correct, click the OK button.

Previous: Next: 

Building (Manufacturing) Items
mSupply provides for a mechanism to manufacture (build) a new item from two or more existing items. A build is a 
way of recording items you have manufactured. That is, raw materials that are in your stock are used (taken out of 
stock), and a new stock item is created.

Note that you must have a version of mSupply® that allows use in manufacturing for this feature to be enabled.

Show builds...

From the Items page of the Navigator, click on the Show Builds button:

You will be shown the standard find window to enter either the number of recent builds to display, or a particular build 
number.
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You will then be shown a list as shown below:

From this list you should select the required build by double-clicking on it.
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New build...
From the Items page of the Navigator, click on the New Builds button:
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On choosing this menu item you are shown the build entry window:
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If you have restricted access to builds, you 
will not be able to see cost prices or the 
profit summary window at the bottom.

The build window has two parts:

• The top part of the window records the details of the item to be built
• The lower part lists ingredients that are used in the manufacture of the product.

click the Item to build or to edit icon

and in the next window enter the name of the product you're manufacturing (Syrup in our example)
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and this window is displayed where you should complete the appropriate fields:

Adding ingredients manually
Note that ingredients can be added automatically from the Bill of materials tab. If you regularly build the same item, we
recommend that you enter a Bill of Materials for the item being built, and use the method outlined under the Using a 
Bill of Materials heading below. 

First, if you are entering a projected build (one that you expect to perform in the future), check the This is a projected 
build check box. If checked, all items added will be placeholder lines rather than actual stock. Doing this allows you to 
enter your manufacturing schedule in advance of ordering raw materials. The schedule will be taken into account when 
ordering to ensure that you will have enough materials in stock when the time comes to manufacture.

• To add a new ingredient, click the New ingredient button. You will be shown the standard window for issuing goods from stock:
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• Enter ingredients just as you would for entering a customer invoice.
• Once you have finished entering ingredient lines, click OK to return to the main window.
• If you wish to edit a line, double-click it, and change the details.
• To delete a line, double-click it, set it's quantity to zero, then click the OK button.

Adding the item to be built.

• To add the item to build, click Item to build or edit button. You will be shown the Add/edit supplier invoice line window below for
receiving goods.

• The cost price for the item is automatically calculated for you. You may enter the margin or the selling price as you prefer.
• Once you have entered the item to build, click OK to return to the main window.
• If you wish to edit the item, simply double-click inside the “item to build” rectangle.
• At the bottom right of the window in Summary section is a summary of the cost, margin and selling prices for the build.
• Once you are satisfied with the details, click OK to enter the build into the system. You will be asked if you want to enter the 

details into stock. If you say yes , the newly created item will immediately be available for issuing to customers. If you click later 
then the stock will not be available until you open the build window at a later date and enter it into stock.

• Note that the ingredients used in a build are considered to have been “sold” for re-ordering purposes, and will be counted in your 
usage.

Finishing build entry

• Understanding build status codes enables you to know what stage each build is at. The codes are the same as for other 
transactions.

Each build transaction has a status code:

Code Meaning 

nw A new build is being entered, but has not been saved. 

sg “Suggested”. A build has been entered, but has not yet 
been confirmed. 
If stock lines have been entered, raw material stock is 
reduced so 
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that it is no longer available for other invoices, but the new
item is not yet entered into stock. 
You should leave builds with this status while 
manufactured items are “in process” ,
 or if it is a projected build for a future date. 

cn “Confirmed.” The item to build has been entered into 
stock. 

fn “finalised.” The build can no longer be edited 

• When you click the OK button you may be asked if you want to enter the build into stock. You should only do so once the 
manufacturing and Quality Assurance (QA) process is complete. You will not be asked this question if there are any placeholder 
lines (those with a batch of “none”) entered as an ingredient. Such builds are presumed to be for projected manufacturing, and are 
kept with status sg automatically.

• To finalize builds, choose File > Finalize builds when the splash screen is showing.

Converting projected builds into an actual build.

• Once your manufacturing of a projected build is about to take place, choose Item > Show builds … to locate the build you want to 
edit.

• For each line whose batch is equal to “none” (a placeholder line) you will have to double-click it and choose an actual stock line 
from the item issue window (either by entering the line number or double-clicking the line you wish to use). Once you have done 
this, the stock you have chosen will be reserved, and manufacturing can take place.

• mSupply® calculates the number of items that will result from your build, and clicking on the Print labels icon prints the correct 
number of labels.

Using a Bill of Materials
A Bill of materials can be thought of as a “recipe” or “formula” for building an item. It records the ingredients, and the 
quantity of each required to make the finished product. You should create a bill of materials for an item before you 
come to this screen. This is done in an item's Item details window: see here for details. Screenshots in this section are 
using Simple Syrup as an example, and for this product a Bill of Materials has already been created.

When you click the “Bill of materials” tab in the build window, this window appears:
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First you need to choose the item to be manufactured: 

in the next window you need to specify the quantity to be manufactured and other details:
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When you click OK, you are returned to the New Build window, and when you click the Add Bill of Materials 
Button, a window appears where you can confirm or cancel the quantity to be manufactured:
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Assuming the quantity is correct, click OK, and you are returned to the New Build window, where the open tab is the 
Bill of materials tab. Click the Add Bill of Materials button, and the details on the Bill of Materials according to the 
formula previously entered for Simple Syrup is displayed:

Now click the Ingredients tab, where the ingredients are listed, but no stock is attached to any item - they are 
placeholder items (displayed in red). This is done as mSupply® cannot take into account all the factors that go into 
choosing an appropriate batch to use for each manufacturing run (The expiry, amount on hand, etc). click each line in 
turn to select the quantity and batch number of available stock lines for each ingredient. Note that there is a button 
displayed Re-distribute all. Clicking this button will take the “total quantity issued” figure and re-distribute it over the 
available batches, making it easy to move from using a placeholder line to issuing actual stock. The ingredient is 
repeated in black with appropriate details displayed. At this time (or later) you can also adjust the amount issued to 
reflect actual issued quantities and the actual batches of raw materials used, as opposed to the theoretical quantities that 
are initially entered.
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If you are manufacturing the product immediately, the status of the build transaction should be changed to Confirmed 
on completion of the manufacturing process.

Print options:

It's possible to print either a Pick list, detailing the ingredients and quantities, or a summary of the manufactured 
product. To achieve this, check the print icon in the bottom right hand corner of the window and click the OK button. 
The printing options window will appear and you can choose which document to print: 

Calculate Yields button: This button (on the Bill of materials tab) compares the actual quantities issued and the actual
final quantity manufactured with the theoretical amounts that should have been used and made. This allows you to 
monitor production efficiency. Use the Print yield report button to print the yield information if required.

Previous: Next: 

Merging two items
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If you merge two items that are, in fact, different, you will really mess 
things up. There is no un-do for this operation, so you will be begging us to 
help you fix the mess, and we charge a special penal rate for people who do 
things after having been warned

This feature requires activation in 
Preferences > Invoices 1

If an item has inadvertently been added twice, with slightly different descriptions, here is your safety line! Choose 
Merge two items… from the Item menu. Enter the item to keep and the item to be merged.

• Notes
• Merging items affects all historical records except for item names on finalised transactions, which will retain the original name 

for safety reasons.
• Items that either have a bill of materials or are used in a bill of materials cannot be used for the item to delete/merge. If you try 

to do so, you will be warned.
• If the item you merging/deleting has stocktake lines associated with it, these stocktake lines will be deleted, as you can't 

stocktake a non-existent item (except if you're Harry Potter).

Previous: Next: 

Ad Hoc items
From the Item menu, choose Ad Hoc items…
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mSupply® defines Ad Hoc items as items that you don't keep in stock, and that you never will keep in stock. An 
example of an Ad Hoc item is a specialised item of diagnostic equipment which you would purchase on one occasion 
only. When a customer orders an item that you decide will be a “one-off” purchase, you can enter it as an Ad Hoc item.

Ad Hoc items differ from non-stock items only in this one respect; non-stock items are items which, although they do 
not feature in your stock list, may nevertheless be purchased with some degree of regularity.

The following diagram outlines the work flow for Ad Hoc items:
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When you choose Items>Ad Hoc items , the following window is displayed:
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From this window you can view Ad Hoc items, add new items, delete items and edit existing items.

The "Show" Drop-down list

This drop-down list allows you to view Ad Hoc items by their status. Ad Hoc items can have the following status codes:

<div align="center">

Status code Meaning 

== un == The item has not yet been assigned to a supplier- think of 
this as your “to-do” list 

== as == The item has been assigned to a supplier, but has not been 
placed on a Purchase Order. These items also need action. 

== po == The item has been added to a Purchase Order, but the 
goods have not arrived. 

== fn == The item has arrived from a supplier and been invoiced to 
the customer 

</div>

The "Name" field

Enter part of a customer or supplier name in this field and press Tab to show a list of matching names. Choosing a 
supplier will show items assigned to that supplier. Choosing a customer will show items supplied or to be supplied to 
that customer.

Once you have chosen a name you can fine-tune the list displayed for that name.

The "New" button

Clicking the “new” button displays this window:
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From this window you can add an item name, the name of the customer, then name of the supplier, the quantity to order,
and add a comment.

When the customer orders an item, you may not know who the supplier is. You can just leave the supplier name blank.

Editing an Ad Hoc item

To edit an item, double-click it in the list to display the item details, and a window Edit Ad hoc item, almost identical 
to the Add Ad hoc item :, appears where you can edit the required details.

Adding Ad Hoc items to a Purchase Order

When you are making a Purchase Order for a particular supplier, you can click on the Ad Hoc items Tab to view a list 
of Ad Hoc items you have assigned to that supplier, allowing you to add them to the Purchase Order. More information 
is available here - The Ad Hoc items tab.

Previous: Next: Non stock items

Manage drug interaction groups
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The examples given in this section are 
included only for the purpose of familiarising 
the user with the interactions feature of 
mSupply and how to use it. Use of this 
feature is the responsibility of the user, and 
Sustainable Solutions® bears no liability 
whatsoever for any consequence of 
inappropriate use.

This feature is chosen from the Item menu

Drug interaction groups allow you to specify groups of items that interact with each other, and then prepare a warning 
message to be displayed if these items from interacting groups are issued to the same patient.

You can set up interactions in store mode, but warnings will only appear in dispensary mode.

To use this feature, it must be set up, and these are the steps:

1. Choose a way of defining interaction groups. A number of systems are in use or are under development, and the internet is a 
useful resource for further investigation.

2. Define which items are in which groups.
3. Add interactions between groups.

Let's look at each of those steps in turn

Defining interaction groups

Choose Items> Drug interaction groups … Until you have set up some groups, the list will be blank; a number of 
groups have been set up for the purposes of this guide, shown below right:
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Click the New Group button to add a new group, or double-click an entry to edit it.

Double clicking on NSAID displays this window:

The window has two tabs.

The Items tab shows a list of items that have been assigned to the group.
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Define which items are in which groups

You assign an item to a group by viewing the item details (Choose Items > Show items ), and setting interaction group 
from a drop-down list.

Add interactions between groups

The Interactions tab shows a list of groups that the current group interacts with.

This tab has two buttons allowing you to add or delete a drug interaction. (To delete an interaction click on the line you 
wish to delete before clicking the Delete interaction button).

To edit an interaction double-click on the one to be edited. This window appears::
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You choose the group that affects the current group, and then enter details about the interaction by choosing from the 
drop-down lists.

The choices available are:

• Type of interaction
• Inhibits (I)
• Augments (A)
• No effect (N)
• Conflicting evidence (C)

• Clinical Significance
• Minor (1)
• Moderate (2)
• Major (3)
• Unknown (?)

• Quality of evidence
• Poor (P)
• Fair (F)
• Good (G)
• Unknown (?)

You can enter a message to be displayed when an interaction occurs, and any notes you may want to record. These 
fields are optional.

When you are issuing items in dispensary mode, in order to display a warning:

• the Alert when there are drug interactions checkbox must be checked in File > Preferences > Drug Interactions. The warning 
as shown will be displayed if the patient is being issued with interacting items:

• Number of days of patient history.. must be set. We recommend setting it to 180, so that any items dispensed in the last six 
months that interact with the item you are currently dispensing are found.
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Previous: Non-stock items Next: 

Managing Item Access...
Choosing Show departments from the Item menu displays the Edit departments… window, where you are able to 
create and edit item departments. Once you have created departments the window might appear something like this, and
you are now ready to assign each item to a department:

Item departments are a bit complicated. Here's what you need to remember:
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• Each customer is a member of one group.
• Each item is a member of one department.

Taking as an example the group Anti anaemic tablets, the items in the group are shown by clicking Show item 
departments . on the Item menu, and then double clicking on the appropriate group:

• Each group can have any number and combination of item groups in it.
• When you attempt to issue stock to a customer whose group does not contain the department of the item you are issuing, either a 

warning will be displayed or mSupply® will not allow you to issue the stock. From the Item menu, choose Manage item 
access…, and this window is displayed: 

• The left hand list shows the available departments
• The right hand list shows the customer groups that are presently members of the department which is highlighted on the left hand 

side.
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• The example shown identifies the four customer groups which are linked to the Anti-anaemic item department
• The icons on the right side allow you to add and/or remove groups from the highlighted department. Clicking the Add a new 

relationship button shows a list of groups you can add.
• Double-click (or click and then click OK) to add a group to the current department. You will be given a warning if you try to add 

the same group twice.

• Depending on how the item department options are configured, attempting to issue an item to a customer whose group is not a 
member of that department will either result in a warning message or in mSupply refusing to issue the stock.

• Note that the option must be turned on in the Preferences under the Invoices2 tab before this option will have any effect.
• Here is a summary of how department groups affect whether or not an item can be issued.
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Show groups...
Customer groups can be used to group customers (or suppliers) together for reporting purposes, and also to set up an 
item restrictions scheme, allowing some items to be issued only to certain customers.

See the explanation of how to set up a restriction scheme by clicking here.

The groups window allows you to set up group names:
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• Click the New group button to add a new group.
• Double-click an entry to edit its name:

• You can enter or edit the group name in the top field.
• The list displays all names which are members of this group.
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• Click the Delete button to delete a group. You can only delete groups that have no names as members. You can remove group 
members from the Groups tab of the name viewing window (From the Customer menu, choose Show Customers and find the 
required customer in the usual way.)

• The drop down list displays the group to which this customer belongs, and to remove the customer, make sure none is selected 
from the drop down list; to assign the customer to a different group, highlight the new group in the drop down list.

• Click OK to leave the window.

Departments
Overview: A manufacturer might create departments for raw materials, packing materials, and quality control reagents. 
A drug store or hospital might create departments according to dose form or according to pharmacological 
classification, etc.

From the Item menu, choose Show departments …; you are shown a list of departments:

170



By default the list displays in alphabetic order; clicking on Departments toggles between alphabetic order and reverse 
alphabetic order; you may also drag and drop individual departments to any position in the list to suit your own 
requirements, and on clicking OK you will be asked whether or not you wish to save the list in the order you have 
specified.

To add a new department, click the New dept button.

To edit a department, double-click the department you want to edit. You are shown a window allowing you to edit the 
department name:
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The radio buttons allow you to choose what will happen when you attempt to issue an item to a customer who is not a 
member of a linked group. Either the user can be warned or the issue can be disallowed. This only applies if you have 
Activate restricted item access by customer group turned on in the Preferences - otherwise you can ignore this 
setting.

The Items tab displays a list of items that are members of the group you are viewing:

To delete a department

Double-click it to display the entry window, then click the Delete button. Note that you can not delete a department that 
has item members. You will be warned if you try to do this. To delete a department with Items, click the items tab and 
note the items that are members, then edit those items (using the Items > Show items … menu command) and set their 
departments to either none or a different department. You will then be able to delete the department.

Previous: Next: 

Prices in mSupply
The price you charge customers for your goods is, of course, very important. mSupply provides you with several 
different ways to set the selling price of your goods. Here they are:

• Each supplier has a margin field that determines how much to add on to the cost price when buying from that supplier
• Each item has a margin field that determines how much to add on to the cost price when buying that item
• There is a preference ( File > Preferences > Invoices 1 ) which controls how these 2 margins relate:

•
• If this preference is ticked then the item margin will be used instead of the supplier margin. If it is unchecked then the supplier 

margin will be used instead of the item margin.
• You can set custom margins for each customer group ( File > Preferences > Invoices 2 )

•
• You can fix the item price under the General tab in the Item details window.
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•
• You can set item prices when setting up a data file by importing an item list.

Per customer pricing
Updated: version 3.12

Alternatively, individual prices can be set for each customer. This can be done in the Edit Customer/Supplier window 
which you can find by:

• going to the Customer tab of the Navigator
• click on the Show Customers button
• find the customer you wish to customise prices for
• double click the customer line
• choose the Item Lists tab (see below)

To customise the pricing, add a list to the Favourite Lists column by clicking Add local list. Check the Price list 
checkbox from the window that comes up and any other checkboxes that you require (Note: You only need the Price list
check box marked to customise prices and only one list per customer can be price customised). 
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Make sure the list is selected and then go to the Items section of the window called. Enter the corresponding prices that 
you would like to assign to each item for that customer by clicking on the item and then clicking on the price (“0” by 
default). You can also add items to the list by clicking Add item and entering the item name and the price in the window
that appears. The customer will now be charged the prices set in the list instead of any other price set.

Previous: Next: 

Splitting a batch
The Split Batch feature of mSupply provides us with the ability to break down stock into smaller pack sizes, consolidate
it into larger pack sizes or move part or all of a batch to a new location. Here's how to use it:

• From the Item menu choose Show items to find the item to be split
• Enter the start of the item name and click Find 
• Once the Item details window is displayed, choose Stock from the side bar list and you will see this window:
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• Click on the line you want to split, then click Split:

• In the Quantity to split field enter the number of packs you want to move/split (if you're repacking the whole lot, then enter the 
total quantity - the number to the right of the word 'of'!)

• In New location enter the new location for the packs that are being split (leave it alone if you're not changing the location)
• In the New pack size field enter the The new pack size for the split items (leave this as it is if you're not changing the pack size!).
• Click OK and you're done - the changes will be immediately visible in the item stock details window.

So, to summarise, you can use the split command to perform these actions:

• Change the location of some or all of a batch
• Repack some of a batch into a different pack size
• Both of the above at the same time!

Produce a Movement report
mSupply provides a feature to produce a 'Movement report' for stock that you have moved to a different location using 
the split function. It's useful for printing off and giving to the person who is going to physically move the stock in the 
store.

Here's how to create one:

• Once you have entered the details of your split/new stock location, click on the checkbox labelled Print Location Movement 
report and click OK:

175



• The following report is displayed:

• Note that the original and new locations are clearly identified so a printed version of this report can be easily referred to when 
physically carrying out the move in the warehouse.

Previous: Next: 

Repacking Items

Creating a New repack
The command Items > New repack will display a window where you can repack a particular item into smaller or larger
packs and/or move all or part of a batch to another location. It is a more complex version of the and will allow you to 
handle several batches at a time.
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There are 4 steps for creating a repack. The window is numbered from top to bottom to help you follow the correct 
steps:

1. Choose item to be repacked: At [1.] type the first characters or code of the item to be repacked, then press the Tab key. If only 
one item text or code matches your entry, it will be filled in automatically, otherwise you will be shown a standard choice list 
from where you can select the item.

2. Choose a batch: At [2.] double click a line to choose the batch; for repacking, batches cannot be mixed, and a single batch must 
be used.

3. Quantity to be repacked: At [3.] enter the quantity which is to be repacked; the pack size field is automatically completed.
4. Details of new line(s) - i.e. the repacks: At [4.] click the New line icon to bring up this window calling for the details of the 

repacks, and enter the details as appropriate.

177



You cannot edit a repack transaction after 
you have clicked the OK button, so get it 
right the first time! (Tip: You can always “re-
repack” an item to adjust a mistake 
however!)

Note that repacks of different sizes may be created at this stage - e.g. 5,000 Paracetamol tablets may be repacked into 
40×50 and 30×100. The Sell price, the Batch number and the New Location are automatically completed, but all these
fields may be edited as required.

Not infrequently, because some tablets may be broken, for example, the total quantity of the item re-packed will be less 
than the quantity selected for re-packing at [2.]. To maintain the accuracy of your stock record, an inventory stock 
adjustment should be performed - see the stock adjustments section for this.

Printing a repack

While the status of the repacking transaction is suggested (sg), checking the box beside the print icon will produce a 
picking slip of the number and size of packs of the original item; once the status is finalised, the same operation will 
give you the choice to produce a detailed record of the re-packs or a stock movement report (for when you're moving 
stock - perfect for giving to the people physically moving the stock in the warehouse because it shows what is to be 
moved to which location).

On clicking the OK button, a transaction is created showing the original line taken out of stock, and the new line(s) put 
into stock. The total value of the transaction is always zero.
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Deleting a repack
If you click on the Delete button, then the repack will be deleted. Only repacks whose status is “sg” (suggested) or “nw”
(new) can be deleted.

Viewing repacks
Repacked items can be viewed in the normal transaction list window - (Item > Show repacks) and select Repacks 
from the drop down list

Note that repacks created with versions of mSupply® prior to v1.4 will not show up using the “recent transactions” 
section of the window- you will have to enter the number directly.

Previous: Next: 

Updated: Version 3.1

Stocktakes

General
Traditionally, during a physical stocktake, the store is closed, and no transactions may take place until the exercise is 
completed. The inconvenience caused by closure of the store varies from minor to significant. The benefit of using 
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As of version 3.1 mSupply also has a web 
stocktake module, that allows entering 
stocktake results from a laptop or tablet on 
the warehouse floor.

mSupply®'s stocktake module, while requiring that the store is closed while the physical stock check is in progress, is 
that the store may be opened immediately after the physical count is completed. Entry of the adjusted figures into 
mSupply® may be made at any convenient time over the next few days.

A stocktake makes a list of your stock, providing you with a 'snapshot' of your stock at a point in time. mSupply® 
enables you to automatically create custom printed lists of your stock items from which you and your staff can do the 
physical stocktake. The items included can be customised to focus on particular location(s), particular items, or your 
entire store.

The default list produced (i.e. the one where you don't change any settings) will:

• be in alphabetical order
• omit items whose stock level is zero

Lines on a stocktake may be edited provided the user's permissions are appropriately set. [File > Edit user > 
Permissions]

180



Displaying stocktakes already performed
Select Show stocktakes.. from the Items menu to display any stocktakes already performed. This displays the 
following screen:

 The Show: filter allows you to choose which previous stocktakes are displayed. Options are: All, Current, This year, 
Last year; Current is selected by default and displays all stocktakes with a status of Suggested (sg).

Creating a new stocktake
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After viewing the current stocktakes, click on the New stock take icon, and the following window will appear:

Choose the items to be included
You can produce a stocktake for all items in your store by clicking OK without entering any criteria. If you want to 
narrow the items your are stocktaking, you can do this in a number of ways.

• Search for items by some criteria (item name, code, category). 
• Search by actual shelf location. 
• Search for items whose expiry is before a particular date. This allows you to easily remove all expired items from stock.
• Select a number of items randomly chosen by mSupply.

The two drop-down lists allow you to customise the stocktake list you are producing, while the filter allows you to 
specify a particular location
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To find stock at a particular location

Note that the “Shelf location” in the top left drop-down list is the default shelf location of the item, which is where the 
item is usually stored. To search by actual shelf location- where the stock has actually been stored- use the “Actual shelf
location” panel.

In our example, only the location filter has been set to equals , and the entry in the box is MAN; 

The stocktake list shown below, with items listed in alphabetical order is the result.

Such a list is, of course, dependent upon locations having been defined, and items allocated to specific locations

At this point the status of the stocktake is sg , i.e. suggested.

Print sheets to do the stocktake
Before printing you need to ensure that the order in which items are displayed is appropriate. By default the list is 
alphabetical, but for stocktaking purposes, it may be more appropriate to sort the list by location and then by item name;
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this is achieved by clicking on the Order by button and choosing Sort by location then item name

If you want another sort order, click a column heading for a simple sort, or choose the Custom sort option from the 
Order by button.

You can filter a stock list by entering the item name - or the first few characters of the name - or the item code in the 
box Item name/code in the top right area of the window, then clicking the Find button

Clicking on the Print icon displays the available options:

• Inventory adjustments: prints information about all the inventory adjustments made when the stocktake has been finalised (see 
finalise section below).

• Inventory adjustments-all items: prints information about inventory adjustments made after finalisation but includes all items, 
not just those which have had their quantities adjusted.

• Stock take lines: prints all lines in the stocktake and includes the quantities mSupply has recorded for each item.
• Stock take lines without quantity: prints all lines in the stocktake and excludes the quantities mSupply has recorded for each 

item.
• Stock variance report: prints out a report showing the differences between the stock recorded in mSupply and that counted 

during the stocktake. Only lines which show a difference are included in the report.

Ususally it is better to print out stock take sheets without the quantities. This ensures that the quantity of stock on the 
shelves must actually be counted and not just guessed!

[There is a further option - you may provide the staff performing the stocktake with blank sheets, requiring them to list 
both the items and the stock figure manually.]

Perform the stocktake
Allocate staff to perform the stocktake, instruct them in the process you wish to follow, and issue the sheets to them.

Enter quantities into the system
Once the physical stocktake has been completed, you are ready to make entries to record any differences in stock levels 
into the system. Remember that any item which mSupply® calculates as having zero stock will not appear on the 
stocktake sheet.

Filtering the list by item name or code
To facilitate making any adjustments, you can rapidly find an item by entering the first few characters of its name, or its
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code in this field, and clicking the Find button. The list will be reduced to show only the matching items. To return to 
the full list, clear the find field and click the Find button again

Making Adjustments
If there is a discrepancy between the amount mSupply says you have in stock (the figure which appears in the Snapshot
quantity column) and the physical amount counted or between the batch, expiry date or location of the stock and what 
is shown in mSupply, you need to make an adjustment as follows:

1. Double click on the row you wish to edit, and the Edit stock take line window appears, with the figure in the Stock take 
quantity field highlighted.

2. Enter the figure from the completed stock sheet in the Stock take qty field (just type the new figure, and the currently 
highlighted figure will be replaced).

3. change the batch, expiry date or location fields also if needed.

Note: If you only need to change the quantity for a particular stocktake line then click the line to select it then click on 
the value in the Enter quantity column and type the correct value directly into the stocktake sheet (don't do it too 
quickly or mSupply will think you're double clicking the line and the Edit stock take line window will appear!).

Adding items not in the stocktake list
In the event of an item being physically present, but absent from the computer generated list, then it needs to be added 
to the stocktake in mSupply®. Proceed as follows:
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1. Click the New line button, and the Add stock take line window appears with the options of using existing batch lines, or a new 
unrecorded batch line, and the appropriate radio button should be checked:

•
2. Enter the item name or code (enter part of the name or code and press tab to search), and if mSupply®'s records have details of 

the supply of this item, a window appears listing the entries, from which you can highlight the one with a matching batch number,
and click the Use details button

•
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Finalising is not reversible, so you have to be 
quite certain you're ready to proceed.

3. In the example, propranolol 40mg tablets have been found with batch no. PK2077, so this line is highlighted, the Use details 
button clicked, and appropriate entries made in the window which appears:

• Note also that from the colour drop down list a different colour (blue) has been selected, and this entry will now appear in that 
colour on the stock take sheet, making it easily identifiable.

• When the Use details button is clicked, you will be returned to the General tab where the details have been completed, and only 
the quantity needs to be entered under the General tab

You are returned to the Stocktake sheet window, where the new line entered will now appear in the colour selected, if 
any; note that the entry in the Snapshot column is zero.

All details of a new line added may be edited, but only the quantity or the location of existing lines on the sheet may 
be edited; this is performed by double clicking on the row you wish to edit.

The Delete item button will only work to delete lines which you have added yourself (i.e. lines with a snapshot quantity 
of zero).

Create inventory adjustments
When all necessary adjustments have been entered, you are ready to create the inventory adjustments; this is easily 
performed by:

• clicking on the Create inventory adjustments button
• confirming your intention in the window which appears

Once inventory adjustmens have been created, the status of the stocktake changes from suggested, sg , to finalised, fn .
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• You will now observe a change in the buttons appearing on the Stocktake sheet; 
• in the upper area only the Print button is present
• while at the bottom two new buttons are present - Show added adjustments and Show reduced adjustments

• click on either button to display the related inventory adjustment transaction.

Print the report
Clicking on the Print button and highlighting Inventory adjustments will print this information; you may select the 
format to be printed from several options:

In this example, three adjustments have been made:

• Magnesium carbonate: present at the physical check but not on the sheet, has been added
• Peppermint oil has had its stock increased
• Sodium bicarbonate has been reduced in stock

Items that weren't changed don't show in the report.

Some points to note:

• When you have created the stocktake sheet, it's like `taking a snapshot'; the physical stock at that location should not be removed 
until the stocktake has been performed; nor should stock be added.

• New transactions can however, be entered into the system.
• the Log tab on the Stocktake sheet will list any anomalies. An anomaly may occur if a transaction has been entered after the 

stocktake that issued more stock than you physically counted. Obviously someone has made a mistake in such a situation.
• There is on the stocktake window (lower left corner) a checkbox Locked , which, if checked, will allow neither deletion of the 

stocktake nor any changes to be made to it.

Previous: Next: 

Show items with stock
Updated: version 3.12

This can be accessed by choosing Show items with stock from the Item menu or by clicking on Show stock from the 
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Item tab in the Navigator.

Either of these options will display the window as shown:

By default all stock is listed, and where the stock of an item is present in different batch numbers, each one is displayed.

You can choose the columns displayed by clicking on the Customise button to display this window: 
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Listed under Available are the columns not presently displayed, and under Chosen are the columns presently displayed.
Changes are made by highlighting your chosen column on this window, and moving it using the buttons in the centre to 
add or remove it from the display.
 You can order the list by a specific column of your choice by clicking on the column heading.

Filtering the list
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To find all items containing ran enter @ran 
which will display all items which include 
the characters entered, not only those items 
where the characters entered are at the start 
of the item name - e.g. this will not only 
display any Ranitidine in stock, but will also 
display `Pyrantel', `Nitrofurantoin', 
Propranolol', etc..

Entering the item name or code in the box will filter the list; entering the first few characters of an item name will 
display only those items which begin with those letters (or numbers). 

To display a specific item, either the item code or the full name should be entered.

Filtering by location
Alternatively you can filter by location. Leave the first search box blank and enter a location into the second search box.
This will show only the items with that location.
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Even more specific
To view an even more specific selection of stock you can filter by both item name and location. By entering your 
criteria into both boxes, only the stock which matches your specified name and location will appear.

192



If you are doing a “normal” stocktake, it's 
better to use the stocktake module described 
as it will create the needed inventory 
adjustments automatically.

Previous: Next: 

Inventory adjustments
Choose Items > Show inventory adjustments

Inventory adjustments allow you to increase or decrease the stock of an item that is recorded in mSupply®. You will 
need to adjust the inventory if:

• Stock is discarded (due to damage or expiry)
• You do a Stocktake and find that physical stock is different to the stock recorded in mSupply®. In this case the first thing to do is 

to see if you can find out where a mistake may have been made in issuing stock. For example, you may be able to retrieve extra 
stock mistakenly given to a client, or may need to ask a supplier for an order that has been entered but never actually received.

• Stock has been stolen.
• As a general rule, consider using a regular invoice to account for any transactions with a customer or supplier. Only use an 

inventory adjustment as a last resort.

Inventory adjust - add stock...
Choose Items > Inventory adjust (Add stock) Use this function when you have performed a stocktake and find that 
the physical stock of an item or items exceeds the amount recorded in mSupply®.
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A transaction that is like a supplier invoice will be created. Enter the details in just the same way you would as if you 
were receiving goods from a supplier, except that mSupply® fills in the Name field for you automatically, and does not 
allow you to edit it.

After a stocktake, this can be used to adjust any stock lines where the stock recorded in mSupply® is less than the 
physical stock.
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You will be asked to enter the margin when starting this transaction. For a normal inventory adjustment, set this to zero. 
If you are using this procedure to enter stock when starting to use mSupply® for the first time, enter the percentage to 
apply here.

Inventory adjust - reduce stock...
Use this function when you have done a stocktake and find that the physical stock of an item or items is less thanthe 
amount recorded in mSupply®. A transaction that is just like a customer invoice will be created, except that you do not 
choose the customer. The section on entering customer invoices describes the entry procedure. See the section on 
Issuing goods - Customer invoices here

Inventory adjustments are treated by mSuppy as a kind of Supplier invoice (or credit). To view or edit an inventory 
adjustment, Choose the “Show inventory adjustments” option from the “Item” menu.

Previous: Next: 

Units
Choose Show units from the Items menu. When you have defined your units, a list is displayed:
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Click the New button to add a new unit.
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Do not change the record for one unit into a 
different unit, as all items using that unit will 
be updated.

Note that you will need to have sufficient user permissions to use this function.

Click the Merge button to merge two units. Note that duplicated units can occur on import of units or a user may 
duplicate a unit being unaware of one existing already. The below window appears to merge the units. The green boxed 
unit is the one that will be kept, the red boxed unit will be deleted.

Accounts...
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Choose Show accounts from the Items menu. This window allows you to manage the range of accounts that can be 
assigned to items.

Account codes are used when exporting transaction data from mSupply® to external accounting software. Double-click 
a line to edit its details. Changing an account code or description will affect all items that are assigned to that account.

Click the New button to add a new account.
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Updated: version 3.2, May 2014 (This functionality 
not available in earlier versions)

Fill in the code, description field and select the account type. The field Items that use this account code will display 
such items for each account code. Account types are Expense, Income and Asset .Click on OK button to add a new 
account, and Delete button to delete an account.

Previous: Next: Names: Using, adding and editing

Forecasting
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In mSupply, consumption is defined as stock 
that is issued. Stock lost due to damage, 
expiry, etc. (managed through ) are not 
included in consumption. During the later 
quantification calculation, there are options 
to include or exclude Stock Transfers and in 
the consumption calculation.

By default, mSupply uses the assumption that future consumption will continue at the same level as consumption over a
given historic period. Our experience is that in 99% of situations the results obtained using this method are between 
very good and excellent. However, in certain situations you may want to provide your own forecasts. Reasons for this 
could include factors such as:

• Natural population increase
• An epidemic causing increased demand
• Historical usage being inaccurate due to operator error or out of stocks.
• A change to Standard Treatment Guidelines meaning a new treatment is being introduced, and there is no historical data
• Morbidity and mortality data has been obtained and used to calculate requirements. mSupply provides a number of alternative 

methods for making a forecast of future consumption. These other methods are detailed in sections following below.

/*

Worked Example
To illustrate forecasting and quantification for purchase orders, a worked example will be used. In our worked example, 
we have monthly consumptions of Amoxycillin 250mg tabs/caps over a two year period of May 2013 - Apr 2015 as 
shown in the table below:

Month 2013 2014 2015 

Jan 461,700 638,600 

Feb 109,700 321,000 

Mar 290,000 1,152,000 

Apr 274,000 398,000 

May 657,284 248,000 

Jun 147,400 666,000 

Jul 764,400 1,313,100 

Aug 310,210 683,500 

Sep 417,080 852,200 

Oct 504,000 684,100 

Nov 764,200 639,000 

Dec 767,642 491,000 

From the data above, we can see that the Average Monthly Consumption (AMC) for Amoxycillin 250mg tabs/caps over 
historic periods are:

Period AMC 

Last 24 months (May 2014 - Apr 2015) 564,755
Last 12 months (May 2014 - Apr 2015) 673,875
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For our worked example, we will use the 
Historic AMC method, based on 12 months 
of historic data.

Last 6 months (Nov 2014 - Apr 2015) 593,326
*/

mSupply allows you to choose to use from a range of forecasting methods on a per item basis. To choose a different 
forecasting method for any given item, find the item you are interested in, then open it's details view, and choose the 
Usage tab:

In the Forecasting section of the window shown above there are four options:

Use Historic AMC
This is the default option, and is the recommended method. During the later quantification stage (creating a new tender, 
creating a new purchase order or the suggested order report), there is an opportunity to provide the number of months of
historical data to use to calculate the forecast.

Use historical AMC increased by a factor of X %
Using this option, mSupply will still calculate requirements based on historical AMC, but increased by the percentage 
you have entered.
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BEWARE! Once set, this option will 
continue to govern for every forecast 
generated by mSupply for this item until you 
re-set forecasting to the default (use of 
historical AMC).

BEWARE! Once set, this option will 
continue to govern for every forecast 
generated by mSupply for this item until you 
re-set forecasting to the default (use of 
historical AMC).

Don't double-click: you need to click once, 
wait for a second or two, then click again

Use a fixed, estimated AMC of .....
This option allows you to specify a particular amount that will be applied to all future months. For example, you might 
have caluclated a target consumption for an oral contraceptive based on fixed population and coverage targets.

Use Projection (A or B)
With this option, mSupply allows you to maintain an A and a B projection, and easily swap between them. Of course 
you must enter projections for this to be of any use!

Entering Projections
You can enter projections in a number of ways

Manually entering projections

If you click once on a cell that contains a projection (as opposed to a cell containing historical data), then you can click 
again to edit the cell's value.

Copying a projection

You might want to copy historical data as a starting point for your projection. You can do this by choosing a column for 
from column and to column in the Projections section, then clicking Copy values.

Modifying a projection
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If you are using projections, you are 
responsible to fill in future values for the 
period to be covered by your ordering. 
Leaving future projections at zero will have 
potentially serious consequences.

BEWARE! Once set, this option will 
continue to govern for every forecast 
generated by mSupply for this item until you 
re-set forecasting to the default (use of 
historical AMC).

You can use the Modify selected cell button to increase or decrease a column or some cells in a column by a certain 
percentage.

For example, you might have entered values for 2016, and then decide your 2017 values should by the 2016 values plus 
8%. To do this

1. Fill in your 2016 column values
2. Add a column for 2017 if one doesn't already exist
3. Use the Copy values button to copy 2016 to 2017
4. Drag to highlight all rows in the 2017 column
5. Enter 8 in the percentage field, then use theModify selected cell button to increase the 2017 values by 8%.

Where does mSupply use forecasts?
Any time mSupply produces a suggested order quantity, it will consider each item and use the forecast options for that 
item to produce a forecast. This includes:

• Creating a new tender
• The suggested order report
• Creating a new purchase order

Names: Using, adding and editing
Updated: version 3.1 

About names
In mSupply® a “name” can be a customer, a supplier, a manufacturer, a patient, etc. (Note that a “customer” can be any 
recipient of your goods - e.g. another organisation, a ward in your hospital or a patient)

Adding a Customer, Supplier or Manufacturer
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To add a new customer, choose Customer > new customer from the menu. 

To add a new supplier, choose Supplier > New supplier from the menu. (Makes sense really!) The window will look 
the same as for adding a customer, except the supplier checkbox will be checked and disabled.

To add a new manufacturer, choose Supplier > New manufacturer from the menu.

The window will look the same as for adding a supplier, except the manufacturer checkbox will be checked and 
disabled.

Items in the names entry window
Name Code: The unique code to identify this customer, supplier or manufacturer.

Charge to: mSupply is made to work in tandem with an accounting program (although it will also function just fine by 
itself). The “Charge to” code is what is exported with each invoice. Generally you should make the charge code and 
name code the same (If you want, there is an option in the Preferences > Misc tabto make sure this is the case). For 
example:

• If you have 3 hospitals you supply, but you send the bills to one centre for payment, you may want to enter each hospital with its 
own name code, and all of them with the same charge code. In your accounting program you would just enter one debtor 
(customer) with a code the same as the charge code. eg

<div align="center">

Customer Name code Charge code 

Fred H Hosp fhhosp bluehos 

Mary P Hosp mphosp bluehos 

Sam Q Hosp sqhosp bluehos 

</div>

• In your accounting program you would enter “Blue Hospitals Assoc” with the code “bluehos”
• For a supplier, if you have entered a default currency and margin these will be entered, but you can override them. Every supplier 

should have its currency entered (The currency it uses for your invoices). If the currency isn't yet in your system, close the name 
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if you do not wish to use different name 
codes and charge codes, check the “supplier 
name code and charge must match” and 
“customer name code and charge must 
match” check boxes in the mSupply 
Preferences. If you do this, the charge code 
will automatically be identified with the 
name code.
spaces are not allowed in name codes and 
charge codes

entry window and choose Currencies from the Special menu to add it.

Either the “customer” or “supplier” check box will be checked as appropriate, depending on whether you have chosen 
“new supplier” or “new customer” from the menus to produce this window. However, you can still alter things here 
without upsetting mSupply.

Name: The customer/supplier name. (Remember you can use the Tab key to move from field to field)

Master ID & Master name: These are used when using the remote tender module to link suppliers with their master id 
maintained by Sustainable Solutions.

Type: In the main entry screen, there are 4 check boxes to mark each entry as a customer, a supplier, a manufacturer 
and an additional Benchmark category. This last category is a feature of the Tender Management module, and is fully 
explained in that section, under Using Benchmark prices

Status - Hold checkbox: If this is checked this name can not be used for receving or issuing goods.

Donor checkbox: (Applicable to suppliers only) There are two situations in which this box should be checked:

12. If this supplier/organisation provides goods free of charge (either in whole or in part).
13. If this supplier/organisation provides funding (either in whole or in part) for purchasing. 

Price Category: Selection of any of the categories will fix a certain price margin for that Supplier or Customer.The 
price category value is entered in File >Preferences > Prices . When goods are being issued to this customer, the selling
price is increased/decreased by the percentage specified in the Preferences for this price category.

• Eg: Consider customer XYZ, who is in category B, and in the preferences category B is assigned a value of 50. If an item is issued
to customer XYZ with a normal selling price of $10, the selling price on this invoice will be $15.

Address and contact details: These should be completed with relevant details

• For customers, you can enter separate delivery and billing addresses as necessary.

Other - Category: There are 6 category fields available for customisation as required, each category having its own 
drop-down list showing the choices which have been defined using Supplier > Show categories or Customer > Show 
categories (see for more details). In our example, Category 1 is displayed as Ownership, and Category 2 is displayed as 
Classification. The default names are category1, category2, etc., but these may be replaced by customised names by 
editing the text displayed in File>Preferences, selecting Names in the side bar.
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Category 1 is now displayed as Ownership, the choices available being Government and Private, while Category 2 is 
now displayed as Classification, the choices available being displayed in the drop down list: 

These fields are available for you to make whatever entries are appropriate in your situation. For example, you might 
wish to subdivide your Hospital category by number of beds, or your Clinics by the number of patients seen daily, etc. 
Or you may wish to identify your customers by their geographical location, or by location type - urban, city centre, 
rural, remote, etc.. The choice is yours - the main point to remember is that these fields are searchable, enabling you to 
produce reports relating to very specific criteria. which are displayed once they have been defined in 
File>Preferences>Names. 

Analysis: You can use this field to group together certain types of customers or suppliers. You can filter the report by 
selecting the group in the Analysis field.

Postal address: Here you can enter a postal address if it is different to the physical address of the supplier.

Mapping a customer's location
You can use the coordinates

If you locate a customer on Google Maps and then click the link button at the top right corner of the window, you can 
copy a google map link. If you copy and past the link into a text editor or word processor you will see a section that 
looks like this 
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If the US President suddenly becomes your 
customer then his location would be :
Latitude : 38.897669
Longitude : -77.03655

ll=-21.261901,-175.140309

The first number after “ll” is the longitude, and the second number is the latitude. If you enter these numbers into the 
provided fields in mSupply, you can then view the customers location by clicking the Google maps button.

Hiding Names on a per-store basis
If you check the Hide in this store checkbox, the customer/supplier you are currently viewing will no longer be shown 
in the store your are now logged in to.

• This allows you to have customers that are specific to each store.
• To find a name that is hidden, you can use the Complex find button in the window that is shown when you choose Names > 

Show customers or Names > Show suppliers

Extra information for customers only.
Shipping address: If the name is a customer, shipping address fields will be shown.

Extra information for suppliers only:
Currency: Enter the currency code of the currency this supplier uses for invoicing you.

Margin: Enter the percentage margin to apply to items received from this supplier.

Freight factor: Enter the amount to add to quotations from this supplier to adjust quoted prices for freight. For 
example: a physical check on invoices from IDA reveals that freight to Nepal generally amounts to about 15% of the net
value of the invoice. Therefore we would enter “1.15” in this field for IDA. Note that if suppliers quote you “CIF” 
prices, then you should enter “0” here.

About Manufacturers
When you are receiving goods, you can optionally specify the manufacturer of each item. Manufacturers can be chosen 
from a list that is made up of names which have the Manufacturer checkbox checked.

For the manufacturer field to be shown, the option must be turned on going to Special > Show stores > [choose your 
store and double-click] > Preferences tab and checking the Able to specify manufacturer when receiving, ordering
or quoting for items checkbox

Editing a Customer, Supplier or Manufacturer
For this example we will edit a customer. Editing a supplier is just the same, except that you start by choosing Show 
supplier from the Supplier menu.

Choose Customer > Show Customer. You are presented with a window to enter as much of the Customer name or code 
as you know:
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• The slide bar at the top of the window may be set to Normal, at the left, or at intermediate points towards the Fuzzy end (right); 
this determines the accuracy of matching your entry; when set to Normal, the search will only match exactly what has been 
entered; when set at Fuzzy the search will list entries which are approximate matches to what has been entered. The accuracy with
which the list matches the entry is determined by the position of the slider.

• If you leave the name/code field empty, clicking the Find button will produce a full list of all customers.
• Note that the window has a series of radio buttons to select the target of your search - All names, Customers, Suppliers, 

Manufacturers, etc. So even if you start this search from, say, Customer > Show Customer., by selecting the Suppliers radio 
button, you can search in suppliers, rather than customers.

If the text you entered matches more than one entry, a list of matching names is shown.

Buttons in the names list window
New: This button allows you to enter the details of a new customer

Modify: This button opens a window displaying the details of the highlighted customer, allowing their details to be 
modified.

Set Flags: This button allows you to mark certain names with a flag.

• First, highlight the names you wish to flag by holding down the control key (command on Mac) and clicking the names in the list 
you wish to use. Then click the Flags button to show a window where you can enter the flag you wish to add, and decide whether 
to replace any existing flags or append the new flag to the old one.

Print: Clicking this button will print a list similar to the one displayed on screen.

Find: This button shows the same find window as choosing the menu item did so you can find a different group of 
names.
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Order by: This button allows you to sort the displayed list by the criteria you choose. The Labels and Print buttons will 
use the order that is displayed. By default names are displayed alphabetically based on the name column.

Merge: This button allows two customers to be merged into one; highlight the two entries click on the Merge button to 
display this window:

Choose the record you wish to keep and click on OK ; the data from the deleted record is then merged with the data of 
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the reord being kept. If you change your mind, click on the Cancel button, and the merger will be cancelled.

Labels: Clicking this button allows you to print address labels for the names in the list. The label editor is displayed.

Report: Click on this icon to open the Quick Report editor window. Use of the Quick Report is discussed elsewhere in 
the guide. See Custom Reporting Tutorial

Customise: Allows you to choose which columns to display using this window (Note: this only affects the columns you
see in this list, it won't affect what other users see):

Columns on the left are available. Columns on the right are the ones in use in your names list. Click a row in either 
column then click the move left or right button to transfer it to the other column. Click OK when you're done, or 
Cancel if you want to stick with what you've got. Your choice of columns to display will be remembered for the next 
time you display a list of names (customers, suppliers etc.).

OK Button: Closes the window

Editing or viewing a name
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To edit/view a particular name, double-click the entry you want from the list, remembering that you may view all 
customers or suppliers, by clicking the Find button without entering anything in the search field. A window showing the
customer details is presented. Double-click a line to view details for that name. Note the window displayed has a 
sidebar with many options, General, Invoices, Backorders, Quotes, etc., and opens at the General tab. 

The Invoices tab
Here you can view the invoices for a customer or supplier.
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You are able to edit an invoice directly from this window by double-clicking the one you wish to edit. A new window 
will open with the invoice details displayed.
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Buttons on the Invoices tab :
Print Range: Click this button to print a range of invoices for a customer. You will be asked to enter the first and last 
invoice numbers to be printed.

Aging: Click this button to display a list of aging categories and the outstanding unpaid balance for each invoice in each
category.
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Dates: Choose a date range from this menu to show quickly recent invoices, or to revert to showing all invoices

The Backorders tab
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• Here you can view, add and edit the backorders for a customer. mSupply allows entry of backorders against suppliers as well, but 
we are not sure why you would want to do this!

Buttons on the backorders tab:
New backorder: Clicking this button presents you with a window where you can add a backorder line for this 
customer.
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• Type at least a portion of the item code or item name, then press the Tab key.
• Today's date is automatically entered. You can change the date if you like
• Enter the total quantity owing.
• Enter a comment (e.g. an expected arrival date)
• Click OK to save changes and exit the window.

Delete backorder: Click a backorder line to highlight it, then click this button to delete the line.

Copy: This command copies the backorder to the clipboard, allowing you to paste the report into an email message, 
word processor or spreadsheet document.

Print: The list of backordered items for the customer is printed.

Viewing Backorders
Double-click a backorder line to edit the line. You will be shown the backorder entry window, where you can change 
any details you wish.

Show: This drop-down list allows you to choose which backorders to display.

• Backorders are normal items that have not been supplied to customers.
• Ad Hoc items are items that customers have ordered but which you do not want to add to your stock list, rather making a special 

order just for that customer.

The Quotes tab
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You can view the quotations you have entered in mSupply for this supplier.

The Notes tab
To add, edit or delete a note, click on the Notes tab, and this window displays:

Click on New note to create a note, or select an existing note and double click on it to view, edit or delete it.
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• The date on which you are entering a new note is already completed, and in the main panel you should type in the wording of the 
note itself. 

• In the lower left of the window is a drop-down list offering various choices concerning the displaying of the note on screen; it may
appear as an alert when a Supplier invoice is created, when a Purchase Order is created, etc..

If never is chosen, the note will never be displayed on screen, and if all is chosen, it will display for all events for this 
customer/supplier. You may also set the background colour of the note , but as the text is always black, dark colours 
should be avoided. A further option allows you to have one or more audible `beeps' sound when the note is displayed. 
Each note will display according to the attributes set for it, independently of other notes defined for the same 
customer/supplier.

Subsequently, when this customer/supplier is selected and depending on the display settings made, the note will appear 
on screen; be aware that the note does not disappear automatically - you must close it/them manually.

The text of a note can be up to 32,000 characters.

Click OK when you are finished.

The Contacts tab
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To add a contact for this customer or supplier, click the Add contact button , then enter the details in the window that 
appears. [At the time of writing, December 2011, the column on the right headed Yes/No is inactive]

Note: mSupply is not designed to function as your main source of all contact information- it is only designed to keep 
simple information about customers and suppliers, and people within those organisations.

To delete a contact, click on the contact you wish to delete, then click the Delete contact button.

The Group tab
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Groups are only relevant to customers, not 
suppliers.

If this customer has been added to a group, this tab displays the name of that group. An explanation of groups and how 
to work with them will be found here: Show groups...

Here you can select the group of which a customer is a member. When you choose a group, you will be shown a list of 
item departments which are linked to the chosen group. Once the group system is activated in the Preferences, only 
items belonging to one of the listed departments (or items with no department) may be supplied to that customer.

The Purchase Orders tab
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This tab shows a view of Purchase Orders for the current name, and applies to suppliers only.

The Web log-in tab

If you are allowing customers to access their order information using the mSupply web server, this is the window where
you assign a logon name and password to a customer.

Also displayed on this tab is the internet connection speed. It should be noted that this value is derived from your 
network settings, and may not be edited manually.

The Item lists tab

226



Above is the window which appears when the Item lists tab is clicked.

Presently this window is used by those operating an Imprest or Stock history system of stock control. For more 
information, see Item master lists

The Stock history tab

A list of stock histories, showing dates of both the stock take and the date of entry into the computer, the ID reference, 
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Only users who have Admin privileges may 
access this feature. See Managing users

the status and the type, is displayed.

The Store Tab

When the Store tab is chosen, this window appears.

The window displays the status of stores which this customer/supplier may use. Only when the visibility checkbox is 
checked, is the customer/supplier visible (and able to be used for receiving and/or issuing goods) in that particular store.

Previous: Units Next: 

Contacts...
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This command from the Special menu displays a window where you can edit contacts.

Contacts are usually associated with a name (a customer or supplier), and it is easier to edit such contacts using the 
“show suppliers…” or “show customers…” command.

If a contact is not associated with a name, you can edit details for that contact using this command.

Buttons in the contact list window:
New: Use to add a new contact.

Report: Presents the Quick report editor window. See Using the Query Search editor

Find: Use to find an individual contact

Order by: sort the contacts

Print: clicking this button will present you with a dialog with two choices:

• If you click list a list will be printed of the records in the window.
• If you choose labels, you will be shown the label editor, allowing you to print a set of address labels for the current list of 

contacts. Note that you can save a particular label layout and then use the load command in the label editor to restore your layout.

New: To edit a contact, double-click on the line you want to edit. You will be shown the contact details:
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Previous: Next: 

Name Categories
You can categorise names in mSupply with 6 different categories. You can apply one or all or some of these categories 
to a name. Categories 2-6 are standard categories but category 1 is special - it's hierarchical and has 3 levels, level 1 is 
the top and level 3 is the bottom (similar to item categories).

Suppliers and customers have their own sets of categories. To view and edit them you choose Show categories from the 
Customer or Supplier menu and that brings up this window:

Here you can add and edit categories for your suppliers or, in this case, your customers.

Show drop down list: This determines which category type is shown in the list and which type of category will be 
created if you click on the New button.

Delete button: Deletes the category you have selected in the list. You'll be asked to confirm the deletion first of course!

New button: Opens up the new category window which looks like this (Note that double clicking on a category in the 
list opens up this window too but it will be populated with the current settings for the category you double clicked so 
that you can edit them all):
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Description: This is the category name and will be seen everywhere when assigning names to categories or filtering on 
name categories in reports.

Category_user_field_1: This is a user-defined field. If a label has not been entered in the preferences then the default 
Category_user_field_1 shown here is used. The information you enter here is used in some reports.

Category_user_field_2: A second user-defined field, same rules as for Category_user_field_1 apply. 

Parent category drop down list: This only appears if you're editing a category 1 level 2 or 3 category because they are 
the only ones that can have parent categories. A parent category is the category to which this category belongs. If the 
category you are creating or editing is level 3 then you will be able to choose one of the level 2 categories as a parent. If
you are editing a level 2 category then you'll be able to select one of the level 1 categories.

Previous: Next: 

Merge two names....
If you accidentally enter two names into mSupply that identify the same organisation, you can use this command to 
combine them.

Use extreme caution: This operation will move all historical records from the name you delete to the name you are 
keeping. The operation can only be undone by reverting to a backup copy of your data file.

In the window displayed enter the name to keep, and then the name to delete. When you have checked then checked 
again that the information is correct, click the OK button. You will be given one last chance, and then…..
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If the virtual store is 'Active' on a satellite 
server in a synchronised system (refer 
Remote Synchronisation) then the merging 
needs to take place on the primary server.

You can also merge a name into a virtual store (the store must be the name to keep). This is particularly useful if, for 
example, you have a customer which you now want to turn into a store to manage their stock more fully. This has the 
benefit of moving all the transactions connected with the customer into the store so that you don't lose any historical 
transaction information. Note that when you carry out such a merge you must finalise all transactions belonging to the 
customer first (mSupply will tell you to do this if you have not already).

Previous: Next: 

Suppliers: Adding and Viewing

New Supplier...
To add a supplier, choose this item.

Note- if this supplier will have invoices entered against it and you are exporting invoice data to an accounting program,
a new “creditor” must be made in your accounting software with the same code, or you will get an error when you 
import! (You can usually make the code when you get the error in your accounting software when you try to import!)
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The window for viewing/editing a supplier contains basic information. Fields that especially relate to suppliers include:

Currency: If you are using currencies, enter the currency used by this supplier. This value will be filled in with the 
value set in the “default currency” option of the Preferences.

Margin: The amount (as a percentage) that will be added to the cost price to calculate the sell price when you enter an 
invoice. For example, if you enter “10”, items from this supplier that are bought for 30 dollars will have their value 
increased by 10% (i.e. 3 dollars) and will be sold for 33 dollars.

Category: You will note that the Supplier box is already checked. The special Benchmark category is discussed fully in 
the section on Tender management, which you can access here.

Freight factor: The amount to multiply supplier quotations by to account for freight charges. (If their quotations are 
“CIF” you should set this to zero).

Show suppliers...
This item allows… you guessed it - you to view suppliers. This window is displayed.

In the field, type as much of the supplier name or code as you want to. If there is only one matching item, the details 
will be displayed, otherwise a list will be displayed from which you can choose the name you want by doubling clicking
it.

Note that if a supplier has invoices entered against it, you will not be able to uncheck the “supplier” check box, and you 
will not be able to delete the supplier.

Previous: Next: Introduction to Tender management

Updated: Version 3.1

Introduction to Tender Management

Introduction
In order to achieve the best value for available funds, it is common practice to seek out the best prices for the medicines 
that will be required, usually for the forthcoming year, by publishing a tender. Normally, the full tender process creates 
a lot of work which can be very time consuming and error prone. The mSupply tender module is designed to make the 
process as simple as possible, to minimise the work involved and to reduce the chance of errors.
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Note that for multi-user installations, Tender 
management activation requires payment of a 
fee. Please see the website here or contact 
Sustainable Solutions for more information.

As usual in a tender process, forward planning is necessary, as the process must be started several months before the 
goods will be on site and available for use.

The work flow for using the tender module is:

14. Prepare list of items and quantities. See Creating a new tender
15. Distribute list to suppliers. See 
16. Create benchmark prices. See 
17. Evaluate received quotations. See 
18. Select preferred suppliers. See Accepting tenders 
19. Create Purchase Orders. See 

From your usage history, mSupply can prepare a list of items and anticipated quantities. This list is distributed to 
suppliers, who are invited to submit, after a reasonable period of time, their quotations, inclusive of all additional 
charges., e.g. freight.

The list may be uploaded to the web, and interested suppliers invited to submit their quotations online; conventional 
methods of submitting quotations are also available. We recommend the online method, as it reduces paper 
consumption, and is less labour intensive.

Once all the quotations have been received, mSupply will assist in processing them, comparing quotations, performing 
necessary currency conversions where appropriate, applying freight charges etc.,

The user then has all the relevant information enabling informed choices to be made in selecting which supplier for 
which item.

Finally mSupply will create Purchase Orders for the successful bidding suppliers. While mSupply can perform all these 
tasks from stored usage data, it will allow users to change supplier and/or quantities, should special circumstances 
prevail in particular situations.

Preferences: If you want to see what preferences can be set for the tender process, see tender preferences.

Getting started
Select `Show tenders' from the supplier menu or from the Navigator's Suppliers page.
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There is filter allowing selection of tenders to be displayed according to this list:

A window is shown with a list of current tenders (if any) and some options.
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Creating a new tender
Two options are available :

• New Generated Tender Once you have been running mSupply for a year, and providing that year is fairly typical of your overall 
usage, the New Generated Tender is recommended; this option will suggest quantities based on actual usage, having regard to 
seasonal fluctuations, thus eliminating any guesswork. Note, however, that quantities are suggested only, and may be amended as 
required.

• New Tender - allows you to create the tender manually and is a more labour intensive process

New Generated Tender [Auto-generation]
To have mSupply automatically create a suggested tender based upon your projected demand, click on the New 
Generated Tender button, and confirm your intention by clicking Yes on the Confirm window.

This window will appear. You may recognise it from the Item usage report and suggested order report - it uses much of 
the same functionality:
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You can tailor your search by item in the usual way. Clicking the refresh button (double arrows near the centre) shows 
an estimate of how many items will be processed. Further refinements can be added. Be sure to enter the number of 
days stock cover you require in the last text box - in the example above, items whose names start with `A' are to be 
processed, including those which have not been used in the last 12 months, and 300 days of stock is to be ordered (if it's
needed).

Processing all this data may take some minutes if you have a lot of stock items recorded in your system, so mSupply 
will ask you if you've got the time to do it. If you do, click `Yes'. A progress indicator will show you how much work is 
left to be done. When mSupply has finished processing everything, it will let you know:

Auto-generated tenders may be rather large, so you may wish to process several tenders with more specific criteria 
rather than one huge one at once. In our example, if we restrict our search to all items beginning with `A', we get 46 
tender items instead of 839.

You can choose to look at your tender immediately, or return to it later. If you click `Yes', you'll see something like this:
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Points to note here:

• Several default values have been entered for the description, dates and ref fields at the top that you're going to want to change.
• There are no units chosen for any of the tender items
• The message `Automatically generated as part of a tender' has been entered into each item's comment.
• The pack size for most of these items is 1.

A pack size of 1 is assumed because mSupply looks for the default pack size and default unit for each item as it creates 
the tender (these values are set when editing Items - see Item Basics ). If it does not find a default unit, it leaves units 
blank, but enters a `Check units!' warning into the comments. The same goes for pack size - although if you don't tell it 
otherwise, mSupply assumes a default pack size of 1. Tender auto-generation will therefore be most useful if these 
default values are set for items.

New Tender [manually entered]
To create a new tender manually, having opened the Tenders window by clicking on Show tenders on the menu, click 
the New Tender button.

This window opens:
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Here you can fill in basic information about the tender.

Creation date: The date the tender was created. This defaults to today's date.

Issue date: The date the tender is/was sent to suppliers. This also defaults to today's date, but can be changed.

Response by date: The date by which suppliers must respond to the tender. The default is set to one month from the 
creation date, but can be changed.

Status: Tenders can have a status of sg/cn/fn (suggested, confirmed and finalised).

• Suggested status - tender is still being built.
• Confirmed status - list of items & quantities is complete; suppliers invited to provide quotations may be added, and, once 

received, their responses added. Decisions may then be taken regarding which quotation is preferred for each tender item.
• Finalised status - no further editing may be performed, and the tender can now be used as a basis for purchasing

Locked checkbox: Check this box to ensure the tender is not accidentally deleted.

Our ref: This field may be used to enter a short reference code to appear in tender-related correspondence.

Comment: The comment field is for your internal use. It is not printed on any tender documents.

Tabs on the Tender Details window

Items and compare prices
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This tab displays by default when you open a tender for editing. It displays the items currently included in the tender, 
and by selecting 'All', 'Filled' or 'Unfilled' from the drop-down list above and to the right of the list, you can select 
which items are displayed.

New line button: click this to add a new item line to the tender.

Delete line button: select an item line from the list and click this button to remove it from the tender.

Print internal report button: click this to select one of several reports to print out or export to a spreadsheet. There are 
several to choose from and will give you the information you need to help evaluate or analyse a tender: Preferred 
suppliers only, Winning tender lines, All supplier responses, Supplier quotes with adjusted price, Supplier quotes for 
each item, Tender lines with predicted cost, Tender lines where the lowest price was not chosen.

Notes

Clicking this tab shows a field where you can add conditions which apply to the tender as a whole and are NOT specific
to certain items. To start a new line (as with any text box), press Shift+Enter (although any long lines will wrap). See 
below for an example:
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Choose suppliers and enter responses tab: This tab is used to manage sending of the tender to suppliers, and entering 
responses. See 

Standard conditions: Use of this tab is described here: 

Purchase Order: Use of this tab is covered in detail here: 

Reference Documents: Use of this tab is covered in detail here: 

Tender Preferences: Use of this tab is covered in detail here: Setting up Purchase Order (PO) preferences

Synchronise: 

Log: This tab shows recent events relating to this particular tender. It will show, for example, changes in prices or other 
significant events. You cannot edit this tab.

Adding items to a tender
To add an item to a tender, click the New line button on the Items and Compare Prices tab.You will be shown a window 
like this, which opens at the Set tender item criteria tab:
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1. Type as much of the item name or code as you know, then press the Tab key. If only one item matches your entry, it will be filled 
in. If multiple items match, you will be shown the standard item choice list to choose the item you want. Any details completed in
the Full description under the General tab of the selected item are displayed (Description).Should you wish to identify a line (or 
lines) for any reason, clicking on the Colour button presents you with a selection of colours available for the type on that line.

2. Fill in the number of packs you wish to purchase, and the pack size. The total quantity of individual units will be calculated. The 
Round quantities button will round the number of packs to the nearest reasonable number of whole packs (most useful for auto 
generated tenders when the number of packs can sometimes be set to a decimal number).

3. Choose the units you wish to use.
4. You may optionally enter a price per pack figure in the Estimated price field.
5. Click on OK & next to add the next item to the tender, and when you are finished, click on OK .

Entries in the Comment field are for your internal use, and won't be printed on the tender documents you present to 
suppliers.

In the Conditions field, enter any conditions which are specific to this item of the tender , but NOT applicable to the 
tender as a whole. These conditions will be printed on the tender letter with the item details.

The second tab Compare supplier responses, is for use after suppliers have responded to the tender. This will be covered
later.

Note: It is perfectly possible to add the same item more than once to a tender. Each entry will be treated separately. This
allows for the same item to be added, for example, in different pack sizes.

Deleting tender items
Click the line you wish to delete so that it is highlighted, then click the Delete line button. If a supplier has already 
quoted on a tender item, you will be warned before deletion.

Editing tender items
From the Items and compare prices tab, double-click the tender line you wish to edit. The 'Edit tender item' window will
open, allowing you to edit the details in the same way as entering a new tender item, above. Note: you cannot edit or 
delete lines on finalised tenders.

The Search item field allows you rapid access to any item in the tender - just enter the name (or first few letters of the 
name) of an item in the tender, and it will be displayed.

Here's how the Edit tender window looks when the item Ranitidine 25mg/mL injection has been selected; the 
automatically generated tender has calculated that 1023 ampoules are required; here you can edit the quantity to 
conform with, say a pack size of 10, so you would adjust the pack size to 10, and the quantity to 102 or 103.
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Previous: Suppliers: Adding and Viewing Next: 

Standard conditions
mSupply allows you to set up a list of standard tender conditions called master conditions. These are all the conditions 
you will apply to tenders from year to year. Each time you create a tender you can copy the master conditions you want 
to your tender as required - these form the standard conditions list for that one tender. These instructions cover 
managing master conditions and applying them to individual tenders as standard conditions.

When you print your tender letter, the list of standard conditions will print (not all the master conditions!), followed by 
the list of items for which you are requesting prices.

Setting up conditions and their categories
Choose Suppliers > Show tenders, and open the Master Conditions categories tab

Here you may define categories for your master conditions. Examples shown above are Annual, Supplementary and 
Emergency. Subsequently you can restrict the display to a single category by selecting that category from the Show drop
down list.

Choose Suppliers > Show tenders, and open the Master Conditions List tab:
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You can print a master condition selected in the list by clicking on the Print conditions button. To add a new master 
condition, click on the New Condition button. This window opens:
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Point: The conditions will sort by their point entry when printed. We suggest you label your points 1.1, 1.2, 1.3, 2.1, 2.2
etc.

Note that if you have more than 9 points in one of the levels, you should add a leading zero so that they sort properly 
(01.1, 01.2, etc)

Heading: Enter the Heading.

Body: The body can be as long as you like for each entry.

Category: If you have defined categories, they will be displayed in the drop down list, and you may select the 
appropriate one.

Flag: Say you have some entries that need changing after copying to an individual tender (e.g. a closing date). You can 
enter a value in the flag field to identify such entries.

Print heading and body: Use this drop-down list to choose what will print. Normally you'll want to print both heading 
and body, but near the top of a tender form you may want several headings together.

Click OK & Next to add further conditions.

Editing and deleting conditions
Double-click an entry to edit it.

To delete a condition click on it to highlight it, then click the Delete condition button.

Copying master conditions to a tender
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when deleting rows you can highlight 
multiple rows by holding down the control 
key (command key on Mac) as you click 
rows, or press control + A to highlight all 
rows.

When you enter a new tender, go to the Standard conditions tab.

Click the Copy from master button to copy conditions from the master list

Once you have copied conditions, you can add, edit and delete them in the normal way.

Previous: Next: 

Adding suppliers to a tender
To add suppliers to the tender, click the Choose suppliers and enter responses tab to open this window, where the 
suppliers to whom your tender will be sent may be added, or subsequently deleted:
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To add suppliers to the list, click the Add Suppliers button.

A list of all suppliers is shown:
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You can add multiple suppliers by holding down the control key (command key on Mac) and clicking on those suppliers
you wish to add. Once you have selected a supplier or suppliers, click the Use button to add them to the list. To create a 
new supplier, click the New button.

Once suppliers are added, they will appear in the list.

Double clicking a supplier will open a window for adding and editing quotations - see below.

It there are any suppliers listed that do not have a tick in the RTM Link column you will need to contact mSupply 
Support: support@msupply.org.nz

Deleting a supplier

Highlight the supplier you wish to remove from the tender, then click the Delete supplier button. This will remove the 
supplier from the tender - it will not delete the supplier from mSupply. Note: you cannot remove a supplier from a 
finalised tender, or if the supplier has quoted on one or more tender items. If you want to remove a supplier for which 
quotations have been entered, delete the quotations first, then you can delete the supplier.

Inviting quotations from suppliers

Print Invitation letter

Clicking this button prints an `Invitation to tender' letter ready for despatch to the highlighted supplier; the letter 
includes all the items, quantities, etc. as specified in the tender. The default date for a response is one month after the 
date of the letter, but this can be amended to a date of your choosing.

If the default format of the Invitation letter does not meet your requirements, please let us know and we will customise 
the print format to meet your individual requirements.

Email Selected button

Clicking this button produces email documents for each of the highlighted suppliers. A PDF document (the same as the 
printed document) is produced, attached to an email and stored in the email queue. This option will work only if you 
have entered email addresses for the chosen suppliers.

Whichever method you choose, you will be given the option for the `Date sent' field to be filled automatically with 
today's date.

To Spreadsheet

Clicking this button opens your spreadsheet application, with all the items and quantities required on the tender 
document already entered in appropriate rows and columns. This may be saved and sent to the supplier along with the 
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tender letter. Appropriate columns are already in place for suppliers to enter their responses.

Previous: Next:

Reference Documents
While generating a tender, several documents may be consulted - for example, the quotations received from bidding 
suppliers, quality assurance documents, or prequalification documents. These documents, provided they are in 
electronic form, may be uploaded and conveniently stored so that they may be readily consulted.

Note: In order to use this feature, appropriate settings must be checked in the operator's User profile. From the main 
menu, choose File>Edit users , select the desired user, and view the settings under the Permissions(3) tab:

Note that if a supplier has supplied paper documentation, you may wish to scan it and incorporate the scanned copies 
into the tender.
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Clicking Upload document allows you to browse to the folder containing the required document, select it and upload it 
to your computer to a folder within the mSupply data folder. It now appears in the lower section of the window.

A document may be deleted by selecting it and clicking on the Delete document icon

To view a document which has been uploaded, select it from the list, and click on the Download document icon; you 
then have to choose whether simply to download or to download and open the document; a window appears, Browse for
folder , and you should select a folder (as a rule, this folder will be on your own computer) where a copy of the 
document is to be stored; it may then be accessed from that folder for viewing and/or editing.

To edit an uploaded document, the procedure described for viewing is followed, and, once edited, the document is 
saved. The edited document now needs to be uploaded, following the Upload Document procedure. It is not necessary 
to change the document's name, as mSupply will recognise that changes have been made, and will save it as a new 
version, the relevant number appearing in the rightmost column. The drop-down list above that column allows all 
versions to be displayed, or only the latest one.

Previous: Next: 

Receiving Quotations from suppliers
To process a quotation from a supplier, double-click the supplier name from the Choose suppliers and edit responses tab
of the tender. The Edit quote window will appear:
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The date sent field has already been entered by mSupply, but may be edited if necessary. You should enter the date the 
supplier responded, and in the Valid till field, the expiry date of the quotation. Also enter the reference that the supplier 
is using for their own records (to be quoted in future correspondence), and, importantly, the currency in which the 
supplier has responded. If you have previously set a default currency for this supplier, this drop-down list will already 
be set to that currency. Otherwise, your own default currency will appear.

The freight charge per cubic metre [m3] should be entered; if the volume of each item's pack is known, this can also be 
entered (at a later stage), allowing a more accurate total cost of each item to be evaluated.

Multiple currency tender quotations.
A quotation may be received from a supplier which has used one currency for some items, and another currency for 
others; or has submitted more than one quotation for the same item, each one in a different currency (e.g. Euros and US 
dollars). Should this occur, it is strongly recommended that you process the quotation as two or more separate 
quotations, each one restricted to a single currency. That is, enter the supplier twice in the list of suppliers, then add a 
comment to the quotations to distinguish which quotation is in which currency. We have designed mSupply like this so 
that when Purchase Orders are created, a single Purchase Order only uses one currency. Mixing currencies on a 
Purchase Order is likely to cause confusion and errors.

Adding quotation lines

To add items for which the supplier has provided a quotation, click the New line(s) button. You are shown a list of items
for this tender.
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In Windows hold down the Control key (Command key on a Mac) and click the items you wish to add, then click the 
Use button to add the items as quotations from the supplier. You can use the Control-A shortcut to select all items as 
well.
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To add the same item twice to a quotation from a supplier, click the Add lines(s) button and choose the item a second 
time. You will be shown a warning that the item already exists, and be asked if you want to add it again. You might need
to do this if the supplier has supplied two prices for the same item based on differences in packaging or other 
specifications. Note that if you entered an item twice in a single tender to account for such differences, it will appear 
twice in the list and you won't need to carry out two selections.

In the graphic below, the six lines in the tender have been added to the quotation for this supplier. As the lines have not 
been edited yet, the price appears as 0 and the tender pack size has been used.

In the event that the currency of the quote from the supplier is not the same for each line, mSupply allows each line's 
currency to be edited, and the appropriate one selected.

Deleting an item from a supplier's quotation
If you wish to delete an item from the quotation, click on the line to highlight it, then click the Delete line button. Note 
that this action only deletes the selected item from the quotation.

Entering prices for each quotation line
Once you have added the items, double-click quote lines to display the 'Edit Tender Response Item' window:
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You will note that this form is very similar to the form for ad-hoc quotes; the related tender is shown at the top, and the 
item and supplier fields are filled in automatically. Enter the price and other details the supplier has provided.

If you are calculating freight based on volumes or weight, or using a freight factor, this window is the one where the 
information is entered.

You can also add Price break information that the supplier has provided you. Price Break: is the quantity that 
generates a price break along with the percentage discount that will apply once this quantity is reached.

Note that the price you enter is the price for one pack, as is the volume.

To cycle through all the items, click OK & Next. To edit this quotation line only, click OK.

Comparing quotations from different suppliers
Once you have received all quotations for an item and entered the information, or once the due date has arrived, you are
ready to compare prices. We suggest that at this point you change the status of the tender from suggested (sg) to 
confirmed (cn).

In order to make use of the benchmark figures you have entered, in the Edit Tender window click the Tender 
preferences tab , and select the benchmark supplier who has benchmark prices recorded:

To compare prices, open the window for the tender, and on the Items and compare prices tab, double-click the item. If 
you have changed the tender status to cn, a list of all received quotes for that item will be shown, with comparitive 
prices (Net Cost and Adj. Cost) in your home currency; the supplier with the lowest quoted figure is easily identified, as
it is displayed in blue.

In the window shown below, we are looking at the quotations submitted for Ibuprofen 200mg tablets; the 3rd one in the 
list is the cheapest, and it is displayed in a different colour (blue) from the others. Also note in the column headed +/-% 
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the entry of -8.37, which tells us that the price from this particular quotation is 8.37% lower than the benchmark figure, 
taken from Benchmark's list.
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Should you have reason to mark a particular entry, you can have it displayed in a different colour by selecting one from 
the drop down list at the top-right of the window (note that this is the colour of the line when viewing the tender on the 
Items and compare prices tab. Here two items have been coloured green. Note too that that here the drop-down list 
has been used to only show items for whom a supplier has not yet been chosen- useful!

To view detailed information about a quote, double-click it. The window for editing quote lines from a supplier is 
shown. You can make on-the-fly changes to the quote line in this way (if, for example, you made a data entry error).

Adjusted cost: All elements having a bearing on the quoted cost, differences in exchange rate, pack size etc., have been
factored into the figure appearing in this column, which shows a comparative price in your local currency.

The figures appearing in the Adj cost column show the unit cost of the item, and may have a very small value; this is the
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case in, for example, Paracetamol suspension if the unit has been set in Preferences to 1 mL., or ointments with a unit 
value of 1 gram; for this reason, 4 decimal places are used in this column.

Figures in this column are the ones to examine, as we are comparing like with like. In practice, a greater number of 
suppliers would be invited to submit quotations compared with our example, in which, two quotations for Ibuprofen 
200mg tablets are compared; Mission Pharma's quotation is for AUD 2.65 per pack, to which is added the per pack 
freight charge of AUD 0.06 per pack, making a total cost per pack of AUD 2.71; similarly, General Supplier's quotation 
works out at a total price of AUD 2.51 per pack, and represents the better buy; before checking the Preferred checkbox 
on the General Suppliers entry line, however, you should be satisfied on a number of other points, for example:

• Has the supplier met all the tender conditions?
• Is the proposed delivery schedule acceptable?
• Is the item manufactured by a reputable and trusted company?

You have the option to disqualify any quotation for reasons such as these, otherwise you should proceed to check the 
Preferred checkbox, and click OK & next to repeat the process for remaining items, finally clicking the OK button when
you are finished.

After you have chosen a preferred supplier, their name will appear on the main tenders form on the tender line page (see
below).

+/- % column: If there is a benchmark price figure for this item, there will be a figure in this column to indicate how 
this quotation compares with the benchmark figure; a minus sign before the figure indicates that the quotation is lower 
than the benchmark figure.

There are two important checkboxes for each quote line:

Preferred checkbox: The supplier with this item checked is the successful winner of the tender.

Disqualified checkbox: If the supplied quote fails to meet compulsory criteria you have specified, you may choose to 
check this checkbox.

Note that if you want historical data of all stored quotes for an item, including those from previous tenders, this is 
available by choosing the menu item Items > Show items, locating the item, then viewing the Quotes tab.

Accepting tenders
When you have chosen a preferred supplier for all the items in the tender (or as many as you wish to purchase - tenders 
do not have to be completed; you may want to wait for more favourable market conditions, for example), return to the 
main tenders window. You should see something similar to this window, with the names of the successful suppliers 
appearing in the Preferred Supplier column. Our example shows that General Supplier has been chosen as the preferred 
supplier for four out of six items, and Mission Pharma has been selected for the remaining two items:

* graphic needed *

At this point, the tender's status should be set to Finalised (FN) , thus preventing any further editing.

Printing an internal report: At any time during the tender process, click Print internal report to print a report 
showing the current progress of the tender. A variety of information is shown on this A4 landscape report.

Purchase Orders from tenders
Once you have awarded all items, you now need to start to generate Purchase Orders. The first step is to set the Tender 
preferences under the Tender preferences tab on the Edit Tender window.

Based on …… months usage: The number of months' usage which should be considered by mSupply when predicting 
your requirements. This figure should not exceed the number of months that you have been using mSupply!

Note that this is only relevant if you are recalculating tender quantities (see the next paragraph).

Purchase Order Calculation method
Presently two options are available:

1. Recalculate PO quantity according to usage should be chosen if you wish mSupply to take into account the usage during the 
period since the tender was generated; this may be significant depending on the length of that period of time.
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2. Distribute Tender quantity evenly should be chosen if you wish to make no changes to the quantities calculated at the time the 
tender was generated.

If you require the delivery from one or more suppliers to be split into two or more shipments, on the Tender Preferences
tab, check Create split deliveries

Now go to the Purchase Order tab. We will cover the two purchase order creation methods separately:

If creating purchase orders with split deliveries

1. The button Create Blank POs appears as the first button at the left in the Purchase order tab window 
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2. Click this button and you will be shown a list of suppliers from which you should select those suppliers for which you are 
creating Purchase Orders; the possibilities range from a single supplier to all suppliers. As usual, click to select one, use the Shift 
or Control keys to select some, or press Ctrl +A to select all.

•
3. You may need to enter a delivery date when selecting suppliers:

1. If you have checked “Recalculate quantities” in the tender preferences you will also need to enter a delivery date, and this 
will be used to calculate how much of the tender quantity to assign to this purchase order.

2. If you have checked Distribute quantities evenly in the preferences, it will have no effect- the tender quantity will be split 
evenly amongst however many purchase orders for that supplier you create. For example, say you have Supplier A from 
whom you want a single consignment and Supplier B from whom you want 2 equal consignments:

• Preferences should be “Split deliveries checked” and “Distribute quantities evenly”
• Create one blank PO for Supplier A and two blank POs for supplier B.
• Click Fill quantities
• You're done.

Calculation of the Target days figure.

If you are recalculating the Purchase Order quantities, note that the target days figure is what is used. The expected 
delivery date is only for your planning and reporting purposes, and is not used for caluculating quantities.

Here's an example of how to calculate. Let's say the date is November 2009. You are going to request two deliveries, 
one in May and one in November 2010

Delivery #1 must last until Delivery #2 arrives (365 days from today) along with 90 days buffer stock: 365 + 90 = 455

Delivery #2 must last until Delivery #1 of 2011 arrives in May 2011. (365 +182 days from now) along with 90 days 
buffer stock: 547 + 90 = 637

So here's what your entries should look like:
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Filling blank Purchase Orders

Having created the blank Purchase Orders, they now need to be filled -

• Highlight the Purchase Orders you wish to fill.
• Click on the Fill quantities button to fill out the required quantities for each Purchase Order.
• Once filled, a message appears on the screen informing you that the operation has been completed successfully.

Notes:

• Quantities are rounded up to use whole packs according to the manufacturer's quoted pack size. When working out the quantity 
for the second and any subsequent shipments, mSupply will take into account the quantities on earlier shipments.

• When two (or more) Purchase Orders have been created for one supplier, that supplier will appear in the list more than once; it is 
imortant to note that one entry only should be highlighted and all the Purchase Orders for that supplier will be generated.

Now your Purchase Orders list should look something like the example below, in which a total of 6 Purchase Orders 
have been created for 5 suppliers, IDA's order has been divided into two shipments with different delivery dates.

Purchase Order status

The status of the Purchase Orders until this point is tn, signifying that they have been created using the tender module, 
and as such they are not displayed in the Purchase Order list. (i.e. when Suppliers > Show Purchase Orders is clicked in
the Navigator). Likewise, the Show selected PO button will not display POs whose status is tn; only POs with a status of
Suggested (sg) will be shown.

To change a Purchase Order's status to sg (“Suggested”), select those whose status you wish to change and click on the 
Convert to SG button. When you are setting the last Purchase Order's status to SG, mSupply will offer to set the tender's
status to FN (“Finalised”).

In the example shown, one IDA order has the status sg, while the other has the status tn.

Once a Purchase Order's status has been changed to sg, any editing must then be done from the Suppliers > Show 
Purchase Orders button in the Navigator. Purchase Orders with sg status cannot be edited while in the Tender 
Management module.

Delete PO: Click on this button to delete a highlighted Purchase Order; if it has already been filled, you will be alerted 
to the fact. All the lines on such deleted Purchase Orders will be deleted.

Editing a Purchase Order: Double click on an entry in the Purchase Order list to display the details of that order, 
showing the Item code and name, quantity, price and requested date of delivery,

The amount you need to order may differ from the amount in the tender, as your usage will have reduced your stock 
levels since you created the tender. Return to the Items and compare prices tab and Double-click the item to be edited. 
Go to the Purchase Order tab. The Purchase Order options for the winning supplier will be shown
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Note in our example there are two rows, corresponding to the two Purchase Orders set up for General Suppliers (the 
winner of this item). Highlight the line with the desired Purchase Order., and edit as required.

Note there is a field that allows you to see the actual quantity mSupply is suggesting for a given number of days 
entered.

Use the OK & Next button to go through each item and assign quantities.

As you assign quantities to each line mSupply updates the total spend for each item and for each supplier. You can see 
the figures on the Items and compare prices tab and the Choose suppliers and enter responses tab. The price is the 
combination of all Purchase Orders entered- not just the first one for each supplier.

Sending POs to suppliers

Once you've finished, you will want to send the Purchase Orders. Go back to the the Choose suppliers and enter 
responses tab and double click each supplier, then go to the Setup POs tab. Click on the PO for the next shipment to 
order, and click the Make SG button. This will turn the Purchase Order into one that can be seen, edited further and sent 
to the supplier using mSupply's normal Purchase Order functions.

Reviewing and continuing with the tender process is, from this point on, done in exactly the same way as normal 
Purchase orders: see Editing a Purchase Order for the details.

Previous: Next: 

Using Benchmark prices
A benchmark price can be considered to be a standard price to which other prices can be compared once you are at the 
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The International Drug Price Indicator 
Guide, published and maintained by MSH, is 
available on their website, 
http://tinyurl.com/2czskk2, and is a good 
source of information on global drug prices 
from a range of international distributors.

stage of evaluating quotations. mSupply provides the ability to set up benchmark prices to help you make such 
comparisona. This section describes how to set them up and how to use them.

Setting up
You need to create a dummy supplier, that is to say a `virtual' supplier, whose only purpose is to store benchmark prices.

From the menu, or the Navigator, choose Supplier > New supplier

mSupply® requires that the Code, Charge to and Name fields are completed, so you should choose appropriate entries. 
In the Category section, the checkbox Supplier should already be checked, and you must check the Benchmark 
checkbox.

You may set up more than one benchmark `Supplier'

Entering benchmark prices
Once you have the required benchmark prices, they should be entered into mSupply, and here's how to do it:

From the menu, or the Navigator, choose Supplier>Show supplier, and enter the start of the name or code - for our 
example, we're using the `supplier' Benchmark'

When the Edit supplier window for Benchmark appears, click on the Quotes tab
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Click on the New Quote button to enter the benchmark figure for each item - in our example we're entering the details 
for Albendazole 400mg tablets:

Points to note:

• If the figure you have is for a single tablet, we suggest you multiply it by 100 and change the pack size to 100 to avoid working 
with very small figures.

• Make sure that the currency used for the entry is correct, remembering that it might be different from your default currency.
• Make sure that your pack size matches the pack size of the benchmark figure.

Once a number of entries have been made, the window may appear like this:
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You will note the difference for each item in the Price column and the Cost column; the explanation is that the default 
currency in this example is AUD (Australian dollars), while the benchmark figures are in US dollars; the Cost (and 
Adjusted cost) columns show the figures converted by mSupply to their AUD equivalents.

Using the benchmark figures when evaluating submitted quotations from suppliers is discussed here

Previous: Next: 

Supplier responses & Creating Purchase Orders

Review
At this stage you should already have performed the following:

1. Created a new tender
2. Quantified how much you need to order and added these lines and quantities to the tender
3. Decided which suppliers should be invited to tender, and added them to the tender
4. Sent out the tender
5. Entered quotations from suppliers

Having performed these steps you are ready to compare the prices quoted, and decide upon a preferred supplier for each
item
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Open the tender
Once you have the tender open, select the Items and compare prices tab

and double-click the first item in the list, which in our example is Acetazolamide 250mg tablets, to bring up the Edit 
tender item window, which opens at the Compare supplier responses tab.

In our example, 5 suppliers have been invited to tender, and 4 have submitted tenders, one supplier having submitted 
prices for two different pack sizes. One supplier has not submitted a quotation, so all the entries for that supplier are 
zero. 

The important column is the Adj Cost column, this allows you to compare prices which have been evened out to cater 
for differences in pack sizes, currencies and freight costs. mSupply® makes it easy to identify the best price quoted, 
which appears in blue type. By clicking the Adj Cost column header to sort the entries so that the cheapest one appears 
at the top of the list.
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If you want to see more information about an 
item, double-click its row to view all the 
details of the quotation. You may want to fill 
out the Quote Comment to record any 
decisions you made - e.g. reason for 
disqualification.

Before marking supplier of the cheapest item as the preferred supplier, there are other factors to be considered, 
including:

1. Has the supplier met all the tender conditions?
2. Is the proposed delivery schedule acceptable?
3. Is the product being supplied by a reputable manufacturer?

The Disqualified column allows you to disqualify the quotation from a particular supplier if required by checking the 
box in the relevant row.

When you have decided on a supplier for an item, check the box in the Preferred column in the row for that supplier. 
Proceed to the next item by clicking the OK & next button and repeat the process. When you have finished, click the 
OK or Cancel button to return to the Edit Tender window. It is, of course, not necessary to complete the selection of 
preferred suppliers at one session on the computer; it can be done in stages. 

Back to the Items and compare prices tab
Once you have finished editing, click OK (or Cancel if you want to close the window without saving changes to the 
current tender line).

The column Preferred Supplier will now display either the name of the supplier you have chosen or Not chosen where
you have not yet processed the item.

The original column will display the cost of that line if you purchase the tender quantity of that item from the preferred 
supplier in the currency quoted. Note that you might end up editing the quantity on the purchase order to a different 
value, and then the PO local column will have a different value.

Reports
You might need to provide reports to a tender board, or for internal records. The tender module has several reports built 
in as shown:

An example of the Winning tender lines report is shown:
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Setting up Purchase Order (PO) preferences
Once the choice of supplier has been made for all the items in the tender, the next stage is to generate the Purchase 
Orders.
Click on the Tender Preferences tab on the Edit Tender window.

mSupply® offers two options for creating Purchase Orders:

For our example, we are choosing Distribute Tender Quantity evenly which means that you are content with the 
quantities which mSupply® has calculated, and you do not want to make any adjustments. In this case, the Based on 
field should be ignored.

Split deliveries

If you want to receive split deliveries, then mSupply will create mulitple puchase orders for you, each with a different 
requested delivery date.
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mSupply will behave differently when 
creating Purchase Orders depending on 
whether this option is checked or not.

Creating Purchase Orders with split deliveries

1. Go to the Purchase Orders tab
2. If you have checked the “Split deliveries” checkbox in the preferences for this tender, the first button on the toolbar will be 

Create blank POs. 

You will need to confirm that this is what you want to do by clicking the Yes button on the confirmation window which 
appears:

You then are shown a list of suppliers. 
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Click on the supplier(s) you want to add, and enter the requested delivery date, then click OK

You will need to add each supplier twice if there are to be 2 deliveries, or 3 times for 3 deliveries (etc) Make sure you 
get the delivery date right for each one.

You can double-click and already entered line to change the delivery date

Use the Delete PO button to remove a purchase order (highlight to one(s) to delete before clicking the button). 

Creating Purchase Orders without split deliveries (single delivery)
If you aren't creating split deliveries, the first button will be labelled “create POs”

1. Click this button, and the needed Purchase orders will be created.
2. Double-click a row to see the order.
3. Return to the “Suppliers” tab if you want to see the value of the purchase orders in total.

Editing Purchase Order Quantities
Once you have created Purchase orders you might want to edit some quantities (for example, you might want the first of
two purchase orders for a supplier to have 60% of the total order, and the second purchase order only 40%)

1. Go to the “items and compare prices” tab
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2. Double-click a line to edit
3. Go to the Purchase Order tab.
4. You will see your purchase orders for that item.
5. To edit the first row, click once on the quantity, wait 2 seconds and click again.
6. You can now change the quantity.
7. Use the tab key to advance to edit the quantity of the second row, etc.

Converting to a "normal" purchase order
While a purchase order is being created and edited inside the tender module, it has the status of “tn” and isn't visible in 
the same way that purchase orders created outside the tender module are. Purchase orders that are visible in the main 
mSupply system have a status of “sg” (or “cn” or “fn”) Once you are satisfied with your purchase order in the tender 
module….

1. Go to the purchase orders tab
2. Click on a purchase order to convert (only one at a time at the moment, sorry)
3. Click Convert to SG
4. Confirm the warning window, and the purchase order will now:

1. no longer be editable in the tender module
2. be available using Suppliers > Show Purchase orders from the mSupply menu or navigator.

5. Repeat the process with other purchase orders that are ready to send to a supplier.

You can now view the purchase order, confirm it, and send to a supplier.

Supplier instructions for using the tender submission web 
interface

Introduction
This user guide explains how to use the web site at https://tenders.msupply.org.nz that is used by mSupply users to 
publish tenders. It is only relevant if you are a supplier who is being invited to tender by a user of this system. If you 
have been invited to tender and have questions that are not answered in this document, you may request support by 
emailing tender_support@msupply.org.nz. 

Charges to suppliers
These instructions used to say “There is no charge for support”, but due to a steady stream of requests for help for issues
that are covered in this guide, or issues that are not our fault (e.g. password reset requests) we now charge for these 
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kinds of support requests.

How it works - a summary

1. The Client prepares tender document and distributes by email to suppliers. 
2. Each Supplier receives details, including a username and password, for accessing the secure website where the tender is to be 

found.
3. The password provided is valid only for the first time the website is accessed, so the supplier’s first action will be to change it.
4. During the period between receiving the tender document and the tender’s deadline, the supplier decides on the quotations to be 

submitted, and enters the details on line. This may be done over multiple sessions.
5. Before the deadline, the supplier finalises the quotation; this action is not reversible and prevents any further changes being 

made. The status is changed from SG (suggested) to FN (finalised).
6. Once the deadline is passed, the client may access all quotations which have been finalised, evaluate them, and notify successful 

suppliers.

How it benefits suppliers

• Accuracy: you can be confident that the information entered by you will be accurately transferred. Manual systems are prone to 
transcription errors in the price, pack size, currency, etc.

• Speed: while the tender process may be slightly slower for the supplier, the time between tender closing and bid evaluation is 
dropped from weeks to one or two days. This means tender closing dates can be moved closer to the date on which suppliers are 
notified of winning bids, benefitting all involved.

Costs

• There is no charge to suppliers to use the system. Development and maintenance costs are covered by software support contracts 
with mSupply users.

• If you pester us with frivolous support requests (i.e. things that are answered in this document), this policy will be reviewed.

Security

• Only https (secure) website access: observe the closed padlock icon in the corner of your browser.
• Automatic disconnection: should there be no activity after a short time, you are required to confirm that you are still working on 

the website. In the absence of such confirmation the login screen reappears.
• One-time password: the password provided for the first time you access the website is valid only for that first occasion. You must 

change it to a password of your own choosing for continued access to the website.
• The server running the Tender Management System is managed by Sustainable Solutions. We know this system will only be 

successful if we maintain the highest standards of ethical, impartial behaviour and keep your data secure and accessible only to 
authorised parties.

• Restricted access by IP address: if you wish to limit access to your online account to users within your office, let us know an IP 
address or subnet that you will use and we will put this restriction in place until you instruct us to remove it.

• We track the IP address of all log on attempts. Repeated attempts from the same IP address will be blocked.
• We have coded the software carefully to ensure that supplier information entered is only available to that supplier and to the 

customer (obviously once the customer downloads the submitted bids, we can not control the information flows outside of our 
system).

First logon
Log on to https://tenders.msupply.org.nz and this is the window which appears when you log on
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You should enter your user name and password, both of which were sent to you by email.

You will immediately be shown the window for changing your password:

In the Old Password field you should enter the password sent to you by email. You must then enter a password of your 
own in the New Password field, re-entering it in the Confirm Password field; when you have done this, and clicked on 
OK, the standard log on window appears again, and you should enter your user name and the password which you have 
just created. You will now be logged on to the system, and these are the details you will use for logging on in future..

Note that the web site uses a large Javascript library, so will take a few moments to load the first time you use it. In 
return you get a fast and easy-to-use interface.

If you have chosen to do so in the preferences, each time you log in, you will be sent an email saying that you logged in 
to the web interface - this means if someone else was to log in to your account, you would know about it.

Staying logged on
If no user activity is detected for a few minutes, as a precautionary measure to restrict unauthorised access, a window 
appears. You need to click Keep Working, otherwise you will be logged out.

Once you have logged on, you will be shown a list of tenders for which you have been invited to submit quotations.

The example shows that 4 tender documents from client Namaste Medical Stores, have been uploaded and await the 
supplier’s attention.

The My Information button
Clicking the My Information button displays this window:
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The above window may not display properly 
using the Google Chrome web-browser. If 
this is the case, then please use Firefox.

This is where the supplier’s details held on the server are entered and stored, and this is also where they can be edited. 
Those details include name, address, contact details, and the default currency for this supplier.

Default currency The default currency is that currency in which the you normally supply quotations - in the example 
shown, it is Singapore dollars, and this will normally remain unchanged for a particular supplier; suppliers located in 
another country are likely to use their own country’s currency as their default one.. In the case where a supplier submits 
a quotation with one or more lines quoted in another currency - e.g. Euros or US dollars - the particular currency used is
entered on the appropriate line of the quotation Note that changing your default currency will affect new quotations, and
won’t have any affect on existing quotations.

Email me manufacturer list As the name suggests, this will email a tab-delimited text file with the complete list of 
manufacturer names and their corresponding codes to the email address specified. If you want to take advantage of the 
new facility to upload a quotation as a tab-delimited text file, you will need to use the manufacturer codes specified in 
this list.

Saving your settings and closing the window Click the “Save” button to save your settings. Use the close box in the 
top right of the window when you are done.

Viewing the tender list and individual tenders
The window which appears when you log on is the Current Tender List, and it shows all of the tenders for which the 
supplier has been invited to submit a quotation; it also shows the status of the tender, which is set to SG (= suggested), 
and should remain at this status until all work has been completed, and the quotation is ready to be finalised. Access to a
particular tender document is achieved by double clicking on the line. The tender and the items involved in it are then 
displayed in a window which looks similar to the following:
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Currencies drop down list and Set currencies icon: Use these two together to change the currency for all items in the 
list.

Show button: displays the whole of the customer's comment if they've entered one. May contain useful information for 
you.

Edit button: Displays a window to enable you to enter or edit a longer tender comment for the customer (the one who 
invited you to tender). Any information you want to convey to the customer about your quotes can be put in here. Note: 
you also have the opportunity to enter comments on individual quote lines. See Entering prices section below. 

Duplicate button: Duplicates a selected quote line. Will put the new quote line at the top of the quote. Helpful if you 
want to enter a quote for the same item but with slightly different details. If you need to do this for many items, use the 
Upload button mentioned below.

Show totals button: Shows the total value of your quote for each currency you've included in your quote.

Reset lines button: Removes any changes you have made to the selected quote lines.

Email me this quote button: Sends you a copy of your quote as it currently stands. It will be sent to you a tab-
delimited text file attachment to an email.

Email me a quote template button: Sends you a copy of the tender with all items included with no price or other 
information added. This is the perfect thing to use as a base for your quote if you are going to create it in a spreadsheet 
and upload it using the upload button (see below).

Browse button: Allows you to select the tab-delimited text file to upload as your quote.

Upload button: Uploads the selected text file as your quote (see the Uploading prices section below).

Entering prices
To enter the details for a line, double click on the line.
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Delivery times should be specified from 
when you receive the purchase order, so must 
also include the time for order compilation 
by the supplier

Details should be entered in each of the columns:

Item code, name and quantity These are fixed by the tender and cannot be changed.

Pack size The pack size requested by the customer is already on the form; if needed, it can be changed.

Price per pack The unit price of the pack you are offering to supply in the chosen currency.

Expiry date and delivery time When completing these fields, it is suggested that a series of abbreviations be used:

• min = minimum
• max = maximum
• w = week
• m = month
• y = year
• So for example, if you want to indicate a delivery time of 3 months, enter “3m”

The tender document is likely to specify minimum expiry dates, but it is important that there should be no 
misunderstandings. Delivery time is understood to mean the estimated period of time between the consignment leaving 
the supplier’s premises and delivery to the customer.

Currency: The relevant currency should be selected from the drop down list - it doesn't have to be the same as the 
default currency.

Manufacturer: The name of the manufacturer should be chosen from the drop-down list. Typing the first few 
characters of the manufacturer's name will show a list of matching manufacturers. Click to select one.

Manufacturers are not linked to suppliers in our system, so multiple suppliers who source goods from the one 
manufacturer do not cause a problem.

Adding new manufacturers into the tender module
Due to the desire of mSupply users to collate manufacturer data, you cannot enter manufacturer names yourself. If you 
want to have a manufacturer added to the list, please email to tender_support@msupply.org.nz and we will add the 
name(s) within 24 hours. 

Please submit Manufacturers in the following manner:

The country where the manufacturer is based must be specified. The address column is option. 

If you have more than 5 manufacturers to add then it may be worth creating and a spreadsheet with the column headings
described below, then sending to us as an attachment:

Manufacturer Country Address (optional) 

John Western Pharmaceutical US 32 Obama Road, Virginia 

Jürgen Klinsmann Group Germany Göppingen, West Germany 

Universal Supplies Great Britain 

If you do not want to or cannot specify the manufacturer, choose the entry 'Not specified' from the list. You may wish to
add a comment to that quote line to explain your entry.

Country of Origin: Some tenders require you to specify country of origin instead of manufacturer. Common countries 
are specified in the Manufacturer list, so you can just choose a country rather than a specific manufacturer if you wish.

Comment: Use this column for entering any comment or note you may wish.

Once you have made all the entries for a row, click Save to update the tender document with the details you have 
entered. It is quite possible that you will not have all the necessary information to complete a tender document at a 
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single session; this is not a problem - just close the document at the stage you have reached and later, once you have the 
further information you require, reopen the document and continue with the process.

Submitting multiple quotations for the one item If you wish to do this, then select the line you wish to submit a 
second (or third) price for and click the 'Duplicate' button in the toolbar. Fill in the details of the second quotation.

Tender conditions Some tenders may have more restrictive conditions than the web site allows for. For example, a 
tender may specify only one currency, or that multiple quotations for the same item are not allowed. Currently the web 
site will NOT reflect such conditions, and it is your job to read the tender conditions and respond accordingly.

Uploading prices
This facility allows you to upload a specially formatted tab-delimited text file containing a header line and one or more 
item lines for your quotation. 

Preparing the quotation file
The file should be in plain text format, having the following 10 columns, each separated by a tab, and without using any
kind of quote characters as a text delimiter around individual fields:

• Item code
• Item name
• Quantity
• Pack size
• Currency
• Price per pack
• Expiry date
• Delivery time
• Manufacturer code
• Comments

This is very similar to the file format you will get if you select the 'Email me this quote' button on the tender items 
window, but with the manufacturer name replaced by the manufacturer code (less likely to make mistakes as the code is 
shorter). You can download a manufacturer list from the 'My information' page (see the 'My Information button' section 
above). Note that the Item Name and Quantity columns are only included for the sake of human readability, and will be 
ignored.

If you wish, you can download a suitable template for uploading by clicking the 'Email me a quote template' button on 
the top-right of the tender items window. This will have the first four columns pre-filled for your convenience and is the
best way to start if you intend to upload your quotes.

• If opening using Excel, save it in Text(Tab delimited) format before uploading.
• If opening this template using OpenOffice, select Tab as the separator and set the text delimiter to nothing (i.e. delete the quotes). 

Save it in text/CSV format before uploading.
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Please note that
The text file must be in tab-delimited format 
(not comma separated)
The end-of-line character is a carriage return- 
you must not have any carriage returns (end 
of lines) in the comment or manufacturer 
fields of a row, or the upload will fail, 
thinking it has reached the end of a row.
The decimal point separator must be a period 
(“.”) not a comma.
the upload process will ignore the first line of 
the file. This line is reserved for the column 
headings so that the text file remains human-
readable. So, whether you use the template 
sent to you via email or whether you 
manually create an upload file make sure the 
first line of the file contains column titles and 
not quote information.

• The header line, with the column titles, is included for the sake of human readability, but will be ignored during import. But make 
sure the header row is there, otherwise your first quote line will be ignored.

Uploading the quotation file
First of all, you need to select the file that you wish to upload by using the Browse button on the far right of the tender 
items window. The selected filename will then be visible in the text field to its left. Then click on the Upload button and
you will be presented with the following window:

Update existing quote lines: Select this if you want the contents of the file to update quote lines already in the tender. 
Note that information will only be updated for items in the tender where the current price for the line is 0. If a line in the
tender has a non-zero price any line in the file with details for that item will be ignored. So, if you want item lines to be 
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updated by the contents of the file reset their prices to 0 before you carry out the upload. Note also that if there is more 
than one matching zero-price tender item line with the same item code, then it will select the first match it comes to i.e. 
the system will cope with multiple quote lines for the same item. Therefore, if you want to upload multiple lines for an 
item, you need to duplicate that line in the tender first (using the Duplicate button on the toolbar) before uploading the 
file.

Replace existing quote lines: Select this if you want the contents of the file to replace everything already in the tender. 
All your existing lines will be deleted from the tender and the contents of the upload file will be entered into the tender. 
Note that if there are multiple lines in your upload file with the same item code this method will put them all into the 
tender. This is helpful if you keep your text file as a master copy and use it to update your quotes.

Click on the Cancel button to cancel the upload or the OK button to continue.

Having clicked on the OK button you will, after a short while, get a confirmation that the upload was successful and the 
list of displayed tender items will be updated to reflect the data that has just been uploaded.

Please note the following points regarding the file upload process:

• Only text files (extension of '.txt' or '.csv') smaller than 1Mb are accepted.
• Currently, the only web browsers which fully support file upload are Firefox and Chrome. The next versions of Internet Explorer, 

Safari and Opera are also planned to include support for this new HTML5 feature. 
• A successful upload message does NOT imply that the contents of the file are valid, simply that it has been processed. An email 

will be sent to your email address, with two attachments:
• A text file which contains the output generated from the upload process i.e. the number of records which were successfully 

processed, and any error messages generated during the upload process.
• A tab-delimited text file in the same format as produced by the 'Email me this quote' button, which will include the updated 

tender items - you should check that this reflects the changes you are expecting.
• Any blank lines in the uploaded file will be ignored.
• Any lines which do not contain the expected number of columns, or with data in the wrong format will generate an error message 

and will not be imported.
• Any lines with an invalid item code or an invalid currency code will generate an error message and will not be imported. We use 

the standard 3-character currency codes - see here for a complete list.
• Any lines with an invalid manufacturer code will still be imported but will be given a manufacturer of 'Not specified'.

Note also that it is possible to perform as many file uploads as you like.

Finalising a tender
Firstly, be warned: Finalising means what it says, and can not be undone. Only when you are satisfied that you have 
completed the details on all the lines for which you are quoting should you finalise your tender entry. 

Email it to yourself first
We strongly recommend you use the button in the tender window to email yourself the tender, and then check that the 
entries in the online tender module match your intended entries.

To email a quotation to yourself, open the tender your wish to email, and then click the “Email it to me” button at the 
top-right of the window.

What finalising does
Clicking on Finalise does two things:

1. It locks the tender document, changing its status to FN (finalised) and you can make no further changes to it.
2. It makes the finalised tender submission accessible to the customer once the tender has closed. Only finalised quotations will be 

accepted by the customer.

Finalising the tender submission, therefore, must be performed before the closing date as specified by the customer.

How to Finalise

1. You need to be viewing the list of tenders, not the particular tender you have just entered.
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1. If you are not logged in: Log in and you will be shown the list
2. If you are editing your tender, close it to return to the list of tenders.

2. Check the checkbox in the left-hand column next to the tender you have completed 
3. Click on the Finalise button. 
4. You're done

Closing date and time
Note that closing date and time is specified as GMT (Greenwhich Mean Time). This is NOT likely to be the same as 
your local time. Please take this into account when planning for when you will finalise your prices.

Results notification
The client will notify successful suppliers directly by submission of a purchase order. The web site will not show you 
any information about you or any other supplier’s success or otherwise

Obtaining support
Please email tender_support@msupply.org.nz if you have any problems. We are based in Nepal, but provide support 18 
hours per day Monday to Friday while there are open tenders in the system.

Note that you should only communicate with us regarding technical matters. For all matters relating to tender 
conditions, pricing, etc., communicate directly with the client who published the tender.

The future
We hope you appreciate both the concept and the hard work we’ve put into making this system work for both clients 
and suppliers. We expect the system to be used by several mSupply users in 2012. We have lots of our own ideas on 
how to improve the system, and we’d love to hear your criticisms, compliments or ideas as well. Use the email address 
above.

Warranty
There is none. Our software is provided “as is”. We take our responsibility to act fairly and carefully seriously. We are 
replacing a manual system that was prone to gross errors, so we hope that even if our system proves to have the odd 
issue, it will be a vast improvement on what has gone before.

Infrequently asked questions

• Q: What if your server failed just before a tender closed.
• A: Our advice is: This isn’t an auction. There is no need to submit at the last minute. However, if there was more than a few 

minutes of downtime in the last 24 hours of a tender, we would ask the customer's permission to extend the closing date. Also, 
our server has been running for several months. Should the tender module prove popular we will transfer it to a data centre.

• Q: Can we phone you for support.
• A: Yes. 

• Nepal: +977 1 5548021
• New Zealand: +64 9 889 4486 or +64 225 44 4486

Thanks
Thanks to the staff of Republic of Kiribati’s Ministry of Health & Medical Services Pharmacy Department for being 
willing to be the test case - we hope it is worth it!

The mSupply team:

email: tender_support@msupply.org.nz

Previous: Next: 

Uploading and Downloading Web Tenders

Setup
To use web tenders, there are several setup steps that only need to be done once:

1. Contact Sustainable Solutions to arrange a user account.
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2. In your mSupply Preferences, select 'Tender' from the side bar, and complete the fields in the section 'User details for Tender 
module' (using the details you are sent from us). 

3. Link each of your suppliers with the Supplier's master record on the tender web site. For further information see Adding and 
editing names:
• You will need to tell us about any of your suppliers that are not in the web site list. We will then add them, and you will then be

able to link to those suppliers.

Summary
The following steps summarise the process:

1. In mSupply, create a new tender.
2. Set up tender name, reference number, opening and closing date.
3. Add items to the tender.

• Add quantity and pack size for each item.
4. .
5. Upload the tender to the web site.
6. Inform suppliers, send physical or electronic tender documents.
7. After the tender has closed, download tender.
8. Compare prices, print appropriate reports for tender committee.
9. Award each item to a supplier.
10. Create purchase orders.

Using the upload and download actions
You simply go to the Synchronise tab when viewing a particular tender in mSupply, and click the appropriate button.

Note that:

• To Upload
• Each supplier must be linked. You will be warned if they aren't.
• Your internet connection must be working.
• You must have entered the user name and password correctly in the mSupply preferences (see above).

• To Download:
• Your internet connection must be working.
• The tender closing date must have passed.

You will be given an error message if the upload or download is not successful. If you get stuck, contact Sustainable 
Solutions for further assistance.

After uploading

• mSupply records when a tender has been uploaded, and no longer allows editing or deletion of tender lines.

Previous: Next: Ordering Items From Suppliers

Ordering Items From Suppliers

Introduction to Ordering
mSupply provides ways for you to manually or automatically generate a Purchase Order to send to a supplier. Each 
organisation tends to have different requirements for their ordering process, so we have tried to strike a balance between
providing different methods and making the ordering module so complex that it is of little use to anyone. mSupply has 
two general methods for generating a purchase order:

• Creating a new calculated purchase order. We recommend that you use this method since it will save you time and avoid 
mistakes.

• Creating a blank Purchase Order. This method allows you to create a purchase order based on manual calculations of 
quantities.
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Creating a new (calculated) Purchase Order
Before launching into creating a new (calculated) Purchase Order, it is important to understand the logic that mSupply 
uses.

Logic used for calculating Purchase Order quantities
There are three distinct steps required to arrive at Purchase Order quantities for each line of stock:

• Forecast future consumption
• Calculate required stock quantity
• Calculate purchase order quantity

mSupply uses this methodology to produce a suggested order quantities in a number of other places including:

• Creating a new tender
• The suggested order report

To assist in understanding these calculations, an example will be developed through the following sections. 
Amoxycillin 250mg tabs/caps is being ordered at the end of December 2015. Historical consumption data is as 
follows:

Month 2013 2014 2015 

Jan 200 1,000 1,000 
Feb 250 1,050 1,100 
Mar 300 950 900 
Apr 350 1,000 1,000 
May 400 1,200 1,400 
Jun 450 800 600 
Jul 500 1,000 1,000 
Aug 550 1,150 1,300 
Sep 600 850 700 
Oct 650 1,000 1,000 
Nov 700 1,100 1,200 
Dec 750 900 800 

From this data, the following AMC (Average Monthly Consumption) calculations can be made.

Period AMC 

Last 36 months (Jan 2013 - Dec 2015) 825
Last 24 months (Jan 2014 - Dec 2015) 1,000
Last 12 months (Jan 2015 - Dec 2015) 1,000
Last 6 months (Jul 2015 - Dec 2015) 1,000

A more detailed analysis of this historic consumption shows a steady increase through 2013, and then the AMC sits at 
1,000 per month in 2014 and 2015. In this case, we have an AMC of 1,000 per month regardless of whether we look at 
6, 12 or 24 months of historic consumption data.
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mSupply does not use set “minimum” & “maximum” stock levels as its 
primary means of determining order quantities. Conventional minimum 
and maximum stock levels are calculated using the methods described here, 
but it is * problematic to try and fix these values, because:
The parameters will keep on changing,
It takes a lot of manual work to calculate,
The assumptions made in calculating them are often lost.
Be assured that the system that mSupply uses will give you much better 
inventory control!
Having said that, mSupply does allow for minimum stock levels so as to 
allow you to ensure a minimum quantity of rarely used items. e.g. essential 
emergency supplies - refer Other information on the stock details page. 
These minimum stock levels should not be used for most items.

Some agencies recommend the buffer stock to be double the Ordering 
cycle. However, if your ordering cycle is long (say 12 months) then this 
means keeping two years worth of stock as a buffer. This could become a 
problem with expiry dates.

Forecast future consumption
By default, mSupply uses the assumption that future consumption will continue at the same level as consumption over a
given historic period. mSupply has a number of other options for making a forecast of future consumption. All of these 
methods are documented in the Forecasting section.

Calculate required stock quantity

The amount of stock you require to have is based on the forecast of future consumption (previous section), modified by 
a range of factors including:

• The Lead time: The time delay between ordering stock and its delivery to your store.
• The Ordering cycle: How often you order from this supplier
• How much “buffer” stock you want on hand just before your next order arrives.

All of these are measured in months.

Stock required = Lead time + Ordering cycle + buffer stock

/* * note that mSupply® calculates for how long this order will provide stock coverage, and displays the calculated 
date.*/
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For example:
Lead time = 3 months
Ordering cycle = 6 months
Buffer stock = 12 months
From the equation above, Stock required is calculated as:
= Lead time + Ordering cycle + buffer stock
= 3 + 6 + 12
= 21 months.
So, 21 months worth of stock is required.

The amount of stock required is almost certainly NOT the amount of stock 
to be purchased! See the next section: Calculate purchase order quantity for 
an explanation.

mSupply makes an important assumption as to how to handle anticipated 
stock-out. That is, the situation of running out of stock before the order 
arrives. mSupply assumes that the consumption that you forecast to happen 
between you running out of stock, and the purchase order stock arriving 
should not be provided under this purchase order. The basis for this are two 
further assumptions:
You will either obtain the shortfall through another purchase order (an 
emergency order, or from another supplier), or you will simply run out of 
stock.
Your customers will not increase their demand in the time immediately 
after you receive the stock from this purchase order to compensate for the 
stock being unavailable prior to the new order arriving. /*Note that if you 
did manage to obtain stock as an an emergency order, or from another 
supplier, then your customers will have received that stock, and they will 
still not increase their demand in the time immediately after you receive the 
stock from this purchase order.*/
Therefore, mSupply reduces the purchase order quantity by the anticipated 
stock-out amount.

Calculate purchase order quantity
Purchase Order quantities are based on the amount of stock required, normally expressed as a number of months of 
AMC, modified by factors including:

• The current stock level.
• The amount of stock on backorder to customers ((if you are running the backorder feature).
• The amount of stock already on order from Suppliers, but that has not yet arrived in your store.
• The months of anticipated stock-out before the order arrives (more on this below).

Purchase order quantity = stock required - current stock level + stock on backorder to customers - stock on 
backorder from suppliers - months of anticipated stock-out
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Continuing our worked example, suppose:
Current stock levels = 5 months
Stock on backorder to customers = 3 months
Stock already on order from Suppliers = 2 months
Then, Anticipated stock-out is calculated as:
= max(0,Lead time - Current stock levels + stock on backorder to customers - stock 
on backorder from suppliers)
= max(0,3-5+3-2)
= max(0,-1)
= 0
and Purchase order quantity is calculated as:
= stock required - current stock level + stock on backorder to customers - stock on 
backorder from suppliers - months of anticipated stock-out
= 21-5+3-2-0
= 17 
So 17 months worth of stock to be ordered. Compare this with the 21 months worth 
of stock required calculated in the previous section!

It can be seen that

• Anticipated Stockout = the Lead time - Current stock level + stock on backorder to customers - stock on backorder from suppliers

If the above equation produces a negative number, this means that there will be no stock-out, and the anticipated stock-
out will have no impact on the Purchase order quantity. So, for the purposes of this mSupply calculation, Anticipated 
Stockout = maximum of zero and the above expression. This is expressed mathematically as:

Anticipated Stockout = max(0,Lead time - Current stock level + stock on backorder to customers - stock on 
backorder from suppliers)

To demonstrate the impact of a stock-out, let us suppose that we have only 1 month's worth of stock on hand:
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Current stock levels = 1 month
Stock on backorder to customers = 3 months
Stock already on order from Suppliers = 2 months
Then, Anticipated stock-out is calculated as:
= max(0,Lead time - Current stock levels + stock on backorder to customers - stock 
on backorder from suppliers)
= max(0,3-1+3-2)
= max(0,3)
= 3
and Purchase order quantity is calculated as:
= stock required - current stock level + stock on backorder to customers - stock on 
backorder from suppliers - months of anticipated stock-out
= 21-5+3-2-3
= 14
So due to the 3 month anticipated stock-out, only 14 months worth of stock are to 
be ordered.

To Create a Purchase Order
Choose Supplier > New Purchase Order.

In most instances the following window will be displayed:
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This window allows for a number of factors to be entered. Firstly, you have the opportunity to select the order types.

Types of order available from the popup menu

Order for all suppliers.

• All items in the database will be evaluated to see if they need ordering. This is the default option
• If you have a large number of items, this may take a few minutes.
• By default, a single order will be generated. You have the option to generate a separate order for each supplier by checking the 

Separate order for each supplier box. In this case, mSupply will
• For each item, look to see whether a supplier has been identified as preferred on a current quote
• Create a separate order for each supplier.
• Items without a preferred quotation will all be placed together in a single order.
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Order for some items only

• Either click on the Query items box, to bring up the Query Editor window, and enter the required parameters, or select one or 
more criteria by placing check marks as appropriate in the three boxes; use of the Query Editor is described in detail in the 
Reports chapter. See Using the Query Search modifyor

Order for one supplier

• This method is the best method to use for ordering from a particular supplier (you might have guessed that!)
• Enter the supplier code, and press the tab key. The supplier name will be filled in, or you will be given a list to choose from.
• Any items that have a quotation from that supplier that is marked as “preferred” will be evaluated to see if they need reordering.

Calculate Forecast

Secondly, the forecast of future consumption will be calculated in accordance with each item's settings as documented 
in the Forecasting section. The only forecasting factor that can be adjusted here is the number of months of historical 
consumption data that will be used to calculated historical AMC.
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The bigger the number you enter here, the more accurate mSupply is likely 
to be, provided that consumption has been reasonably stable over that 
period. Entering a large number will slow down the calculation.
Also, beware of extending this time period to a time in the past when data 
is inaccurate or non-existent. This will be detrimental to the quality of the 
forecast.

From our worked example above, consumption has been stable at 1,000 per month 
for the last two years (2014 and 2015), but was significantly lower in 2013. Putting 
36 months would result in a lower AMC than has been the case for 2014 and 2015.

The number of months of historical consumption data to be used to 
calculated historical AMC will be ignored for those items that are 
configured not to use AMC in the forecast - refer Forecasting.

Calculate quantity required

The quantity of stock required can be entered directly into the Months of stock required field. However, as 
demonstrated in the Calculate Purchase Order quantities section above, a more reliable way of getting to this figure 
is to use the Lead time, order cycle and buffer stock parameters. Clicking on the Calculate button brings up a window 
allowing you to enter the necessary information from which mSupply will calculate the quantity required.

Using the same figures as in our worked example above:
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Orders take three months to arrive from your supplier - (Lead time = 3 months)
You order every six months. (Ordering cycle = 6 months)
We want a buffer stock of at least 12 months when a Purchase Order arrives.

The Lead time figure will generate an Expected delivery date, and the Lead 
time / Expected delivery date can have a significant impact on actual 
Purchase order quantities - refer Calculating Purchase order quantity 
above.
BEWARE of manually entering in a date that is unrealistically far into the 
future - this will REDUCE the quantity ordered!

Other settings in the create order window

Comment

Add a comment (note) to the order should you so wish.

Exclude transfers from usage calculations

This option is only applicable if you are running multiple (virtual) stores. If you have more than one store, this option 
controls whether inter-store transfers are taken into account when calculating required quantities. The default setting is 
not to exclude transfers. That is, stock transfers will be included in the calculation.

Include usage for build ingredients

Selecting this option ensures that any items that are going to be used in builds (i.e. manufactured items) will be taken 
into account when calculating required quantities.

Builds can be entered with placeholder lines to reflect a projected manufacturing schedule. If the Include usage for 
build ingredients check box in the “new order” window is checked, the proposed order quantity for each item will be 
compared to the amount of the item that is required to all projected builds, multiplied by the “times covered” value you 
have entered.

For example if there is 50,000 gm of Mag Stearate on projected builds, and you have entered 1.5 in the “times covered” 
box, at least 75,000 gm (minus the quantity already in stock and the quantity already on order) of Mag Stearate will be 
ordered, whatever the usage calculation comes up with for an order quantity.

Include items with suggested zero order quantity

If mSupply calculates that any of the lines from the supplier are not required, when this box is checked such lines will 
appear on the Purchase Order, the order quantity being 0.

Create Order Now button

Once you have entered the details, click the Create order button. Order generation may take a couple of minutes, 
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depending on how many items need to be evaluated. You will then be presented with the order modifying window. 

Split Deliveries
There may be occasions when you want to arrange for split deliveries - for instance if you are placing a single order for 
a year's supply, but you want certain items to be delivered in, say, four consignments, at three monthly intervals. The 
order as generated lists the total quantity to be ordered, and you need to modify this; what you are actually doing is 
modifying a Purchase Order line. The procedure is described in Split deliveries in The order menu

Creating a blank Purchase Order
Choose Supplier > New blank Purchase Order . You are presented with a blank order form, to which you can add items.
This form only allows the choice of one supplier.

The name field is where you choose the supplier you are ordering from.

If it has been set in Preferences, the Donor field will appear, and the donor details may be entered here. Setting this 
preference is decribed here: Supplier Invoices

The Reference field allows you to enter any relevant information.

In the top right hand corner, there is a box where you may select a particular colour from a range of colours - in the 
window shown below, blue has been selected.

The effect of this is to show this particular Purchase Order (number 5) in the selected colour (blue) in the Purchase 
Order list, as shown below:
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Once a supplier(Name) has been chosen you may enter the item you are ordering by clicking the New Line button.
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In the Item field type the beginning letter of the item you want and hit the Tab button. You may then choose the item 
from the displayed list. If you want to see the entire list of items available type @ and then Tab.

From more information on the other tabs in this window see Editing Purchase Order lines

Once you have chosen the Item and entered the appropriate details clicking OK will retun you to the Edit Purchase 
Order screen where you will see the line you have created. Below I have ordered 300 Packs of Chlopromazine.
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The Original and Adjusted Quantities columns show the number of packs you ordered multiplied by the number of units
in the pack.

Viewing a Purchase Order
To view a recently created order choose Show Purchase Order… from the Supplier menu.

Choosing this menu item shows a window where you can enter enter either the number of recent orders to display or the
order number (this is printed on an order if you have printed it out). If you click OK without changing any information 
you will be shown a list of the 15 most recent orders.

You will then be shown a window with a list of Purchase Orders. (If you entered a Purchase Order number you will be 
taken straight to the Purchase Order details window, bypasing the Purchase Order list, as shown in the previous 
column).

The above window “Purchase Order list” shows the orders for the stock to the suppliers

mSupply provides a way for you to generate and to calculate a Purchase Order to send to a supplier on the basis of your 
current stock situation and past usage pattern. See the section Ordering items from Suppliers for a fuller description of 
creating and modifying orders.

Buttons in the Purchase Order list Window

New Purchase Order

When you click the New PO button, a Purchase Order details window is displayed . See “New Purchase Order” below.

Delete

Any highlighted orders will be deleted by clicking this button. You can delete multiple Purchase Orders by highlighting 
more than one line. To do so, control-click (on Mac:: command-click) the lines you wish to highlight. If your orders are 
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finalised, those can not be deleted. If you attempt to delete a finalised order, you receive an alert message:

Report

Clicking on the Report button presents you with the quick report modifyor window, from which a simple report can be 
constructed. This report can be viewed, saved to disk or printed.

Find

This button is very useful for quickly finding a group of Purchase Orders. when you click on the Find button, you will 
be presented with a window with the same functionality as if you chose the Menu item Supplier > Show Purchase 
Orders (above).

Order by

The Order by button allows you to sort the orders by multiple fields. Otherwise simply clicking on an individual coulmn
will also sort the order list by that coulmn.

Print

When you click on the Print button, it shows two windows. The first window is the page setup for your printer, the 
second window allows you to specify how many copies to print .Whatever column sizes for fields are set in the 
Purchase Order list window, those sizes are reflected in the printed output.
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E-mail order(s)

Any highlighted orders will be converted to queued emails.

Customise list

This button activates the customise list window and allows you to include or exclude from the onscreen display the 
available columns:

 See Working with lists.

Duplicate

If you wish to duplicate any orders, highlight desired orders from list and click the “Duplicate” button.

Split

This button allows you to split the selected order between two or more suppliers, and may be used only on orders with a
status of sg. 

Editing a Purchase Order
Double-click the order in the list you want to modify.

You will be presented with the Edit Purchase Order window:
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If the entire order qualifies for a discount, either the discount percentage 
should be entered at 1, or the cash value of the discount should be entered 
at 2.

Editing Purchase Order lines
To modify an order line, double click on the line you wish to modify.

Note: you can resize the order modifying window to show more lines, or to show more of the item name. To do so, drag
the handle in the lower right corner to a new position.

When you double-click an order line you will be presented with a window allowing you to modify the item, quantity 
and pack size:

Information in the Edit Order Line window

Item

Here you can modify the item that is being supplied. To change the item, type as much of the item name as you know, 
then press the tab key. If only one item matches your entry, it will be filled in automatically, otherwise you will be 
presented with a list where you can double-click the item you wish to enter.
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Comment

You can enter any information you wish to record about this order line here. Comments will be added to order lines 
when you email an order to a supplier.
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Original quantity

The original quantity ordered from the supplier. This information is not modifyable once you have confirmed an order.

Pack size

This is the pack size the supplier prefers.

Units

The units that the pack is measured in.

Price

The quoted price for this item

Price extension

The price multiplied by the quantity ordered.

Volume per pack

In this field, you can define the volume per pack for the pack size chosen. If you are entering a new line the volume and 
pack size you have entered for the item will be used.

Note the mSupply always stores volumes as m3 (cubic metres), but you can enter a volume as millilitres (ml), litres (L) 
or cubic metres (m3)

Shelf location

Type the first few characters of location name or code as you know, then press the Tab key. If only one location code 
matches your entry, it will be filled in automatically, otherwise you will be shown a standard choice list.

Adjusted quantity

The total quantity you now expect to receive from the supplier in all consignments. You can adjust this figure so that the
amount received is reduced or increased due to changes in what the supplier actually sends.

Refresh Buttons

The refresh button (to the right of Volume per pack), on clicking, displays the default volume of the selected item if it 
has been set previously. Similarly the refresh button next to Shelf location displays the default location.

The refresh button in the “Pricing for this item” frame reloads the price data from a preferred quotation. The price from 
the most recent quote is used if ttthere are no preferred quotations.

If you have received an updated quotation after generating the original price, use this button to apply the updated details
to this line.

Other information in the Order line details window:

On hand: This is the quantity of stock on hand of the item

On order: This is the quantity of stock in other confirmed orders awaiting delivery.

On backorder: The quantity of stock you owe to customers on backorders

Quantity received: The total quantity of this line that has already been received on this order.

Tabs in the Order line details window

The usage tab

This tab shows the usage for the last 24 months of the item being viewed. This is useful for deciding if reported usage is
consistent from month to month, or is due to one or two very large supplies to clients.
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The quotes tab

This tab shows quotes from suppliers for the item being viewed.

You can double-click a quote to view and/or modify details.

View quotations for the item in question. You can double-click a quotation to modify its information.

Note that the supplier of the quotation that is marked as “preferred” will be the supplier selected when using the “split” 
command to break a general order into orders for each supplier.
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The New button allows you to add a new quotation.

The receipt history tab

This tab shows all goods receipts for the item being viewed.

If you double-click a line the associated goods receipt transaction will open in a new window.
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The Ledger tab

This tab shows supplier and customer invoices for the item being viewed.

You can display a sub-set of the transaction lines by choosing options from the drop-down lists.

The option Received ledger for this Purchase Order line shows all supplier invoice transactions for the current Purchase
Order line. Goods receipts are shown on a separate tab.

The Dates drop-down list allows you to show only recent transactions….

If you double-click a ledger line, the associated invoice will be opened in a new window
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From version 1.7 onwards, mSupply displays a new column (Price Ext) in 
the order modifying window that shows the cost of the order line.

Buttons in the Edit Purchase Order window

OK & Next

This button will take you to the next order line, unless you have reached the last line in the order, in which case you will
be taken back to the order modifying window.

OK

Will exit the window saving changes to the current window.

Delete

If you click the Delete button, the order will be deleted and the order number will be reused for the next order. 

Order status explained:

• When an order is first created it has status “sg” (for “suggested”)
• after an order has been confirmed, it has status “cn” (for “confirmed”) Confirmed orders have the order amount added to the “on 

order” field for each item, so that if another order is created for the same item, this quantity already on order will be taken into 
account.

• Orders that have been finalised have status “fn” (for “finalised”) and an appropriate log entry is created.
• An order becomes finalised by clicking the Make supplier invoice button,
• finalised orders can no longer be modifyed.
• Should a supplier be unable to supply some or all of an item ordered, when the order is finalised, the `unsupplied' amount is 

ignored in any of mSupply's subsequent Stock on order calculations.

Estimated order costs explained

Buttons on the General tab

New line

Click this button to add a new line to the Purchase Order.
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You may enter the quantity of the item either by number of packs or by total quantity. mSupply will automatically fill in
the other fields for you.

By default the Requested delivery date will be today's date but you may edit this to request deliveries at the times you 
require. The expected delivery date can be entered manually now but it would normally be entered once a response 
from the supplier has been received.

Delete lines

Select one or more lines in the Purchase Order and then click this button to delete the lines from the Purchase Order.

Update EDD

Select one or more lines in the Purchase Order and then click on the Update EDD (Estimated Date of Delivery) button 
to enter a new date when delivery is expected.

Info

Click the Info button to display information about the Purchase Order including the name of the initials of the Purchase 
Order creator and modifier - refer figure below. 
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Notes:
If the Purchase Order has not been modified, then a modify date of 
00/00/00 will be displayed.
If there is no name against the Created by and Modified by entries, then 
this Purchase Order was created / modified on the Primary Server in a 
synchronised mSupply system.

Print

This Print button will print the complete Purchase Order form for sending to a supplier. Note that you should fill in 
relevant details on the Details tab before printing the order.

Confirm

See the section above on “order status” for an explanation. Orders should be confirmed once the order has been placed 
with the supplier.

Check boxes on the General tab

Locked

When the locked check box is checked, the Purchase Order cannot be processed to the next status (confirmed or 
finalized) - refer Order Status explained.

Auto calc usage

When the Auto calc usage check box is checked, each time you modify an item line, the usage for that line will be 
calculated. This is slower, but gives useful information upon which to base your ordering . Note that this option can also
be turned on within the order line modifying window.

Print my signature

When the Print my signature check-box is checked, the user's signature will be printed on the Purchase Order if it has 
been loaded - refer Managing users.

Other tabs on the Purchase Order Form
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The Details tab

This tab allows you to record a range of information that will be entered on the Purchase Order when it is sent to the 
supplier.

PO sent date

Enter the date the Purchase Order was sent to the supplier. When you print a Purchase Order mSupply will offer to fill 
in this date for you, but you should modify it if necessary to reflect the exact date.

Heading message

Any text you enter here (e.g. “Urgent”, “Supplementary order for PO 183”) will be printed in a large font across the top 
of the Purchase Order so your supplier will (or at least “should”) notice the message.

Expected Delivery

Enter the date you expect the order to arrive

Goods Received date

Fill in the actual delivery date. Leave the date blank for Purchase Orders that have not been delivered

Invoice received

Enter the date when you received the invoice from the supplier

Hint: you can find all orders that have not had an invoice supplied by querying on this field.

Comment

You can enter any appropriate comments here.

Supplier's agent

Enter the name of the intermediary party here - if there is one.

Delivery method

Enter a delivery method (eg “Air”, “Courier” …)

Authorizing officers

Enter the names of the people who are required to sign off the Purchase Order. These names are printed on the Purchase
Order.

Freight conditions

Enter the delivery address, shipping marks, etc. here.

Additional instructions

Enter any further information you wish to appear on the Purchase Order.

Commisions and charges fields

Fill in any relevant charges agreed between you and the supplier. Note that any charges that are zero will be skipped 
when printing the Purchase Order.

The Ad Hoc items tab
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Here you can display a list of items that have been assigned to the supplier, but not yet added to a Purchase Order.

Click on a line, then click the “Add selected line to order” button to add a line to the current Purchase Order.

Warning: if you delete a line from a Purchase Order it will not have its status updated automatically- it is your job to do 
so using the Items > Manage Ad Hoc items menu.

New Ad Hoc line button

Here you can add an ad hoc item “on-the-fly”. This is useful if you want to process a Purchase Order for a single Ad 
Hoc item that has not yet been entered into mSupply.

Note that the Items > Manage Ad Hoc items menu is the normal route to add, modify and delete Ad Hoc items.

The Goods Received tab
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This is a record of the receipt of the order, and, where multiple deliveries have been made, records each instance.

The Invoices tab

This tab displays a list of invoices that have been created from this Purchase Order.
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There are two types of invoice that are created directly from Purchase Orders:

Supplier invoices are created each time a consignment arrives.

20. Customer invoices are created when a supplier invoice is created that contains Ad Hoc items.

The Supplier Invoice tab

This tab list Supplier Invoices related to the current Purchase Order.
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The Log tab

This tab provides information of events that users have performed on a particular order. The below image shows that the
Purchase Order has been confirm for sending to the supplier and printed.
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The Location tab

This tab displays the locations of the items received, if this feature is used. Where details of the volume of available 
space in any location has been entered, and where details of the area/volume of item pack has also been entered, the 
remaining available space will be displayed.

Lines will also be coloured red/orange/green to indicate greater than 100%, 90 to 100% or less than 90% of space used. 
showing which lines are likely to cause space problems on receipt.
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The Order Menu
When the order modifying window is being shown, an extra menu is added to the menu bar:

Copy order to clipboard

Copies the order details to the clipboard, so you can paste it into an email or text document.

Export html ...

If you want to produce an order which can be saved as a file in html format, use this option. . If you have Excel 
installed, the report will open in Excel. Note that if you want to keep the Excel file, you should choose File > Save as.. 
in Excel and choose a location.
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Print

Prints the order. You will be shown the standard printing dialog boxes.

Note that if Show all lines is selected, the entire order is printed; if Show incomplete lines is selected, the printout lists 
only lines which have either not been supplied at all or require a balance to complete the order.

Split

Splits the order into a number of smaller orders based on the preferred supplier for each line. The preferred supplier is 
the quotation that is marked as “preferred” for that item. To view and modify quotations you can double-click the order 
line then chose “quotes” from the “show” menu. All items that do not have a quotation marked as “preferred” will be 
put into a separate order.

Email in body

The order will be turned into an e-mail and placed in the queue so that it is sent next time you send e-mails. You will be 
warned if you have not entered an e-mail address for the supplier.

The e-mail will be formatted as follows:

To check the email before sending it, choose Special > show l_formatemails , then double-click the email to modify it. 
Note that to make the columns line up properly, you will have to click the <|-|> button to view the text in a fixed-width 
font.
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Email HTML attachment...

The order will be turned into an HTML attachment, and attached to a new email that is then placed in the queue so that 
it is sent next time you send e-mails. You will be warned if you have not entered an e-mail address for the supplier. The 
attachment will be stored in the export folder you have nominated in the Preferences. (For multi-user mSupply, the 
export folder is set as the folder “C:\mSupply\mSupply client\Export” (on the assumption that you have selected the 
default install location for mSupply).

Email PDF

Choosing this item will cause mSupply to generate a PDF file, create an email and attach the PDF file to the email.

Note that you must use the PDF xChange PDF driver installed on the computer generating the email for this to work. 
The driver currently costs US$50, and is available from Sustainable Solutions info@ss.org.np

The PDF that is created is stored in the mSupply data file, so you can create a PDF attachment on one computer and 
send it from a different computer without problems.

Update quotes using this order

This command allows you to check that quotation data is up to date based on actual supplied prices.

Each order line will be evaluated, and if a quotation does not exist, one will be created. If a quotation does exist and the 
price you have paid in the order and the price stored for your quotation are different, you will be shown a window to 
compare prices, and you can decide whether to keep the existing quotation or update it.

Note that you need to have your user permissions “Can add quotations” and/or “Can modify quotations” set before this 
command is available.
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Split Deliveries

Creating split or multiple deliveries will now be described using the following example.

It is important to note that the Purchase Order should not be finalised before this procedure is performed, as a finalised 
order may not be modifyed or altered in any way.

A store is placing an order for Normal Saline and, having followed the normal procedures, mSupply has created the 
Purchase Order displayed: below.

The store does not have the storage capacity to hold 1250 packs of Normal Saline, so the supply of this item needs to be
made in multiple deliveries; it is decided that 500 be requested for delivery at the beginning of January, followed by 250
at the beginning of each of the months of April, July and October - i.e. at three monthly intervals.

The Purchase Order is modified as follows:

• Click on New line, and add the item `Normal Saline'
• In the Number of packs field, enter 500
• In the Requested Delivery date enter 1/1/17
• Click OK & Next
• In the Number of packs field, enter 250
• In the Requested Delivery date enter 1/4/17
• Click OK & Next
• In the Number of packs field, enter 250
• In the Requested Delivery date enter 1/7/17
• Click OK & Next

Repeat the last two steps, but enter 1/10/17 in the **Requested Delivery date* field for the final delivery in October.

To complete the process, delete the line calling for 1250 units on 1/1/17.
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The Purchase Order should now look like this:

You won't see the different requested dates on this screen. Expected dates are generated upon feedback from the 
supplier or can be entered manually.

This feature enables mSupply to take future deliveries into its reckoning if, for example, an additional order for Normal 
Saline was placed in mid June, and a delivery of 2,500 had already been arranged for 1 July.'

Previous: Uploading and Downloading Web Tenders Next: 

Managing Purchase Orders
Managing purchase orders you have placed is an important part of running a medical supply facility. There are two main
windows you will use to do this, along with a variety of reports.

Show outstanding Purchase Order lines....
Choosing this Suppliers > Show outstanding purchase orders from the menus or the Navigator displays a list of all 
lines outstanding on all confirmed Purchase Orders.

Using the find box
In the toolbar there is a field to enter searches. To the left of the field you can choose from the drop down list what to 
search for.

You can restrict the list displayed to a single supplier, to a single item, or to items whose delivery is expected within a 
specific number of days.note that the search excludes finalised orders.

Printing and opening in Excel
Click the Print button to print the list as displayed. If you want to send the list to Excel, choose Open in Excel from the
print options window that is shown after you click Print Double click on a line to display the Purchase Order 
containing that line
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Show Purchase orders
Choose Suppliers > Show Purchase Orders.

• In the find window you can choose what will be displayed. By default mSupply displays the last 15 purchase orders.

• You will be shown a list of matching Purchase Orders. Double-click a purchase order to open it.
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For a more detailed description of this window see 

Previous: Next: 
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If you are using purchase orders (which you should be!) supplier invoices will be 
created automatically when you create a goods receipt. You should skip this section 
and see 

Purchase Order categories.
If you are using this feature, and have defined categories for Purchase Orders, they will be displayed when you select 
this option, and you are able to edit their details from the window which appears.

Previous: Next: Ordering from one store to another

Receiving Goods - a Supplier Invoice

Introduction

All goods you receive should be recorded in mSupply either by entering a “Supplier Invoice” or by using the Purchase 
Order system, which leads to the creation of a supplier invoice. In some countries a supplier invoice is called a “bill”

Entering a supplier invoice puts the goods into stock ready for issue. It calculates the selling price based on the margin 
you have chosen for that supplier or for that item, depending on how you have set your mSupply Preferences.
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If you are receiving the goods from another virtual store in your mSupply system, 
and they are not responding to an internal requisition (purchase order) from your 
store, then they should have followed the procedure for transferring goods to another 
store.
Provided that they have finalised their customer invoice, a new supplier invoice will 
be created automatically in your store, populated with the stock lines that they are 
sending to you. In this instance, you should NOT create a new Supplier invoice, and 
can skip most of the following section.
Search for this automatically created invoice using Suppliers>Show invoices…
Depending on the store preferences, the supplier invoice may be finalised. If not, you 
will be able to add, edit or delete lines on the supplier invoice if what you actually 
received is different to what the supplier invoice states…

You will notice there is a Prices tab in the Supplier Invoice window- this is for use with invoices received in foreign 
currencies, which will usually be done via the goods receipting system. See 

Creating a new supplier invoice
To create a new customer invoice, choose Supplier > New invoice. The supplier invoice entry window will open. The 
cursor will be in the Name field.
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If you have turned on any of the custom 
stock fields in store preferences they will be 
displayed as columns (between the Batch and 
Expiry columns) in the list of invoice lines 
and the information you entered for these 
fields will be shown in the appropriate cells.

Information to enter in the main window
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Name: Enter the first few characters of the supplier's name, and then press the Tab key. Any name that has the 
“Supplier” check box checked can be used. If only one name matches the entry, the supplier name will be filled in. 
Otherwise, a list will be displayed: 

Double-click the appropriate entry, or click Cancel to try again. You can also use the up and down arrows or the “u” and
“d” keys on the keyboard to move the highlighted item up or down, then click the Use button or use the Enter key to 
choose the highlighted item. This will return you to the Supplier Invoice window with the name of the supplier you 
have chosen entered in the Name field.

The downward pointing arrow to the right of the Name field takes you directly to the Edit Customer/Supplier window, 
giving access to all the information relating to the name entered. 

Bill no.: Enter the bill number - the serial number on the bill the supplier gave you.

Comment: Click on the downward pointing arrow to the right of the Comment field to display a window where any 
comment relating to this invoice can be noted. 

Category: Category for supplier transaction is created in File>Preferences>Invoices1 . The categories created are listed
in this category field.

Colour: Clicking on the colour box in the top right corner presents you with a selection of eight colours from which the
desired one should be selected; this does not make any change on the invoice window itself, but when the list of 
invoices is displayed, the line showing this particular invoice will show the entry using text of your chosen colour.

Buttons in the supplier invoice window
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If you have the store preferences set to force supplier 
invoice authorisation, you will not be able to confirm 
supplier invoices until they have been authorised. See here 
for details.

New line: Will add a line to the invoice. This command can be used on any invoice that is not finalised. Clicking the 
button will present you with the window for adding a line from stock.. See the Adding lines to an invoice section below 
for more details. To select a line to edit, simply double-click on it. Note that New line and Edit line are disabled on 
finalised invoices

Delete line: Will delete a line whose batch is “none”. To delete other lines, you must first edit the line and set it's 
quantity to zero. Multiple lines can be deleted if highlighted.

The Hold Check Box: Checking this box means that the invoice can not have its status changed. If its status is “nw” it 
cannot become “cn” (confirmed). If it is “cn”, it cannot be changed to “fn” (finalised).

Note the “nw” status invoices do not have the stock entered into the system yet, so this allows you to enter a supplier 
invoice, but to make sure the stock is not available for issued until all the details have been checked.

The Finalise Check box: This check box allows you to finalize an invoice when you click the OK button. This will 
mean that it can no longer be edited, so be sure first that all the details are correct. Note that only users with Can 
finalize individual invoices checked in their user permissions have access to this check box. Other users will be warned 
if they try to turn it on, and the check box will automatically uncheck.

If this check box is not checked and OK button is clicked, it will display a confirm window with a message Confirm 
invoice and enter into stock now? If you click on Later , the invoice will have a status “nw”(new). If you click on 
Confirm , the invoice will be confirmed.

If this check box is checked and if the invoice is not yet confirmed, it will display a confirm message. If you click on 
Later , the invoice will have a status “nw”(new) and will not be finalised. If you click on Confirm , the invoice will be 
confirmed as well as finalised.So be very careful! A finalised invoice may be viewed and/or printed but it can not be 
edited.

Should a finalised invoice need to be changed, the entire invoice may be cancelled, and the correct data may be entered 
as a replacement. In order to maintain the accuracy of any subsequent audit trail, mSupply creates a transaction which 
reverses all the stock movements on the invoice being cancelled, having due regard to all appropriate details, such as 
batch numbers, etc. See Cancelling finalised invoices on p …………

If Confirm supplier invoices without asking is checked in the “Invoices 1” tab of the Preferences window, then all 
invoices will be finalised automatically (whether you like it or not!)

Copy button: This button copies the invoice details to the clipboard, allowing you to paste them into a spreadsheet or 
email message.

Delete: Allows the deletion of an invoice.

When you press Delete button, it will leave no trace of your entry, and the invoice number assigned will be reused.

Note: Unless the invoice has a status of “nw” if you have added lines to an invoice, you must manually delete each line 
using the “delete line” button before deleting the invoice. This is intentional, to save the “Oops, I just deleted my 
invoice with 100 lines on it” feeling.

<div align="center">

Invoice status Description 
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If the invoice has already been saved by previously clicking 
OK, Cancel will be disabled or not present.

nw The invoice has just been created- clicking cancel will 
delete the invoice and automatically delete each line 

sg The cancel button will only delete the invoice if you have 
first deleted all lines using the “delete line” button 

cn Same as for status “sg” 

fn No changes or deletions can be made 

</div>

OK: Saves the changes you have made and exits the window. You are given the opportunity to print if you want to. If 
the invoice status is “sg” a packing slip will be printed, otherwise an invoice will be printed. (Tip: you can bypass the 
print messages by holding down the shift key as you click OK)

Adding new lines to a Supplier invoice

Click the New line button to add a line to the invoice. This window appears: 

The cursor will be in the field ready for you to enter the item name.

Item: Enter as much of the item name (or code) as you know, then press the Tab key. As usual, if only one entry 
matches, it will be filled in. More than one matching entry will present you with a list from you should double-clicking 
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on the required item. The text you type will be matched against both the item name and the code. A match for either will
display the item.

Note: To query for an item name or code that contains (rather than starts with) “250mg” (for example), enter 
“@250mg” in the search field (without the quotes).

Hint: you can use the “up” and “down” arrow keys to change the highlighted item (You can also press u to move up and
d to move down!) . Pressing the enter key will choose the highlighted item.

Note: If you did wish to apply a different margin to the whole invoice, click the cancel button, and edit the margin for 
that supplier by choosing Supplier >Edit supplier and change the margin. If you wish to apply a different margin to just 
some lines, you can do this as you enter the lines, as long as Editing margins is enabled in the Preferences.

If the the item you are entering is not listed, you can click New item to add it.

Note: it is a good idea to agree upon a standard form for entering items. For example, will you enter an “infant feeding
tube” as:

• “infant feeding tube”
• “feeding tube, infant”
• “tube, infant feeding”

Duplicated items can later be merged, but it is better to get it right first time!

Now there are a series of fields to enter to fill in the basic information for the line

Num units: How many did you receive?

Location: The location of the item should be entered in this field.

Pack size: How many units in a pack

Note: Say you receive 50 packs of 100 amoxycillin caps, you should enter “50” in the quantity field and “100” in the 
pack size field. However, if you issue the capsules in strips of 10 to customers (eg you allow them to order 20 or 30 
capsules), you should enter quantity “500” and pack size “10”

Batch: The batch number or other identifying information. The batch appears on the invoice, so you can use this field to
differentiate between brands if you need to (eg you operate using generic names, but occasionally want to give a 
specific brand- you can put an abbreviation for the brand name here as well as the batch).

Expiry: You can use “/” or “.” to separate the day/month/year. Note: Use whichever date format you have set in your 
computer (dd/mm/yy or mm/dd/yy or yy/mm/dd). You can enter the year as 2 digits, which will be understood as a date 
between 1961 and 2060. This should cover the expiry date on most things you receive in the next 52 years!
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mSupply provides the feature of receiving service items into 
stock. Service items are items that are not normally held in 
stock and one use of service items is for managing assets. 
For more information see chapter Asset Management 

Cost price (invoice line unit cost): Enter your cost price for one pack of the pack size you entered above. If your 
supplier's currency is different to that of mSupply the cost price will appears in the supplier's currency.

Adjusted local cost: This information field displays the cost of a single unit of the item in local currency.

Margin and sell price: If you have allowed editing of these fields in Preferences, you can adjust the margin (and the 
sell price will adjust automatically), or you can adjust the sell price (and the margin will adjust automatically).

Click OK if you are finished, or OK & next to add another line. (The invoice lines added will be displayed in Items 
Display Field.)Click cancel to exit to the main screen without saving any of the details.

Manufacturer: This field displays the name of the manufacturer of the item. It will only be shown if you have turned 
the option on in the Preferences.

Entering a manufacturer follows the same pattern as entering an item or supplier- type the first few letters of the 
manufacturer's name or code, and press the Tab key. Choose the required manufacturer from the list if more than one is 
displayed.

To add a new manufacturer, click the New button.

Donor: The donor of the item can be entered to this field. A valid donor should be entered, type the wildcard character 
'@' and press the TAB button to view your list of donors.

Price extension: This information field provides the cost price in local currency for the total quantity of the item you 
have entered.

Custom field 1-4: The appearance of these fields is controlled by the Custom stock field store preferences. Any 
information you enter in these fields will be displayed wherever stock information is displayed (e.g. when issuing stock 
on a customer invoice or when viewing the stock of an item on the stock tab of the item details window).

Editing lines on a supplier invoice
Supplier invoice lines can be edited at any time until the invoice is finalised.

To edit a line, simply double-click on the line you wish to edit.

Editing lines if stock has been issued

If you have already issued stock of this line to a customer, you will be warned with a window like this:

Clicking View issued invoices will show you a list of customer invoices containing this particular line:
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Clicking OK will take you to the item issue window, where certain fields only may be edited. You may not reduce the 
received quantity to a figure lower than the quantity already issued.

The item issue window: You will be presented with a window where you can edit the line details in much the same 
way as when entering new details.
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In the graphic above you will notice the “units issued: 100” text in blue to the right of the Quantity field. This will only 
be present if stock has already be issued to customers. You can click on that text to display a list of issued invoices as 
described above with the View issued invoices button.

Note that the OK & Next button is very useful for editing a whole invoice. Simply double-click the first line of the 
invoice, then use the OK & Next button to go from line to line.

Note also that many options for the window are set in the mSupply Preferences. For example, whether or not line one is 
chosen automatically, and whether you can use placeholder lines.

Working with the list of invoice lines
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You cannot delete a line from a supplier 
invoice that has been finalised.

Resizing columns: These columns are resizable. If any of the column data is cut-off or remains hidden, the column 
width can be increased or decreased by positioning the mouse at the borders of the column. The cursor changes to a 
cross with arrowheads on the horizontal bar. Click and drag the cursor to the left or right. 

Sorting columns: Columns may be sorted either in ascending or descending order by clicking on the header. 

The order of the columns can be re-arranged by clicking on the header and dragging it to the new position.

Deleting a line on a supplier invoice
To delete a line, do one of the following:

• Click on the line you wish to delete, then click on the Delete line button: 
• Double-click the line to edit it (see above) and set it's quantity to zero.

Click the OK button. You will be asked for confirmation. Click OK to proceed.

Selling price calculations in mSupply
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mSupply uses a number of items of information to calculate the selling price of an item. This enables you to have the 
price calculated just the way you like it.

Here's the logic mSupply uses:

• Does the item have a selling price specified? If it does, this price will be used regardless of any other information. Note that the 
price entered for the item is for one unit. The price will be multiplied by the pack size to get the selling price for the line.

• If either the supplier margin or the item margin is specified as zero, then the other (non-zero) value will be used?
• If a margin is specified for both the supplier and the item, the Preference Item margin overides supplier margin will be examined 

to see if it is on or off. If it is set, the item margin will be used, if not the supplier margin will be used.

For example:

<div align="center">

Cost price Pack size Supplier margin Item margin Preference set
for Item margin

overriding
Supplier margin 

Item price Price used 

100 100 6 10 yes 1.15 115 

100 100 6 10 no 1.15 115 

100 100 6 10 yes 0 110 

100 100 6 10 no 0 106 

100 100 0 10 no 0 110 

100 100 6 0 yes 0 106 

</div>

Note that if you have turned on “allow editing margins and sell prices on supplier invoices” in the Preferences you will 
be able to over-ride the prices mSupply calculates.

Applying a Discount to the whole invoice
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Rapid access to Goods Received note from 
Supplier invoice, and vice versa
Supplier invoices show the number of the 
Goods Received transaction in the upper 
right area of the window. By clicking on the 
actual number, that particular Goods received 
transaction will be displayed. Similarly, the 
Edit goods received list has a link Click here 
to open Supplier inv ……. which will 
display the required invoice.

If a supplier gives a discount at the bottom of the invoice rather than adjusting the price of each invoice line, you can 
use the discount button. 

This window will be shown:

If you enter “5” the cost price of each line will be reduced by 5%, and the invoice total will be recalculated. It should 
then match the amount the supplier is actually charging you.

If you want the sell price calculated based on the new cost price, check the “Recalculate sell price” checkbox. The 
pricing rules as described above will still apply.

Viewing supplier invoices
To view or edit any supplier invoice, choose Supplier>Show invoices. The details of how this works is virtually 
identical to that of viewing customer invoices.

Previous: Ordering from one store to another Next: 

Receiving goods (Goods Receipt function)

Entering goods received
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If the receiving store is receiving goods from another virtual store in your 
mSupply system, in response to an Internal Requisition (Purchase Order) 
from that store, The Goods Receipt will be created automatically - refer 
Receiving the goods (Customer Store. Open this automatically created 
Goods Receipt. Do not create a new one!

Choose Supplier > New goods received and this window appears:

If you have authorisation set up in Store Preferences there will be an extra column and the window will look like this:
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In the Supplier field (which displays Search Purchase Order when it first opens), enter the first few characters of the 
name of the supplier from whom the order has been received; to display all Purchase Orders awaited, enter @ in the 
Supplier field. (This has been done in the example shown below):
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From this screen select the entry which matches the order you have received either by double clicking on the entry, or 
by highlighting the entry and clicking on the Use button.

The New Goods Receipt window reappears with the supplier field and some other details completed. Clicking on the 
Add from Purchase Order icon brings up the Choose order lines ….. window, which displays the goods on the Purchase 
Order, and you may either select each item separately, or - when the items ordered and the quantities ordered match the 
delivery exactly - select the entire order to enter the details of the items received .
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Occasionally goods may be received which were not ordered; when this occurs, click on the Add an un-ordered item 
icon and complete all relevant details. Select the item before proceeding. 

In both instances, when the items have been selected, click on the Use button.

Multiple line Goods Receipt Entry
You are now presented with the Edit goods received window for the first item.
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If you are entering details for an item which has its “Expiry date required on receive” 
preference set (see here for details) and you do not enter an expiry date for any of the 
item's batches then, when you click on the OK or OK & Next buttons, you will be 
shown a warning message and you will not be able to close the window without 
entering an expiry date for each batch or deleting all the item's batches.

You can edit a row by clicking on the various cells. It is best to click on the left-hand quantity cell and adjust that one 
first. Then you can use the tab key to advance to the next cell in the row. Let's take the following example for 
amoxycillin 500mg caps.

quantity pack batch expiry 

648 1000 b1234 30/6/18 

324 1000 b1235 30/11/18 
Let's say there are 12 packs in a box, and 27 boxes on a pallet, so you have 2 pallets of the first batch and one pallet of 
the second batch. You can only put one pallet in each location, so the first row will be split into two.

Enter the details into the first row as above.

Location management when receiving goods.
If the items you are receiving have had a location and volume entered when the Purchase Order was created, these will 
be transferred to the goods receipt. If you want to edit these details you can do so by double-clicking a line and either 
changing the volume or the location.

You can then choose a different location by entering it in the location field, or enter the start of a location code and press
tab to get a list of matching locations.

When you get to the location column, we type m then press tab. you are shown the location choosing window with 
locations that match “m”
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If the item you are receiving has a default location set for it, this will have already 
been filled in when the line was added to the purchase order. Default locations should 
be set if the same item is always put in the same place, otherwise leave it blank. In 
the current example we've assumed it has not been set for each item.

Note we have then clicked the Show empty radio button, as we are putting away a whole pallet, and pallets only go in 
empty locations. We then double-click on the location to choose.
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Now we have entered all details for the line, we can click on the row to highlight it, then click Duplicate to create 
another row the same without entering all the details again- you then only need to click on the location column twice 
(on the newly duplicated row), and you can edit the location to find another empty location for the second pallet.

Once done you can duplicate the row again, and this time you have to change the batch (to b1235), expiry (to 30/11/18) 
and location. Then your window should look like this:

Note that the bottom row of the table shows you the total number of packs and total quantity being received.

If all the details are correct click OK or click Cancel if you want to abandon this entry. You will be taken to the window
showing the overall goods receipt:

Review overall Goods Receipt
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Red line in the Goods Receipt?
If you see lines show up in red on the Goods Receipt that means that you 
have set a note that must be actioned for that line on the Purchase Order.
Once you have actioned the note, the lines will return to their 'normal' 
black colour.

All the items you've selected have been added to the goods receipt The quantity is set to the total remaining to be 
received for that item.

Double click on each item in turn and the window allowing you to enter quantities, pack, batch numbers, expiry dates.
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If you have the store preferences set to force supplier invoice authorisation, you will 
not be able to confirm supplier invoices (and therefore bring items into stock) until 
they have been authorised. See here for details.

The right hand side of the window shows you the shelf location, total capacity and available space for a particular item 
in a particular shelf location. You are also shown the volume or space required for a particular item. The small “refresh”
icon the right inserts the default location for the items.  The volume of the shelf location is now reduced to reflect the 
space consumed by our newly added stock item.

After entering the details for each item, you can click on OK & next to proceed to editing the next item.:

Finalising Goods Received
When all available stock on the Goods Received list has been received, a Supplier invoice will be created (to enable you
to enter detailed pricing information), but in order to do this the Goods Received list must be finalised by checking the 
Finalise box in the bottom left hand corner of the window and clicking on the OK button. The point at which the goods 
on a goods received note are entered into stock by mSupply is controlled by the “When finalising a Goods Receipt” 
store preference - see here for details.

Viewing existing Goods Receipts
Choose Supplier > Show goods received…

A standard mSupply find window is shown:
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Click the OK button to view the last 15 goods receipts, or enter a value to find in the lower field, and choose the field 
you are searching for in the left-hand drop-down list.
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New button: Creates a new goods received note

Find button: Opens the search filter window again, allowing you to make a new search for goods received notes.

Viewing a related Purchase Order or Supplier invoice
Accessing the related Purchase Order when the Edit goods received window is open is achieved by clicking on the blue 
“Purchase Order” on the right side. 
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Similarly, if you want to see the linked Supplier Invoice then click on the blue Supplier Invoice“.
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If you have turned on any of the custom stock fields in store preferences 
they will be displayed as columns (between the Batch and Expiry columns) 
in the list of items and the information you entered for these fields when 
the stock was received will be shown in the appropriate cells. If you 
double-click on one of the supplier invoice lines to edit it (assuming they 
are editable!), you will see the custom fields and be able to enter 
information into them.

Outstanding Purchase Order lines

Outstanding PO lines may be viewed by either:

• Clicking on Show outstandng PO lines in the Navigator's Supplier window
• From the Supplier menu> Show outstanding PO lines

Viewing and editing supplier invoices created via Goods Receipts
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Supplier invoices created via goods receipts differ slightly from standard supplier invoices.

The Price tab
Here, you can add in any extra currency related charges

21. in the supplier's currency in the Extra Foreign Currency charge field , and
22. in your local currency in the Local charges field and mSupply will automatically calculate the updated invoice price.

Here's an example of how mSupply will do this with a currency “YXB” whose rate is YXB 7 = USD 1

Item Foreign Price Quantity Foreign Currency 
Price Extension 

Local Price Local price
Extension 

Amoxycillin 
250mg tabs 

50 10 500 70 3,500

Paracetamol 
500mg tabs 

300 5 1,500 35 10,500

Now we add USD300 of freight charges and YXB1400 of import duties:

• The total USD value of the order is USD2000, so 15% must be added to each line to account for this
• The YXB1400 is equivalent to USD200 in local charges, so 10% must be added.
• Therefore a total of 25% is added.

Item Foreign Price Quantity Foreign Currency 
Price Extension 

Local Price Local price
Extension 

Amoxycillin 
250mg tabs 

50 10 500 87.5 4,375

Paracetamol 
500mg tabs 

300 5 1500 43.75 13,125

Currency and Currency rate

Select the supplier currency from this drop-down box, and enter the current exchange rate in the Currency rate field . 
Note that currencies must first be entered using the menu item Special>Currencies. See Currencies...

Extra foreign currency charges
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In the supplier's currency, enter any extra charges from the supplier.

Local charges

Enter any local charges, in your local currency.

Application of charges

mSupply ditributes any extra charges proportionally according to the invoice value of each item on the invoice; this is 
done automatically

MoneyWorks tab
If you are using the MoneyWorks accounting software (which is highly recommended), clicking on this tab allows you 
to export the invoice details to MoneyWorks. Elsewhere in this guide instructions on setting up mSupply to work with 
Moneyworks are to be found. See Moneyworks.

Previous: Next: 

New Supplier credit....
Entering a supplier credit is exactly the same as entering a customer invoice, except that you enter a supplier code rather
than a customer code.

Note that the transaction uses the cost price of the goods to calculate the invoice value. If you have set the mSupply 
Preferences to allow editing sell prices, you will also be able to edit the price at which you return goods on a supplier 
credit.

You can also adjust the cost price of an item line manually. To change an item line's cost price, choose Items | View or 
edit item… Locate the item concerned, then click on the “stock” tab to display the item lines. Click the item line you 
wish to change, then click the “edit line” button. (Only users in the “high access” group can perform this action.)

Previous: Next: 

Editing Pack Sizes
New: version 3.03

Changing pack sizes for items already received
If you have received goods and the supplier invoice is taken off hold, these goods will go into stock and be available for
issue.

You can still edit the pack size if.

1. No stock has been issued, or:
2. You have the user preference set that allows editing pack sizes even after issue. 1

Allowing editing of pack sizes

1 If you don't want to allow this, then simply turn the user preference off
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Changing a received pack size after items have been issued
Take as an example chloramphenicol eye ointment; a delivery has been received, comprising 500 tubes, packed in 
outers of 100 - i.e. 5 boxes each containing 100 tubes. When the entry is made into mSupply the operator in error enters 
a quantity of 5 and a pack size of 1, instead of a quantity of 5 and a pack size of 100.

Provided the user permission described above has been set, the error can be rectified, and the invoice altered to show 
the correct pack size of 100. From the Supplier menu, choose Show invoices to access the required invoice. Select the 
line Chloramphenicol 1% eye oint,and double click on it. If stock has already been issued, a window will appear to alert
you, and allowing you immediate access to the customer invoices detailing the issues.
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It should be noted that adjustments may be necessary on these invoices.

Click OK to display the Add/edit supplier invoice line where the correction can be made by changing the Pack size 
entry from 1 to 100.

How is this different to splitting a batch?
Splitting a batch is required when a store receives an item whose pack size contains the number of units in the outer, but
typically issues the item to the store's customers in smaller quantities; taking the example above, the store receives 
chloramphenicol eye ointment in a pack size of 100, but issues in single tubes. The Item details screen is displayed 
from the Item > Show items menu, by entering the first few characters of the item in the Find item window. From the 
list on the side bar, click Stock, and on the window which appears click on the appropriate line to select it; the window 
should now have this appearance:
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Click the Split button, and fill in the appropriate details on the form - in this example the 3 packs of 100 are to be 
changed to 300 packs of 1.

Looking again at the Item details window, the stock is now displayed as 300 single units, and the store is now able to 
issue as little as a single tube, or any quantity up to the total available. 

Previous: Next: 

Show outstanding Purchase Order lines....
Choosing this menu item displays a list of all lines outstanding on all confirmed Purchase Orders; from the drop down 
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list you can restrict the list displayed to a single supplier, to a single item, or to items whose delivery is expected within 
a specific number of days.note that the search excludes finalised orders.

Double click on a line to display the Purchase Order containing that line:

On the Navigator's Suppliers window, selecting Outstanding performs the same function.

Previous: Next: 

Managing Donors

What/Who is a Donor?
In mSupply, we have the idea of a “name” - a name can be a customer, a supplier, a patient, etc.

A name can also be a donor. A donor is the organisation that has either paid for or somehow managed the supply of 
certain items.

In some cases the supplier will also be the donor, but mSupply allows you to specify the donor for each incoming item 
independently of the supplier.

For example, Global Fund might agree to supply certain malaria medicines, and then contract a supplier to deliver them 
to you. mSupply allows you to record this accurately, and to track and report on all the stock and transactions relating to
a particular donor.

Using the Donor Module
To use the donor module, you must first turn it on. You can do this by going to File > Preferences > Invoices 1 and 
checking the check box beside Allow tracking of received stock by donor

Once you have done this you can add donors.

Adding or Editing Donors
To add or edit a donor you should first bring up the list of donors. Do this from the Navigator. Go to the Suppliers tab >
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Show Suppliers and check the box beside Donors so that the list shows donors rather than suppliers. Click Find.

This will bring up a new window. It will show any donors you have added. You can add donors using the tool bar at the 
top of the window. You can edit a donor by double-clicking on it. A donor can also be a supplier and/or a manufacturer 
etc. or they can be just a donor.

Track a Donor in mSupply

• This section describes how to create a donor in mSupply and record that donor against items from purchase from Supplier to 
distribution to customer.

• Before we track our medicine donor we need to switch on a preference in mSupply that allows tracking to happen.
• Click drop down menu File> Preferences… click tab Invoice 2 and check the box Allow donor tracking on received goods.

Create a Purchase Order - record donor

• Click on Navigator> Suppliers> Create Blank Order The below screen will appear.
• Note the Donor field in this window. The value you enter here will be passed through to receipt and dispatch. This is good for 

traceability of donor medicines.
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• Type a supplier name and then type @ in field Donor and press the TAB button. This displays the below window.
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• In this window click button New to add a new donor to mSupply. Clicking button New displays the below window.
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• Now add your donor details and click OK. Click OK again to return to your Purchase Order entry screen.
• Note that the newly created donor appears in the Donor field.
• Add you Item line(s), check your order is correct and click button Confirm to make the order available for Goods Receipt.

Receive Donated Goods
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• Click on Navigator> Suppliers> New Goods Received The below window will appear.
• In field Supplier type the supplier for whom you just created the above Purchase Order. 
• Click button Add from Purchase Order and choose the order that you just created and click button Use.
• Note that once you return to the main Goods Receipt window the Donor's name is now present in the Donor field.
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• Enter the batch and expiry details for the item(s) you are receipting and once you are happy the Goods receipt accurately reflects 
the stock that has entered your Store click button Finalise to make the Goods Receipt available for introducing to inventory and 
uneditable.

Supplier Invoice

• Clicking finalise on the Goods Receipt generates the Supplier Invoice - a representation in mSupply of the invoice for the goods 
from the supplier.

• Note that you can see the Donor's name in field Donor.
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• When you add a new incoming good you can enter the donor in the box with the other details of the item.

• If you are adding multiple goods from the same donor, you can enter a donor in the Default Donor box. Any goods you enter 
while a default donor is entered will automatically have that donor. 

368



• If you change the default donor for other items, the previous goods will keep the name of the default donor at the time you added 
them. You can still add goods from other donors while there is a default donor.

• Once you are happy the money values on the Supplier invoice are accurate click checkbox Hold to remove the tick. This 
introduces the items to stock so that they are available for distribution.

• Click button OK to return to the Navigator.
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Customer Invoice

• Now that we have our donated stock available for distribution click Navigator> Customers> New Customer Invoice The below 
window will appear

• Select a customer, click button New Line and in the item detail window that appears locate you donated stock.
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• Note the donor code appears in the item line listbox labelled Donor so that you can distinguish your donated stock from other 
stock lines.

• Note also the batch and expiry details we entered at the Goods Receipt stage.
• Enter a quantity to distribute and click button OK to return to the main Customer Invoice window.
• Now click button OK to pick and/or despatch the donated stock to your customer.

Previous: Next: Issuing goods

Issuing Goods to a Customer (Customer Invoices)

Creating a new Invoice
Choose Customer>New invoice. A window like this will open:
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By default, names with their code starting with a tilde (~) are not shown.

User defined fields are displayed in the above screenshot. To show or hide user defined fields go to File> Preferences> 
Invoices 2.

Information to enter in the main window

Name:

Type as much of a customer name here as you know and then press Tab. If there is only one name that matches your 
choice, it will be entered automatically for you, otherwise you will be presented with a list of available choices. Once 
you have entered a valid name, the New line button will be enabled. If you can not find the name you are looking for, 
you can add a new name by clicking the icon to the left of `Name'.

 The downward pointing arrow to the right of the Name field takes you directly to the Edit Customer/Supplier window, 
giving access to all the information relating to the name entered

Their ref:

Enter the customer's order number if there is one
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Comment:

Click on the downward pointing arrow to the right of the Comment field to display a window where any comment 
relating to this invoice can be noted.

Category

If you are using the category feature, and have defined them, the appropriate category is selected from the drop-down 
list.

Customer transaction fields:

If you are using the customer transaction fields, they will appear here and can be filled in here. Should you wish to use 
them, they have to be activated in Preferences>Invoices 2, refer Show customer transaction fields.

Buttons at the top of the customer invoice window
At the top of the Customer invoice window, there are a series of buttons:

New line

Will add a line to the invoice. This command can be used on any invoice that is not finalised. Clicking the button will 
present you with the window for adding a line from stock.. See the Adding lines to an invoice section below for more 
details. To select a line to edit, simply double-click on it. Note that new line and edit line are disabled on finalised 
invoices

Delete line(s)

Will delete a line which has been selected, and appears highlighted; multiple lines, which do not need to be sequential, 
may also be selected and deleted using this button.

Backorders:
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Refer to for a full coverage of the backorder 
topic.

This icon is displayed only if `We run a backorder system' is checked in the Preferences > invoices 2 options - refer We 
run a backorder system. Clicking this button shows you a list of items that are on backorder for the customer you have 
chosen. To view the backorder list of items, you must first confirm the transaction.

History:

Clicking on this icon will display a record of all that this customer has purchased in the past. This may produce a very 
long list! The list appears in chronological order, but clicking on any of the column headers will sort the list according 
to that parameter.

Confirm:

When this button is clicked, the status of the order changes from nw (new) or sg (suggested) to cn (confirmed). 
Modifications may still be made to the invoice. See Confirming an invoice.

Buttons and checkboxes at the bottom of the Customer invoice window
At the bottom of the Customer invoice window, there are a series of controls.

Currency Settings
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If the Finalize checkbox is checked and you 
click the Confirm button, the invoice will be 
confirmed as well as finalised when the OK 
button is clicked, so be very careful! A 
finalised invoice may be viewed and/or 
printed, but it can not be edited.

If the Finalize checkbox is checked but 
dimmed out, it means that 
File>Preferences>Invoices 2>Finalize 
customer invoices automatically is checked 
and all confirmed invoices will be finalised 
whether you like it or not!

If you have customers that use a currency other than your own, currency settings provide information about the invoice 
in your Customers own currency.

Currency: This is the currency your customer uses. It is set in the Customer Details window of the Customer record and 
is displayed when you add your customer's name to the invoice.

Currency rate: Gives the exchange rate stored in mSupply.

Foreign currency total: Provides the invoice total in the currency the customer uses.

To switch on the currency feature go to drop down menu Special> Show stores… select your Store then select 
Preferences tab and tick the checkbox Store mode: Able to issues in foreign currency.

Hold

Checking the Hold checkbox prevents the Customer Invoice from being confirmed or finalized.

Finalize

Checking the Finalize checkbox allows you to finalize an invoice when you click the OK button. Only users with Can 
finalize individual invoices checked in their user permissions can check this box. Other users will be warned if they try 
to turn it on, and the Finalize checkbox will automatically uncheck.

OK & Next

The OK & Next button saves the changes you have made and exits the window. You are given the opportunity to print if 
the Print checkbox is ticked.

Delete

The Delete button allows the deletion of an invoice. If the invoice has a status of 'nw' you can delete the invoice even if
has lines added. If the status is 'cn' or 'sg' you will have to delete the lines manually first. When an invoice has been 
deleted the invoice number that it was assigned will be reused.
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If the option to turn on the print check box 
has been set under File>Preferences>OK and 
print, you can override the printing process 
by holding down the Shift key as you click 
OK, and no invoice will be printed.

Instead of an invoice, should you wish to 
print a pick list for an invoice whose status is 
'cn' or 'fn', hold down the Alt key (Windows) 
or the Option key (Mac) while clicking OK.

OK

The OK button saves the changes you have made and exits the window. You are given the opportunity to print if the 
Print checkbox is ticked.

Printing the invoice

If the Print checkbox is ticked then print options will be presented when the OK or OK & Next buttons are clicked.

If the invoice status is 'nw' (new) or 'sg' (suggested), pick list options will be printable.

If the invoice status is 'cn' (confirmed) or 'fn' (finalized), invoice options will be printable.

Tabs in the customer invoice window
The three tabs allow the invoice to be viewed in three different formats, but note that the lower area of the window 
remains the same and is available for appropriate input in all views.

General

Once an invoice has been created, a detailed view of the items on it may be seen by selecting this tab; where the supply 
of a single item is made up of different batch numbers, they will be displayed as separate lines:
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Buttons in the General tab

There are a row of small icon buttons at the bottom left of the window. Hovering the mouse over each button gives a 
description of what it does.

Process button (grinder icon)

Clicking this button shows a menu with the following choices:

23. Renumber lines: will re-assign line numbers to all lines on the invoice according to their current order (you can move lines 
around by dragging and dropping to a new position.

24. Issue stock for all placeholder lines: This option will go through each placeholder line on the invoice and attempt to issue stock.
Note that there are several factors that affect the success of this operation, so you should review the automatic choices mSupply 
makes to ensure it is appropriate. Also, note that all things being equal, the oldest expiry stock will be issued, but there are 
reasons to cause either no stock or a batch other than the shortest expiry to be issued, including:
1. Availability of sufficient stock of the line in question
2. Pack sizes that fit with the quantity/pack on the placeholder line

Financial summary

Clicking this button shows you a summary of the cost and selling price information for the invoice.
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If you check the Print as Pro-forma invoice checkbox in this window, rather than printing a pick slip, a pro-forma 
invoice will be printed, allowing you to give a paying client a form showing expected charges.

Transaction note

Allows you to make a note relating to this invoice.

Copy to clipboard

Copies the entire invoice to the clipboard.

Summary by Item

The Summary by Item tab displays the items on the invoice, consolidating different batch numbers and displaying the 
total quantities for each item only; the invoice above appears in the following format when the Summary by Item tab is 
selected.

379



Summary by Batch

The Summary by Batch tab displays the items differentiating between batches, and showing a breakdown where more 
than one batch has been supplied on the order. The above invoice appears in the following format when the Summary 
by Batch tab is selected; note that two different batches of metronidazole tablets were supplied.
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Transport Details

Selecting this tab displays the following window:
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You can make the Order written date and 
Order received date fields compulsory in 
File>Preferences>Invoices 2 explained here: 
Invoices 2

Here you can add information about the method of transportation and other related information.

Order Tracking data

The five date boxes enable you to track your order from it being generated (written) to the customer confirming receipt 
of it (actual arrival date):'. The five date fields are:

• Order written date: The date the customer wrote the order (this will usually be on their requisition form).
• Order received date: The date the customer's order was received by you
• Order shipped date: The date the order left your store
• Expected arrival date: Given the shipping method you're using, when you expect the goods to arrive at the customer's premises.
• Actual arrival date: The date the goods reached the customer you are supplying. Obviously you will only know this if they 

report the information back to you (e.g. via SMS message)

If you use these date fields, it allows reporting using the Transaction Report using the report form Order Processing 
time.
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Shipping method

The choice list for Ship methods is set by choosing Customer > Show shipping methods… where you are shown a 
window with a list of shipping methods.

To enter a new method, click the New button. To edit an existing method, double-click the item in the list.

Responsible officer

The choice list for Responsible officers is a list of mSupply users for whom the “Can be responsible officer” check box 
has been checked. Choose File>Edit users…, then double-click a User Name to set up each user as a responsible officer
(or remove them from the responsible officer list)

If you enter information here, you can report on performance of your transport operations in various ways using the 
Report>Transport Report….

Box Management and label printing

The 'Box Management' feature is used to represent the containers or boxes your items are held in hen being transported 
to the customer. There are two ways to record box details:

• Simple: Records only the box number or reference. 
• Quickly enter a box number (or other reference) by clicking on a line in the list, and then clicking again in the Box number 

column. Once you have started entering box numbers, you can use the Tab key to advance to the next line.
• Detailed (requires the Store preference to be switched on): Record the box number or reference, volume and size. Also see what 

empty space is remaining in your boxes. This is useful for efficient packing and storage of items during transport.
• Enter box details by clicking the 'Manage Boxes' button. You can alternatively select one or more item lines and click the 'Box 

Selected' button. See for detailed instructions.
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If you are using the Box number feature and have allocated a box number to every item in the order, you may then print 
labels for each box by clicking on the Print labels icon (arrowed). The requisite number of labels will be printed and 
may be attached to the appropriate box. An example of a printed label is shown:
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Log tab

Added: version 3.1 
 
 The log tab displays changes to the invoice that have been logged. Details of all logged activities are record in the 
mSupply Log. 

MoneyWorks tab

If you are using the Moneyworks accounting software then the link between mSupply and Moneyworks will need to be 
enabled in File>Preferences>Moneyworks - refer General Preferences - Moneyworks. If this option has not been 
enabled, then the Moneyworks tab will not be visible.

The Moneyworks tab will show the status of the invoices inside Moneyworks accounting software once mSupply has 
carried out an export.
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By default Items with a Code starting with a 
tilde (~) are not shown.

Caution should be exercised before adding a 
new Item to your mSupply system. Duplicate 
items cause problems. Ensure that the item 
you are looking for does not already exist in 
your system under a different Item Name and 
Item Code.

Adding lines to an invoice
Clicking New line will bring up the Add Item… window:

Finding the Item you want
The first thing to enter is the Item Name or Item Code in the Item field. Type as much of the Item Name as you know, 
then press Tab. mSupply searches for all Items whose Name or Code starts with the text you have typed.

If no entries match the request, the Item field will read 'try again'. You can try as many times as you like! If you 
conclude that the Item you want does not exist in your system, click New item to add the Item.

If only one Item matches your request, it will be chosen automatically and you will be returned to the Add item… 
window with that Item already selected.
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If your mSupply system has been set up with 
unique Item Codes for each Item, then the 
experienced user will find that typing in the 
full Item Code here will save mouse clicks 
and / or key presses.

If more than one Item matches your request, all of them will be displayed.
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If the wanted Item is visible, double-click on it or click on it once and then click Use.

If the wanted Item is not visible, click Cancel to try again to find it.

Selecting from Item Lines
Once the item you want has been selected, the Add item… window will display a list of available Item Lines (if any). 
Each Item Line may be a different pack size, batch, expiry, or price. The Item Lines are sorted by expiry date; first 
expiry at the top.

The lines are numbered in the left hand column. You can choose the line you want in one of three ways:

• Type the line number into the Line field and press Tab. The cursor moves to the Quan field.
• Double-click on the line in the list. That line number is displayed in the Line field and the cursor moves to the Quan field.
• Single-click on the line in the list. Clicking again in the Issue column will allow you to directly edit the issue amount in the list - 

see following.
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The number entered in the Quan field is the 
number of packs. The pack size of the 
currently selected line will be used to 
calculate the total quantity of units issued - 
which is shown below the list of lines.

Once you have chosen your line, the number of packs available will be shown to the right of the Quan field, the Pack 
size will be shown in the Pack field, and the total quantity to be issued will be shown below the list of lines.

In the Quan field, you can enter any number greater than zero.

Issuing from a single line

If the number entered in the Quan field is less than or equal to the number available for the selected line, then that value
will be shown in the Issue column in the list.

Click OK to return to the main invoice screen, or OK & Next to add another Item.

Issuing from multiple lines

If the amount to be issued is greater than what the top line can issue, then you can issue from multiple lines without 
leaving the window. There is an automatic and a manual way of doing this.

Manually issuing from multiple lines

For each item line that stock is to be issued from:

1. Click once on the list to select the line
2. Click again in the Issue column
3. Enter / edit the issue amount in the Issue column

The Tab / Shift-Tab keys move the focus up and down the Issue column.

The Total quantity issued is updated at the bottom of the Add Item… window.

Automatically issuing from multiple lines

If the amount to be issued is greater than what the top line can issue, mSupply can automatically select stock from 
multiple lines on a FEFO basis. To allow mSupply to do this, simply enter the total quantity you wish to issue into the 
Quan field.
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If the quantity typed in the Quan field is more than there is available for the selected line, and the Tab key is pressed to 
leave the Quan field, this message is displayed:

If you accidentally entered more than you intended, click Try again, otherwise click the Distribute button.

Issuing when there is inadequate stock

If the amount to be issued is greater than the total stock available from all of the available lines, then a placeholder line 
may be utilised, if your mSupply preferences allow it.

Placeholder lines

If there are no lines available, or none of the lines are suitable (for example, this order needed strip packaged stock, and 
the available lines are all bulk packs), then you can add a placeholder line that will record the desired quantity and pack 
size until either you get stock, or go to confirm the order, at which time the item will be either moved to backorder or 
deleted (depending on how you have set your Preferences).

A Placeholder line can be added manually or automatically.

Manually adding a placeholder line

A Placeholder line can be added by clicking the Add Place holder button. 

As shown in the window displayed below, placeholder lines are coloured in red and have a batch of “none” so you can 
easily identify them.
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If you have allowed placeholder lines in the 
Preferences, and you choose an item that has 
no available stock, a placeholder line will be 
created automatically.

The quantity to be issued in the placeholder line is entered in the same way as any other Item Line - refer Manually 
issuing from multiple lines

Automatically adding a placeholder line

If the number entered in the Quan field is greater than the total stock available from all of the available lines, then 
mSupply will prompt you with an Alert:

After clicking OK, all existing stock lines will have the Issue column populated with the total quantity available for 
each line, and a placeholder line will be created with the outstanding quantity inserted in the Issue column.

Confirming an invoice with placeholder lines
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When confirming an invoice that has placeholder lines, the following actions will occur:

• If you have activated backorders, a backorder line will be created for each placeholder line.
• If you have set the Preferences to delete placeholder lines when confirming, they will be deleted, otherwise they will remain on 

the invoice to show the client that their order was received, but the goods were not supplied.

Issuing all available stock of a batch

Sometimes you might end up with an unusual available amount of a particular batch. Due to the fact that mSupply 
rounds the available quantity, it may be hard to enter the exact amount to completely issue the batch. In such situations 
you can issue the total amount available by holding down the shift key while you double-click a line. This will issue the 
total available amount of that batch.

Lines on Hold

Sometimes an Item, batch or location might be on hold. If the entire item is on hold you will not be able to add the item 
to your invoice form but if a batch or a specific location is on hold you will see the item appear on your invoice form 
with the hold column ticked for each batch or location held. Held lines cannot be issued. If there are no lines that are not
held with sufficient quantities to fulfill the invoice then a placeholder line will be created.

You can tell whether it is a particular batch or a particular location on hold by double clicking on the line in question.

Editing an invoice line
To edit an invoice line, double-click on it. You will be presented with the Edit line window, which is identical to the 
New line… window, except that the item name is already chosen.

393



In the Edit line window the quantity you 
have already chosen is added back into the 
Available stock column. You are viewing the 
stock records as if the line has not yet been 
processed.
Similarly, any other invoice lines for the 
same item are also shown in the same way; 
the Issue column is filled out with the the 
amount being issued from each batch on the 
invoice and the Available column includes 
the Issue amount.

For example, in the window below, there are three lines on the invoice for different batches of paracetamol, and all three
are shown when editing, irrespective of which of the three lines was double-clicked.
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Selecting a different item has the following 
effects
If you proceed to issue the new item, all 
invoice lines for item you were editing will 
be deleted, and invoice lines will be added 
for batches being issued of the new item.
If you choose a new item for which there is 
already an invoice line(s) on the invoice, the 
stock to be issued on those lines will be 
shown in the “issue” column. If you proceed 
you are effectively editing the quantities of 
the item you have just selected, and you are 
deleting all invoices lines of the item that 
was originally on the invoice.

At this stage you can:

• Edit the Issue value for the selected line item, or change the value in the Quan field
• Select a different item line (that is, a different batch) and edit it's Quan or Issue value.
• Click in the item name field, and select an entirely different item!

Changing the batch to be issued

If you want to choose a different batch for an existing invoice line:

• double-click the invoice line
• set the quantity of the batch you don't want to zero,
• double-click the batch you do want, and enter the quantity you want to issue.
• Note that if possible the new batch will be added to the invoice at the bottom of the other lines, and the former invoice line will be

deleted. You can use drag and drop to reorder invoice lines if this is a problem.

Editing a placeholder line on an invoice

When you double-click a placeholder line, an extra button is displayed:
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The Redistribute all button takes the quantity on placeholder lines and re-assigns it to actual batches in stock.

When you are not editing a placeholder line, the button is not visible.

Deleting a line from an invoice

• If the line is a placeholder line, you can simply click the line you wish to delete, then click the delete line button.
• If the line is a normal invoice line (with stock associated with it), double-click on the invoice line. In the line details window that 

appears, press Tab to advance to the quantity field, enter 0 (zero), then click OK. You will be asked to confirm that you really want
to delete the line.

Note : Once an invoice that has been finalised, you can not remove an item from it.

Reordering invoice lines
Invoice lines can be reordered by drag-and-drop of a line to a new location. This can be useful to group lines for the 
same item.

If the invoice lines are currently sorted by line number the renumbering will happen, otherwise you will be shown an 
alert mesage.

If you really want to reorder lines when sorted by a different column, hold down the shift key as you drag-and-drop to 
override the message.

Note that reordering can not be undone, apart from you manually dragging lines back to their original location.

Confirming an invoice
Note: if you have “confirm invoices automatically” set in the Preferences, the confirm invoice button will be hidden, 
and this option will not be applicable.

• Confirming an invoice should be done when the goods have left the store (or have been packed ready for dispatch).
• The confirm button is only available for invoices with status “sg” (suggested).
• Each item line records two stock levels- the quantity is the total stock on the premises. the available amount is what can be issued 

on an invoice. See the section below for a fuller explanation.
• For example:
• You get an order for 3 bottles from Fred, and create an invoice for Fred. The quantity is still 10, but quantity available drops to 7, 

as these 3 bottles can't be issued to someone else.
• You are about to dispatch the order. At this point you confirm the order. The quantity and the available amounts are now both 7.
• In summary, the confirm button does the following:
• Each line has its quantity in stock reduced by the amount issued on that line
• It changes the order status to “cn”
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If you have the store preferences set to force 
customer invoice authorisation, you will not 
be able to confirm customer invoices until 
they have been authorised. See here for 
details.

• If you are running a backorder system, it deletes any placeholder lines (those with a batch entry of “none”) and adds them to that 
customer's backorder file. Otherwise the line is simply deleted. Once an invoice is confirmed you will be asked if you now want to
print an invoice.

Printing an invoice
You can print an invoice at any time by checking the print icon checkbox (next to the OK button) and clicking the OK 
button:
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But note: you print different things depending on what status the invoice has:

• If the invoice is suggested (sg) then a picking slip is printed.
• If the invoice is confirmed (cn) or finalised (fn) then a customer invoice or delivery note is printed.

The general idea is that the customer invoice remains at suggested status, the goods are picked using the picking slip 
and then any differences between what was actually picked and what was on the picking slip are entered into the 
invoice (still at suggested status) in mSupply. The invoice is then confirmed and the delivery note is printed out to go 
with the packed goods. Quick and simple!

Entering a service line on an invoice
All “normal” customer invoice lines represent the issue of stock lines to a customer. (These lines appear in the large 
section in the middle of the “Customer invoice” window).

mSupply also allows you to charge a customer for “service” item(s) such as freight, or advice or a refundable deposit on
a cool box.

Enter the description and amount at any time until the invoice is finalised.

Note: the “subtotal” amount on the invoice includes any service charges, and tax (if any) will be added to the amount 
you enter.

Editing tax on invoices
The tax rate on an invoice is determined by the “default tax rate” setting in the mSupply Preferences.

To edit the tax rate on an invoice, click on the tax rate box at the bottom of the invoice entry window. You will be asked 
to enter a new percentage tax rate. Click the cancel button if you do not want to change the tax rate.

Note: you can not change the tax rate on finalised invoices.
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Invoice from supplier invoice
Choosing this command from the Customer menu allows you to take a supplier invoice and directly make a customer 
invoice.

It is useful for goods that are delivered directly from a supplier to a client, but are charged through your organisation.

You will be asked to enter the supplier invoice number and the customer code for the invoice to be created, so have this 
information ready.

When finished, a customer invoice with suggested status is created.

If any lines from the supplier invoice have been issued already, you will be alerted and only the available balance will 
be added to the customer invoice.

Previous: Show outstanding Purchase Order lines.... Next: Invoice Authorisation

Viewing customer invoices
To view or edit any customer invoice, choose Customer>Show invoices

The Find Transactions window
You will be presented with this window where you can enter a number.
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If you enter: Transaction(s) Displayed 

1 You will be taken directly to the most recent invoice 
entered 

25 A list of the 25 most recent invoices 

123 in the lower box Invoice number 123 will be displayed. 

Click the Complex Find button The query editor will be displayed, where you can enter a 
more detailed query. 

The list invoices window uses the Transactions list form, which looks like this:

Note. All of the columns may be adjusted in width to meet your requirements; for the screenshot above to fit on the 
page, most of the columns were reduced in width.

Down the left side is a sidebar, with 5 headings:

1. Type 
2. By date
3. By status
4. My transactions
5. My custom filters. 

Clicking on the small triangle to the left of each heading will expand it and display the options available. In the graphic 
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below, the Types heading has been expanded to display the available options

Once the type of transaction has been selected, it remains selected while you further define the required criterion from 
one of the four remaining headings, By date, By status , etc. Be aware that a single criterion only from this group of 4 
headings may be selected.

At the bottom left of the window you'll notice there are 3 numbers separated by slashes- “1/15/67” in the example 
above. These numbers, in order, are the number of highlighted rows, the number of found rows, and the total number of 
transactions in the database.

Along the top of the window are these buttons:

Their functions are now described.

Find: This button recalls the Find Transactions window, where several options are available.

Click on the drop down list on the left to display the options available for determining which field to query:
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If the invoice was part of the internal 
requisition process (from one virtual store to 
another) then the links to the originating 
purchase order will be maintained, and a 
goods receipt will be created if you finalise 
the customer invoice at a later date.

Choose the comparison from the next drop down list (equals, starts with, etc)

Note: the comparison popup menu will change depending on the type of field you have chosen in the first list.

This window is very useful for quickly finding a group of invoices.

If you want to query on multiple criteria, click on the Complex Find button, which takes you to the Query Editor, which 
has powerful features to perform queries with multiple conditions. Detailed guidelines for using the Query Editor are to 
be found in Working with lists

Sum: Displays the total value of the highlighted invoices. Highlight more than one invoice by control - clicking (Mac: 
command-clicking) invoices. Highlight a block of invoices by clicking on the first invoice of the series, then shift-
clicking on the last invoice in the series.

Order by: The invoices displayed may be sorted according to any of the columns by clicking the column heading. A 
more comprehensive sort facility is available when you click the Order by button. This displays the order by window, 
where you can drag fields from the list on the left to the right-hand pane to sort the list by the fields you have chosen.

Print: Prints the list of invoices displayed. (Does not print the actual invoice - just a list)

Finalise: Click on this icon to change the status of the invoice to finalised .

Duplicate: Click on this icon to duplicate the transaction; you would use this feature, for example, to supply exactly the
same items to another customer. You will be asked if you want to duplicate all lines on the invoice, or just the 
placeholder lines. 

Cancel: Click on this icon to cancel the transaction. This command only works on finalised invoices. The invoice is not 
deleted from the system; mSupply makes a duplicate finalised invoice with the same invoice number but with negative 
quantities matching those on the invoice you're cancelling. This ensures that all transactions are preserved and will 
appear in an audit trail. But note that you will not be able to cancel a finalised customer invoice which put stock into 
mSupply and some of that stock has been used. An exception to this is a stock transfer: if none of the transferred stock 
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has been issued then the original finalised customer invoice which initiated the transfer can be cancelled if the supplier 
invoice produced from it is first deleted.

Filters:
This feature enables the application of filters to reduce the volume of information displayed to reflect more precisely 
what you require.

Take as an example, a hospital where you have searched on a large number of customer invoices, but you are really only
interested in issues to the Orthopaedic Clinic during the first six months of a year.

Clicking on the New Filter icon presents you with a window where you can define the criteria for your filter, in our case
the customer's ID is entered, and the period under review - i,e, January to June 2009 using the syntax of a WHERE 
clause in SQL

The Respect selected invoice type checkbox has the effect of applying the filter to the type of invoice which has been 
selected in the sidebar, and if we do this in our example, instead of displaying several hundred invoices, only the 
handful of invoices for the Orthopaedic clinic will be shown.
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Any filters so created are listed under My custom filters , and are available for use as required until they are deleted.

Customising the displayed columns
This feature allows you to

• display the information you require
• arrange the column order display to suit your requirements

Display the information you require 

Displayed under Available on the left are the available fields, while displayed under Chosen on the right are the 
presently selected fields.

To add a column to the display, click on the required one to select it in the Available column, then click the upper button
between the two displays, and it will appear at the bottom of the Chosen list.

mSupply provides the feature of analyzing customer invoices by their despatch/delivery/arrival dates. Once a customer 
invoice has delivery dates entered for it, Transport details, choose the customer delivery columns 'Order written', 
'order received', 'dispatched', 'expected arrival', 'actual arrival' to be included in your transaction list.
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 This list show customer invoices in mSupply ordered by Expected Arrival Date. Click on the column header to order on
that column.

Arranging column order:
This is done by clicking then dragging the column heading to the required position.

Sorting the list:
Click a column heading to select it, then click on the small triangle on the right to display the list in order or reverse 
order as required.

Previous: Next: 

Customer credits
Choose Customer > New customer credit from the menu bar.
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Entering a customer credit is exactly the same as entering a Supplier invoice, except that:

• You will enter the customer name rather than the supplier name
• Items will be entered with zero margin. This is because mSupply uses the cost price entered to calculate the amount to credit the 

customer, so you must enter the amount you charged them as the cost price for each line. Presumably you want to sell the item 
again for the same price you sold it originally, hence the cost and selling price must be the same

Note: there is no need to enter negative values in mSupply . Even when you are entering returned goods from customers,
or returned goods to suppliers, enter positive values. mSupply automatically converts the invoice total to a negative 
amount.

Previous: Next: 

Backorders

Overview
mSupply's backorder system allows you to record items you were unable to supply to clients, and (hopefully) supply 
them at a later date when you have enough stock.

When you do not have enough stock of an item that a customer orders, it is normal to add a placeholder line to the 
invoice you are creating. If you have local suppliers, it is possible you will be able to receive stock in time to fill the 
order, and the placeholder line can be edited and replaced with a normal stock line.

Once it is time to ship the order, placeholder lines will be converted to backorder lines, and you will be invited to enter 
a comment for each item (e.g. “We're very sorry- it's coming next week.)

Backorder preferences
The behaviour of mSupply in handling backorders is controlled by several preference settings:
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• To do anything at all with backorders, you need to choose File > Preferences and go to the Invoices 2 tab . There, check We run a 
backorder system

• If you wish to have customer invoices automatically created when goods on backorders are received, the appropriate box should 
be checked.

• On the same tab, check Allow placeholder lines on customer invoices . This allows you to use placeholder lines to record stock 
ordered by a customer but not able to be issued.

• On the right side of the same tab is the option to Delete placeholder lines when confirming invoices. If this option is not checked, 
placeholder lines will be left on an invoice when it is confirmed. Otherwise they will be deleted. In either case, as long as the We 
run a backorder system option is checked, confirming an invoice will result in placeholder lines being transferred to backorders.

How much is on backorder?
There are four ways in which you can view backorders

• When creating a customer invoice, there is a backorders button. This is described in detail below.
• Use the backorders report to view some or all backorders.
• When viewing details for a particular item, see all the backorders for that item on the backorders tab.
• When viewing details for a particular customer, see all the backorders for that customer on the backorders tab.

Backorder management from the Customer invoice window
Clicking the Backorders button when viewing a customer invoice will show all lines for the entered customer that are 
on backorder.
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The Backorders button will be hidden if ” We 
run a backorder system “ is not checked in 
Preferences > Invoices2.
If you are entering a new invoice, you need 
to have entered a customer name on the 
invoice before clicking the button.

The window also shows current stock, so you can easily see which backordered lines can be added to the current 
invoice

Buttons in the backorder window

New backorder: Placeholder lines are automatically changed to backorders when an invoice is confirmed, but there 
may be occasions when the manual entry of a new backorder is necessary: click this button to create one.

Delete backorder: You can delete an item line or multiple item lines by selecting the line(s) and clicking on Delete 
backorder button.

Modify line: This button is used to edit the item line. Select the desired line and click on Modify line button to display 
the following window.
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Add lines to invoice
Highlighting lines and then clicking the Add lines to invoice button will (surprise) add the highlighted lines to the 
invoice. The backorder quantity will be set to zero, and may then be deleted.

Note that as you issue lines on an invoice, the quantity on backorder is automatically reduced. However, once a line 
reaches zero, it is not automatically deleted. This is because it is possble the user will delete or edit the line on invoice, 
and hence the reduction in backorder quantity may have to be reversed.

The Backorders report
Choose Reports > Backorder report.

You can enter settings to reduce the scope of items or customers for which the report is produced.

The first drop down list allows the report to be filtered by many options, but note that if Item name is chosen, then the 
full name must be entered and not just partial details.
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Two options are available: for display:

• each customer and the items on backorder for that customer
• each item and the customers having backorders for that item.
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Note that this report does have limitations, as if a customer orders the same item more than once, it is likely that 
demand will be overstated.

Viewing backorders for a customer or an item.
Clicking the backorders tab when viewing a customer or item details shows a window where you can view or edit items 
on backorder. The example shows backorders for an item, ibuprofen 200mg tablets.

Notes

• If you have set the preference to leave placeholder lines on confirmed invoices, then you can use the Item ordered shortfall report 
to display the difference between customer demand and what was actually supplied.

Automatic creation of customer invoices for backorders
With the required boxes checked under Files > Preferences > Invoices , mSupply will automatically create invoices for 
those customers having items on backorder when the items are received from suppliers.

This description is illustrated by the situation in which two customers, Urban Clinic and Rural Clinic both have 
Promethazine 25mg tablets on backorder - Urban Clinic awaiting 5 x 100, and Rural clinic awaiting 2x 100. The 
supplier is Arbuckle.. This may be confirmed by previewing a backorder report:

On receiving the goods from the supplier, a new goods received record is created in the usual way, and finalised. When 
you click on OK to create the supplier invoice, you are required to confirm your intention to finalise the order, which 
you would normally do. The supplier invoice is displayed, and in the bottom left corner of the supplier invoice, you will
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see that the Hold box is checked. You should click on it to remove the check mark.

and this alert message is displayed:

Review the invoices as alerted, and for this example the invoice generated for the Urban Clinic is shown:
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The invoice generated has all the relevant details, e.g. batch no., expiry, etc., copied across from the supplier invoice, 
and the comment has been added to the effect that the invoice has been generated automatically, and also identifies the 
Goods Received ID:

Previous: Next: Electronic Invoices

Transferring goods to another Store
This feature is available only to those users who are managing more than one store on their systems - e.g. if you have a 
General store for holding stock, and you supply a Dispensary with their day to day needs - refer Virtual stores.
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If you are transferring goods to the receiving store in response to an 
Internal Requisition (Purchase Order) from that store, DO NOT follow the 
instructions in this section. The relevant section is Processing the customer 
invoice (supplying store)

If you're not able to perform a transfer there are several possible reasons
There must be more than one store set up in your copy of mSupply
You must have the user permission to perform transfers
The store you're transferring to must be visible. To make it visible choose 
Special > Show stores and double-click the store you want to transfer to, 
then on the preferences tab click the View name button and set the 
visibility on the Stores tab. Phew!

This procedure follows closely the steps as described under ; to avoid unnecessary repetition, please make sure you are 
familiar with that procedure.

You must be logged in to the issuing store (the store you're transferring stock from); the 'customer' in this process is the
receiving store. So, you create a new invoice from the Customer menu, and in the Name field the you put the name of 
the receiving store in the normal way (i.e. type the first few letters of the store's name, press the TAB key, and select the 
store in red colored text from the list displayed). You are presented with a window in which you must confirm your 
intention:
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Stock transfer label (under comment field) defines that the goods being issued are for a store. not for a customer.

The procedure from this point is identical to that described under .
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It is necessary to finalise the transfer when you have finished entering the 
items to be transferred. Only after finalising the transfer will the new 
invoice appear on the system, as a Supplier Invoice in the receiving store, 
and as a Customer invoice in the issuing store. The status of the supplier 
invoice in the receiving store will either be confirmed and on hold or 
finalised, according to the setting you have for the “For stock transfers, the 
supplier invoice in the receiving store should be…” store preference. See 
here for details.
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If the item(s) you are transferring are not visible in the destination store the following message will appear:  Check 
whether there is any reason for the item(s) in question not to be visible in the destination store. If there is no reason to 
prevent visiblity click OK.

Reversal of stock transfer

Should a reversal of a stock transfer be necessary, this may be achieved by the operator at the sending store, and only if 
the receiving store has not issued any of the transferred stock.

Receiving the goods (customer store)
In the customer store a Supplier Invoice will be automatically generated, provided that the Customer Invoice in the 
sending store was finalised - see above! You can view the customer invoice record via the Suppliers tab on the 
Navigator or via the Supplier > Show invoices… menu item.

On the supplier invoice the lines from the customer invoice will have been filled in automatically.

Depending on your store preferences, this customer invoice may or may not be locked, or finalised.

Previous: Electronic invoices Next: 

Printing invoices
On the Customer menu, there are two choices regarding printing invoices:
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Print special invoice

A special invoice is the same as a regular invoice, except that you can set different text to appear at the bottom of the 
invoice. One common use is to print invoices with areas for signing for the receipt of narcotic goods.

You can set the text that appears at the bottom of a special invoice from the “printing” tab of the Preferences window.

Print invoice series.

Allows printing of a range of invoice numbers. You will be asked for the first and last numbers to print.

Invoice printing preferences
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Preferences related to the printing of invoices appear in this window, allowing users to customise the printing of 
invoices.

Previous: Next: 

Box Management
Added: Version 3.1

On the transport tab of a customer invoice window, there are two methods for managing boxes.

• The simple method allows you to directly enter any Box identifiers in the Boxes column
• To use this method you should not turn on the preference mentioned below. You simply click twice (slowly) in the box 

numbers column of the “Transport details” tab on a customer invoice and enter box numbers.
• If you want to assign exact quantities of each invoice line to a box or boxes, and also possibly record box weights and volumes, 

you need to:
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• Choose Special > Show Stores
• Double-click on the store in question (you might only have one)
• Click on the preferences tab
• Check “Able to pack items into multiple boxes”

The rest of this chapter assumes you're using mSupply with this preference checked.

Setting up boxes

• Once you've created a customer invoice, and picked goods, the pickers should have marked the pick slip with what quantities of 
each item were put into what box.

• Now go to the Transport tab of your customer invoice.
• Click Manage Boxes (Note: if you haven't turned on the preference as above, these buttons are hidden)
• You'll see this window:
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•
• Click New to add boxes
• We suggest you keep box names short. e.g. 1, 2, 3, 4 or A, B, C, D
• Type a box name, click OK & Next (shortcut: the Enter key) to add another box.
• On the last box click OK to save and close the window.
• If you're Gary, you might have clicked OK & Next one too many times. In that case you can use the Cancel button to close the 

window. 
• Note that you can't have a blank box name, and you can't have two boxes on the same invoice with the same name (You can just 

use the same series of box names over and over on different invoices).
• If you make a mistake with a box name you can double-click a row to edit it.
• Click OK to close the Box Management window when you're done.

Using the Box Selected Button

• In most cases you will be able to put the total contents of an invoice line in the one box.
• In that case, click on a row, or hold down <control> (Windows) or <command> (Mac) and click on multiple rows.
• In the example below we have highlighted rows 2, 3 and 4.

•
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• Now click Box selected
• You'll be shown the “Pack selected boxes” window:

•
• Choose the box for the items from the drop-down list.
• Click OK to close the window.
• You'll see the boxes column in the list has been filled out.

Splitting a single invoice line over multiple boxes

• If you have bulky invoice lines or large quantities, you will need several boxes to hold the one line.
• Double-click the line to assign to boxes.
• Let's say in the example above, you got a supplementary request to increase the water for injection quantity from 100 to 2000. You

go back to the “general” tab and do this. Now back on the transport tab you double-click the water for injection. This is what you 
would see:

•
• Notice that at the top of the window “1900” is in red. That's the quantity still to distribute.
• Click the Add to box button.
• You'll see this window:
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•
• Let's say we're going to put 1000 in box A and the remaining 900 in box B

• Enter 1000 in the quantity field
• Choose A from the drop-down list
• Click OK & Next
• Fill out the window to enter 900 in box B and click OK to close the window.
• Now your window should look like this:

•
• You can double-click a row to edit it.
• To delete a row, click on it to highlight it, then click Delete
• Note that the weight and volume for the item will be calculated automatically if you have set them in the item details window, but 

you can also override the calculated weight/volume when you are assigning an item to a box.

Removing an invoice line from all boxes

• You can use the Unbox button to remove an invoice line from all boxes at once.
• Highlight one or more invoice lines.
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• Click Unbox
• You're done.

Seeing what is in a box

• If you click Manage Boxes and then double-click a box you will be shown a list of items in that box.
• You can also set the measured weight and volume in this window, which will usually be somewhat higher than the calculated 

weight/volume:

•

Printing packing list for each box

• We have custom printing forms available that will print packing lists for each box. Ask us for more details.

Previous: Next: 

Stock Control methods for your customers

Stock supply philosophy
mSupply is designed for situations such as a central supply facility within a country or region, or within a hospital 
where the supply of stock to Customers is controlled by the supplying facility. That is, supply of stock to Customers is 
managed by the supplying store.

Regardless of who controls the supply of stock, it needs to be made principally on the basis of information about the 
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Master Lists and Local lists and how to create and assign customers to them are 
covered elsewhere in Master Lists

Customer's anticipated usage. mSupply has two methods of arriving at quantities to be supplied to Customers:

• The Stock History Method
• The Imprest Method

(If you can think of better names, please tell us!)

Defining the list of items to be included in the re-supply
Both the imprest and stock history methods require a stocktake of the Customer's stock. The list of items to be included 
in the Customer's stocktake is defined. These lists are specific to each customer, and must therefore be individually 
compiled, however, they can be based on Master Lists.

Lists are defined for each customer in the Edit Customer window. Click on Item lists in the side bar menu.

This displays the window in which you create the required lists. 
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Adding a Local List
First, click on Add Local list and in the panel that appears, enter a name for your list then click OK - in the example 
we've named it Items_Imprest. 

Adding items to a List
Select the list to highlight it, and you're ready to compile it. Click on Add Item to do this, and repeat until you've added 
all the items you require. Our example (below) shows that one item (Ibuprofen) has been added, and a second item 
(Prednisolone) is being added. 
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Only if you are using the Imprest Method is it necessary to enter imprest quantities. 
If you are not using the Imprest system, the Imprest Quantity field should be left 
blank.

Entering an Imprest Quantity
We'll now add another item, Haloperidol 5mg tablets, with an imprest quantity of 200, to demonstrate how 
it's done.

1. Click on the Add item icon to bring up the standard search window.
2. Type the first few letters: hal, followed by the Tab key.
3. From the list, select: HALOPERIDOL TABS 5MG by double clicking on it. The Add item window appears.
4. Enter 200 in the Imprest Quantity field.
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For the purpose of the guide, only 3 entries are present for the fictitious Highland 
Health Centre. In the real world your imprest list is likely to contain many items

Note that mSupply uses stock issued by the 
supplying store to arrive at the parameter B. 
Obviously, if the customer has received 
goods from other sources during the 
calculation period, B would be inaccurate.

The Stock History Method
The basic approach of the Stock History method (or Historical Logistics Method) is based on the the assumption that 
future Customer usage will be similar to historic usage.

We can calculate the Customer's average usage over time if we know their stock levels at two points in time. We assume
that this average usage rate will continue over the coming supply period.

There are three more variables that need to be estimated:

• The Number of days in the coming supply period
• The lead time required to supply them (that is, the time lag between the Customer doing a stocktake in order to trigger re-supply, 

and receipt of the stock)
• The number of day's worth of buffer stock they need

With this data the calculation is like this:

• A = Stock on Hand on date1
• B = Amount supplied to Customer between date1 and date2
• C = Stock on hand on date2
• D = Quantity used in period between date1 and date2 = A+B-C
• E = number of days between date1 and date2
• F = Usage rate = D/E
• G = Number of days in coming supply period
• H = Number of buffer stock days desired
• I = Lead time (days) between date2 and delivery of stock
• J = Amount to supply = F*(G+H+I)-C

Using the Stock History method:

• A and C are reported by the Customer on date1 and date2 respectively
• B is calculated by mSupply based on mSupply records
• G, H and I are entered by the user
• D, E, F and J are calculated by mSupply
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First Stocktake Record
In order to calculate the usage rate, mSupply requires stock on hand figures of the items on the list recorded on an 
earlier date (date1) = A, above. This becomes the initial stock history record.

To create such a record, follow the procedure described below for entering a stock history, noting particularly, the 
following:

1. Enter the date as the correct date at the time the stocktake was performed.
2. Ignore the figures that automatically appear along each row, except for the Their current stock column.
3. Enter their current stock figures in the Their current stock column
4. Close the window using the OK button.

Regular use
Once your Customer's first stocktake record has been entered, and a period of time has passed with some Customer 
stock usage, re-supply can be be generated on the basis of this usage.

A re-supply using the stock history method needs to be triggered by a Customer Stocktake. IF your Customer is set up 
with mSupply Customer, then this process can be initiated by the Customer directly, and then completed in the 
Supplying Store as described below.

If your Customer has not used mSupply Customer to report their Stocktake, then their stock data needs to be entered in 
manually into the Supplying Store.

Manual entry of Customer stock history

Show Customer Stock Histories

To begin the process, choose Customer > Show customer stock history, and the list of any historic Customer stock 
histories is displayed. The Status column lets you know the status: sg (suggested) or cn (confirmed). The Type column 
shows the stocktake type: im (Imprest) or sh (Stock History):
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Add New Customer Stock History

Click the New customer stock history button, to display the Enter New Customer stock history… window:

Enter the first few letters of customer's name in the Name field, then press the Tab key to call up the list of customers' 
names from which the required customer may be chosen. In this example, our customer is Medical Ward.

Once you have chosen a customer, the window is populated with the items that are members of any item lists that:

• Have been assigned to that customer (both master lists and local lists)
• and that have the “Stock history” check box checked for that list

You are presented with this window:

Fill in Customer Stock History

The Our SOH column is the stock on hand in our own store, while figures in all subsequent columns are the customer's 
data.

The first entry to be made is in the Days to supply field, where the appropriate figure should be entered - e.g. 30 if the 
ordering frequency is monthly, 90 if it is quarterly, etc.

You will see in our example that
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• 29 days have passed since the last stocktake
• The column headed Their old SOH shows their stock on hand at the last stocktake
• The column headed They received shows the amounts supplied when their last order was processed
• The column headed Their current SOH is the column where the customer's current stock figures (as provided by the customer) are

entered. But note that, just as with the imprest method, if the name you entered in the Name textbox is actually another store then 
this column will be automatically filled in with the current stock in the store - saving you a lot of time (you only need to edit those
figures where the stock in mSupply does not actually match what's on the store's shelves).

• As figures are entered, mSupply® calculates a suggested quantity to order, and this appears in the Suggested quan column. These 
suggested quantities should be reviewed, and any adjustment entered in the Actual quan column to reflect, for example, pack sizes
and to ensure that actual quantities match exact multiples of the pack size.

After entries have been made in the column Their current SOH the window will look like this:

All that remains is to make adjustments in the Actual quantities column, to reflect appropriate pack sizes.

Once you are satisfied, the Confirm box (bottom left corner) should be checked, the Create customer invoice button 
should be clicked, and you should proceed exactly as earlier described. See Creating the customer invoice above.

Printing forms

Clicking the Print button provides several options for printing forms:
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1. Customer stock takes: This form you can give to the customer (for example, if they are a ward in a hospital that has mSupply 
running in it's pharmacy store), and they can fill out the quantities they have on hand, and then values are entered into mSupply. 

2. Customer stock supply: This form provides information to give to the customer about the quantity they will be supplied.
3. Customer stock request and issue: Provides information for the customer comparing what was requested with what was 

actually supplied.

The second two reports are for use after you have entered quantities to be supplied into the customer stock history 
window.

More on the Customer Stock History list.

With the passage of time, entries on the list will rapidly grow in number, and so mSupply allows you to apply a filter 
selecting exactly what will be displayed.

The default display is for All suggested , as these are most likely the ones you will be processing; other options are All , 
All confirmed , All web entries to be processed - this covers histories submitted over the internet - and Entered today

Viewing customer stock history by item

• When editing an item, you can view the customer stock history records for that item. More information is available here

The Imprest Method
With the Imprest method, the quantity to be ordered is the quantity necessary to restore the stock on hand to a pre-
agreed fixed quantity. This imprest stocktake must be carried out on a regular fixed frequency (daily, weekly, 
fortnightly, monthly, whatever.) This pre-agreed fixed quantity is arrived at on the basis of a number of simplifications 
to the stock history method:

• A = Stock on Hand on date1
• B = Amount supplied to Customer between date1 and date2
• C = Stock on hand on date2 THE ONLY INFORMATION COLLECTED
• D = Quantity used in period between date1 and date2.
• E = number of days between date1 and date2
• F = Usage rate PRE-DETERMINED AND FIXED
• G = Number of days in coming supply period PRE-DETERMINED AND FIXED
• H = Number of buffer stock days desired PRE-DETERMINED AND FIXED
• I = Lead time (days) between date2 and delivery of stock = 0
• J = Amount to supply = F*(G+H+I)-C

The Imprest Quantity = F*(G+H+I)

If stocktakes are not taken at the pre-determined frequency, and particularly if they are missed, the system will fail. It is 
a fairly rigid system, in that once set, F, G and H must remain constant. It is frequently used for supplying wards in a 
hospital setting, where operations are generally more controllable.

Using the Imprest system
The Imprest system operates in this way: the stock of a particular item which a customer - usually a clinic, ward or 
department should hold is agreed - for example, take the case of a rural clinic, which receives a monthly order from a 
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central store; it is agreed that the clinic should, when fully stocked, hold 10,000 paracetamol 500mg tablets and this is 
known as the Imprest quantity for paracetamol tablets. At the end of a particular month, a stocktake shows that there are
2,400 paracetamol tablets in stock; to restore the stock of paracetamol tablets to the imprest quantity, the amount to be 
ordered is calculated according to the formula:

Imprest quantity - stock remaining = order quantity

In the above example for paracetamol tablets, this is the calculation:

• 10,000 (imprest quantity) minus 2,400 (quantity remaining in stock) equals 7,600, and this is the order quantity.

The Show customer stocktakes feature caters for mSupply users who operate an Imprest system, where a central store 
supplies goods on a regular basis to a number of customers, who may/may not be mSupply users themselves. We advise
that the customers should be provided with a list - perhaps for a 12 month period - of the dates on which they should 
perform a stock check and submit the figures, ideally on a customised form, to the central store acccording to the 
prearranged schedule. It is important to note that the customer needs to supply only the current stock on hand figures, a 
relatively simple task; customers are not required to submit details of what they perceive to be order quantities.

It should be remembered that the items to be included in the list and their imprest quantities must be defined for each 
customer individually. The imprest quantity defined for a particular customer is unique to that customer, and has no 
bearing on imprest quantities defined for other customers.

Processing the order from the customer

The central store, on receiving the stock on hand details from the customer, selects from the Navigator or Customer 
menu the item Show customer stock history, which displays this window:
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If you are working with a customer for whom no imprest list has been defined, clicking on the New customer imprest 
will display the Enter new imprest window, where appropriate entries are made. 

Continuing to use Highland Health Centre as our example (for whom we have created an imprest list), double clicking 
on that entry displays this new window on which the imprest list appears:

You will note that there are no entries in the Their current stock column, and the figures supplied by the customer 
should be entered; click on each line, and after a second or two the zero appearing in that column can be edited with the 
required figures.
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There is an important exception here: if the 
name you entered in the Name textbox is 
actually another store in mSupply then the 
Their current stock column will be 
automatically filled in with the stock in the 
store. Very useful time saving feature!

Simultaneously, mSupply completes the next two columns, Suggested Quantity , and Actual Quantity. The Actual 
Quantity entries may be edited to reflect, for example, pack sizes, to ensure that actual quantities match exact multiples 
of the pack size. After editing, the window may appear like this:

Should you have any reason to identify one or more lines, this may be performed by highlighting the line(s), and 
changing the colour of the font. Black is the default, but other options may be selected from the drop-down list:
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Selecting 5 or more lines brings up an alert requiring confirmation of your intention.

Creating the customer invoice

Once you are satisfied, the Create customer invoice button should be clicked, and the following window appears:

All the entries appear in red, as mSupply needs the operator to select the specific item to be supplied from your store, 
i.e. the batch required, and, if necessary, to distribute the order over two or more batches, if there is insufficient quantity
of one batch in your store. The next step is to double click on each entry and in the example, the 1st item on the invoice,
Ibuprofen 200mg tablets, is being processed; there are several batches in our store, some of which have reached their 
expiry; although line 4 indicates there are sufficient to meet this order in the store, you will note that only 106 tablets 
are available, so we select line 6.
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Clicking on OK & Next displays the next item on the invoice, Prednisolone 5mg tablets. 

Click Redistribute all, which is the normal procedure. There is only one batch available, but there is insufficient stock to
meet the order, so mSupply® creates a placeholder line for the outstanding amount.
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When the final item has been processed, clicking on OK will display the completed invoice. 

Make sure the Hold checkbox is not checked, and at this stage the invoice may be confirmed.

Danger of failing to re-supply in time
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Obviously, regardless of the calculation 
method employed, if the supplying store fails 
to re-supply the Customer within the supply 
period (G) then the Customer will start eating 
into the buffer stock and is in danger or 
running out of stock!

Previous: Next: 

Customer Budgets
This feature enables you to manage the budgets of customers in your system. Remember, in mSupply customers are 
names to which you supply goods. To enable the feature you need to turn it on and then set preferences for its use and 
allocate budgets to your customers. When using it, you see extra fields on a customer invoice which tell you how much 
budget the customer has been allocated and the amount you have remaining. Once a customer has reached their budget 
limit a customer invoice cannot be confirmed unless it is first authorised. All the details you need are below.

Setting up the customer budgets feature

Turning the feature on: File preferences

• Go to File > Preferences…
• Select the Invoices 1 tab.
• Check the 'Per customer budgets' checkbox. Note that 'Activate budget module' must be checked first and you should have 

previously set up your budget periods (see Budgets for details).
• After clicking Per customer budgets checkbox confirm dialog box is shown with message “Turning on the customer budgets 

functionality requires that the preferences for authorising customer invoices be turned on and automatically confirming and 
finalising customer invoices be turned off. Is this OK?”

• You must click OK to activate the functionality. When you do, the “Customer invoices must be authorised” and “Authorisation 
needed only if over budget” store preferences are turned on for all stores.

• Optionally, you can divide budget periods up into smaller equal parts and apply the same fractional amount of the period budget to
each part-period. For example, if your budget period is a year you might want to split this up into quarters and allow customers to 
freely spend up to a quarter of their annual budget in this time. To activate these additional limits check the Apply part-period 
limits checkbox and type into the textbox the number of part-periods you want to split the budget periods into. To split annual 
periods into quarters you would enter 4 into the textbox:
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Note that any unused amounts of part-period 
budgets roll over to the next part-period. Full 
period budget amounts do not roll over to the 
next period.

Configuration: Store preferences

• If Per customer budgets is turned on then “Customer invoices must be authorised” checkbox and “Authorisation needed only if 
over budget” are turned on. This is done automatically for you when you turn the feature on (as mentioned above). You can, 
however, uncheck these checkboxes for individual stores to have the feature work in different ways:
1. “Customer invoices must be authorised” and “Authorisation needed only if over budget” both checked - customer invoices 

can be confirmed freely until the budget limit is reached. After that, customer invoices must be authorised before they can be 
confirmed.

2. “Customer invoices must be authorised” and “Authorisation needed only if over budget” both unchecked - mSupply will 
display the budget information on the customer invoice but it will not enforce the budget.

3. “Customer invoices must be authorised” checked, “Authorisation needed only if over budget” unchecked - all customer 
invoices must be authorised, regardless of whether the customer has exceeded their budget.

Add budget periods

• These are the system-wide budget periods that mSupply uses for its budget functionality. Customer budgets are assigned to these 
budget periods so you must set them up before you can start setting up individual customer budgets. 

• From the Navigator click the drop down menu Special > Show budgets…. You click on the New button to create a new budget 
period but for the full details please see Budgets.

Setup: Set individual customers' budgets

• Note that if you want to set up many or all customers' budgets at one time you can use the import feature, details of which are here
• To set up the budget for each customer, go to Customer > Show customers…, click on the Find button, and double click on the 

first customer to show their details
• Click on the Budget tab
• Add budget: Click on this button to add a budget. This opens the edit budget window shown below.
• Delete budget: Select a budget in the list and click on this button to remove the budget for the customer.
• Edit a budget by double clicking on a budget in the list. This will also open the edit budget window (shown below) pre-populated

with the budget's current settings, all of which are editable.
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Customer budget edit window

• Description: The description for the budget. This is for your reference, only displayed in the budget tab of the customer details 
window.

• Budget period: The period that the budget applies to. This list contains only the budget periods previously set up using Budgets.
• Amount: The amount of the budget in your local currency
• Additional budget: If checked this tells mSupply that the budget amount is to be considered as an additional amount available 

only from the part-period in which its effective date falls. For example, if you have a budget of 100,000 which runs from 1st 
January to 31st December in a given year and is split into 4 part periods and you then have an additional budget amount of 10,000 
with an effective date of 30th July, the following budget limits will apply: for the 1st quarter the customer has 25,000 available, 
the 2nd quarter 50,000 available (25,000 + 25,000 because part period amounts roll over), the 3rd quarter 85,000 available 
(25,000 + 25,000 + 25,000 + 10,000) and the 4th quarter 110,000 available (25,000 + 25,000 + 25,000 + 10,000 + 25,000).

• Effective date: This field is only visible if the Additional budget checkbox is checked. The date that the budget amount is to be 
effective from: mSupply applies the additional budget amount to the part period in which this date falls. Note that if part periods 
are not in use then additional amounts simply add to the total budget available for the whole budget period.

Using the customer budgets feature

The customer invoice window
This is where you see the customer budgets feature doing its job; when you're distributing goods to a customer:

• Create a new customer invoice (Customer > New invoice…) 
• Enter the customer name
• Select the budget period that this invoice belongs to from the Period drop down list (this list contains the periods you set up using 

Budgets).
• If you haven't set up a budget for the customer you are warned with this message: “There is no budget set for this customer in that 

period. You will not be able to confirm the invoice until the budget has been set.”.
• If you've followed the instructions above and setup the customer's budget correctly then the Total budget used and total budget 
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fields are populated to show you exactly how much of their budget the customer has used so far.
• Add items to the invoice as required.
• Everything will behave exactly as it has done before until the customer's budget amount has been exceeded.
• When the customer's budget has been exceeded (this can be the full period amount or the part-period amount if the part-period 

limits are turned on) and the confirm button is clicked you will be alerted with the message “This invoice exceeds the budget set 
for this customer. You cannot confirm it without authorisation (Note: you cannot confirm the invoice at the same time as 
authorising it, you must save the authorisation first by clicking the OK button, then re-open the invoice and confirm it)”.

• The invoice must now be authorised by a user with suitable permissions before it can be confirmed: See Invoice Authorisation for 
details on authorising customer invoices.

Reporting on Customer Budgets
There are several reports that provide various information on customer budgets, they are:

• Disbursement Report - shows items with their values which have been distributed to customers during a budget period.
• Expenditure report - shows spending against budgets with remaining available budget.
• Trend Report - shows, in graph format, spend against budgeted amount.

Disbursement Report

• From the Navigator click drop down menu Reports and click option Customer Budgets. 
• Choose budget_balances from the print options window which appears: 
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1. Budget period: select the period you want to report on.

Expenditure report

• From the Navigator click drop down menu Reports and click option Customer Budgets. 

• Choose budget_district_expenditure (or budget_facility_expenditure) from the print options window which appears: 

1. If District: Select “All” to see expenditure for all districts, or select a district to see expenditure for the facilities in that district
2. If Facility: Select the facility to see expenditure for that facility, and select the reporting interval
3. Select the date range you want to report on.

Trend Report

• From the Navigator click drop down menu Reports and click option Customer Budgets. 
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• Choose budget_trend_district (or budget_trend_facility) from the print options window which appears: 

1. District/Facility: Select “All” to see a graph for all, or select a district/facility to see a graph for just the selected district/facility 
2. Interval: Choose the intervals you want for the horizontal axis, eg. quarterly, yearly, etc.
3. Select the date range you want to report on.

Note that this is a cumulative report, so the graphs generated need to include the entire budget period. This means that 
the date range is only used to determine which budget periods intersect with the selected dates e.g. if the date range 
covers more than one budget period, a graph will be generated for each one.

Previous: Next: Payments to Suppliers

Payments to Suppliers
Updated: version 3.1

Entering payments
This functionality is used to record payments that you have made to suppliers for goods received from them. To be able 
to record payments you need to activate the payment module in the preferences (Invoices 1 tab, 'Activate supplier 
payment module' check box) first.

Some important points:

• When the payments module is activated, each supplier invoice will have its amount outstanding recorded (the amount left to pay 
to the supplier). Any invoices finalised before the module is activated have their outstanding amount set to zero, so will not show 
for payment.

• Only finalised supplier invoices can have payments entered for them. Use the File > Finalize supplier invoices command to 
finalise all invoices or view invoices (Suppliers > Show supplier invoices) and finalise them individually once all the details are 
correct.

• You cannot pay a supplier more than the total outstanding (as if you'd want to!). This is different to a , where you can accept an 
overpayment from a customer.

To enter a new cash payment, go to Supplier > New Cash Payment to be shown the new cash payment window:
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Entry steps

25. Enter the supplier name or code in the Name field. Once you have chosen the supplier, a list of finalised supplier invoices that 
still have an amount outstanding will be displayed.
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26. Enter a comment about the payment in the Note box. If you leave this blank mSupply® will automatically create a note 
containing a list of the invoices the payment is paying off.

27. Select the currency you want to pay in. You can only enter payments in one currency at a time so all those invoices that are in a 
different currency to what you have selected will be greyed out in the list and you will not be able to enter a payment amount 
against them.

28. The rate stored in mSupply for the particular currency you have selected is displayed in the Rate box. If you wish to use a 
different rate (e.g. the rate you know the bank will use ) you can change the rate to match it (and the calculated payment amounts 
will be updated automatically). Note that the rate is set to 1 and is unchangeable if you have selected your local currency.

29. Enter the total amount you wish to pay in the Payment box and click the Distribute button. This will distribute as much of your 
payment as it can among all the outstanding invoices in the currency you selected, in the order they appear in the list. If there is 
any left over it will be shown in the To allocate box.

30. Alternatively, you can shift-double-click each non-greyed out invoice to pay the full amount of that invoice. (Note that shift-
double-clicking toggles between allocating nothing and full payment against an invoice). A quick way to find out the total 
outstanding amount for a supplier in the selected currency is to shift double click all the non-greyed out invoices. The total will 
then be displayed in the Allocated amount.

31. To partially pay an invoice you can double-click it's line and enter the amount you wish to pay.
32. If there are any local charges that need to be added onto the payment, they can be entered after you have allocated the full amount

entered in the Payment box to invoices.
33. As well as adding in local charges you can edit the total amount of the payment in local currency if needs be so that the actual 

payment amount matches your bank records (such a situation might arise if your bank uses a different currency conversion rate to
that stored in mSupply® but you don't know what it is).

34. Once you are happy with the details, click the OK or OK & Next button. If you want to print the information, make sure the 
print checkbox is checked.

35. Note that the OK and OK & Next buttons will remain disabled until the Payment amount is non-zero and the To allocate amount
is zero (i.e. a payment amount has been entered and has all been allocated to invoices).

Viewing cash payments already made
Go to Suppliers > Show cash payments… You will be presented with the standard transaction find window which 
allows you to filter the cash payments you see:

When you click on the Find button will be taken to the usual transaction viewing window with the cash payments you 
selected displayed:
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Note that the “Activate customer receipts 
module” checkbox on the Invoices 2 tab of 
the Preferences must be checked before you 
can use the Customer Receipts module. Once 
this option is checked, new invoices will 
have the outstanding amount recorded. If this 
option is not checked, the outstanding 
amount of invoices is set to zero.

To view an individual payment simply double click on its line in the list and you will be shown a read-only view of the 
cash payments form containing all the details of the payment you made and the invoices it was paying.

Previous: Customer Budgets Next: 

Receiving payment from Customers

A payment from a customer is referred to as a Cash Receipt (whether the payment is by cash, cheque or transfer)

The system mSupply uses to record payments is the accounting standard “open invoice” system, which means that the 
outstanding (that is, unpaid) amount of each invoice is tracked by mSupply®.

Payments from customers can be received in any currency that customer invoices have been issued in. But a single 
payment transaction can only record payment in one currency - if you need to record multiple currency payments from a
particular customer then record a separate payment for each.
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To begin the process of recording a received payment choose Customer > New cash receipt… and you will be presented
with this window:

1. Enter the customer name or code into the first field and press Tab. You will be shown a list if there is more than one matching 
entry for what you have typed.

2. Once a customer is chosen all (customer) invoices that have unpaid amounts for that customer will be listed.

• Note: only finalised invoices are shown. If there are no finalised invoices with outstanding amounts, this alert appears: 

4. Select the currency of the payment you are receiving (your home currency will be chosen by default). Any invoices that are in 
currencies different to the one selected are disabled and cannot have a payment entered against them. If you are receiving a 
payment in a currency other than your home currency you can manually adjust the conversion rate that mSupply uses by entering 
the rate you want to use in the Rate field.

5. Enter the total amount of the payment you are receiving into the Receipt field.

6. You have a number of choices to allocate payment amounts to the various invoices:
• Click on the Distribute button. This will allocate payment to the top invoice first and work its way down the other invoices 

until the payment is all allocated (note that disabled invoices in a different currency are ignored). If the payment is not enough 
to cover all invoices then one will receive a partial payment and some may receive no payment.
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• Double-click an invoice in the list to be shown a box to enter the payment amount, or
• Hold down the shift key while double-clicking an invoice to allocate the full outstanding amount of that invoice.

7. Click the OK button to record and finalise the payment (you will be warned that the payment cannot be edited).

Note: If you receive more than the total amount of the invoices you will be asked to confirm that this is OK and the 
extra received amount will be recorded as an overpayment - see below.

Note: customer credits should be entered as a negative Receipt amount. It is generally good practice to allocate credits 
as soon as they show in the list.

Overpayments

• Sometimes a customer might pay you more than the amount owing (not so likely, but it does happen to some nice organisations!), 
or the customer might pay you for an invoice that is not yet finalised. If this happens, allocate any amount that relates to invoices 
in the list. When you click OK you will be warned there is an overpayment and you will be asked if you want to continue.

• Click OK if you want to continue, or Cancel if you want to allocate the extra amount to invoices.
• The next time you enter a payment for that customer you will be presented with a window asking you if you want to use the 

overpayment for this transaction:

• Click Use if you want to use the overpayment, or Don't use if you want to enter another payment (Some customers just keep 
sending in the money…)
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Previous: Next: Importing Items

Importing Items
You can import a tab-delimited text file of items by choosing File > Import.

Please note that this command only imports items and not the stock. If you would like to import both, see the next 
heading: .
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When you choose the command you are first shown an open/save window where you can choose the text file to import. 
Once you have chosen the file this window is displayed

First line contains column headers: If you have used the first line of your import file for column headers, check this 
box. Then mSupply will ignore the first row in the file, and start import from the second row.

Remove quote characters on import: Note that if you do not check this box , mSupply will strip out quotation 
characters as MS Excel inserts quotes around fields when it shouldn't. If you have put the quotes character into a field as
an abbreviation for an “inch” it will be removed.. (Consider using the metric system! )

Finalising Duplicate items in mSupply: mSupply can allow you to import items into a data file that already contains 
item, depending on which radio button you have chosen for the duplicate codes section.

Create new duplicate and continue: Even if the code is a duplicate a new item will be created. Note that you can not 
use this option unles the preference “Allow duplicate item code” is selected in the mSupply Preferences
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Ask each time mSupply will warn you if it detects an item with the same code as an existing item. Having two or more 
items with the same code will not affect how mSupply works

Field order for the text file:

Column number Column letter Field Description 

1 A item code 18 alphanumeric characters 
(must be a unique value) 

2 B item name 80 alphanumeric characters 

3 C units 3 alphanumeric characters 
recommended (ea, ml or 
mg). Entries in the units list 
will be created
 if you import a unit that 
does not already exist in the 
data file.
60 characters supported 

4 D reference pack size integer 

The above fields are mandatory, while the following fields are optional and may or may not be included
 as per your requirements 

5 E shelf location 60 alphanumeric characters 

6 F user field 1 30 alphanumeric characters 

7 G user field 2 30 alphanumeric characters 

8 H user field 3 30 alphanumeric characters 

9 I user field 4 “ “true” or “false” 

10 J edl “true” or “false” 

11 K ATC category 30 alphanumeric characters 

12 L ddd value 8 alphanumeric characters- 
the ddd and its units 

13 M ddd factor number greater than zero 
(default=1) 

14 N item description The long description for the 
item. Do not include carriage
returns
 (new lines made with the 
return or enter key) in your 
text file. 

15 O item department The name of the department 
that the item belongs to.
 If the department does not 
exist, mSupply will create it. 

16 P account code for stock The account code used for 
stock purchases .
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 Note that these accounts 
will be created if they don't 
exist. 

17 Q account code for cost of 
goods sold 

18 R income account code 

19 S Price 

20 T Category The item category is actually
stored in a separate table. As 
each item category is 
imported
 a new record is created in 
the “item_category” table if 
one does not already exist.
 We strongly recommend 
you use the WHO EDL 
categories for this field 

21 U Weight 

22 V Critical stock “true” or “false” 

23 W Normal stock “true” or “false” 

24 X User field 5 number 

25 Y User field 6 “true” or “false” 

26 Z User field 7 “true” or “false” 
The chances are that you already have a set of codes that you use internally. In this case open up Excel or a similar 
spreadsheet program, fill in the item description in the order shown above. For a quick solution, you only need to take 
account of the first four column, the rest can be ignored.

The third column representing “Units”, can be left blank, however, it is better to fill this in. The fourth column 
“reference pack size” can be set to “1” for all rows unless you know what pack size you want to use as the “standard” 
(Don't worry about this. The reference pack is used for comparing quotations. You can receive and issue any pack size 
you like).

Save a spreadsheet file as shown above as a tab-delimited text file.

Open up mSupply with a new data file and chose the import command. Direct the open/save dialog box to the text file 
and click “OK” to import the file.

You will be asked if you want to remove quotation mark characters. If you have created the file in Microsoft Excel, it 
adds quotation marks around fields that have a comma in them (even though it shouldn't). If this is an issue, choose the 
option to remove the quotation marks.

Previous: Receiving payment from Customers Next: 
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Importing items & stock

Importing items

On the File menu, choosing Import items… only imports item codes and descriptions, which still leaves you with the 
task of entering quantities for all items (usually by entering an inventory adjustment).

Importing items and stock

The Import items and stock command lets you import item codes, names and the initial stock of that item.

You can now import items and stock into an existing data file; however, this is a somewhat risky procedure, and we do 
not recommend it. If mSupply detects an item in the import with the same code as an existing item, the stock will be 
added to the existing item.

You have been warned!

Make a backup before proceeding with this command.

More than one batch of an item

It is possible to enter in various batches of an item separately. For example, if your import file contains two batches of 
“ace250t” on separate rows. mSupply will first fill in the item description and code and then enter in the stock for the 
first batch the item. For the next line of data, mSupply carries out a search for the code, and adds another batch as the 
same item already exists, and then updates the total quantity.

It is not necessary to group the same batches together, but making sure that various batches of the same item have the 
same identical code is important, otherwise extra items will be created. The actual full name of the product is taken 
from the first batch the program encounters; subsequent batches that have the same code as an item that already exists 
in the data file will use the item name of the exisiting item. (You can even leave the item name blank for subsequent 
lines if you want to).
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Note on pack sizes

The “pack size” and “quantity” field should be entered taking into account the way you will issue stock (For example, 
say you are importing Amoxycillin stock of 3000 capsules that are in boxes of 100. If you are going to issue stock of 
Amoxycillin individually (28 to this patient, 21 to another patient), then enter a pack size of “1” and a quantity of 
“3000”. If you will only issue whole boxes, use a pack size of “100” and a quantity of “30”. If you enter a pack size and
quantity that does not fit, you will still have the option of repacking the items (using the “repack” function from the 
“item” menu) to meet your supply needs.

Duplicate options

You will notice several options for what to do when a duplicate is found. Most are self-evident. The last two options are 
important to understand:

• Update item details and add stock: If this option is chosen, you will effectively add all stock in the import file on to the stock 
already recorded in mSupply, and also update the item details with any changes recorded in the import file.

• Update stock only: If this option is chosen, you will effectively add all stock in the import file on to the stock already recorded in
mSupply, but not change any item details.

Field order for import file

Column Field Note 

1 (A) Item code Up to 18 characters 

2 (B) Item name Up to 80 characters 

3 (C) Units 60 characters (ea, ml or mg) 
recommended, but supports up to 60 
characters 

4 (D) Pack size Integer 

5 (E) Quantity The number of packs (not the total 
quantity.
 Although if the pack size is “1” then 
this will be the same as the total 
quantity). 

6 (F) Cost price The price you pay for one pack 

7 (G) Sell price The selling price of one pack (Set to 
the same as the cost price if you do not
sell stock you issue) 

8 (H) Batch Up to 20 characters 

9 (I) Expiry In short format (dd/mm/yy or 
mm/dd/yy depending on the format set 
in your computer's operating system) 

10 (J) Description Full description of the item. Up to 
32,000 characters (Be careful not to 
have any carriage return characters in 
the text though, or 
the import file will not be valid) 

11 (K) Item Department Text, up to 30 characters. If you import
a department name that doesn't exist, 
the department will be created 

12 (L) Shelf Location Up to 60 characters. The code for the 
shelf location of the batch being 
imported. Note that this does not set 
the default location for the 
item- only the location of the particular
batch. 

In order to create a text file for importing purposes, first you need to enter your stock details into a spreadsheet (e.g. 
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Microsoft Excel). The first row should be taken up by column descriptions or left blank as the import function will 
ignore this row.

You can omit the batch number and expiry date columns as in the example below.
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Make sure every line has an item code 
assigned: any lines without an item code will 
be skipped when importing.

Patients can only be imported in Dispensary 
mode 

Once you have completed the spreadsheet list, save the file as a tab-delimited text file. Open up mSupply with a newly 
created data file and choose File > Import items & stock . A window will appear allowing the import file to be located. 
Choose the text file that you have created and click “OK”. If the file has been successfully imported, an “All done” 
message will appear.

Previous: Next: 

Importing Customers, Suppliers, Manufacturers, Patients

Introduction

The File > Import > Import customers & suppliers… menu item allows you to import customers and suppliers into 
an mSupply data file. If you are working in Dispensary mode, this is where you can import patients.

Setting up the import file
A Tab-delimited file (see notes below) must be set up to import the data. The required field order is:

Column Field 

A Code 

B Name 

C Type 

D Address1 

E Address2 

F Country 

G Email 

H Phone 

I Category1 

J Customer group. If the group name does not exist, it will 
be created by mSupply on the fly. 

K Last name (make sure this field is blank if you are 
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The customer or supplier category1, 2 and 3 
fields will be created if they don't already 
exist. If the name is a customer and a 
supplier, a customer category will be created.
You must always include every column in 
every import file but, apart from the first 3 
columns (which are mandatory), you can 
leave columns blank and mSupply will only 
import the information you have provided.
When you import the file you can choose 
whether or not to ignore the first line (you 
will want to if you have used the first row for 
column headings), and whether or not you 
wish to strip out line feeds and quote 
characters (which you'll want to do if you've 
used Excel to save the text file.

importing a supplier or if you are importing a customer 
who is not a person (that is, an organisation)

L First name (applies only to people) 

M Date of birth (please use 4-digit year) 

N Gender (enter “F” or “True” for females. All other values 
taken as male) 

O Custom 1 

P Custom 2 

Q Custom 3 

R Category 2 

S Category 3 
Column C describes whether the name being imported is a customer, supplier, manufacturer, or donor:

Value Meaning 

C Customer or Patient 

S Supplier 

M Manufacturer 

D Donor 

(blank) Both a customer and a supplier 
You might find this template useful: name_import_template.xls or this export settings file: names_export_order.4si.zip
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Save the template as tab-delimited text (rows 
end with a carriage return and columns are 
separated with a tab character) before 
importing into mSupply.
MS Excel tends to add extra characters (line 
feeds and quotes), but mSupply will 
gracefully remove these without 
complaining!
Avoid having the Code field containing a 
space character as this can cause problems 
during import

Importing the file
When you choose File > Import > Import customers & suppliers… you'll be shown an open/save window where you
choose the file to import.

Once you've done that, you'll be shown this window:
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Importing patients
If you are importing patient names, leave column B (the full name) blank. Make entries in the Last name (col K) and 
First name (col L) columns, and mSupply will automatically generate the name field for you. Below is an example of a 
spreadsheet for importing patients, customers and suppliers which demonstrates how to fill in the fields with respect to 
each import type.
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Applicable in Dispensary mode only

If you have a lot of patients there will be a short delay once you have chosen the import file while mSupply counts how 
many records there are to import, then a progress window will be shown displaying the rate of progress.

Previous: Next: 

Importing prescribers

From the File menu, choose Import Prescribers, and the Import alert window is displayed.
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You may import a list of prescribers who have the authority to prescribe medicines.

Your list should be in the format of a 6-column spreadsheet, saved as a tab delimited file. The columns should be in the 
following order:

<div align="center">

Column 1 Unique code for each prescriber 

Column 2 Last name 

Column 3 First name 

Column 4 Initials - these will appear on patient labels 

Column 5 Registration code 

Column 6 Category 

</div>

Your tab delimited spreadsheet file would appear something like this:

Choose import options from the preview window and click OK to begin import.
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Previous: Next: 

Importing abbreviations
This feature allows patient instruction abbreviations to be loaded into mSupply so that they can be used in Dispensary 
mode. It is accessed from the File menu by choosing Import abbreviations.

You may import the list of abbreviations used for patients' directions - e.g. the abbreviation tid would appear on the 
label as three times daily .

Your list should be in the format of a 2-column spreadsheet, saved as a tab delimited file. The first column should 
contain the abbreviation, and the second column should contain the expanded text as it should appear on the label.

Your tab delimited file would appear something like this:

Previous: Next: Printing Preferences
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Importing a supplier invoice
From the Supplier menu, the Import invoice comand allows you to import an invoice generated by one of your suppliers
who also uses mSupply. You will be presented with an open/save window where you should locate the invoice file to be 
imported.

Note the following points about importing invoices:

The invoice must have been generated by the “export invoice” command in another copy of mSupply. The item codes in
your copy of mSupply must have your supplier codes entered (see below). If mSupply attempts to import a code that it 
does not know, the import process will stop. Once an invoice has been imported, you are still free to edit it. You should 
check the invoice against a paper copy when it arrives. After import the file is edited so that if you attempt to import an 
invoice again you will not be able to. This prevents accidental double-importing of the same invoice.

Entering Supplier Codes If you are importing invoices from a supplier, you must perform the following steps:

enter a quotation for each item you receive from the supplier. This is done from the quotes tab of the item details 
window, or from the quotes tab of the supplier details window. enter the supplier code for the item in the supplier code 
field of the quotation. There is no need to enter other details for the quotation if you do not want to.

Previous: Next: 

Importing customer budgets
You can set up budgets for customers manually if you wish (see here) but if you have to set budgets for many customers
at a time then this feature will save you a lot of time. As with the other import features of mSupply, this import uses a 
tab delimited text file (easily produced by exporting a spreadsheet from Excel or other spreadsheet programme). The 
columns that must be present in the file and their contents are as follows:

Column number Column letter Field Description 

1 A budget description The description for the 
budget, as it will appear in 
the list of budgets for a 
customer. 

2 B customer code The customer's code as 
entered in mSupply. If this 
code does not match a 
customer in mSupply an 
error will be generated. 

3 C customer name For your reference only. This
column is ignored during the
import and can be left empty,
but it must be present. 

4 D budget period start date The start date for the period 
to which the budget belongs 
in the format dd/mm/yyyy or
mm/dd/yyyy (whichever 
your copy of mSupply is 
using). 

5 E budget period end date The end date for the period 
to which the budget belongs 
in the format dd/mm/yyyy or
mm/dd/yyyy (whichever 
your copy of mSupply is 
using). The budget period 
start and end dates must 
match an existing budget 
period period in mSupply 
(set up using Budgets), 
otherwise an error will be 
generated. 

6 F budget amount The amount of the budget. 
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Must be a positive number 
with or without a decimal 
point. 

7 G additional budget Whether the budget amount 
is to be considered an 
additional budget. A “T” or 
“Y” is interpreted as true, 
anything else is interpreted 
as false. 

8 H effective budget date The effective date for an 
additional budget in the 
format dd/mm/yyyy or 
mm/dd/yyyy (whichever 
your copy of mSupply is 
using). Ignored if the budget 
is not additional. If this field 
is left blank and the budget 
is additional then the current 
date is used. 

When you have created the import text file go to File > Import > Import customer budgets and select your text file. 
You will be show the following window:

Now choose the import settings to match your file:

• First line contains column headers: check this if the first row in your text file contains the column descriptions. If checked, 
mSupply will ignore the first line of the file.

• Remove quote characters on import: check this if fields in your file is surrounded by quote (“ or ') characters. If checked, 
mSupply will attempt to remove them from each field.

471



And select how duplicates are to be handled (a duplicate is a row which matches another line in the file or a budget 
already in mSupply):

• Skip the duplicate without asking: The duplicate record is ignored completely
• Stop the import: mSupply will stop importing form the file if it detects a duplicate. Any budgets already imported will be kept 

but no further lines in the file will be processed.
• Update customer budget: The budget already in mSupply will be updated with the new details found in the file and the import 

will continue.

You can also click the Next and Previous buttons to see a preview of what mSupply will import on each row from your 
file. This can be useful for showing differences in the contents of your file and what mSupply is expecting.

When you're ready to carry out the import, click on the OK button. mSupply will carry out the import and tell you how 
many lines were imported, how many budgets already in mSupply were modified and if there were any errors. You can 
see more details by viewing the log (see The log).

Previous: Next: 

Exporting invoices
From the Customer menu the Export invoices command exports any customer invoice to a file. The file created is in a 
special format that can be imported into another copy of mSupply using the Supplier>Import invoice… menu command.
Do not use this command for sending invoices to customers for them to view or print - use a PDF file for that purpose.

When using this command you will be asked to enter an invoice number. The default choice is the last invoice created. 
The invoice will exported to the export folder you have set in the Preferences, and will be labeled with the invoice 
number.

Before you can export, you must set your “own code” in the Preferences. This is the supplier code that your customers 
will use to identify you when importing the invoice.

Once the invoice is exported, you will be told where to find the file on your hard disk.

Previous: Next: 

Exporting items and stock

Exporting items

Choosing Export items from the File menu allows you to export all of the stock items in your data file to a text file; see 
where the format of the text file is described under 'Field order for the text file'. This allows you to import them to 
another data file. When you select this option you will see this dialog box:

Click continue to carry on. The standard file dialog window for your operating system will appear, allowing you to 
select a file name and location to save the text file.

Exporting items and stock
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This option, like the previous one, allows you to export all of the stock items in your data file together with the stock on
hand; all details are exported, including batch numbers and expiry dates. The output is a text file, in a format 
recognisable by mSupply so that you can later import it to another data file.

Previous: Next: 

Exporting names
Choosing Export names from the File menu exports all the names (suppliers, patients and customers etc) in your data 
file in exactly the same way as for Export items… above. For the required field order, 

Previous: Next: 

Exporting to MYOB
Added: version 3.05

Setting up MYOB/mSupply

• set up mSupply to use the same account codes as MYOB (See Item units and item accounts). If necessary, the accounts associated 
with any item can be edited via the Misc tab after selecting an item (See Item basics)

• set up MYOB to use the same suppliers and customers as mSupply (See Names: Using, adding and editing) - the suppliers and 
customers in mSupply need to be added to the Card List in MYOB, where the Charge to field in mSupply corresponds to the 
Card ID field in MYOB.

Exporting from mSupply
This can be done from two places:

• from Files>Export invoices for MYOB
• You can choose a range of dates, either from the drop-down list (e.g. last year) or by typing the date values directly
• You can choose either supplier or customer invoices
• If the show all item lines box is checked, then you will get a line for each item line in the transaction, otherwise you will just 

get a line for each different account code used in the transaction
• If transaction categories have been setup, you can also select only transactions from a single category, or where the category 

name matches
• Clicking OK will prompt you to create a tab-delimited text file in the folder of your choice.

• from the transaction list: See Viewing invoices
• Select the transactions you wish to export, and click the Export to MYOB button. This will create a text file in the same way as 

before.

Importing to MYOB

• Select File>Import Data>Purchases>Service Purchases for supplier invoices (or File>Import Data>Sales>Service Sales for 
customer invoices)

• In the Import File window, make sure that the settings are Tab-delimited, Data Record, Reject Them, and Card ID respectively
• Select Continue and browse to your exported file
• Double-click on the text file, and select the Match All button, and then Import
• MYOB will then attempt to import the records. If it reports that no records have been skipped, then all is well, otherwise you need

to view the MYOBPLOG.txt file (which will be in the same folder as the .MYO accounts file that you are logged into).

Understanding the MYOBPLOG.txt file
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• MYOB inserts an error (negative number) or warning code (positive number) at the start of each line, and adds an explanation of 
the codes at the bottom of the file

• You can most likely ignore warning messages
• The most likely errors will be because the supplier/customer code doesn't exist in MYOB, or there is a duplicate invoice number 

(i.e. the record has already been imported)
• If the error is because of a missing supplier/customer, then you can see the mSupply code at the end of each record line
• Search for that name code in mSupply and create the corresponding Card record in MYOB
• Then you can try to re-import the same file (and this time, it will reject all of the records that it managed to import first-time 

around).

Notes

• mSupply will only export finalised customer or supplier invoices, and it will ignore stock transfers and inventory adjustments → 
sometimes it may not export as many records as you might think.

• mSupply doesn't export the customer/supplier name, otherwise MYOB will reject the invoice even if the customer/supplier code 
matches.

• mSupply will attempt to export as much reference information as possible into the Journal Memo field in MYOB - this will 
include the Tender reference, Purchase order reference, and the Invoice reference.

• mSupply will include the quantity of each invoice line inside brackets, appended to the item name e.g. 'Amoxycillin (200)'
• MYOB doesn't have a field for unit price, but you can work out the unit price by dividing the total price by the quantity.

• MYOB expects every line to have a unique invoice number → the item line number has been appended to the invoice number 
when exporting i.e. each line will have an invoice number like 812-1, 812-2 etc.
• The invoice number shown in MYOB will reflect the total number of lines in the invoice
• The same applies to purchase order numbers
• If a blank purchase order number is exported from mSupply, then MYOB assigns the next one in it's internal sequence.

• MYOB will not allow you to import invoices with dates outside of the current financial year → make sure that you export 
everything you need to from mSupply before the new year starts.

• The export format that mSupply uses is based on the current version of MYOB (version 12). If MYOB is upgraded, there is a 
good chance that the format will change → importing to MYOB will no longer work until mSupply is updated to output the new 
format.

Previous: Next: 

Exporting records
Choosing Export on the File menu will display the export window, allowing you to export records from mSupply to a 
file.
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You can search for a set of records by checking the New search check box, which displays the Query editor for you to 
specify your search criteria, or else use the currently selected records. 

If you tick the Open in Excel button mSupply will export any output to your spreadsheet application and will allow you 
to edit the Headings etc within your spreadshhet. Otherwise mSupply will open a basic editor that will allow you to 
shape the look of the document.

After you click OK the Query Editor will open allowing you to filter the data you would like to export. Clicking on a 
field on the left will add it to the filter criteria shown at the top. You then can add from the list of Comparisons and enter
your own value in the text field below. To add another line of criteria click the Insert Line button. Likewise to remove a 
line highlight the line and click the Del Line button.

Once you have chosen your filtering criteria and if you did not click Open in Excel the the Export Editor will open. 
This is where you can choose what fields to export.

You can add a field by highlighting it in the Fields box and clicking on the down arrow below it or you can remove a 
field by highlighting it in the preview window at the bottom of the page and clicking the up arrow. If you want to add or
remove all fields click the double arrows.
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If you want the fields to be ordered ready for item import, unzip the attached .4si file.

export_items_order.4si.zip

Previous: Next: Dispensary Mode

Dispensary Mode
Dispensary mode allows you to use mSupply to issue medicines to patients. It is ideally suited for pharmacies, clinics, 
hospital dispensaries and facilities where medicines are supplied to individual patients.

The particular benefits of using Disensary mode include:

• Prescription data can be entered into mSupply including
• Patient details
• Prescriber details
• Prescribed items
• Item directions which can be quickly selected from standard abbreviations, and edited as necessary. Item directions do not 

need to be printed in English.

• Labels can be printed with
• Item description and quantity issued
• Patient name
• Prescriber name
• Directions
• Institution name
• More…
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Use of Dispensary mode depends on your 
mSupply registration type. Contact 
Sustainable Solutions if you wish to upgrade 
your registration.
Regardless of mode, each user can only use 
those functions for which they have 
permission, according to the permissions set 
for that user. See Managing Users
In client-server versions of mSupply, 
different users can be logged in in different 
modes at the same time, allowing you to 
dispense to patients and supply wards, stores, 
clients or cost centres simultaneously.
Users whose permissions allow them to 
operate in either Store mode or Dispensary 
mode may change from one to the other by 
pressing Ctrl+2 on the keyboard. Re-entry of 
the user's password is not necessary.

• Patient Histories are recorded, allowing repeat prescriptions to be:
• Duplicated
• Repeated

Activating Dispensary Mode
When you create a new data file, dispensary mode is on by default.

To turn dispensary mode off:

• Choose File > Edit users…
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If one mode or the other is dimmed out, it is 
because your mSupply registration does not 
allow you to use those modes. Contact 
Sustainable Solutions if you wish to upgrade 
your registration.

• Double-click on a user in the list
• Go to the Log-on modes tab.
• Uncheck the boxes for the modes you want to be inaccessible for that user
• Repeat for other users in the list as appropriate
• Once you have deactivated a mode for a user, it will not appear in their choices when they log on.

• Choose File > Preferences > Invoices 2 then check the Show direction entry in dispensary mode box.
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What is a "name"?

In mSupply a “name” can be a customer, a supplier, both or neither. A “customer” can be anyone you supply goods to - 
e.g. another organisation, or a ward in your hospital, or a patient.

What changes in Dispensary mode?

Different menus

The menus in dispensary mode have different names. For example, the Customer menu becomes the Patient menu.
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In simple dispensary mode, there are a lot less choices in the menus. There should be enough options to allow a user to 
dispense medicines, but not to do much else.

Different windows

The windows displayed are appropriate for dispensing medicines to individual patients; in addition to the ability to 
record individual patient's notes (e.g. allergies), prescribers details are maintained. A patient history is maintained and 
other features specifically related to dispensing activities are maintained. 

Prescription entry
In dispensary mode, supply of items is made against a patient's prescription rather than an invoice as in store mode. 
Click on New prescription to display the prescription entry window: 

Note 

• Reference will be made to the numbers shown as the various features are described in the text that follows.
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If the new patient's date of birth is known, it 
should be entered, otherwise an entry should 
be made in the Age field; for a patient aged 
18 months, valid entries in the Age field may 
be in one of 3 formats, namely 18m, 1.5, or 
18/12.

Entering a new patient
To enter a new patient:

• In the Prescription Entry window, click the New Patient icon to the left of the name entry area, annotated 1 in the screenshot 
above. This window will be shown (Shortcut: Ctl-Shift-P). All entry fields are blank, except for the Code field where the entry 
shown is the next number in the table of unique numbers applied to each individual patient.

• All applicable fields should be completed.

• When a patient's code is known, that patient's record may be rapidly displayed. Note also that the Male radio button is checked; if 
you are entering details of a female patient, remember to check the Female radio button!.

Custom fields are available for storing information such as insurance details etc.
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When you are entering a patient name, 
mSupply will treat anything entered before a 
comma as a last name, and anything entered 
after a comma as a first name.

How to look up a patient on file

• For example, to find John Smith, enter “Smi,J” or “smith,joh”

• If the patient's name code is known, enter a “*” (no quotes) and then the name code or part of it. eg “*58298”

• If there is more than one matching name, you are shown the name choices window

Editing patient details
Once you have chosen a patient, you can click the small down-arrow to the right of the patient name, annotated 2 in the 
screenshot above, to display a window where the patient details can be edited.
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Entering the prescriber
To enter a presciber, you can type either their code, their last or first name in full or abbreviated, or “last comma first”. 
For example for the presciber Dr Felix Brown (whose code is 123) any of the following are acceptable:

• 123
• bro
• fel
• bro,fe

Press the tab key after making the entry to show a list of matching prescribers. If only one presciber matches, the name 
will be entered directly without the list being shown.

Note that there is a setting on the Dispensing page of the mSupply Preferences that affects whether or not you can 
accept and print a prescription without entering a prescriber.

Notes display
Any notes you enter in the notes tab will display each time you enter the patient name in the Prescription entry window.
These notes can be used to remind you of patient Preferences for certain dosage forms, or drug sensitivities.

Before you add an event for a patient, you need to make sure that patient events have been set up.

Patient Events
This is the term mSupply uses to denote any item of information relating to a particular patient; for example, you may 
want to record the patient's weight, the patient's blood pressure, any allergies from which the patient suffers, vaccination
records, etc. - a wide range of information relating to a particular patient may be recorded here.

First, some definitions of patient events need to be made;choose Patient > Show Patient events , then click the “New” 
button.

=
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One patient event is already defined, the code is `NT', the description is `Note', and the type is Text ; you can also have 
events of type Numeric or Boolean . For example, to create a patient event recording a patient's weight, the completed 
Add patient event window would look like this:

A further example, this time using the Boolean type - i.e. where the options are limited to two, `Yes' or `No' - could be 
to identify patients who have insurance cover to meet the cost of their prescriptions; for this event, the Add patient event
window, once completed, would appear like this:

Once a number of patient events have been defined, choosing Patient > Show Patient events, will produce a window 
like this:
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Now it is possible , using the Notes tab of the patient details window, to add individual items of information to the 
profile of any patient.
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=

View the record of the patient in the normal way (from Patient > Show Patients) , and select the Notes tab. Click on the 
Add event button to bring up the window shown above.

In the Event field, Search event type appears by default. To display all the events you have defined so that you may 
choose the one you require, enter the character “@” (without the quote marks), press the TAB key, and make your 
required selection from the list.

Alternatively, you may enter a word from the description of the event - e.g. if you have defined Patient's body weight as
an event, you may enter the start of the event name or code (e.g. pat ), and that event will appear in the Event field. If 
more than one event matches what you have entered, a list will displayed for your to choose the event you want to enter.

Should you wish to add any note or comment, you may do so by moving the cursor into the Note area, clicking, then 
typing your entry. You can customise the note in terms of when it will be displayed on screen etc. as described in the 
Items chapter of this guide. Here's the link - The Notes tab.
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After a period of time, a patient's notes may look like this:

The default view shows all patient events, but you have the ability to vew single events by selecting the event code from
the drop down menu Patient events under Show

A new event may be added by clicking on the Add event button, and an event which is no longer of any relevance may 
be deleted by clicking on the Delete event button.

Events may be edited by selecting the specific event, double clicking on it, when the Edit patient event window appears.

Entering prescribed items
On the Prescription entry window click on New line , and Add item window appears.
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mSupply stores the expanded text for each 
line, not the abbreviation. This means that 
there is a full audit trail of what was printed 
on the label (unless you edit the directions 
after printing!).

Once the item name and quantity have been entered, provided that the Show direction entry in dispensary mode option 
has been selected in Preferences, directions on how to take the medicine should be entered.

Entering directions
For many commonly prescribed items, default direction abbreviations can be defined - refer to the section on Item 
Default Directions. In the example below, the item being dispensed is FRUSEMIDE 40mg tablets, and the default 
directions are “Take ONE tablet in the morning”. Alternative directions present may be displayed by clicking on the 
down arrow to the right of the abbreviated direction field; directions not already present may be typed in using either 
the Abbrev entry area, or the Expanded entry area.

Note that you can mix abbreviations and text like this.

The drop-down list shows any default abbreviations you have entered for the chosen item. If one or more default 
abbreviations exists, the highest priority default abbreviation will be 'suggested' when you choose the item. If there is 
more than one standard abbreviation available, you can choose another one by choosing it from the drop-down list.

Default directions
The set up of default directions is done on the dispensing tab when editing an item. You will find it described here.

Printing Labels
Patient labels are printed when the Print labels option is checked in the Prescription Entry window. Sample labels, 
produced by the Zebra TLP2844 printer are reproduced below:
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mSupply currently is designed to work with the Zebra TLP 2844 label printer. The Zebra is a very nice printer. It can 
use either thermal labels or a thermal ribbon which gives non-fading results.

We currently support plain 90 x 40mm label stock as this is cheap and readily available. The Zebra printer is auto-
sensing of the ending of a label, so you can most likely used labels longer than 40mm with no problems.

• Label specifications:
• 90mm x 40mm high
• White Matt Thermal Transfer Paper
• Wide Edge Leading
• 1 Across on a roll
• Perforation between each label
• Produced on 1“ core to suit TLP2844

We are happy to support other printers if you use a different brand.

Reprinting labels
If you need to print the labels for an item again, choose Patient > Show Prescriptions to locate the prescription entry.

In the list of items dispensed, click on the line you wish to reprint, and then click OK (with the printing checkbox 
checked)

If you wish to reprint labels for all the items on the prescription, first click in the list of items below the last item so that 
now one item is highlighted. Then all labels will be preinted when you click OK

Printing multiple labels
If you want to print more that one label for an item, hold down the Alt key ( Option on Mac) as you click the OK button.
You will be asked for the number of labels required as the label is about to print.

What if there is not sufficient stock of one batch?
As the quantity of a particular batch of an item gets used up, you will need to issue stock from more than one batch to a 
patient. mSupply handles this when printing labels, and combines the totals for any item on a prescription so that only 
one label is printed for the total quantity.

The directions for the item with the first line number will be used, so enter directions for the first batch you dispense, 
and leave the directions empty for subsequent batches.

Note: if you have the rare situation where you need to issue the same item to one patient with different directions you 
should either combine the directions onto the one label, or enter two prescriptions with the directions entered differently
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on each prescription (That is enter the line, then print the label(s), then choose Patient > New prescription and issue the 
item again with the second set of directions).

View history
In the new prescription entry window, once you have entered a patient name you can click the “history” button to view 
a patient's history of what you have dispensed.

Duplicating a prescription
Once you have a history window open you can click to select a single entry or control-click to select multiple entries, 
then click the “duplicate” button to create new prescription line(s) with exactly the same details. Stock will be issued for
these lines automatically.

Repeats
mSupply allows for the recording of repeat prescription. This is achieved when the prescription is first dispensed; in the 
Add item window, click on Total field in Repeats box in the top right corner of the window, and enter the number of 
repeats that the prescriber has authorised. The Repeat Dispensing procedure is described here.
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Merging patients while dispensing
While dispensing, you may observe that a patient has been inadvertently entered twice - perhaps because there was a 
minor error in the spelling

When the Choose patient window appears, you need to highlight the two patients to be merged, then clicking on the 
Merge button displays this window:
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Here you need to decide which record should be kept, and which one should be merged, and check the appropriate radio
buttons. This combines the information in the record to be merged with the information in the record to be kept.

Viewing patient details
You can view a patient's details on-the-fly as you enter a prescription as described above. You can also view patients by 
choosing Patients > Show patients.

Enter the details you want to search for and click Find

You will be shown a list of matching entries, or taken directly to the detail view if only one patient matches the values 
you entered.
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Patient history tab

The details displayed are similar to displaying a customer in store mode. However there is also a history tab that shows 
each item dispensed. Double-clicking an item in the list will display the transaction in a new window.

Repeat Dispensing
The Repeats panel (upper right of the window shown below) allows details of repeat prescriptions to be recorded. Take 
the example of a patient presenting a precription for Frusemide 40mg tabs x 30 on 1st January 2007, with the prescriber 
requesting “Repeat monthly x5”; in the Total field you should enter “5”, and in the Expiry Date field you have the 
option of entering (a) the actual date on which the final repeat may be issued - in this example, “1 July 2007” (allowing 
the patient one month's grace) - or (b) “6m” for 6 months. Note that the characters “D”,”W“ & “M” in upper or lower 
case are interpreted in this particular field as the specified number of days, weeks or months before the repeat 
instruction expires. mSupply defaults to an expiry date two months later than the current date, but this may be edited as 
appropriate. The system automatically updates the number of repeats remaining as the patient makes further visits to 
have the repeats dispensed. The window below is displayed when you click on the New line in ” Prescription window “
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The number of repeats is assigned in Total field in Repeats box, and as the repeats are dispensed, the number remaining 
is displayed in the Left field.

When you click on the blue arrows on the upper right side ,the total repeat number and total quantity for each repeat is 
shown. Clicking on the small arrow displays the window below.

This window allows the user to alter the quantity of a particular repeat - e.g. if there is insufficient stock on a particular 
visit of the patient; the quantity can be edited by clicking on the quantity line, and again clicking on the quantity, which 
may now be edited. The arrow on the left bottom corner enables you to restore the default quantity setting.

Once you have filled repeat and other details on the Add item window properly, click on OK button to save details .

The Repeats icon is contained in Prescription entry. 
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When the Repeat function is used, and there are future repeats to be issued, the icon appears on a red background:

 The red background disappears when either:

• expiry date is reached
• all repeats have been dispensed

You can issue the repeat to a particular patient. Clicking on the Repeats icon displays this window:

The repeat window shows items to be dispensed, quantity, total repeats, repeats remaining and expiry date for a 
particular repeat. Process repeats and OK button are described below.
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OK

Click OK button to exit from the Repeats window

Process repeats

This button is used to issue the repeat for a particular patient and for a particular item line. For issuing the repeat, first 
select a desired item line and then click on the Process repeats button. Now the system automatically manages the 
repeats internally.

Printing receipts
When the Print Receipt option is checked in the Prescription Entry window, the printer will, after printing the medicine 
labels, produce a patient receipt as shown below.

Should you wish to use a different printer for receipts, this option can easily be incorporated in mSupply if you advise 
us of your requirements.

Previous: Exporting records Next: 

Prescribers
From the Special menu choose Prescribers
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When you are in dispensary mode, issuing items to a patient allows you to add a prescriber. This menu item allows you 
to set up your list of prescribers.

To add a new prescriber, click the “New” button.
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Add a code for the presciber. You can use the code quickly to look upthe prescriber when dispensing.

Other fields are fairly self-explanatory. Note that the code, first name and last name can all be used for looking up 
prescribers when dispensing.

Initials

The text you put in the “Initials” field will print on dispensary labels.

Active status

If you have a prescriber that is no longer used, you can change their status to “inactive” and the prescriber will not show
in the choice list when dispensing. Inactive prescribers will still show when you choose Special > Show Prescibers…

We suggest you might want to add a “Miscellanous Prescribers” item to the list, and use this if you have a lot of 
prescribers whose prescriptions you only dispense infrequently.

Category

This field can be used to group prescribers together, and can then be used to filter prescribers when producing a 
transaction report.

Merge prescribers
This item from the Special menu is used to merge two prescribers, where the same prescriber has inadvertently been 
entered twice. You are shown a window like this:

Enter the two prescriber names by entering the start of their surname or their code, and then pressing Tab . The top 
prescriber is the one who will be kept. The lower prescriber will be deleted.

Once you have entered the two names, check the details are correct, and then click OK. You will be warned one last 
time, and then the operation will be completed.

All transactions that recorded the deleted prescriber will now show the name of the prescriber that was kept.

Import prescribers
For information on the procedure for importing a file containing your prescribers see Importing prescribers

Previous: Next: 
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Choosing from the menu Special > Abbreviations allows you to enter directions quickly and accurately when 
dispensing medicines.

It is worth mentioning that abbreviations may also be used in other situations - e.g. if a significant number of customers 
live in the same locality, an abbreviated form of their address could be employed. Such abbreviations are created in the 
same way as described below.

As usual, you can sort the list by clicking on the column headers

Double-click an abbreviation to edit it.
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Click the New button to add a new abbreviation.

Type an abbreviation and the text that it will expand to.

Click the Report button to construct a simple report listing all abbreviations. This report can be previewed or printed.

When you are issuing an item you can mix abbreviations and your own text to add common directions quickly.

Do not use actual words as your abbreviation, or else attempting to type the word will result in the expanded text 
appearing on your label!
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If you change an abbreviation or add a new 
one, you will see the change immediately 
(v317 or later), but in a multi-user 
environment other users will have to log out 
and log in (use Switch user to do this 
quickly) to see the edited or added 
abbreviations.

Importing abbreviations...
The procedure for importing a file containing your abbreviations will be found here.

Printing a list
From the abbreviations window, click the Report button.
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While smaller screen devices will function, it 
is generally impractical to use devices 
smaller than a tablet.

Batch number and expiry date are not 
displayed, selectable or editable in mSupply 
Mobile. These details are recorded, 
maintained and reported for the store by the 
mSupply Server on the basis of the 
assumption that the store is being managed in 
accordance with FEFO (First Expiry First 
Out).
Removing the need to handle batch and 
expiry date information dramatically 
simplifies the management of stock in the 
store.

36. Double-click on Abbreviation
37. Double-click on Expansion
38. Right-click on Detail and set font size to 8 or 9
39. You can use the lines on the column headers to adjust column width
40. Choose File > Generate to print the list

Item Default Directions
Once you have entered abbreviations, don't forget to enter the default directions for all common items. Instructions are 
here

Previous: Next: 

Printing Preferences (setup)
For setting up a printer for the first time, see Printer Installation

Choosing this item from the Special menu shows the printing Preferences window.
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The default printer is stored for each client 
computer - so each computer can be set to 
print to a different default printer. When you 
alter this setting, you are only altering it for 
the computer you are working at

Changing your default printer

To change the default printer, simply click the checkbox in the right-hand Default Printer column on the row of the 
printer you wish to use.

Adding a Printer

• click the New Printer button

Editing a Printer

• Double-click the printer in the list.

Settings for a particular printer

• Description Here you give the printer a name 
• Connection type

• If you are connection with a network cable (recommended) choose network
• If you are connecting with a serial cable choose serial
• Note we do not support direct USB connections as we are not using the computer's printer driver- we are sending instructions 

direct from mSupply to the printer.
• Port number For network connections this will usually be 9100
• IP Address- the address of the printer e.g. 10.1.1.253
• Label dimensions Enter width, height and margins in m.m.
• Make this printer default - Checking this box means that the computer you are using will always print to this printer. 

• Important: this setting is “per computer” - you need to set each computer to have a default printer.
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• Reset printer You can use this button to send a command to the printer to reset it. Occasionally a printer may misbehave if it's 

memory is corrupted by an electricity spike or the like, and this button may help. If your printer is not behaving we recommend 
you contact Sustainable Solutions rather than charging ahead on your own.

Previous: Next: Warnings 

Patient Medication Records
Added: Version 3.11

Introduction
A Patient Medication Record (PMR) is a way of recording all the medications a person is using, whether or not they 
were dispensed by you. The record contains useful information for the patient such as

• The dosage in a clear easy-to-understand format.

• An (optional) picture of the dose form (tablet, capsule, etc)
• The medication's purpose.
• Common instructions for taking/using the medicine, which may be customised for each patient

Setting up items
Before adding items it is good to set up the standard purpose, instructions and item photo for common items at least. 
Once set up, you can add these to a particular patient's PMR with just the click of a button.

511



1. Find the item you are interested in and go to the dispensing tab
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mSupply will automatically resize large 
photos when you add them- there is no need 
to resize photos yourself first.

2.
3. Enter purpose and instructions. Both these fields can take as much text as you wish to enter.
4. Add a photo by either dragging a photo from another application or pasting a photo from the clipboard. 
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Adding items to a Patient's PMR
There are 2 ways of adding items to a PMR

1. From the patient history tab:
• Highlight the items from the patient's history you wish to add, then click the Add to PMR button.
• The record will be shown on the “PMR” tab if you switch to it. 
• Note that on the PMR tab you still have to double-click on the added record and fill in the dose, instructions etc.

2. From the Patient details PMR tab
• Here you can add any item that is in the mSupply catalogue.
• For example, a patient might be regularly taking paracetamol or aspirin that they buy themselves. You can add such items here.
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•
1. To add an item, click the Add item button. You will be shown a new window:
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2.
3. Item name: type the start of the item name and press <tab>, then select from the list
4. Dosage: Enter the number of tablets/drops/whatever to be taken/administered morning, noon, evening and bedtime.
5. Purpose: If the item has a purpose entered, click the copy button to copy it to the right-hand box. Here you can edit the 

details if you want to.
6. Instructions: If the item has instructions entered, click the copy button to copy them to the right-hand box. Again, you can 

edit the details if you want to.
7. Click OK when you're done, or cancel if you decide not to add a record.

Editing a PMR record: Double-click the entry you wish to edit, change details, and click OK to save the changes and 
close the window. Deleting a PMR: Highlight the record(s) you wish to delete, then click the delete button. (Do be 
careful- it's not reversible!)

Printing

Setting up printing preferences
When a PMR is printed, it has a header and footer. These are set up by choosing File > Preferences and then clicking 
the Patient Medication tab.
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Note that you can style the text in these boxes by selecting text and right-clicking on your highlighted text to get a 
contextual menu to apply font styles, colour and size.

Printing a PMR
Simply click the Print button. Note that you do not have to highlight records- all records will be printed.

Currently we have included a single PMR printing form in mSupply. We are happy to include others- send us your 
designs.

Previous: Warnings Next: Why an HIS module for mSupply?

Introduction to web interfaces
mSupply data can be accessed through simplified web interfaces for a number of purposes. These web interfaces are 
simpler than the standard mSupply desktop interface described throughout most of this documentation. These web 
interfaces allow users to communicate over the internet with a store on your mSupply server. They are very flexible, 
being able to run on a wide variety of devices:

• desktop / laptop
• tablet (recommended for most applications)
• smartphone (practicality depends on screen size and resolution!)

and operating systems:

• iOS
• Android
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• Windows
• MacOS
• Linux
• any other operating system

In fact, anything which can run a browser and can get an internet connection can use an mSupply web interface. It 
means that you can now use the power of mSupply to manage stock at remote sites which don't have access to local IT 
infrastructure, except, of course, access to the internet!

We are continually developing the web interface services. For details on various components see:
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41. Customer Interfaces
1. The 'Last Mile' Interface (under development)

42. Supplier Interface
1. Uploading and Downloading Web Tenders
2. Supplier instructions for using the tender submission web interface

Next: 

The mSupply Web Server

About the mSupply Web Server
When mSupply's web server is running, it allows you to access mSupply data from any networked computer that has a 
web browser.

Security warning: We have had thousands of uses of our mSupply web server on the public internet since 2005. To date 
we have not had a security problem reported. However, we recommend you use SSL and a proper SSL certificate if 
your mSupply web server is publicly accessible. mSupply fully supports SSL. Contact us for certificate installation 
instructions.

The advantages of accessing mSupply in this way are:

• It's easy. Most people are familiar with using a web browser.
• It's low maintenance. You do not need to install any client software.
• It's cost effective. Once you have purchased a web server licence an unlimited number of people can connect.
• it's secure. The web serversupports access using SSL, the standard for securing internet connections, stopping any malicious 

snooping of passwords or data.
• It allows customer access to information. The web interface built into mSupply can easily be customised to allow clients, supplier 

or other interested parties to have restricted access to the mSupply information you wish to show them. We are also able to include
order submission by customers, making it easy for them to place small orders, and have real time information on stock 
availability.

• You can access mSupply from anywhere on the internet. Once we supply you with a password protected version of the web 
interface, you can access mSupply data from any internet connected computer.

• It's fast over low bandwith connections. The mSupply web server allows you to provide access to mSupply from locations with 
only dial-up acccess.

mSupply web server functionality is being continually expanded according to client requirements. We welcome 
suggestions for more features.

Activating the web server
The mSupply web server feature is not included in the regular mSupply licence; in order to use this function, an 
additional licence is required. On application to Sustainable Solutions this can easily and swiftly be arranged.

For practice purposes, an evaluation version is available on our server - should you wish to access this, please contact us
for instructions.
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You can choose to start the web server or have it start automatically when mSupply starts.

Technical note: By default mSupply is set to use port 8080. This is because the default port number for http access (80) 
on unix systems running mSupply can only be used by applications that have root privileges, and we don't want you to 
have to run mSupply as root! If this is a problem, we can supply you with an application that redirects traffic on port 80 
to port 8080.

Setting up mSupply Desktop Users for mSupply Mobile
Your mSupply server needs to be set up for mSupply Mobile use. Follow these simple steps to get started:

1. Create a virtual store to hold the remote facility's stock.
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2. Create new users for the store or give some existing users permission to login to it. Note: Make sure that only the users who will 
use the mobile interface have permission to login to this store.
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1. Note that the important setting for mobile access is the “Default store.” You'll need to turn on “store mode” for the store too, 
else you can't turn on “Default store.” For example, here's user Debbie set up so that when she logs into mSupply mobile 
she'll be logged into Tulagi Mini Hospital:

2. Note that other user permissions (on the Permissions, Permissions(2) and Permissions(3) tabs) only apply to mSupply 
Desktop Users, not to mSupply Mobile Users.

3. For the steps below, refer to Virtual stores for detailed instructions
1. Make only the items which the remote facility will use visible in the new store.
2. Make only the names which the remote facility will use visible in the new store.

3. Ensure the store can receive transfers from the store that will be supplying it (This is done by ensuring that the receiving 
store's name record is visible to the sending store)

4. Ensure “Pack to one” is turned on for visible items in each store.

Now you're ready - have fun!

Setting up a Customer's user to access the web interface
You can set up multiple Contacts for each customer.

1. Find the customer by choosing Customers > Show Customers and entering part of their customer name to search for them.
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2. View their details by double-clicking the customer's record in the list
3. Click the Contacts tab.
4. Click new to add a new contact.
5. Fill in a user name and password
6. Check the Can log into web interface checkbox.

Previous: Next: 
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While smaller screen devices will function, it 
is generally impractical to use devices 
smaller than a tablet.

mSupply Mobile Users Guide

What is it?

mSupply Mobile is a simplified web interface which allows you to communicate over the internet with a store in your 
mSupply server from browsers on any mobile devices (smartphones, tablets, net-books, etc.).

Features and Limitations
mSupply Mobile is simplified because it is designed for 'lower level' stores that do not need the full functionality 
afforded by mSupply Desktop. Conversely, mSupply Mobile is generally not suitable for 'higher level' stores which 
require the features of mSupply Desktop.

In particular, mSupply Mobile's features are:
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Batch number and expiry date are not 
displayed, selectable or editable in mSupply 
Mobile. These details are recorded, 
maintained and reported for the store by the 
mSupply Server on the basis of the 
assumption that the store is being managed in 
accordance with FEFO (First Expiry First 
Out).
Removing the need to handle batch and 
expiry date information dramatically 
simplifies the management of stock in the 
store.

• Customers: Display a list of existing Customers and the Billing Address of any selected Customer. There is no facility to add, 
delete or edit Customer data; this can only be done with mSupply Desktop.

• Customer Invoices: Display a list of existing Customer Invoices and details of any selected Customer Invoice. Customer Invoices
can be added and edited (lines can be added or deleted). Once created, Customer Invoices cannot be deleted.

• Supplier Invoices: Display a list of existing Supplier Invoices and details of any selected Supplier Invoice. Supplier Invoices 
cannot be created with mSupply Mobile. Supplier Invoices to a Virtual Store will generally be Stock Transfers from a higher level 
store, coming from a Customer Invoice in that store. Supplier Invoices that have been finalised cannot be edited. Supplier Invoices
cannot be deleted.

• Items: Display a list of Items and simplified details of any selected Item Line, including, of course, stock on hand. Inventory 
adjustments are carried out through a stocktake process - refer below.

• Stocktakes: Display a list of Stocktakes and details of any selected Stocktake. Stocktakes can be added, deleted and edited (lines 
can be added, deleted and edited).

• Reports: A selection of reports can be emailed (by the mSupply server) to pre-specified email addresses.

Note: There is no facility to display, add, delete, or edit Supplier data; this can only be done with mSupply Desktop.
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A word of caution
If like us, you've got a long history of drug medicine dealing, it's easy to get confused when a tablet can now refer to 

something you swallow, and also to something you use to run mSupply. To avoid confusion, we've provided this handy 

chart 

Instruction Applies to Medicines Applies to computing device 

Crush, then swallow  

Swipe (Don't! You'll get fired for this!)  

Dissolve in water  
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Plug into USB charger  

Keep in a dry place   

Setting up mSupply mobile
Your mSupply server needs to be set up for mSupply mobile use. Follow these simple steps to get started:

1. Create a virtual store to hold the remote facility's stock.
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2. Create new users for the store or give some existing users permission to login to it. Note: Make sure that only the users who will 
use the mobile interface have permission to login to this store.
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1. Note that the important setting for mobile access is the “Default store.” You'll need to turn on “store mode” for the store too, 
else you can't turn on “Default store.” For example, here's user Debbie set up so that when she logs into mSupply mobile 
she'll be logged into Tulagi Mini Hospital:

2. Note that other user permissions (on the Permissions, Permissions(2) and Permissions(3) tabs) only apply to desktop users, 
not to mobile.

3. For the steps below, refer to the chapter on Virtual stores for detailed instructions
1. Make only the items which the remote facility will use visible in the new store.
2. Make only the names which the remote facility will use visible in the new store.
3. Ensure the store can receive transfers from the store that will be supplying it (This is done by ensuring that the receiving 

store's name record is visible to the sending store)
4. Ensure “Pack to one” is turned on for visible items in each store.

Now you're ready - have fun!

Some general information before you start

When you ask the interface to do something it will mostly need to communicate with your mSupply server over your 
internet connection. We have done our very best to make the communication as fast and smooth as possible but we're 
still limited by your internet connection (we're good but we can't perform the impossible yet!). When mobile is doing 
something and you need to wait you'll see this small icon appear:  When the icon goes away this means that mobile has 
successfully finished its communication and what you asked it to do has been successful (it won't specifically tell you 
that it was successful). If there was a problem doing what you asked it to do then the interface will show you an error 
message (which will usually be caused by a problem with the internet connection). 

Accessing mSupply mobile
To access mSupply mobile open a browser on the device you will use and type in the address of your mobile store. The 
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You can add a web page to your home screen. If you're using Safari® then it's tap 1, 
then 2 in the following screenshot: 

address will look like http://xxx.xxx.xxx.xxx:xxxx/mobile. e.g. http://192.168.10.3/mobile. Tap the return key and after 
a few moments the login screen will appear.
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Using mSupply mobile

Logging in
You can't do anything in mSupply mobile until you've logged in and this is where you do it. The credentials that you 
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enter must already have been set up on the mSupply server through a client. Once you've entered your username and 
password, tap the login button and you'll be taken to the navigator.

The navigator
This is where you see all the things you can do in mSupply mobile. Tapping on a row in the navigator will take you to 
that function. This is what it looks like:

Tap on:

• Show Customers to see information about your customers.
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• Show Customer Invoices to see and edit your customer invoices.
• New Customer Invoice to create a new customer invoice.
• Show Supplier Invoices to see and edit your supplier invoices.
• Show Items to see information on the items in your store.
• Show stock histories to view and comment on upcoming supply issuing.
• Show Stocktakes to view, create and delete stocktakes.
• Reports to have reports emailed to you.

Viewing a customer
(Back up to The navigator)

Tapping on Show Customers displays this list of all your customers (Note: If you have more customers than will 
display on the screen you can scroll the list to see the others):
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To see the details of a single customer tap on them to select their row in the grid then tap on the View customer details 
button. You will be taken to the details screen which looks like this:
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The customer invoice list
(Back up to The navigator)

Transaction Status Codes
Before we go further we need to quickly discuss what is meant by transaction status. See Transaction 
Codes#transaction_status for a full list of codes used in mSupply. In mSupply mobile (for both invoices and stocktakes),
you'll see the following codes used:

Status Code Meaning Explanation 

sg Suggested The transaction or stocktake is
editable, and stock has not been

updated 

cn Confirmed The transaction or stocktake is still
editable, but stock has been updated 

fn Finalised The transaction or stocktake is not
editable, and stock has been updated 

When you first arrive at this screen you will see a list of your 15 most recent customer invoices, just like in desktop 
mSupply:
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To see other invoices you can tap on the Find button to search for other invoices (see Searching for invoices here) or, to
see more details for one of the invoices shown, tap on it to select its row and then tap the View/Edit invoice button. You
will be taken to the customer invoice detail screen which looks like this (for a non-finalised invoice):

If the invoice is finalised you won't be able to edit it (just as in desktop mSupply) but if it's not finalised you can edit it 
as follows:

536



• Their ref Tap the Their ref text box to edit or enter a value. Handy for recording a customer's purchase order number for example.
• Comment Tap the Comment text box to enter or edit a comment or anything additional you want noted about the invoice.
• Add line Tap on the Add line button to add a line to the invoice - it will take you to the Add item screen as described below.
• Delete line Tap on one of the invoice's lines to select it and tap this button to remove it from the invoice. Be careful: once it's 

gone, it's gone! 
• Quantity field You can directly edit the quantity of an item on the invoice by tapping the quantity field of the line. Immediately 

the field changes to a text box and you can enter the new quantity.

• Finalise it If you've finished editing the invoice and you want to make sure it can't be edited by anybody you can finalise the 
invoice by tapping on the Finalise button. You'll be asked to confirm that you really want to because once you've done it, it can't 
be undone and the invoice will be un-editable.

Adding an item line to the invoice

If you click on the Add line + button you'll be taken to this screen to select the item and quantity to add:

Tap the item field and an alphabetically sorted list of all the items in your store will appear. Type the first few letters of 
the item name and the list will reduce to those entries which start with what you typed. Now choose the item you want 
from the list of matching entries: if the list is too long keep typing, the more letters you type the shorter the list of 
matching items will become:
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Tap the quantity text box and enter the amount of the item you want to add. When you're done, tap the Add item button 
and you'll be taken back to your invoice with the new line added to the bottom of those already there (or according to 
the sort order of the items list if you've previously sorted the list by clicking on one of the column headers).

When you've finished viewing or editing the invoice tap on the Customer invoices button to go back to the list of 
customer invoices.
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Adding a customer invoice
(Back up to The navigator)

Just as in desktop mSupply, customer invoices are for giving stock to a customer (e.g. a hospital ward or a patient) and, 
when confirmed, result in stock being taken off what's available in your store. To create a new customer invoice tap 
New Customer Invoice in the navigator and you'll be shown this screen:

From this point, there are two possible ways to add items.
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2. Adding from a master list

Adding lines to an invoice individually
Tap on the Name text box and, enter the first few letters of the customer you're going to supply goods to and then tap on

the matching entry from the list:

If you want to, enter the customer's reference for this transaction (their purchase order number for example) or enter a 
comment such as Regular monthly order or Emergency order (these are optional). Now tap the Add line button to add a 
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line to the invoice. This will take you to the Add item screen to select the item and quantity to add:

Tap the item field and an alphabetically sorted list of all the items in your store will appear. Type the first few letters of 
the item name and the list will reduce to those entries which start with what you typed. Now choose the item you want 
from the list of matching entries: if the list is too long keep typing, the more letters you type the shorter the list of 
matching items will become:

542



If you need to alter the quantities of any item on the customer invoice just tap on the 
quantity field and it will change to a text box and allow you to enter a new quantity.

Now you've selected the item its available stock appears next to the quantity text box (after the word 'of:'):

Tap the quantity text box and enter the amount of the item you want to add. When you're done, tap the Add item button 
and you'll be taken back to your invoice with the new line added to the bottom of those already there (or according to 
the sort order of the items list if you've previously sorted the list by clicking on one of the column headers).

Repeat adding more lines until you've finished. Here's an example after a second line has been added:
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An important thing to note is that when you do save your customer invoice for the 
first time it is automatically confirmed which means that the stock is allocated to the 
customer immediately and taken off what is available in your store.

mSupply Mobile can only process stock 
transfers from another store within your 
mSupply system. Supplier invoices from 
outside your mSupply system must be 
received using mSupply Desktop.
Depending on the mSupply preferences, 
Stock Transfers may need to be finalised in 
the supplying store before they are visible in 
the receiving store through mSupply Mobile.

Don't forget to save your invoice by tapping on the Save button but don't worry if you do forget, as mSupply mobile 
will prompt you. Also, if you need to finalise the invoice (to prevent any further changes to it) then tap on the Finalise 
button. You will be asked to confirm the finalisation because you can't undo it and no changes to your invoice will be 
possible afterwards. 

Adding lines to an invoice from a master list
Firstly, this function will only work if you have assigned a master list to the customer you are issuing to. To do this, see 
these instructions

Assuming your customer has a master list assigned, then simply tap Add lines from master list and the invoice will be 
filled with one row for each item. You can tap the button at any time - whether you've already added items to the 
invoice or whether it's still empty. Only items from the master that you haven't already added to the invoice will be 
added to it. And the quantities you've added won't be changed either. To alter the quantities of any item on the customer 
invoice just tap on the quantity field and it will change to a text box and allow you to enter a new quantity.

When you're finished editing, save the invoice. 

Note that items that have zero quantity will be deleted when you leave the 'new invoice' screen. This means that:

1. You don't have to delete them yourself
2. Once you return to the navigator, if you then edit the invoice (via Show customer invoices) you won't see the whole master list - 

just the items whose quantity was set to greater than zero. Note that using the save button while you have the invoice open on the 
'new invoice' screen won't affect your invoice, the 0 quantity lines will remain (so you can still save frequently and not lose the 
zero quantity lines you still have to edit).

When you're finished, you can tap the Navigator button at top left to return to the Navigator.

Show Supplier Invoices
(Back up to The navigator)

Supplier invoices are for receiving goods into your store.
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If you tap on the Show Supplier Invoices item in the navigator you'll be taken to this screen, which shows your 15 
most recent supplier invoices by default (just like desktop mSupply):
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There are two things you can edit on a supplier invoice:

1. The Accepted status. If an invoice has been accepted before (status is cn or fn) then it cannot be 'unaccepted' so, if this is the case,
instead of a slideable switch you will see the word 'Yes' in the accepted field. An accepted status of 'No' means that the invoice is 
on hold and the stock has not been added to the stock in your store. As soon as you change an invoice's accept field to 'Yes' and 
save it (by tapping the Save changes button), the invoice will be confirmed and the stock on it will be added to your store.
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2. The quantities in the No. received column. This column is for capturing exactly what you received from the supplier, so after a 
delivery you should go through the invoice and make sure that this column contains exactly the quantity you received for each 
item. When you are sure that the quantities are correct you should change the invoice's accepted status to 'Yes'. Note that the 
quantities in this column are set to those that the supplier sent you (displayed in the No. sent column) by default.

Don't forget to save any changes to your supplier invoice. Don't worry if you forget, because mSupply mobile will 
prompt you to save or discard the changes. 

Items

(Back up to The navigator)

Tap the Show items row in the Navigator to view items. You'll be shown a screen where you can find items by name or 
code or SMS code etc. (just spin the wheels to change the criteria used to find the items you're interested in):
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Tapping the Search button will show you a list of results:
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To view more details about a single item, tap on it's row to select it, then tap the Item details button.

At the moment you can't edit an item's details. If an item needs editing, inform the users of mSupply desktop where 
your server is located so that they can log in to the desktop version and make the necessary changes.

Stock Based Orders
This feature allows the viewing of and commenting on recommended supply quantities generated by a central store 
using the mSupply Stock Histories feature. Quantities calculated using the records of previous quantities sent and 
adjusted using stock take information for your store allows the generation of recommended quantities to be issued.

Clicking on Show Stock Based Orders displays a list of central store generated drug quantity issues.

Clicking on the SH no. and then “View/Edit” allows you to drill down and comment on the individual record.
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Supplier SOH shows the amount of available stock on hand at the central store.

Our SOH at submission shows the stock on hand available at your store.

Previous usage history is used to calculate the amount to be sent to you in the final column.

The only editable field is the Your comment field where you may enter feedback to the central store.

Stocktakes
(Back up to The navigator)

Tapping the Show Stocktakes row will show you a list of in-progress stocktakes: 
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In the example above we're going to create a stocktake for all items whose name begins with “A”. To create a stocktake 
for all items, leave this field blank.

Include items with no stock Usually you'll want to leave this switched to no but if you are doing an initial stocktake 
for a new store you have just set up, you might want a list of all items, not just the ones with stock (which will be none 
for a new store). In that case slide the switch to yes before creating the stocktake.

To proceed, tap the Create stocktake button at top-right. The wheels will spin (you might hear a whirring sound from 
your tablet) if you want to use other criteria to select the items to go into your stocktake.
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Now the stocktake is created, you can edit lines by tapping on the value in the actual quantity column of the row you 
wish to edit. In the example below we've counted the Azathioprine and we're 100 tablets short:

As you stocktake a store you might find items on the shelf that are not in your stocktake. To add an item, tap the Add 
line + button. You'll be shown this screen, where you find the item, and enter the stocktake quantity for that line: Tap 
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You do not have to delete rows where the stock is already correct. mSupply will just 
ignore these when creating inventory adjustments.

Add to stocktake once you've entered the item and quantity.

Finalising the stocktake
(Back up to The navigator)

Once your stocktake accurately reflects your actual store stock, tap on Create inventory adjustments You'll be shown 
this warning: 

If you tap I'm sure, do it the necessary adjustments will be made in mSupply.
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Once inventory adjustments are created, the stocktake will have a status of “FN” (finalised) so it will not show up in the
list of current (or pending) stocktakes. 

Deleting a stocktake You can delete a stocktake by tapping on the row you want to delete, then tapping the delete 
stocktake button. You'll be warned of impending doom:

Searching for invoices
(Back up to The navigator)

If you tap the Find button when viewing a list of invoices you will be taken to this screen:

Move the spinwheels until the search matches what you want, enter your search value in the text box then click on the 
Find transactions button. When the search is complete you will be taken back to the customer or supplier invoice list 
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(depending on which type of transaction you were searching for) with all the transactions matching your search criteria 
displayed in the list.

Reports
(Back up to The navigator)

mSupply mobile can email three different reports to you. Tapping the Reports row on the navigator will take you to the 
reports page:

Tapping on any of the Email me this report buttons will make mSupply email you the corresponding report as an 
Excel spreadsheet using the values you select. Obviously, it needs to know your email address to do this so remember to
set this up in your user preferences in desktop mSupply first - see here for instructions on doing this.

Tips and Tricks

You get a message "You haven't edited anything" when you have
This happens when you change a field (e.g. the description of a stocktake) and then tap Save without first tapping in 
another field. This only happens on iPads (iPhones too we guess), not Android devices Solution: tap in another field 
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• When you log in you need to choose “mSupply user” and then enter the user name and password you use to login to the mSupply 
desktop application:

• Choose stocktake and click OK
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You don't create stocktakes in the web 
interface; you do that when you're logged 
into the mSupply desktop application. The 
web interface is for filling out stocktake 
quantities.

2) Select the stocktake you want to use

• You will now see a list of available stocktakes (If the list is empty it's because you have no non-finalised stocktakes waiting to be 
actioned - go to the desktop application and create your stocktake):
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IMPORTANT: Remember to press the tab 
key or click on another item line after you 
have entered the last item's quantity (i.e. 
before you click on the Close button), 
otherwise the last quantity you entered will 
not be remembered.

Double click anywhere on the line of stocktake you want to enter quantities for (or single click on it and click on the edit icon). This 
will open the stocktake and show all the items in it, ready to have their quantities entered:

3) Enter stock quantities

• As you physically count the stock items in your store you can enter the quantities against each item in 2 ways (refer to the 
screenshot above):
1. Double click anywhere on the item line and type in the quantity.
2. Click on the item and click on the Edit button, then enter the quantity.

• Remember, you only need to enter quantities where the quantity of an item you count in your store is different from the number 

shown in the stocktake.
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• To make it easier to find the item you want to enter a quantity for, you can do 2 things (again, refer to the image above):
1. Click on the column headers (Code, Item, Batch etc.) to sort the items according to that column. Sorting by location could be 

particularly helpful if your items are stored in sequentially labelled locations. Note that clicking on column headers again 
toggles them between sorting in an ascending and descending order.

2. Search for the item by typing the start of the item's name in the search box and clicking on the magnifying glass icon. Note 
that you can also search by location or batch the same way. Simply click on the Search By Item button and click on location 
or batch, as shown in the screenshot below:

• When you have entered a new quantity, mSupply adds a little red triangle to the top left of the quantity's cell as a handy visual 
reminder of the values you've updated since you last clicked on the Close button:

• Finally, when you've entered all the quantities you need to, press the tab key to move away from the last quantity you entered and 
click on the Close button. You will be taken back to the list of stocktakes where you can open another to enter quantities for that 
or logout (You can of course make changes to the stocktake you've just entered until it is finalised on the client if you need to)

• To finalise the stocktake and have mSupply create all the inventory adjustments you must return to you desktop copy of mSupply. 
See the 'Create inventory adjustments' section on this page for instructions on how to do this.

Final word
If someone makes changes to the stocktake you are working on, using the desktop copy of mSupply (e.g. adding or 
removing items), you will not see them reflected in your web copy of the stocktake until you close it (by tabbing out of 
your last entered quantity and clicking on the Close button) and re-open it (by double clicking on it in the list).
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WARNING: For security reasons there is a timeout in operation on all mSupply web 
pages. This means that after a certain period of inactivity (time between key presses 
or button clicks) you will automatically be logged off. Any work that you have not 
saved at this point will be lost. For a stocktake, your work is saved when you click on 
the Close button. So don't leave a stocktake half done, walk away for half an hour to 
have a cup of coffee or do your make-up. Tab out of your last quantity entry and 
Click on the Close button before you go. When you return simply log in again, open 
up the stocktake you were working on and continue where you left off. You have 
been warned!

While the Customer Interface will run on 
smaller devices like smartphones, it is 
generally impractical to use with screens 
smaller than 5 inches across the diagonal.

Previous: Next: 

mSupply Customer Interface

What is it?
The mSupply Customer Interface allows staff of Customers in your mSupply system to report their stock levels and 
order stock from a Virtual store in mSupply system. It runs on a browser on any device: tablet, smartphone, net-book, 
desktop computer etc.

Features and Limitations
The Customer Interface is designed to be used by staff of Customers in your mSupply system i.e. people working in 
places you supply, but they could be people outside of your organisation.

The Customer Interface's features are:

• Invoices: Display a list of orders that have been processed and are waiting to be processed by the supplying store. You can also 
see details of any selected Invoice.

• Orders: Display a list of Orders being worked on, which will be placed with the supplying store when they're finished. Orders can
be created, deleted and edited.

• Items: Display a list of Items available in the supplying store.
• Stocktakes: Display a list of Customer Stocktakes (including Imprests) and details of any selected Stocktake. Customer 

Stocktakes can be added, deleted and edited.
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Batch number and expiry date are not 
displayed, selectable or editable in the 
Customer Interface but mSupply does track 
them underneath.
mSupply does not attempt to keep any record 
of stock issued or consumed by the 
Customer. Customers can report inventory 
through the stocktake process and mSupply 
does keep these stocktake records.

The hyperlink above links to Sustainable 
Solutions' mSupply Web Server for mSupply 
Customer demonstration. You will not be 
able to proceed further without a username 
and password - see below. Contact us on 
email:info@msuppy.org.nz if you would like 
a temporary username and password to try it 
out.
Once set up with your own Web Server, the 
correct link can be bookmarked to save you 
typing it each time.

Setting up users to access the customer interface
You can find details of how to do this on The mSupply Web Server page.

Connecting to the Customer Interface
Once the mSupply web server is running, you can access it by typing http://example.com/customer/
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Logging in
Firstly you will be shown the login page:

Enter your username and password and tap Login

The Navigator
You are now shown the mSupply customer options:

Tap on:

• Show Processed Invoices to see invoices from the supplying store that have already been processed (goods have been picked and 
packed).

• Show In-Process Invoices to see invoices from the supplying store that have not finished being processed (still waiting for goods 
to be picked and packed).

• Show Items to see information on items available in the supplying store.
• Show Orders to view a list of orders that have been created but not yet completed.

562



• Create Orders to create a new order for stock from the supplying store.
• Show Stocktakes to view and create customer stocktakes or imprests.

Show Processed Invoices
Tap Show Processed Invoices and the invoices that have already been confirmed in the supplying store (i.e. where the 
goods are picked and packed and being sent to the customer) will be displayed:

Tap Find to show a screen where you can search for other invoices:

Choose the options using the selectors and enter some text in the textbox to define the search filter. Then tap Find to 
search for invoices. When the search is complete the list will be updated with the results.
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Tap Invoices to go back to the list of invoices.

(Back up to The navigator)

Show In Process invoices
Choosing this option will display the list of invoices that are still waiting to be processed in the supplying store (i.e. the 
goods have not been picked and packed):

Again, tapping on a particular row and then then on View will show the details of the highlighted invoice.

Tap Navigator to go back to the main options screen.

(Back up to The navigator)

Show Items
Tap Show Items to make a search of items available in the supplying store. It will display this screen:

Choose your search options using the selectors and enter something to search for in the textbox (or leave it empty to list 
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Note: The Stock on Hand figure is the 
supplying store's stock on hand, not the 
Customer's stock on Hand.

all the items). Tap on Find and the search will be made. When the search is complete the list of items matching your 
search criteria will be displayed:

Tap the row of a specific item and tap on Item details to see the details:
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(Back up to The navigator)

Show Orders
Select Show Orders to display a list of orders that have been created. 

To view or edit an existing order, tap on the order's row to highlight it, then tap on View/Edit order

To delete an existing order, tap on the order's row to highlight it, then tap on Delete order

Tap on Navigator to return to the main options screen.

(Back up to The navigator)

Create Orders
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For setting up a default order list, see Names: 
Using, adding and editing

To add a new line, tap on New line and select the item and the quantity to add: 

Tap on Add to order to proceed and return to the items in this order. If you wish to add a comment you can do so 
directly in the list by clicking the blank row under each item:

Note you can also edit the quantity directly in the list.

If you have been assigned an order List of the items you are allowed to order, tapping the Add lines from Order list 
button will display the items on the list(s) defined for the customer you are logged in for.

The list will be displayed in the same order as was specified when setting up the list in mSupply.
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A note for the user processing the order in 
the warehouse: 

The customer's order will appear in mSupply 
desktop as a customer invoice with 'wf' (web 
finalised) status. This means the customer 
can no longer edit the order but the desktop 
user can edit the order. The customer invoice 
displays the customer's order with 
placeholder lines by default. This gives the 
mSupply desktop user control to choose the 
stock for the customer's order. 

To choose stock see the re-distribute section: 
Redistribute placeholder lines.

Once the order is complete, tap the Finalise Order button to finalise the order that you have created. It will now be 
visible under the In process invoices option until the supplying store processes it. It is also visible and available for 
processing in the supplying store in mSupply. And you might even get your supplies delivered quicker than you would 

have by submitting a written order 

(Back up to The navigator)

Show Stocktakes
Tap Show Stocktakes and the stocktakes that have already been initiated will be displayed:

The stocktakes feature is useful to those users at a central supply facility who are responsible for managing orders from 
a number of remote facilities based on the stock levels in those facilities.
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From this window you can view an existing stocktake by tapping on a row and then on the View/Edit button. You can 
choose to create a New stocktake or New imprest by clicking the appropriate button. The option chosen depends on 
whether you are using the dynamic Stock History system of stock management, or the Imprest system. These systems 
are covered under Stock Control methods for your customers.

By clicking either of the New stocktake or New imprest buttons you are presented with a screen showing the items 
you carry in stock, but with quantities of 0.

Enter the stock on hand for each item into the My current SOH column: 
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Once you have entered all your stock on hand figures, tap Finalise to send the stocktake to the central store. You will be
prompted for a confirmation to finalise the stocktake. Once you confirm the finalisation of the stocktake, you will be 
taken back to the Show Stocktakes window. The stocktake you were just working on will now be invisible unless you 
change the view to include finalised stocktakes.

(Back up to The navigator)

Back at the supplying store...

The operator at the supplying store may then process the information entered by the remote customer by choosing from 
the menu Customer > Show customer stock history, and looking in the Customer stock history list window for recent 
entries having a status of wf (web finalised). Double clicking on the desired entry displays the Edit customer stock 
history window showing the data entered by the remote customer. The details may be reviewed and figures entered in 
the Actual quantity given column before clicking on Create Customer Invoice, at which point the status changes from 
wf to sg and it may no longer be edited by the remote customer.

(Back up to The navigator)

Previous: Next: 

The Dashboard
You can use the dashboard (Enabled in Preferences) to monitor and access reports on the internet. Users browse to the 
IP address of their web server (with /dashboard/index.html added as in 
https://example.com/dashboard/index.html) using their internet browser (such as Chrome, Safari or Firefox). This 
enables users to access reports using their computer at home or even their tablet or cell phone!
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You can choose those users you would like to be able to access the Dashboard by editing the permissions of these users 
and ticking the can view the dashboard box in File>Edit Users. See Managing Users for more help editing users.

Previous: Next: 
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• Enter the pack size of this item that is going to appear in the catalogue in the Catalogue pack size textbox
• Enter the price for this pack size in the Catalogue price textbox. This is optional and can be left at 0 if you don't want the price 

included in your catalogue.

Repeat these steps for each item you want to appear in your catalogue. As with many repetitive tasks in mSupply, the 
OK & Next and OK & Previous buttons are your friends here.

And that's it. Setup is complete and you are now ready for users to view your catalogue. 

Operation
Once the mSupply web server is running users access the catalogue using a browser. The address to visit is 

https://example.com/catalogue/

where example.com is the domain of your web server.

This is what the user will see: 

The catalogue can be searched by either item name (the top section) or the categories that items belong to (bottom 
section).

Searching by item name
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To search by item name enter something in the top textbox and select the comparator in the drop down list next to it. 
These are the options you can choose from: 

Then click on the top Search button and mSupply will search for items with names matching the options you have 
entered. When the search is complete the item detail screen (shown below) will be displayed and you can browse the 
items found.

Searching by category
The category used to search for items in the catalogue is item category 1. This category is hierarchical and has 3 levels. 
For more details about this category, including setting it up and assigning it to items, see here. Note that in the 
catalogue, Top level corresponds to level 1 of category 1, Mid level to level 2 and Bottom level to level 3.

To search by category, click on one of the 3 Search buttons in the lower section of the search screen. When you do that, 
mSupply will search for items belonging to the category of the level of category 1 you selected in the corresponding 
drop down list. If the All option is selected then mSupply will search for items belonging to all the corresponding 
categories at that level of category 1.

When you select an option other than All in the Top level category drop down list, the options in the Mid level drop 
down list are changed to be all the children of the top level category you selected. And when you select a Mid level 
category, the options in the Bottom level drop down list change to be the children of that mid level category.

The Bottom level category drop down list has an additional “None” option. Using this option will search for all items 
which are not assigned to a category 1 category.

The Item detail screen
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The screen looks like this:  When you've finished browsing the items displayed you can click on the Search button on 
the top left hand side to return to the search screen, where you can perform another search if required.

Previous: Next: 

mSupply Mobile API

What is it?
This document describes an application programming interface for communicating with mSupply.

Basics

• Communication is over HTTP protocol
• All data is submitted and returned as JSON

Authentication

• All requests must have standard HTTP basic authentication headers
• You must use SSL to secure your communications unless you want to tell the world your password.

GET - Getting data from mSupply

For all calls

• The basic syntax 

• http://server_ip_address/resource/id_of_resource
e.g. http://example.com/mobile/name/524
will retrieve the complete record for name whose ID=524
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• or

http://server_ip_address/resource?field=blah,field2=blah2&sortby=+foo,-bar 
e.g. http://example.com/mobile/name?name=foo@,customer=true&sortby=+name
will retrieve all names whose name starts with "foo" and who are customers, 
sorted by name in ascending order (a to z)

Note that a "/" is also allowed before the "?" in the URL e.g. 
http://example.com/mobile/name/?name=foo@,customer=true&sortby=+name

• Method: GET
• Note that all price data will be returned rounded to 2 decimal places.

Paging

• If you want a range of items, pass an HTTP header named “range” with a “from” and “to” value separated with a hyphen. See the 
following example to find out the right format for the “range” header. 
• e.g. to return the first 15 items: 

range  bytes=1-15

• The server will reply with a header containing the item range and the total number of items found: 

items 1-15/568

Query notes

• For string searches you can use “@” as a wildcard, as in the example above
• ?name=@foo@ will return all names containing “foo”
• ?name=foo@bah will return all names starting with “foo” and ending with “bah”

• Allowed query operators are:
• =
• # (not equal to)
• >=
• <=
• <
• >

• A query operator must be followed by a query value
• All resources returned are first filtered by the server to only return valid results for the store the user is logged in to.

• Transactions: only transactions created in that store
• Items: only items visible in that store
• Customers (names): only names visible in that store
• More on stores here
• There is a full list of field names here but note that as of Wednesday 31 October 2012 they haven't been updated for mSupply 

v3.2

Available resources

Items

<90% 35%>

Resource name item 
Fields you can query any 

Returns by default JSON array containing: id 
 code 
 item_name 
stock_on_hand_tot 

* DIFFERENT INFO returned when a single item is requested - put in details
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Transactions

<90% 35%>

Resource name transaction 
Fields you can query any 

Returns a JSON array containing: id 
name (i.e. the name of the customer/supplier the 
transaction is to/from) 
entry_date 
confirm_date 
status (a two letter code denoting the status of the 
transaction) 
comment (the user-entered comment) 

If you only request a single ID (e.g
example.com/mobile/transaction/558 

A JSON object containing every field for that record 

Special case one: 
Getting An ID to use when submitting a new transaction;
submit example.com/mobile/transaction/new_id Returns: 

JSON object containing: new_transaction_id 

Names

<90% 35%>

Resource name name (a name can be a customer, a supplier, a 
manufacturer or a donor or a combination of these) 

Fields you can query any 
Returns by default JSON array containing id 

code 
name 
bill_address1 

Invoice

<90% 35%>

Resource name: invoice 
Fields you can query none. Just call the ID number like this 

http://example.com/mobile/invoice/578

Returns by default JSON array containing id 
name_id 
name_name (The actual name of the customer or supplier) 
total 
their_ref 
type 
entry_date 
confirm_date 
comment 
entered_by (username not ID) 
store (name not ID) 
hold 
lines: contains an array containing the lines on the invoice. 
Each array row contains: 
item_id 
item_name 
quantity (no. of individual items i.e. pack size x quantity in
a pack) 
stock: 
contains an array of all stock lines used on the invoice, and
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Note that many preferences are now set on a 
per-store basis i.e. each store has its own 
setting for some preferences. See the Virtual 
stores chapter for more info.

also any other stock lines for items on the invoice whose 
quantity is greater than zero. This means that for a 
“normal” invoice line editing operation (where you are not 
changing the item) you already have all the information 
that you need without a further call to the REST server 
when a line is edited) 

Example {
  "id" : 587,
  "name_id" : 79,
  "invoice_num" : 256,
  "status" : "fn",
  "total" : 824.5,
  "their_ref" : "GIZ05",
  "type" : "ci",
  "entry_date" : "2012-09-30",
  "confirm_date" : "2012-10-30",
  "name_name" : "ZIGO HOSPITAL",
  "lines" : [ {
    "id" : 6396,
    "item_key" : 973,
    "item_line_key" : 960,
    "item_name" : "CLOXACILLIN TABS 
250MG BOT/1000",
    "quantity" : 5,
    "pack_size" : 1000,
    "sell_price" : 161.61,
    "price_extension" : 808.05
  }, {
    "id" : 6397,
    "item_key" : 120,
    "item_line_key" : 14,
    "item_name" : "ATENOLOL TABLETS 
50MG BOT/100",
    "quantity" : 5,
    "pack_size" : 100,
    "sell_price" : 3.29,
    "price_extension" : 16.45
  } ],
  "stock" : [ {
    "id" : 22126,
    "quantity" : 162,
    "batch" : "AD 1002",
    "expiry_date" : "2014-09-30",
    "pack_size" : 1000,
    "sell_price" : 147.09
  }, {
    "id" : 22307,
    "quantity" : 12,
    "batch" : "3026844",
    "expiry_date" : "2014-03-30",
    "pack_size" : 1000,
    "sell_price" : 139.3
  } ]
}

Stock
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<90% 35%>

Resource name stock 
Fields you can query any in the items table or for all the items of a particular 

invoice with the field “trans_id” 
Typically, having located an item to add to an invoice you will

want to locate the total stock available for that item 
http://example.com/mobile/stock?
ID=123 // stock for item.ID 123

http://example.com/mobile/stock?
trans_id=123 // stock for 
transaction.ID 123

Returned: an array of match records containing the item ID
and the total stock quanitity like this 

[ {
  "id" : 5265,
  "quantity" : 30,
}, {
  "id" : 5275,
  "quantity" : 100,
}, {
  "id" : 5274,
  "quantity" : 50,
}
]

Stocktakes
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A note on creating stocktakes: the recommended process is:
Get a new stocktake id
Get items- this will also return the current stock on hand.
Display this, along with a column for the user to enter current stock on hand
When ready to save, post the data (below). Wasn't so hard! 

If the hardware id field is not showing 12 
characters &/or numbers, you do not have an 
ethernet card installed on your computer. 
Please consult us for installation instructions. 
Such cards can be purchased for $10 to $20.

<90% 35%>

Resource name stocktake 
Fields you can query any 

Fields returned from a query ID 
description 
stocktake created date 
status 

You can filter on type of stocktake by querying the status e.g. http://example.com/mobile/stocktake?
status=sg

Requesting a particular stocktake returns the following fields
for the stocktake itself 

description 
stocktake created date 
stocktake entered date 
status 
comment 
An array whose key is “lines” containing an these fields 
for each item in the stocktake: 
item code 
item name 
quantity (the pack size is assumed to be one) 
snapshot quantity 

Example the following request would return the information for the 
stocktake with an id of 123: 

http://example.com/mobile/stocktake/123

Special Case: Creating a stocktake First you need to get a stocktake id that you can use by 
requesting the resource “new_id” 
 
http://127.0.0.1:8081/stocktake/new_id
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mSupply registration codes are specific for 
the computer and organisation name and the 
expiry date of your licence (if it is time-
limited). If you change either your 
organisation name or the computer on which 
you are running mSupply you will have to 
contact us for a new code. (We may require 
evidence of the changes you have made 
before issuing a new number).
If the internet is accessed via 3G USB 
dongle, disconnect this device from the 
computer and to re-start mSupply. Then 
proceed with retrieving the computer's 
hardware details for registration purposes. 

Categories

Use this resource to return lists of different types of categories in mSupply.

<90% 35%>

Resource name category 
Fields you can query any 

Fields returned from a query id - the id of this category (unique only among categories 
of the same level) 
description - the descriptive name of the category 
type - the category's type. Can be one of 1level1, 1level2, 
1level3, 2 or 3 
parent_id - the id of the category which is the parent of this
one. 0 means the category has no parent 
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You can filter on type of category by querying the type (which
can take the values “item”, purchase_order“, “transaction”

and “name”) 

The following query will return all the categories for items 

http://example.com/mobile/category?
type=item

Catalogue Items

<90% 35%>

Resource name catalogueItem 
First URI segment catalogue 

Fields you can query any 
Fields returned from a query for each item id - the item's unique id code 

 Item - the item's code 
item_name - the item's descriptive name 
indic_price - the catalogue price of the item 
description - the lowest level category (category 1, level 3) 
that the item belongs to 
units - the units the item is provided in e.g. Amp (ampule) 
Tab (tablet), report_quantity - the pack size of the item in 
the catalogue, e.g. the following query would return all 
items with an id greater than -1 and a name beginning with
“a” 

* You can filter on the category that items belong to by querying the category number and level. There are 3 categories 
(1-3) but please note that category 1 is hierarchical; it has 3 levels - level 1 is the parent, level 2 categories are children 
of level 1s and level 3 categories are children of level 2s. So, altogether you can query category1level1id, 
category1level2id, category1level3id, category2id and category3id. Note that all queries by category will return items 
that belong to that category and those which belong to all its child categories e.g. this query will return all items 
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assigned to the level 2 category 1 which has an id of 4 and all items belonging to category 1 level 3 categories that 
are children of it:

Example http://example.com/catalogue/catalogueI
tem?category1level2id=4

Customer Stock History Items

<90% 35%>

Resource name customerstockhistory 
Fields you can query any 

Fields returned from a mulitple query id, date_entered 
Fields returned from a single id id, date_entered,stock_take_date, lines (array) 

The lines object array contains: 
 id (the id of the line, [name_s_h_line]id) 
item_id (the id of the item, [name_s_h_line]item_id) 
item_name (the name of the item - [item]item_name using 
[name_s_h_line]item_id) 
item_code ([item]code using [name_s_h_line]item_id) 
store_stock (the amount of stock (number of items not 
packs) the supplying store has of this item) 
stock_on_hand (the stock on hand entered by the user, 
[name_s_h_line]stock_on_hand) 
usage (this store's daily usage of this item. Calculated as 
(stock on hand last stocktake + stock received last 
stocktake - stock on hand this stocktake)/number of days 
between this and the previous stocktake. Use new 
[name_s_h_line]previous_stock_on_hand and 
[name_s_h_line]previous_received_from_us fields in the 
calculation) 
comment (the line's comment - [name_s_h_line]comment) 

Version

<90% 35%>

Resource name version 
Fields you can query none

Returned the current mSupply mobile version
Example: http://example.com/mobile/version

Master List

<90% 35%>

Resource name masterlist 
Fields you can query name_id, type (the type of list to return) 

Returned JSON containing the items for the associated masterlist 
belonging to the name of the specified type 

Example http://example.com/mobile/masterlist/na
me_id="123"&type=weborder

Settings

<90% 35%>

Resource name settings 
Fields you can query none. Precisely. 
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Returned A JSON object with three entities: timeout, name_id, 
name- This is the id and name of the customer or supplier 
or store

Example http://example.com/mobile/settings

Purchase orders

<90% 35%>

Resource name po 
Fields you can query id 

Returned JSON containing the Purchase Order details for the ID you
queried 

Example http://example.com/mobile/po/id="123"

Reports

<90% 35%>

Resource name report 
Query type with one of three options: type=currentstock or 

type=expiringstock or type=orderedvsreceived
Query parameters type=currentstock: none 

type=expiringstock&nummonths=xx where nummonths is 
the number of months in advance of the current date to 
compare expiry dates with 
type=orderedvsreceived&from=yyyymmdd&to=yyyymmd
d where the from and to dates in yymmdd format are 
entered.

Returned JSON containing the “Successfully sent” or any errors 
encounters 

Example http://example.com/mobile/report/type=c
urrentstock

POST/PUT - Sending data to mSupply

• Must include authentication header
• Data in HTTP body as JSON
• Two types of POST/PUT: New and Update
• For New records:

• Must use POST method without 'If-Match: *' header.
• Append the id of the record to be created to the resource: e.g. POST http://example.com/mobile/transaction/134

• For Updates to an existing record:
• Must use either POST method with 'If-Match: *' header or PUT method (headers ignored). e.g. PUT 
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http://example.com/mobile/transaction/134

Available resources

Invoices

<90% 35%>

resource name invoice 
Submit JSON containing 

Transactions

• Resource name: transaction
• Create a transaction

• Submit a JSON object containing:
• new_transaction_id (you must have already requested this from the server - see above )
• comment
• name_id
• lines (contains a JSON array:)

• item_id
• quantity

• Payload. 

{"id": 34592,"comment":"test 1","name_id":3,
   "lines":[
       {"item_id": 19697,"quantity":2},
       {"item_id": 22845,"quantity":1}
       ]
     }

• successful completion returns a JSON object with “invoice_num” and a number
• Assumed data: The following data is assumed and can not be submitted (will be ignored if you try)

• The transaction type: it's a customer invoice (“ci”)
• The store ID: it's the store you're logged in to.
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• The user: it’s the user who is logged in.
• The entry_date: it's today.
• The confirm_date: it's today.
• The status: will always be “cn” (confirmed).

• Updating a transaction: 
• for supplier invoice we are editing only hold status for now. So json payload would be: 

{"id":1002,"hold": "true"}

• for customer invoice we can also update line quantity

{"id": 34592,"comment":"test 2",
   "lines":[
       {"transline_id": 19697,"quantity":20},
       {"transline_id": 22845,"quantity":10}
       ]
     }

• Delete transaction lines:

• {"id": 34592,"comment":"test 2","lines":[<all_lines>]

Stocktakes

<90% 35%>

Resource name stocktake 
Method POST 

Submit a JSON object containing id (you must have already requested this from the server - 
see above ) 

Finalising a stocktake body: include an item “status” with value “fn” 
Assumed fields stock_take_created_date created_by_id finalised_by_id 

store_id 

<90% 35%>

example 1 {"status": "fn", id:123, 
stock_take_date:2013-02-08, 
description:8/2/2013 Stocktake, 
Comment: "test",
     "lines":[
         {"id": 
123,"item_id":234,"item_line_id":345,"i
tem_name";"test_item1";"snapshot_qty":3
00,"stock_take_qty":310},
         {"id": 
222,"item_id":232,"item_line_id":212,"i
tem_name";"test_item2";"snapshot_qty":4
00,"stock_take_qty":300}  
     ]
     }

if the previous status was “sg”, the mSupply server will 
now create the appropriate inventory adjustments, as well 
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as changing the status of the stocktake.

example 2 Submit a stocktake with status “sg” 
http://example.com/mobile/stocktake/123 
{"new_stocktake_id": 
34592,"description":"stocktake test", 
"status":"sg",
   "lines":[
       {"item_id": 
19697,"stock_take_qty":100},
       {"item_id": 
22845,"stock_take_qty":80}
       ]
     }

example 3 Finalise an existing stocktake 
http://example.com/mobile/stocktake/123 
{"status":"fn"}

Customer Stock History

Resource name customerstockhistory 
Method POST 

Submit a JSON object containing an array with 3 fields id
 requested_quantity 
user_comment 

DELETE - Delete Records

Available resources

Stocktake

• Deleting a stocktake
• e.g. http://127.0.0.1:8081/stocktake/123
• Method: DELETE
• Returns a JSON object containing a Description field with the value “stock take id xxx is deleted.” where xxx is the id of the 

stocktake deleted.

Invoice

• <add here>

Item

• <add here>

Errors

• Errors are returned as a JSON object with one item “error” whose text content is the error message
• e.g. 

{"error":"we can't take you seriously while you insist on wearing that 
cardy"}
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• Here is a list of error messages you might see. Most are self-explanatory:
• “No search parameter specified”
• “No query parameter specified”
• “Invalid resource specified”

• “Invalid sort field specified”
• “Invalid range header specified”
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Note that many preferences are now set on a 
per-store basis i.e. each store has its own 
setting for some preferences. See the Virtual 
stores chapter for more info.

• “No transaction with that ID found”
• “Invalid transaction ID specified” (Different to above, in that you specified a non-numeric or negative ID)
• “Yikes! Multiple transactions with same ID found” (you'll never see this error, or we'll be eating hats).

General Preferences
Updated: version 3.11

After Logging in to mSupply select File>Preferences. There is a side bar to the left. In order to see all the subject on the
sidebar, you need to scroll down the list. Clicking on a subject in the side bar shows the options for that subject:

General

Organisation name: This will print on the top of invoices. Note that your organisation name is tied to your registration 
code. Please contact info@msupply.org.nz for a new code before changing your organisation name.

Address lines (1, 2…): Enter the address information about your organisation that you wish to appear on invoices.

The Register button
This button will be dimmed once you have registered. If you have not registered, clicking this button will display the 
registration details window:
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If the hardware id field is not showing 12 
characters &/or numbers, you do not have an 
ethernet card installed on your computer. 
Please consult us for installation instructions. 
Such cards can be purchased for $10 to $20.

• Here you are provided with the two pieces of information you need to register:
• Your organisation name
• Your hardware id.
• Clicking the Copy details button will copy these two pieces of information to the clipboard, so you can paste them into an email 

and send them to us.
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mSupply registration codes are specific for 
the computer and organisation name and the 
expiry date of your licence (if it is time-
limited). If you change either your 
organisation name or the computer on which 
you are running mSupply you will have to 
contact us for a new code. (We may require 
evidence of the changes you have made 
before issuing a new number).
If the internet is accessed via 3G USB 
dongle, disconnect this device from the 
computer and to re-start mSupply. Then 
proceed with retrieving the computer's 
hardware details for registration purposes. 

• Once we have received your registration information we will generate a registration code for you. The code is entered by clicking 
the Enter code button in the window shown above. You will then be shown another window (below) where you can enter the 
registration details you have been supplied. Your registration instructions supplied with the registration number will describe what
information to put in each field.
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Default customer: Leave this field blank for normal operation. If you usually (or always) only issue to one customer, 
enter that customer's code here. You must set the value to the name code of an existing customer. Doing so will mean 

that this customer's details are automatically filled in when you create a new customer invoice.

Default margin: The percentage margin that will be filled in when you enter a new supplier. This value can be edited 
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for each supplier at any time. Enter “0” if you do not apply a mark-up to items you sell (For example, if you are issuing 
stock to hospital wards at cost) default tax rate will be applied to customer and supplier invoices. Note that this amount 
can be edited when you are entering an invoice by clicking on the tax rate at the bottom of the invoice entry window.

Next invoice numbers: You may increase the invoice number at any time, but there is no real need to do this. Some 
people like to start a new year with the numbers moved up to the next thousand or ten thousand.

Note that you can't decrease an invoice number below the highest number already used.

Note too that supplier invoices and customer invoices use separate sets of numbers - a supplier invoice and a customer 
invoice can have the same number without mSupply getting “confused”. This might confuse you though, and if this is 
the case increase the invoice number for one series (eg next supplier invoice number) to “50000” (or some such 
number) so the two series are very different.

Period Closing: There are two fields allowing the entry of dates:

The Closed date is the date prior to which no transactions can be entered. Setting the closed date means that all 
transactions up to that date are finalised and mSupply will not allow the entry of any transactions with an earlier date. 
The closed date can not be moved backwards- only forwards.

The Locked date is the earliest date that can be entered for a transaction. The lock date can be moved forwards as far as 
the oldest non-finalised transaction, and backwards as far as the closed date

If you try to set an invalid locked or closed date you will be warned.
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Be very careful setting the closed date. Changes to the closed date can not be undone.

Misc Preferences

Own code for electronic invoices The code that customers must have for your organisation in their copy of mSupply. 
This code is added to invoices you export, and allows customers to import the invoice into their system automatically.
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This is an old copy: warn me at startup. You may want to save an old copy of your data (for example the data as it 
stood on the last day of the financial year). If you check this box, you will be warned at startup if the database is an old 
copy, to reduce the risk of accidentally entering current transactions into an old file rather than your current file.

Use a lock file to warn if data already open If this box is checked, mSupply will maintain a record of when it is open 
outside of the database. This option only applies to the single-user version of mSupply. This means that if a second user 
attempts to open your data file while the data file is already in use, the user will be alerted, and no damage to the data 
will occur. Note that this option only applies to the single user version of mSupply. The client-server version of 
mSupply allows multiple users to access mSupply at the same time.

What if your machine crashes? If, for example, you have a power failure and your computer shuts down suddenly, 
mSupply will not be able to delete the lock file, and you will get a message when you attempt to restart mSupply that 
another user is already using the data file. If you are sure this is not the case, use Windows Explorer or the Mac Finder 
to locate the folder that contains your mSupply data. Delete the file that has the same name as your data file but ends in 
“_locked.txt”. You will now be able to start mSupply.

We recommend you do not turn this option on unless you understand the above paragraph or have a system 
administrator who authorises your use of this option.

An example of where turning on this option might be useful is when you store your mSupply data on a file server, and 
allow multiple single-user copies of mSupply to access the same data file. In such a situation to have 2 users attempt to 
access the data simultaneously would be disastrous.

Item codes must be unique When this box is checked, mSupply will ensure that each new item entered has a unique 
code.

Include catalogue code for item search When checked, a report can be produced where the item's catalogue code is 
one of the search parameters.

Currency formats This option specifies the format in which currencies will be displayed in mSupply. We provide two 
preset formats for currencies with 2 decimal places and currencies with none. If you want to enter a custom format you 
can change the field below the drop-down list. For example you may want to use a different separator than a comma. 
Note that if you type illogical values into the field the numbers may not display at all, or display erroneous data. Contact
Sustianable Solutions if you need more information.

Service items Service items are items that do not have any stock associated with them. For example, a fee for special 
handling of goods, or for reprinting an old invoice, or a consulting charge.

These Preferences determine whether new items are allowed to be service items or not. Note that changing this 
preference will not affect existing items.

Names

• Customer code and charge code must match - If checked, when entering or editing a Customer, you will have to enter the same 
code for both the “code” and the “charge code” fields. (It is a good idea to leave this checked unless you have several customers 
that are invoiced separately, but whose invoices are collated onto a single statement at the end of the month)

• Supplier code and charge code must match - If checked, when entering or edit a Supplier, you will have to enter the same code 
for both the “code” and the “charge code” fields. (It is a good idea to leave this checked unless you have several suppliers that are 
invoiced separately, but whose invoices are collated onto a single statement at the end of the month)

• Name code for all codes to be unique (both 'store' and 'dispensary' mode) - If checked, when entering or editing a customer or
supplier mSupply will not allow the creation of a second name with the same name code.

Labels for custom item fields

mSupply provides you with seven custom fields that you can use to record your own data for each item.

• the first three fields hold text or numbers,
• the fourth field is yes/no (or true/false)
• the fifth field is a numeric field
• the sixth field holds text or numbers
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• the seventh field is yes/no (or true/false)

Here you can specify the label(or name) for each field. Note that field one is also displayed when you list items. Note 
also that when using the search editor to search for items (for example when producing a custom report), the fields are 

labeled “user field 1” etc.., and not with the labels you might have assigned.

Label for field on cash payment or receipt invoice

One text field is available and the default entry Cheque is displayed. Again, this entry may be edited.

Purchase order default
For an explanation of the sections on Purchase order defaults go to 

Purchase order 2
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For an explanation of the sections on Purchase order 2 go to 

Invoices 1 and 2
For an explanation of these sections see 

Item
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Default account code for new items

• There are 3 spaces for you to select the accounts to use. Choose one account for expenses when buying, one account for income 
when selling and an asset account for stock.

• The accounts you enter here will become the default accounts for newly created items.

Item list (master & local)

If you check this box then, when creating item master lists (see here), items on the list will be made visible in the same 
stores that the name you are creating the master list for is visible. If the box is unchecked then the visibility of items on 
the list is not changed.

Assigning item codes automatically
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If you want item codes to be assigned automatically, check this checkbox.

Price

On checking the box for “Use customer price categories”, mSupply will activate the price categories.

599



Price Categories

By default all customers are assigned a price category of “A”

To assign a different category to a customer, choose Customers > Show customers… and find the customer entry. Then 
set the price category field to a different value

Here in the Preferences, you specify what percentage change to the default price will be made for each category.

For example, you might have a group of customers to whom you charge commercial prices, which are 20% above your 
normal price. Enter “20” in the “B” category field, then assign your private customers a price category of “B”

Ignore price categories for items supplied by these suppliers

Suppliers in this list will have no price category assigned to the items they supply. To add a supplier in this list, click the
Add supplier button. A window will appear with a space to write the supplier's name. You can write the first character 
or two and press enter/return to bring up a list of suppliers that start with those letters. You can then select your chosen 
supplier from the list. To delete a supplier from the list, highlight it by clicking on it and then press the Delete Supplier 
button.

Quotes

Require entry of quote validity date

Check this box if you want a validity date for a quote to be compulsory.

Automatically turn off preferred status after validity date

If you check this box then the preferred status will not appear when the validity date has passed.

Reports
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Check this box if you want negative stock values to be ignored on stock history reports .

Names

 Label list: In this list you can change the labels for name custom fields and categories - not the categories themselves 
(see here for instructions on how to do that) but the labels for the categories. To change one of the labels click on it in 
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the Custom name column to select it and click on it once again to begin editing it. Type the new name and then click 
outside the label to finish editing it. Now, wherever you would have seen that label in mSupply you will now see the 
name you have given it. The defaults are shown in the screenshot above.

Example: If category 1 (level 3) contained district information you could change the Category 1 label to 'District'. Then,
wherever you would have seen the label 'Category 1' in mSupply, you will now see the label 'District' e.g. in report 
filters.

Labels for custom fields on name category: Here you can enter labels for the custom fields used when creating or 
editing name categories. The labels you enter here will appear on the New/Edit category window instead of the 
Category_user_field_1 and Category_user_field_2 labels. These labels are used in some reports.

Tenders
The menu item File > Preferences or clicking on the View/edit preferences icon in the Admin section of the navigator 
will take you to the following screen where you can set the options relevant to the tender module:

Tender letter section

• Title: The title for the printed tender letter. If nothing is entered in here mSupply will use 'Invitation to tender'.
• Tender reference: The reference for the printed tender letter. If nothing is entered in here mSupply will use 'Tender reference'.

User details for Tender module section

We run a Remote tender module

Click this to indicate that you operate an mSupply® remote tender service where suppliers and you will log into a 
common web page to submit and download tender information. You will need to contact Sustainable Solutions for the 
account information required below before using this option. If this box is unticked mSupply® will use a local tender 
service.

Client ID This is the ID that you use to login to the remote tender web page. This will be supplied to you (and probably 
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entered in here) by Sustainable Solutions.

Password This is the password you use to login to the remote tender web page. Like the ID, this will be supplied to you
(and probably entered in here) by Sustainable Solutions.

Tender Module Address The internet address of the remote tender web page in the format IP address:port number. 
Once again, this will be supplied to you (and probably entered in here) by the indefatigable Sustainable Solutions.

Reminders
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Reminders provide a simple to-do list built into mSupply.

If the Show reminders on startup box is checked, any reminders that are not completed and whose due date has been 
reached will be displayed in a window when a user logs on.

See Reminders
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Patient Medication

Here you can add a header and a footer that will appear on patient medication records.

Drug interactions options
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Generally if the logo is used with the width 
twice the size of the height, then mSupply 
will display the image un-squashed.

When operating in dispensary mode, you can choose to have mSupply alert you to drug interactions. Dispensary mode 
is covered fully in this section

The number of days of patient history …. field determines how far back from the current date mSupply should look for 
drugs that have a known interaction with the drug you have just entered.

When drug interactions are activated, you will be shown a warning message when you enter a drug on a patient invoice 
that interacts with other medicines dispensed to that patient during the history period specified.

Printing
For an explanation of this section please go to 

OK and Print
For an explanation of this section please go to OK and Print.

Logo
Here you can paste in a logo you have copied to the clipboard; it must be in the form of a Bitmap (yourlogo.bmp) or a 
Tagged image format (yourlogo.tif). This logo will be displayed at the bottom right of the navigator.

If you want the logo to be printed on invoices, mark the checkbox.

Please note that not all printing forms include the logo. If you would like customisation or assistance, Sustainable 
Solutions can quickly customize forms for you to meet your requirements.
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Dispensary mode

Label Printing
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Message on labels

The text you type here will be displayed on medicine labels on its own line.

Custom identification code

If you wish to identify the origin of the dispensed item, e.g. In-Patient Dispensary or Out- Patient Dispensary, create an 
identification code, and enter it in this field. It will then appear as the last item printed on the the right of the third line 
of each label.

Printing options for units

Three options are available from the drop down menu. You can choose to always print the units on labels, you can 
choose for each item whether or not to print the unit or you can choose to never print the units.

Turn off cell padding in between direction and patient name

mSupply will automatically pad the cell (leave some space in the cell) between Direction and Patient name. If you do 
not want this to happen then check this box.

Print full prescriber name on label

To have the prescriber's full name printed on labels, check the box in Print prescriber full name.

Print organisation address 1 as separate line

By checking the box Print organisation address 1 as separate line , you can print organisation address 1 as separate line
. You have to set the text in Preferences: General »address 1 field. The text which you type here will be displayed on 
medicine labels on its own line. Print patient category on label Once you check the box of Print patient category , 
you are able to print the patient category on medicine label on patient name line. For this, you have to set the patient 
category in Preferences: > Dispensary mode .

Print Expiry date of Item on label When checked, the item's expiry date will be printed on the label.

Print Sales value of item on label When checked, the item's sales value will be printed on the label.

Print Patient code on label This will print the patient code on the label if the box is checked.

Print Batch on label When checked, the item's batch number will be printed on the label.

Don't print placeholder lines If this box is checked, placeholder lines will not be printed.

Print a receipt on labels by default mSupply allows you to print a patient receipt on a label; to enable this function by 
default, check the box Print a receipt on labels by default in Preferences:Dispensary mode as shown above. This has the
effect of enabling the “Print receipt” check box in the Prescription entry window . Note that if the Print a receipt on 
labels by default is not checked, the function may still be turned on in the Prescription entry window. 

For more information on printing receipts, see Dispensary Mode

Patients
Default Patient category The text you enter into this field will be assigned to the category field for new patients.

Default Prescriber name With the cursor in this field, enter the first letter or first few letters of the prescriber's name 
and press Tab. A window appears displaying prescribers who meet the criteria typed; note that both first and last names 
appear, and you should select the desired prescriber and click OK to make that prescriber the default one.

Auto-generate patient code If this box is checked each new patient created will have a serial number assigned to them.
The assigned code can be overriden by the user.

Prefix codes with The text you enter in this field will be used as a prefix for automatically generated patient codes. e.g. 
if you enter “t” codes will be assigned “t1”, “t2” etc.

Capitalise patient names Does what it says. The shift key will still override this option.

Prescriber must be entered If this checkbox is checked, then the user will be warned if a prescriber has not been 
entered when they click the OK button for accept and print a prescription.

Expand abbreviations in patient address fields In the patient address fields, any abbreviations will be written out in 
full instead of the abbreviation if you check this box.
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Share patient prescription over stores If this box is checked, viewing a patient history in one store will show 
transactions entered in other stores.

HIS

Log
The significant events which mSupply automatically logs are listed here. Additional events may be logged by checking 
the appropriate check boxes on this tab.
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Item What is recorded (Date, time, the user name are always
recorded) 

Invoice creation The log will record each new invoice (customer or 
supplier) created 

Invoice editing An invoice (customer or supplier) is considered to have 
been edited if its total value has changed. Both values, old 
and new, are logged 

Creating a new customer or supplier Whenever a new customer or supplier is created, their 
name and code will be recorded in the log. 

Modifying an item's supplier field The supplier field for each item can be used to determine 
to whom orders for goods are placed (depending on the 
type of order you generate). If you use this method, you 
may want to know if mSupply users change the preferred 
supplier for an item. 

User Login and Logout The log will record every occasion on which users login 
and logout. 

A batch is taken off hold The log will record every batch that is taken off hold (and 
so becomes usable) 

A customer invoice is confirmed When the confirm button is clicked, or an invoice is set to 
auto-confirm: the invoice number is recorded. 

A Stocktake line is added manually If a user manually adds a Stocktake line, this will be 
recorded in the log 

Please contact us if you need more logging than is provided here. It is a simple matter to incorporate into a future 
version - the trade-off is that it leaves the potential open to create very large log files, which may be a problem for some
users.

This Computer
The settings in this tab apply to the computer you are currently connected from. That means that if you are using 
mSupply in client-server mode you will see different values depending on which computer you are currently using.

Note that the computer is identified by it's network card, so if you change the network card you may have to re-enter the
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settings displayed here.
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Excel location

Here you can set or reset the location of your Spreadsheet application. Once mSupply knows this location, it won't ask 
you again. Clicking the button results in mSupply searching common locations for Excel. If it finds them it shows the 
window below. If it doesn't it shows an open/save window where you can choose the location yourself.

Click on the version of Excel you want to use and then click OK.

If Excel is installed in a non-standard location you can use the “add another” button to locate it and add that location to 
the list.

In client/server mode the location of Excel on each machine is stored separately.

Staroffice and Openoffice are also supported- if you use these applications just choose the “Soffice.exe” file instead of 
“Excel.exe”

Backup
Note - These Preferences are applicable only in single user mode; in client-server mode, the backup schedule is set on 
the server.

612



Activation
To activate , the Automatic Backup checkbox should be checked, then the appropriate radio button checked to have 
automic backups performed according to your requirements.

This function allows a backup of your datafile to be made. There are two types of backup available.

• Local backups are made to another folder on your computer, or to a networked folder.
• Internet backup allows for your data to be copied from a special backup folder to a secure internet site.- this applies to both single-

user and multi-user systems.

Local Backups
You can perform a backup manually File> Backup as well as automatically. It is not necessary to quit the database 
before performing a backup.

The settings in this window are to be used only for single-user mode. In client-server user mode you must set the 
backup Preferences on the server machine.

Choose backup folder

Click the “Choose” button to specify the destination of the backup files. For added security, we strongly recommend 
you backup to a different physical volume from the one where your mSupply data is stored.

We recommend running mSupply server as a Windows service. This allows automatic log on, and control of the starting
and stopping of the server from command line tools that can be run when a UPS is shutting down. Please contact us for 
more information.

Compression rate

Choose whether backups should be compressed or not from this drop-down list. Compact will give the smallest backup 
size, but it will take longer for backups to run. Fast is a compromise of speed and size.

Internet backups
If you are using an internet backup system such as Spideroak, Dropbox or Memopal, these options allow you to set up a
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folder that is watched by your backup software and backed up to the internet

Verify data file after backup

mSupply allows you to verify the data integrity of your main data file each time a backup is made. This is extra 
insurance against hardware failures and other factors that can lead to data corruption. Check this box to activate.

Restore last backup if database is damaged

Check the box to activate this preference.

Use log file

Email results of check… If you check this option Sustainable Solutions will receive by email a report of the data file 
verification each time it is run. Note that no confidential information is transmitted with the report.

Integrate last log if database is incomplete

If this checkbox is checked, then if your data becomes damaged, mSupply will automatically restore the data from a 
backup and use the log file to restore all transactions between the date of the backup and the current date.

Backup 2
Here you can set the secondary backup location.

This is useful for making copies of just some of your backups that you can then upload to a cloud-based backup service 
for automated off-site backups.

Automatic backup to secondary folder:

Checking this option results in mSupply trying to copy completed backups to another folder which you specify with the 
Choose button below. Fill in the Backup every …..th file… field with number of backups out of which one copy will be 
kept. That is, entering 7 will result in one backup per week being copied.

You should now configure your online backup software to use the folder chosen as the secondary backup location as the
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source folder for backups. Note that if you have plenty of upstream bandwidth, you might simply wish to set your main 
mSupply backup folder as the source folder.

The duplication and block-level comparsisons that services such as Spideroak use mean that it may be better for you to 
use uncompressed mSupply backups, as then only the changed portion of your data file will be backed up.

Secondary backup options 1, 2, 3

mSupply now allows you to make up to 3 secondary backups to separate locations if you would like to. You can use 1, 2
or all 3 if you would like to. At least one is recommended for security purposes.

E-mail
You can choose to send orders, reports, invoices and notifications to recipients using e-mail in mSupply. However, 
before mSupply can send anything by e-mail you must tell mSupply about the server you wish to use and details of the 
e-mail described below: 
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Provide me with a mail server to send emails

If this is checked you will use mSupply's own internal email server to send emails. If it is unchecked you will use your 
own email server, the details of which you must enter in the Mail server name, Username, Password, Port and Use SSL 
fields. 

Mail server name

The name of your mail (SMTP) server. eg “mail.mac.com”. You can only enter this if you are not using mSupply's 
inbuilt e-mail server (i.e. Provide me with a mail server to send emails is unchecked).

User name

The username mSupply will use to authenticate itself to the mail server. Only needed if you are not using mSupply's 
inbuilt e-mail server (i.e. Provide me with a mail server is unchecked).

Password

The password which goes with the username. (Only when not using mSupply's e-mail server)

Use SSL

If this is checked mSupply will use the Secure Socket Layer protocol to send e-mail. A more secure way of sending e-
mails. (Only when not using mSupply's e-mail server). Only check this if your mail server can support SSL.

Port

The port on the mail server which mSupply will send e-mail to (must be the same port the mail server is listening on!). 
(Only when not using mSupply's e-mail server)
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Return email address

Enter an email address you would like any response to come to. mSupply cannot send email unless it also has a return 
address for email. 

Signature

The text you enter here will be added to the end of all e-mails you send. You might want to put your organisation 
contact details here. It is generally poor etiquette to make your signature too long.

By default use a mono-spaced font to view text

A mono-space font such as “Courier” or “Monaco” is better for viewing text in columns, such as is produced by the 
automatic order generation in mSupply . However, visually it has less 'eye appeal'.

Default subject line when creating orders

When mSupply automatically turns an order for a supplier into an email, the text entered here will be put in the subject 
line. For example you might want to put “Acme Hospital order” to advise the supplier of its contents. Note that you can 
edit the subject line of automatically generated emails before you send them.

Sort order lines for email and HTML export by item name

This option allows emails generated automatically to be sorted alphabetically by item name before the email is created. 
If this option is left unchecked, emails will use the creation order of the order lines to create the email.

Web server

Note. To use this feature an additional licence is required. Please contact Sustainable Solutions for further information.

mSupply includes a built-in web server.
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Starting the web server

The web server can be set to start automatically when mSupply starts by checking the box, or manually as and when 
you use the service by clicking the button.

Run Webserver on the following port

The default port is 8080.

Disable the Customer order web module and display the following message:

If for any reason you want to take the customer ordering module off line you can choose a message to display for your 
customers.

Time out

For clients connected via a web browser, this is the maximum period of inactivity, after which the client must log in 
again.

Default store for web interface

Choose which store you want to be the default for the web interface (only applicable if you have more than one store). 
Be careful when changing this option because it will change the default store that all the web interfaces will use to get 
information from mSupply, not just one of them.

User can create XX uncompleted orders at a time

This limits erroneous submission of too many orders. Choose the maximum number of orders that a customer can make.
If they have reached the maximum amount, they will be able to create more when other ones are completed.

Maximum allowable time a mobile interface request can take

This sets how long mSupply will keep trying to supply report data before it gives up and displays an error message.

Synchronise
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For an explanation of this section please go to .

Customisation Options

Should a client wish to have customised features which are specific to their version of mSupply, we are happy, 
whenever possible, to incorporate such features.

If you are running such a customised version of mSupply, you will have received from us a Customisation code . To 
activate the customised features, that code must be entered in this field.

Moneyworks

If you use the superb Moneyworks accounting software, you can have mSupply directly input invoices into 
Moneyworks.

Contact info@msupply.org.nz for more information on these options.

Visit http://www.moneyworks.sussol.net for more information on Moneyworks, including a free demonstration version.

Link to Moneyworks accounting software

The Moneyworks application must be installed on your machine, and this option establishes a link between mSupply 
and Moneyworks. Don't turn it on if you don't know what you're doing, or if you haven't set up Moneyworks as 
described below.

Three options are presented in the drop down menu:

• Gold - select this option if the Moneyworks application you are using is the one installed on your computer.
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• Gold Client - select this option if you are connecting to the Moneyworks application installed on another machine on your 
network.

• Data Centre Client - select this option if you are connecting to a Moneyworks Data Centre

Export to Moneyworks when finalising individual invoices

This allows for production of individual invoices, e.g. for non credit customers, who make cash purchases; if you have 
such customers, check this box , but if all your customers are credit customers, receiving monthly statements, it may be 
left unchecked.

Location of the Moneyworks application

mSupply needs to know the location on your computer of Moneyworks , and by clicking on the Choose button, a 
window appears, and you should navigate to the location of the Moneyworks .exe file

Document Log on

Enter your logon details to access the Moneyworks document that you want to access.

Data Center Log on

If you are using a partitioned data center, enter your logon details to gain access to the partition where your document 
resides. If you are not using a partitioned data center then leave this section blank.

Location of the Moneyworks document (datafile)

You need to identify the Moneyworks document (datafile) you are using

If your link is to Gold, this is done by clicking on Choose , and navigating to the file's location. If access to the file is 
restricted, you need to complete your user name and password in the fields under Document Logon

If your link is to the Client option, when you click on Choose , a window appears and you need to enter the name of the 
Moneyworks datafile to which you are connecting; the file's restrictions will require you to enter your user name and 
password in the fields under Data Centre Logon

Type of customer invoice export

The drop down menu allows you to choose from several options:

• Single income account
• Separate income accounts by item account
• Choose for store

I.P. address of machine using Moneyworks

You only need to fill in the I.P. address here if:
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• You are on Macintosh and
• You are connecting to a remote machine across a network.

If you are on Windows or a Mac connecting to a local installation of Moneyworks, make sure this field is empty.

Notes on setting up Moneyworks:

• The import into Moneyworks relies on using an import map. The map for supplier invoices must be named “si_import.impo” and 
the map for customer invoices “ci_import.impo”. These map files must be stored in the “Import Maps” folder inside the 
“Moneyworks Customer Plug-Ins” which is next to your data file.

• The advantage of using import maps is that it gives you flexibility in deciding which accounts will be designated for sales and 
purchases, and the way the fields exported from mSupply are used inside Moneyworks.

• If you would like sample import maps from Sustainable Solutions, please email us at info@ss.org.np.
• Once you have set up the import maps and turned on the “Link to Moneyworks accounting software” checkbox, mSupply will 

attempt to send invoices to Moneyworks that are finalised using the “finalise customer invoices” and “finalise supplier invoices” 
commands.

• Note that the “Export invoices when finalising” option must also be checked. (See Preferences> Invoices)
• If you get an error when exporting, usually you will get a message telling you what the problem is. Things to check include
• Is Moneyworks running …… it must be!
• Make sure the correct I.P address is specified if connecting to a remote machine on Macintosh.
• Make sure any charge codes used are actually present in the Moneyworks data file you are using. We can supply a version of 

mSupply that automatically adds names to the Moneyworks data file if they aren't found when exporting, but this costs extra!
• Make sure that Moneyworks has open periods for the dates of the invoices that are about to be imported.
• If you still have no success, turn off the Link to Moneyworks. .. checkbox, and produce a file. Then manually import the records 

into Moneyworks using the File > Import > Transactions command (making sure you load the correct import map using the 
“Load” button). The file has errors, Moneyworks will give a more complete error report.

• Note that if export to Moneyworks is not successful, the transactions will not be finalised in mSupply, so you will not get invoices 
that are missed in Moneyworks.

We are also able to provide a similar option to link with Quickbooks accounting software. Please contact 
info@ss.org.np if this is of interest to you.

FrontlineSMS
If you use FrontlineSMS for sending information to mSupply via SMS messages (using mobile phones), this is the tab 
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where you enter all the settings.

For an explanation of this tab please go to 

Adding/editing users
Only users who have been added to the mSupply user list can log in.

User permissions and allowed log-in modes may be viewed and edited here - Managing users

LDAP
This section is about Lightweight Directory Access Protocol.
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Server URL or IP

Enter the URL or IP address for your LDAP server.

Port no.

Enter your LDAP port number.

Dashboard
Before the settings in this section will work you must make sure your webserver is currently running. See Webserver. 
Most users will find it easier to request mSupply support to set this up for you.

To set this up you need to know: What ports are already in use To either have a Self-signed or a digitally signed SSL 
Certificate set up. mSupply recommends Digitally Signed.
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1. Enter an unused port number into the Port field. 2. Tick the SSL box. 3. Tick the We use the dashboard box.

Then restart your mSupply application.You will see the page populated with a range of reports you can then select to 
display on your Dashboard. You tick the reports in the Is active column to select them for display on your dashboard 

and you can also choose how often these reports are updated by clicking in the Update Period (mins) column and 
entering a number of minutes.
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Previous: Statistics (HIS) Next: Report Basics
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Invoices Preferences

Invoices 1

All invoices
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Allow editing tax rate and amount on invoices:
When checked the tax rate can be changed when entering an invoice. Otherwise, the default tax rate is always used. (On
supplier invoices the actual tax amount can be directly edited if this option is checked. This allows perfect matching of 
tax amounts with amounts charged by a supplier).

Allow entry of dates on invoices:
Normally the date is filled in with the date the invoice is created. If you need to enter your own dates, check this option. 
Note that you will not be able to modify the dates on finalised invoices.

The entry date is still maintained by mSupply. You can only edit the confirm date.

Export invoices to disk when finalising:
If this box is checked, each time you finalise customer or supplier invoices, a tab-delimited text file of the finalised 
invoices will be created. This allows you to import the data into an accounting application.

After deleting lines, redo the numbering:
If this box is checked, deleting invoice lines will result in all invoice line numbers being updated so there is no gap in 
the numbering. 

Activate budget module:
In order to use the Budget feature, this box must be checked. This feature is applicable to store mode only. For more 
information on the budget module see The budget module

Activate Ad Hoc items:
Ad Hoc items allow you to receive and issue items that you will only use once. That is, you have ordered the item for a 
particular customer, and do not want to hold it in stock. For further information, see Ad Hoc items

Round prices:
You can choose to round prices to a given number of decimal places. By default prices will be rounded to 2 decimal 
places.

Supplier Invoices

Allow editing margins on supplier invoice lines:

If this option is chosen, you can edit the margin for individual supplier invoice lines. Otherwise the margin will be 
locked at the margin set for that supplier in the window for editing supplier details (reached from the supplier > edit 
supplier menu.)

Hide batch number & expiry date entry:
Some people use mSupply for inventory control of all sorts of general goods. Hiding these fields will speed up entering 
information if you do not use those fields.

Show comparative purchases for supplier invoices:
When checked, the window shown by the new line button on supplier invoices will have a list at the bottom that 
displays recent purchases of the item you enter.
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For some reports, the default setting includes 
all items, and as most stores will have several 
hundred items - maybe over 1,000 - reports 
on all items will, if printed, use a great deal 
of paper. If you must have a printout of your 
report, please exercise caution when 
selecting the criteria, and so avoid wasting 
paper.

Item margin overrides supplier margin on supplier invoices:

When receiving an item where there is a margin set for both the supplier and the item, if this option is checked the item 
margin will be used. If unchecked, the supplier margin is used.

Activate supplier payment module:
Check this box if you want mSupply to record the outstanding amount to be paid on each supplier invoice. If this 
system is not activated, supplier invoices will display a zero amount outstanding. (If you use a separate accounting 
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system, and us mSupply's export facilities, there is no need to use the inbuilt payment system).

Warn if expiry less than XXX days:
An appropriate figure can be entered .

Disallow "Remove hold" status if zero sell price:
If this option is checked you can't receive goods that haven't had their sell price set.

Sell price changes affect un-finalised customer invoices:
If you tick this, when you update a sell price the change will be reflected in all non-finalised customer invoices. You 
will be asked to confirm ticking this box because it can make irreversible changes to customer invoices. Here is a table 
that shows the differences with having this preference turned on or turned off

Original invoice

Item Date Invoice type status price 

Amoxy 250 15 Feb Supplier invoice cn 8.00 

Amoxy 250 15 Mar Customer invoice cn 8.00 

Amoxy 250 15 Apr Customer invoice cn 8.00 

Amoxy 250 15 May Customer invoice fn 8.00 
With preference turned off

Item Date Invoice type status price 

Amoxy 250 15 Feb Supplier invoice cn 9.00 

Amoxy 250 15 Mar Customer invoice cn 8.00 

Amoxy 250 15 Apr Customer invoice cn 8.00 

Amoxy 250 15 May Customer invoice fn 8.00 
You have found that the price should have been 9.00 No customer invoices are updated. Reports on old customer 
invoices will show the old price of 8.00

With preference turned on

Item Date Invoice type status price 

Amoxy 250 15 Feb Supplier invoice cn 9.00 

Amoxy 250 15 Mar Customer invoice cn 9.00 

Amoxy 250 15 Apr Customer invoice cn 9.00 

Amoxy 250 15 May Customer invoice fn 8.00 
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You have found that the price should have been 9.00 Old customer invoices are updated unless their status is “fn”. 
Reports on old customer invoices will show the new price of 9.00 (as long as no invoices were finalised)

Show inner and outer pack fields:

If checked, mSupply will allow the entry of the `inner' and `outer' pack sizes - if an item is packed 100 to a container, 
and 12 containers to a box, the `inner' field entry would be `100' and the `outer' field entry would be `12'

Hold invoices by default:
If checked all newly created invoices will be on hold

Allow tracking of received stock by donor:
If checked, this option allows the user to track donated stock from source (supplier Purchase Order) to store (available 
for distribution in mSupply).
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Invoices 2

Customer invoices
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These options apply to customer invoices only.

We run a backorder system

Check this item if you want to record backorders for customers for supply at a later date (For suppliers, backorders are 
recorded in the ordering system as partially supplied orders).

Note that if you use a backorder system it will affect the way “placeholder” lines are handled.

A placeholder line is a line entered on a customer invoice which does not have any stock associated with it. Placeholder
lines can have an item name, a quantity, and a pack size, but the batch number is set to “none”.

When you confirm an invoice, if you are using a backorder system, placeholder lines will be transferred to make 
backorders. If you are not using a backorder system, placeholder lines will be deleted if the option below is turned on.

Auto-issue customer backorders when stock arrives

Check this item if you want stock to be automatically issued to a customer with a backorder when it becomes available.

Show transport details

If this box is checked, then a transport details button will be shown on customer invoices, allowing editing of transport 
details (arrival dates, etc) and box numbers.

Allow placeholder lines on customer invoices

If you leave this box unchecked, all lines on an invoice will have to be actual stock. If you run a backorder system you 
must check this box.

Show notes in store mode

If this box is checked, the window for issuing stock will be enlarged to show the area to enter abbreviations and 
customer directions or notes under store mode. These notes print on invoices after each invoice line.

Show direction entry in dispensary mode

If this box is checked, the window for issuing stock will be enlarged to show the area to enter abbreviations and 
customer directions or notes under dispensary mode. These notes print on invoices after each invoice line.

Activate customer receipts module:

Check this box if you want mSupply to record the outstanding amount to be paid on each customer invoice. If this 
system is not activated, supplier invoices will display a zero amount outstanding. (If you use a separate accounting 
system, and use mSupply's export facilities, there is no need to use the inbuilt payment system).
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Show item category while issuing goods:

If you are making use of the item category facility, checking this box will allow you to see the category of the item you 
are issuing as it is being issued.

Show 'nw' transaction created by user on log-in

If you check this box then a user will be able to create a 'nw' transaction when they log in and this will be shown.

Choose contact for transport details

Checking this box allows you to choose a contact from your list of contacts when entering transport details.

Show customer transaction fields:

There are 4 customer transaction fields available for customised entries; their use is optional, and should you wish to 
use them, they have to be activated here, where the Show custom transaction fieldscheckboxes should be checked. You 
will note that they are grouped in pairs, 1&2 and 3&4, and this is also the window which allows you to define names for
the fields; for example, you might wish to identify the person preparing the invoice and so give field 1 the name 
Prepared by; similarly the person authorising the invoice could be entered in field 2, which would be named Authorised
by

Warn if expiry is less than XXX days:

Entering a number in this box causes mSupply to alert the user when any item selected is due to expire before this 
number of days has passed.

Disallow issue of goods with short expiry:

If this option is checked, mSupply will not allow issue (customer invoices, prescriptions) of goods with an expiry date 
less than the number of days specified here. Goods with no expiry date will not be affected. Note that once this 
preference is checked, there is no way for the user to override it- the rule is enforced until the preference is turned off.

Enter zero in the field to disallow entry of goods that have expired.

Note that inventory adjustments and supplier credits can still be issued to remove goods from stock or return goods to a 
supplier.

Activate restricted item access by customer group:

When this check box is checked, any item that is assigned to a department may only be supplied to customers who are 
members of groups linked to that item's department.

See the section in the Item Menu chapter on the Manage item access… for more information on how to set up item 
departments, customer groups, and how to link groups to departments.

Warning: Checking this item may mean that some items can not be issued. Make sure you have set up the item access 
system properly before proceeding.

Delete placeholder lines when confirming invoices:

When checked, placeholder lines are deleted when the invoice is confimed.

Print the following message for placeholder lines:

When this box is checked, the message typed in this field will be printed in the batch column for placeholder lines. For 
example, you might enter “backorder” to show these lines will be backordered. If you check the box and leave this field 
blank , the batch field will be empty.

Require category entry on customer invoices

If this option is checked, when entering customer invoices the user will be required to select one of the available 
transaction categories. Transaction categories are set up using the Special > Show transaction categories menu item. If 
no transaction categories for customer invoices have been set up, this option will have no effect.
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Hold invoice by default

Invoices will be put on `hold' if this box is checked.

Customer order written date must be entered

The date that the customer wrote the order must be entered on invoices when this box is checked.

Customer ordered date must be entered

The date on which the customer ordered the item must be entered on invoices.

Other invoices

Allow customer to enter stock balances and request on stock history

Checking this box allows a customer to enter the quantity of stock they have and mSupply will file it as part of their 
stock history and calculate how much needs to be sent to them to replenish their stock.

Invoice Printing preferences
Please see 

Back to: 

Printing Preferences
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Preferences related to the printing of invoices appear in this window, allowing users to customise the printing of 
customer invoices.

Invoice printing

Drop down lists for customer and supplier invoices

Here you can choose the form you want for printing invoices. There are separate choices for customer invoices and 
supplier invoices. We recommend that you choose the Use Pagepro Form option.

Number of lines to advance the paper on dot matrix printers

This is only applicable if you use a dot matrix printer. Here you can enter a number of lines to advance the paper when 
printing.

Form for printing picking lists

This option is for invoices with the status 'sg'. You can choose your preference from the drop down list. We recommend 
that you choose the Use Pagepro Form option.
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Don't print placeholder lines on invoice

Check this option if you don't want placeholder lines to appear on your printed invoices.

Don't print placeholder lines on pick slips

Check this option if you don't want placeholder lines to appear on pick slips that you print.

Don't use label printer for prescriptions

Check this option if you want to use a different printer (not the label printer) to print prescriptions.

Print store name on invoices

This option allows users who have multiple stores to print the name of the issuing store on their customer invoices. 
[Most users will leave this option unchecked.]

Print backorders on invoice by default

If you check this box any backorders for this client will be listed on the invoice.

When printing a pick list...

Sort by...

This refers to how the items on the list are ordered. You can choose to sort by

• line number: the order in which they were entered
• shelf location: which will enable a “logical” order for picking goods from the shelves

You can also set a priority for shelf locations, and this will override the default alphabetical ordering i.e. locations with 
a priority of 1 will come first (in alphabetical order), then those with a priority of 2 etc., with priority 0 locations at the 
end.

Print separate pick lists for these locations

By default mSupply will print a single pick list for all locations. If, for instance, you need separate pick lists printed for 
cool store items (whose locations in your store start with “CS”), and for Dangerous drugs (whose locations in your store
all start with “DD”), you would enter “CS,DD” (no quotes, each location separated by a comma) in this field. If a pick 
list being printed contains CS items, they will be printed separately, and the same for items with a ”DD” location.

Print store name on pick lists

This option allows users who have multiple stores to print the store name on the pick lists. [Most users will leave this 
option unchecked.]

Title of special invoices
In this space you can enter a title that will be shown when you print a special invoice. Special invoices are typically 
used as narcotic receipt forms.

Edit messages on printed forms
If you would like to print a particular message on one or multiple printed forms you can do that here. Choose the 
appropriate form from the drop-down list (menu), and then click the Edit button to edit the message that will appear on 
the bottom of every form of that type. For example, you may use the special invoice for issuing narcotics, and have the 
following message:

  * I have received the above Narcotics.
  * Signed:.........................
  * Print name:..................
  * Position:.......................
  * Date:.............................
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A message on a pick list might be as follows:

  * Packed by:..................
  * Date/time:..........................
  * Checked by:........................

When you have written the message, click OK and you can either add another message to another form (choose another 
one from the drop down list) or move on to another preference.

Printer choices
This option allows the choosing of a particular printer model when printing invoices. We hope to add more printer 
models `over time'.

If you are not sure what to choose, leave this option set to None - show page setup. Then when you click Print to print 
an invoice, the Page Setup window will appear and you can choose printing preferences from there.

If you choose the name of a printer, when you print an invoice the page setup and print windows will not be shown. 
Instead, the invoice will be printed directly using the print setting stored for that printer. 

Other

Print customer statement balance on invoices

If this item is checked and you are using the mSupply cash receipts system, the outstanding customer balance will be 
printed at the bottom of each invoice.

Print subtotal and tax on invoices

If you are adding tax (VAT, GST or Sales tax) to your invoices, check this option to show a subtotal and tax amount.

Default header/footer on reports

There are two spaces here. In one you can enter the header that you would like to appear on reports by default. The text 
will appear on the top left header for most reports. A common use of this space is to include your organisation name.

In the other you can enter the default footer. Text you enter here will appear on the bottom centre space of each page of 
reports. You might use this space to include a confidentiality clause on your reports.

OK and Print

Checking these boxes means that the printing checkbox will be checked by default when the corresponding window is 
opened.

Note that you can still manually turned the option on or off in a window- these settings just affect the default value.

Back to: 

Purchase Order Preferences
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Purchase Order Defaults
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This window allows you to enter text that will be printed on Purchase Orders.

The easiest way to see how these fields will look on a Purchase Order is to fill in the fields and then print a sample 
Purchase Order. Note that we are willing to design custom Purchase Order forms to meet individual needs.

Purchase Order 2

Print signature section on Purchase Orders

When this box is checked a section will be printed on Purchase Orders that shows the authorising officer(s) and includes
a space for signatures. This is applicable if you print Purchase Orders and post them to suppliers, but should most likely 
be turned off if you send Purchase Orders via email.
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Number of decimal places for price field:

This field allows you to specify the number of decimal places that may be entered in the price field on Purchase Orders. 

This will override the currency format setting in tne Misc tab only for the price field on Purchase Orders.

Prefix printed Purchase Order number with

Enter any required prefix in this field

Default number of days usage to evaluate when creating an order

Enter the number of days to “look back” when evaluating each item's usage to calculate the amount of stock needed. 
Entering a higher number will give a better long term average, but will mean that orders take longer to create.

Re-use deleted order number

Check if you would like a deleted order number to be used for a new order.

Print item long description by default

Check if required, leave unchecked if not.

Purchase Order category must be chosen

Check if you need a Purchase order category to be chosen on every purchase order.
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When clicking the OK button on a purchase 
order you can override this setting by holding 
down the shift key as you click OK

Expected delivery date must be chosen:

Check if required, leave unchecked if not.

Show purchase order custom field

Check this box if you would like an extra field added that you can customise and use for your own purposes.

The space below this check box is for you to enter the name of your custom field.

Purchase order contract date must be entered

If you require this information on your purchase orders then check this box.

Purchase order advance payment date must be entered

Check if required, leave unchecked if not.

Purchase order received at port date must be entered

If you require this information on your purchase orders then check this box.

Labels for custom fields on Purchase Order categories:

Fields 1 and 2 accept text entries, field 3 accepts numeric entries. The use of these fields is optional.

Back to: 
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Synchronisation
Note that the main page describing synchronisation is Remote Synchronisation

Synchronization is the process whereby mSupply® maintains data integrity between a master mSupply® server and 
'satellite' or 'slave' mSupply® servers. It therefore only applies to situations where there is a multi-mSupply® server 
setup. In this process the master server will maintain a copy of all the data from the satellite servers as well as its own. It
will also maintain a master list of names and items which are 'pushed' to the satellite servers (items and names can only 
be added, deleted or modified on the master server). So, using the master server to run reports will allow you to report 
on data from the master and all satellite servers. Each satellite server only contains data from its own location.

General
These settings will normally only be changed by Sustainable Solutions. They are not intended for general use by 
customers.
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Click to Un-lock button: Altering these preferences can have serious consequences for your mSupply® data so they 
are protected by an authorisation code. Click on the 'Click to Un-lock' button and you are presented with the following 

screen:  To continue and edit the synchronize preferences enter your authorisation code in the box and click on the OK 
button. To return to the preferences screen without unlocking the synchronize preferences click on the Cancel button.

Max no of stores: This is the maximum number of stores that can be synchronized with the master server. There can be 
more than one store on any one satellite server. (Note: this setting is not actually used at the moment but may be used in 
the future).

Sync time interval: This is the time interval in minutes between requests for new information that the satellite servers 
make to the master server.

Synchronize parameters
Sync ID: The ID of the current store to use in the synchronization process. You choose this - a number between 1 and 
64. This must be unique to each store to be synchronized. ID 1 is reserved for the master server (so, if this is the master 
server put 1 in here).

Client store to Synchronize: The store on this server to use in the synchronization process. If this is the master server, 
this store will contain the master lists of names, items etc. used by all the other stores included in the synchronization 
process.

User name: Communication between the master and satellite servers is authenticated. This user name and the password
field must match what the master server is expecting. So, you can enter any valid username and password in these fields
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but they must all be the same for the master and satellite servers.

Password: See above.

Sync with:

This list contains the names of the servers to synchronize with. If this is the master server all the satellite servers will be 
identified in this table. If this is a satellite server then the master server only will be identified in here. Click on the '+' 
button to add a server to the list (takes you to another window where you enter the Sync ID, Name, Store and URL for 
the server to synchronize. Note that these values, except URL will have been entered in this page on the servers hosting 
the stores selected. Make sure you enter the right values! The URL field contains the full URL of the server hosting the 
store to synchronize) and the '-' button to delete a server you have selected in the list.

Back to: 
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FrontlineSMS
If you use FrontlineSMS for sending information to mSupply via SMS messages (using mobile phones), this is the page
where you enter all the settings.

The settings and what they mean are as follows:

We use FrontlineSMS:

Checking this makes mSupply periodically check the FrontlineSMS database for messages that have been sent to 
mSupply. If this checkbox is left unchecked, mSupply ignores all the settings on this page and will not check the 
FrontlineSMS database for new messages.

FrontlineSMS database (MySQL) settings
To use FrontlineSMS with mSupply, FrontlineSMS must be configured with a MySQL database. In this section you tell 
mSupply the details of this database to enable it to connect to it and retrieve new messages.

Server:

The name of the server hosting the FrontlineSMS database. You can enter the server's name e.g. myserver.mydomain or 
its IP address.

Database name:

The name of the FrontlineSMS database. This is the name it was given when it was created in MySQL.

User:

The username that mSupply will use to log into this database.

Password:
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If a connection cannot be made to the 
database when clicking the Test Connection 
button, the exact error message returned from 
MySQL is stored in the log. To view it go to 
Special > View log. This can be very handy 
when trying to figure out why you can't 
connect to the FrontlineSMS database.

The password that goes with the username above.

Port:

The port that the database is served at on the host. If you leave this blank, mSupply will set it to the default port used by
MySQL (3306).

Test Connection Button:

This button will test the connection to the FrontlineSMS database using the settings above. You should click it after 
you've entered all the settings or when you change any of them. It will tell you whether the settings allowed mSupply to
connect to the database.

Check database every //x// mins. for new messages:

This is the time in minutes between checks of the FrontlineSMS database for new messages. The minimum is 2 minutes
and if you don't set it, this is the value it will be given.

Message settings

Keyword to identify mSupply message:

646



This is what mSupply looks for at the very beginning of an SMS message received by FrontlineSMS to identify it as 
one that it must process. Can be made up of any alphanumeric characters. Keep it short and unique - not something that 
will appear at the beginning of any SMS messages not intended for mSupply.

Error Messages and Notifications
Because the process is otherwise silent, mSupply needs to notify users when a new message has been processed or if 
errors occur in the process (e.g. a message is missing some information). mSupply will email such error messages and 
notifications to the users ticked in the list in this section. The list contains all users in the system and you must select at 
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least one of them.

Back to: 
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For some reports, the default setting includes 
all items, and as most stores will have several 
hundred items - maybe over 1,000 - reports 
on all items will, if printed, use a great deal 
of paper. If you must have a printout of your 
report, please exercise caution when 
selecting the criteria, and so avoid wasting 
paper.

More on Pagepro coming soon

The PagePro Report Editor

• As of version 3.03 mSupply includes the PagePro report editor.
• The graphic below shows the standard mSupply pick list being edited in PagePro.
• It gives almost unlimited customisation possibilities for forms and reports.
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Previous: Next: 

Custom Reporting Tutorial
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The custom report window is displayed allowing you to create a report according to your own requirements using the 
Quick Report editor; once created you may save the form of the report in the custom reports folder for future use.

The window requires you to make three choices:

Report table

A list of tables on the left to choose which table (which type of records) you want to report on, e.g. Names, Items, etc.

As of version 1.6 there are two options for transaction lines. The “Transaction lines (Transaction query)” option allows 
you to search much faster on a large number of transaction lines. For example, if you are wanting to get the quantity of 
each item given to customers in a specific month, you would use this option.

Which records
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A series of radio buttons to choose which records to examine

• All records
• New search (query), if you want to report on records meeting specific criteria. If chosen, you will be presented with the Query 

(search) editor, where you can build search statements to your heart's content! A short description of using the query editor is 
given below, and two example searches are later described. For a more comprehensive description, a range of books is available 
either in electronic or hard copy versions. Please email info@msupply.org.nz for more information.

• The “Current selection” is the group of records that were last displayed. For example, you can use the Item | View or edit item 
command quickly to find all items starting with “a”. When you click the OK button, the items in the list are the “current 

selection”. If you are not sure which records represent the current selection, you should click the “new search” radio button.

Report form

A drop down list displaying available options

• New report
• After clicking the OK button you will be presented with the report editor where you can design a report. The report editor is 
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somewhat complex, but time spent in learning how to use it is time well spent. It is a powerful and invaluable feature. A brief 
introduction together with designing two simple reports are given in Designing a Report below, and more details are available 

in training courses on using mSupply, and in publications available from Sustainable Solutions.
• If you want to save a report or search (query), you can save them on your hard disk, and retrieve them next time you run the 

report.
• If you save the report you have created in the Custom reports folder it will show up in the report form drop-down menu on 

future occasions when you choose custom report.
• The default location for saving your custom reports is My Documents\mSupply\custom reports; it is important to note here that

any custom reports you have created should not be saved in the My Documents\mSupply\Reports folder, otherwise problems 
may arise.

• New label layout
• presents you with the label editor, where you can design and save label layouts. These are useful for use with names for 

addressing envelopes, and with Items for making tags for labeling shelves in your warehouse.
• If you choose this option the “Order by” window will appear after a query. This allows you to sort the records into a particular 

order before printing labels. (In a nutshell: Drag fields from the list on the left to the list on the right to use them for sorting)
• Other items in the menu

• if you have saved any reports in the custom reports folder they will be listed here.

A list of the fields in each table, and what each field contains is to be found elsewhere in the guide. Field descriptions 
are here

Using previously saved layout

Any report layouts which you have used previously, and saved, may be accessed by clicking on File >Open on the 
menu bar, and selecting the required layout.

Using the Query Search editor
There are now many reports included in mSupply®, but there may still be occasions when you require a report that we 
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have not included. The query editor is a bit daunting, but is very powerful and once you are familiar with its 
capabilities, your competence to access the precise information you may require from within the mSupply database will 
increase significantly.

When you open the Custom Report editor, it is ready to take input values for a simple single line query. Each line of a 
query needs 4 items of information:

43. The field to query. Choose this by clicking on the field in the middle-left list of fields. Just above the list of fields is a drop-down
list that allows you to also choose fields from related tables. If you want to perform related queries, see note below.
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44. The Comparator. Choose the comparator from the list of fields under “Comparisons” on the right by clicking on the comparator 
you wish to use.

45. The Query value. Is entered in the bottom area (above the buttons). In the example above, the field chosen is an alphanumeric 
field (the item code), so an entry area is displayed where you can enter text or a numeric value - in this instance the item code 
“gri250t” has been entered. Note that you can also use the “@” symbol as a wildcard in your query value to perform “contains” 

queries.
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Related queries: If you want to perform 
related queries, you need to know a little 
about the internal structure of mSupply data. 
Please contact us if you would like a diagram 
of the table layouts. A simple example of a 
related table is that each transaction line is 
related to a transaction (many to one 
relationship). The means that you can use the 
information stored in the transactions table 
(eg invoice date, number, status, etc.) to 
query transaction lines.

46. The Conjunction. This does not apply to the first line of a query, but the second and any further lines need to start with a 
conjunction. Set the conjunction for the selected line by clicking the appropriate button in the bottom-left area of the window 

( And, Or or Except )

To add lines to a query, click the Add Line button.

If you have created a complex query that you might wish to use on future occasions, you can save it to your hard disk 
and select it again using the Save and Load buttons in the window.

Once your completed query is entered, click the Query or Query selection buttons to proceed.
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Designing a Report
The designing of two custom report is now described:

1. listing in alphabetical order the small number of items which may be supplied to staff or customers who wish to make a purchase 
without a prescription. These items have already been identified by making use of their User field 2, which contains the entry 
“Retail permitted”.

2. listing the sources (suppliers) and the distribution (customers) of a particular batch number of an item - useful if a manufacturer 
recalls a particular batch of an item.

It is recommended that you study both examples, as features described in the first example will not be repeated in the 
second.

Report 1

Having selected Custom Report from the Reports page in the Navigator, you are presented with this window:
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For our example report, we select the Items table, and to perform a New Search, using a new report form, so with these 
options selected, the window now looks like this:
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Click OK, and the Query Editor window appears, as shown in the upper figure below; this is where you specify the 
criteria on which you wish to create your report - in our simple example, the single criterion is that there should be stock
on hand of the item. In the lower window, we have specified this by:
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1. clicking on user_field_2 in the Available Fields panel on the left,
2. clicking on contains in the Comparisons panel on the right, and
3. entering “Retail” in the Value panel below.

You will see that the conditions we specified now appear in the upper panel - it's always a good idea to check here to 
confirm that the report will conform to your specified criteria.

Now click on the Query button in the lower right corner.

The Quick Report window appears; this is where you can design the layout of the report, and specify how you want the 
records to be sorted:
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We'll start by taking a closer look at the Quick Report features. 
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There are two operation modes available 
which generate two specific types of reports: 
List and Cross table . Our examples are 
limited to the List mode. The Cross table 
mode will not be described.

In the List mode, reports typically display records as a list with break rows where calculations are performed.

When you create a quick report, you can specify the following:

• Columns that display fields or formulas, either from the current table or from related tables.
• Sort levels and order.
• Summary calculations.
• Display format.
• Text for labels.
• Formats for numeric and Boolean data.
• Font, font size, style, and justification for labels, summary calculations, and data.
• Background colours on a cell column or row basis.
• Borders, Page headers and footers.
• Presentation style from a wide range of templates.
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1. Master Table: This is the master table that will be used as a basis for generating the report. The fields of this table are displayed 
in the Fields list and the related fields will be displayed in relation to this table.

2. Fields list: This list lets you select the fields to be inserted into the report by double-clicking or by drag and drop. You choose the
type of display in the Field selection list located just above the area. Indexed fields appear in bold. You can also display and 
select the fields of related tables.

3. Column dividers: These lines show the boundaries between columns of the report. They can be moved manually to enlarge or 
reduce the size of each column. Manual resizing deselects the Automatic Width option if it has been activated for the column 
concerned.

4. Cells: A cell is the intersection of a row and a column.
5. Scroll bars: You use the scroll bars to view parts of the quick report design that extend beyond the area of the quick report form.
6. Sort list/Sort order display area: This list displays the fields of the report on which the sort will be carried out, as well as the 

sort order and whether it will be ascending or descending. Each field inserted into this list causes a sub-total row to be added in 
the Quick Report area.

7. Quick Report area: This area lets you build your report by inserting fields using drag and drop, double-clicking or via the 
contextual menu; you can also adjust the width of the columns added, or delete breaks or formulas, define the colors and borders 
of cells, etc.
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1. Title row: This row displays the names of fields or formulas that have been inserted into the report. It is repeated for each page 
of the report. The Quick Report editor inserts field names by default, but you can modify the contents.

2. Detail row: This row contains information drawn from each record and is repeated in the report for each record. You can 
associate a display format with it, depending on the type of data represented.

3. Subtotal rows: These rows display intermediate calculations as well as the wording that is associated with them. A row is created
for each sort order.

4. Column data sources: These titles indicate the source of the data for each column.

Contextual menus

The Quick Report editor has contextual menus that make it easy to access certain row, column, and cell operations. 
Instead of making menu selections or working with the Cell or Column properties areas, you can perform certain 
operations by displaying a Quick Report contextual menu.

There are separate contextual menus for row, column, and cell operations.

To use a contextual menu:

1. Position the pointer in a cell, a row title, or a column heading and hold down the right mouse button (on Windows) or press the 
Control key while clicking in the report area (MacOS).
 A contextual menu appears. The commands in the contextual menu depend on where your pointer is (i.e., a row label, column 
heading, or cell). Also, menu commands that are inappropriate for the particular row, column, or cell are disabled..

2. Choose the desired menu command:
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Selecting Rows, Columns, and Cells

When designing a Quick Report, you need to select rows, columns, and cells in the quick report form. A cell is the 
intersection of a row and a column.

• To select a row: - Click on the Title, Detail, Subtotal, or Grand total cells in the row label area.
• To select a column: - Click the Header row of a column.
• To select a cell: - Click the cell.

Adding and Modifying Text

You can add or modify text in the quick report form to label parts of the report. For example, if you requested summary 
calculations, you can label them by adding text to other cells in the Subtotal and Grand total rows.

You can add and modify text as follows:

• Edit the text that automatically appears in the Title row of the report,
• Insert text in empty cells of the Subtotal and Totals rows,
• Insert the value of a Subtotal field in the Subtotal rows,
• Specify the font, font size, justification, and style for any text that appears in the report.

Returning now to our first report, we want two columns only, the first listing the items in alphabetical order, and the 
second confirming the entry in User field 2. This is achieved by double clicking on item name in the list, and then to 
have the list sorted alphabetically, make sure item name remains highlighted, and click on the green arrow in the centre:
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The second column in our report will show the present stock of each item, and the same procedure is followed; select 
the user_field_2 entry in the list, and double-click on it. You should be aware that items which are presently out of stock
will not appear in the report.

The Quick Report window should now look like this:
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The column widths can be adjusted as appropriate by positioning the cursor on the dividing line between the column 
headings, clicking and dragging to the left or right until the desired column width is obtained:

The vertical red line to the right of the columns indicates the right hand edge of the page as it will be printed, so to keep 
the report to single page width, columns should be positioned to the left of this line.

To preview on screen the report as it will be printed, click on File on the menu bar, and select Print Preview. Our 
example is very brief, but in reality, reports may run to two or more pages, and you can scroll through the pages of the 
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report. This shows how our simple report will appear:

The printed report may benefit from shading or colouring of alternate rows, and this is achieved while the report format 
is being set. In the Quick Report editor, click on Detail to highlight the row, then click on the Alt.background colour 
icon, and a chart appears from which you can select the colour(s) of your choice.

For our report, pale yellow has been selected for the alternate row colour, and the report now has this appearance:
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Adding report title

You may want to give your report a title to appear at the head of each page; this is achieved by clicking on File , then 
Header and Footer ; a window appears in which you can create and/or edit such a header You will most probably want 
the header to appear in the centre of the line, and in this case, type your entry into the Center panel in the Text Settings 
area; here you can also select the font of your choice, and features such as bold, underlined, etc.; these apply only to the 
header, not to the body of the report. A title has been added to our example:
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To print the report, click on File on the menu bar, and select Generate and - provided that your printer is connected, 
online and loaded with paper - your report will be printed.

Report 2

The second report lists the sources (suppliers) and the distribution (customers) of a particular batch number of an item - 
useful if a manufacturer recalls a particular batch. The item chosen for our example is Metoclopramide 10mg tablets, 
the code for which is Metclp10, and the batch no.is BN1234
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When the Query Editor window appears, expand the [Items] table, and once expanded, move down the list until code 
appears, and select it by clicking on it;the upper panel now shows [items]code , the default comparator is equalto ,and 
so to complete the line, move the cursor to the Value entry panel in the lower part of the window and enter 'metclp10'. 
Click on Add Line and accept the default conjunction And ; In the Available Fields panel, shrink the [Items] table, 
expand the [item_lines] table and select batch, accept the is equal to comparator, and enter 'BN1234' in the Value entry 
panel. You have now defined the criteria for the report, and the Query Editor window should look like this:
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You are now ready to click on the Query button.

The Quick Report design window appears, with the Master Table - in this example the 'Transaction lines' table - 
expanded for selection of the fields required by our report; we'll be using four fields from the master table, namely item 
name, batch, pack and quantity; double-click on each of these in the list, and the Quick Report design window should 
appear as shown:
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Don't be concerned at the order in which these fields appear in the report - we'll rearrange the order once all the fields 
have been selected. The fields we now need to add are in other tables; presently Master Table is selected ,and we need 
Related Tables , which is selected from the drop-down menu.

The table to access is the Transactions table, and the fields we require are Invoice number, type, and confirm date. 
Double-click on each, then expand the Names table, and double-click on [names]name.
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All eight fields for the report are now selected, and we can arrange them in their required order. This is easily performed
by selecting the column to be repositioned - we want the item name to be the first column, so we select it by clicking on
the column heading, and move it by clicking on the 'Move Left' icon.

Select and move the columns using the 'Move Left' icon and the 'Move Right' icon until the column order from the left 
is:

• Item_name
• Batch
• Name
• Type
• Invoice_num
• Confirm_date
• Pack_size
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• Quantity

The report will look better in landscape rather than portrait form, so click on File > Page Setup , and select landscape 
Once you have done this, you can view your report on screen by clicking on the 'Print preview' icon.

The next steps are :

1. to sort the report
2. to perform some simple calculations
3. to display this information.
4. to adjust the column widths

All these are simple to perform on the Custom Report window:

1. Sorting the report. Drag and drop in the 'Sort order' panel the parameters required - in this example [Transactions]type and 
[Transactions] confirm_date.
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2. Performing calculations and displaying the information. We need to count the number of transactions, and display the totals 
involved. Observe the two rows added to the report annotated with the sort parameters followed by 'change'; these are the break 
points in the report, and the results of any calculations are displayed in these rows ….. here's how:

1. position the cursor in the Invoice column on the [Transactions]type changed row
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2. click Cells on the menu, and check Count; we need to know how many customers have been supplied with this batch, so the 

Count icon is inserted in the row - it does not matter which column has the Count icon - for the time being it is entered in the 
'Invoice' column, and the reason for this will soon become apparent.

3. also required is the total quantity ordered, and the total quantity distributed, so the cell in the same row but in the Quantity is 
selected, and this time the Sum box is checked in the Cells drop down list. 

1. Column widths can be adjusted as described earlier, and having a look at the Print preview will enable appropriate widths to be 
defined.
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The report should now appear something like this:

Only two tasks remain! It's not necessary to display the Invoice type, so this column may be hidden - right click on the 
column heading, and from the contextual Column menu, click on 'Hide'.

mSupply® by default enters the field name in the displayed column heading, but you can edit these column headings by
double clicking on the cell in the 'Title' row, when an insertion point cursor appears and the current entry is highlighted; 
you can replace the default text with whatever you consider appropriate. This has been done in our example.

Finally, there is a large selection of presentation styles available, any of which can be applied to your report. On the 
menu bar, click on Style > Presentation. In our example, after defining a header for the report, we have opted for 
Report 1, giving our report the appearance you see below.
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At some time in the future, you may wish to run your reports again. You should, therefore, save a copy of each report in 
the Custom Reports folder; this is performed by clicking on File on the menu bar, and selecting Save or Save as, giving 
the report a name, and saving it in the Custom Reports folder, or any other appropriate location of your choice. Then 

when you're ready to run the report next time, having specified your criteria in the Query Editor, when the Quick Report
window first appears, click on File on the menu bar, select Open, and retrieve the desired report from its saved location,
preview it and print it.

Using custom methods in Quick Report Columns
Sometimes you will need to use a custom method in a column to extract data from a related table.
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The following methods are available.

Method Description Parameters 

date_day_number_to_text returns 1 for Sunday, 2 for Monday 
etc. 

qr_account_code_return Returns the account code of an item item_id 

qr_flag_value_change 

qr_get_currency 

qr_get_current_patients_stat 

qr_get_location-from_key 

qr_get_loc_from_key_new_process 

qr_get_Name_code_from_key 

qr_get_stockOnHand_from_itemKey 

qr_get_store_name 

qr_keep_accumulative_value 

qr_ns_customer 

qr_responsible_officer 

qr_ship_method 

qr_get_item_store_field Returns the field for the item in the 
current store 

1:item.id 2:“price” or 
“is_in_catalogue” 

Previous: Next: 

Items and Stock reports
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When Reports > Items and Stock is chosen, a range of available reports are displayed; click on the one you require to 
select it.

Opening Stock...
In the early days of mSupply, this report was designed to show the stock at the start of the financial year; it is dependant
upon having Set the start of year stock, a topic covered in the Special Menu section of the guide. The report produced 
lists the stock at the start of the year.
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If you have not used this Set the start of the year stock feature we suggest you consider using the Stock on date report, 
entering the first day of your financial year as the date, and selecting Stock at start of the day.
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Current Stock...

A report will be produced that lists each stock line that is currently showing stock greater than zero. Should you wish 
the report to include items/batches with zero stock, the box in the lower left needs to be checked.

Item filter
A “Find” report allows you to enter the normal item find criteria to choose which items to include.

A random report allows you to enter a number only. That number of items will be randomly chosen, and stocktake 
sheets for those items printed. This facilitates spot checking of your actual stock situation.

Additional options
Should you wish the report to be department specific, then that department should be selected from the drop down list 
of the departments which you have created.

Should you wish the report to give information on a particular location, then that location should be specified , selecting
the appropriate operator of the three available in the drop down box alongside the Filter by actual stock location option.

Report format
You can choose from three formats:

• “Each batch shown separately” will also give you a column on the right where, having done a physical stocktake, you can enter 
the quantity that is actually in stock, allowing any corrections to be made in mSupply.
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• “Total stock for each item” will not show individual batches, but the total quantity on hand of each item.
• List the price of each batch in stock, with a total at the end of the report.

The lines are reported alphabetically either by item name or shelf location, depending on what you have chosen in the 
“Sort report by” options

Donor Reporting

mSupply provides the feature of printing the Donor name on the Current Stock report so that organisation donating the 
goods can be identified and tracked. 

Stock on date...
This report allows you to produce a report for the stock in your store on a particular date. You are shown a window like 
this:

Enter the date for which you wish to show the stock.
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Type of report
You have 3 options:

1. Show items only: each item in your system will have a single entry with the total quantity on that date.
2. Show items with batches : each batch, its expiry and batch number along with the quantity of stock will be shown.
3. Each batch - for spreadsheet : as 2., but every row has an entry, to facilitate sorting, etc. on a spreadsheet.

In the right hand box you choose whether to include transactions for the day you are reporting on or not.

The Report on items whose…. box allows you to restrict the report to certain items only, and/or to items with a certain 

category.
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Open report in Excel
Check this checkbox to view the report directly in your chosen Spreadsheet program.

Show total stock value...

This report is used to find the total stock value either for a particular department or all departments. The drop down 
menus allow customisation of your report by entering appropriate search criteria from the many options.

Check this checkbox to directly open the report in Excel rather than printing.

Graph: stock by item
This report shows a graph for an item or items showing the quantity of stock on hand for each day over a defined 
period.

Note that if you have allowed editing of confirm dates on transactions, mSupply's ability to calculate accurately the data
used in this report may be affected.

Choosing this item from the menu displays this window:
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Enter the date range, or select the required period from the drop down list, the items on which you wish to report, and 
appropriate filters, if any. Remember you can use the item flag field to select an ad hoc list of items to include in your 
report.

Clicking OK displays a window where you are shown a graph of the quantity in stock on each day for the first item that 
matched the criteria you entered.

689



This window also displays a list of items that were found. To display the graph for a different item, choose it from the 
list.

This report can be used as one of a set of key indicators for performance of a facility by comparing days out-of-stock of 
key items from one year to the next.

Graph: total stock
The total stock graph report allows you to view the value of your stock over a desired period of time. When you choose 
total stock graph, you are able to enter the required period which you would like to view:
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Select OK and a graphical stock history report showing stock value will be displayed
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Item list...
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This report allows you to view an on-screen or printed list of items.

There is only one report layout listed in the window, but please tell us what you would like, and we'll consider adding it.

Local/Remote Report
This option will only show “local data” as an option unless you purchase a web services enabled version of mSupply, in
which case you can view reports from remote locations running mSupply. Contact us for more information.

Items out of stock
Selecting this report displays this window:
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Specify your required options from the drop down lists;

Days out of stock
Selecting this report displays this window:

Specify your required options from the drop down lists; the desired period may be identified either by entering dates in 
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the From and To fields, or by using the drop down list to the right.

Clicking the Complex find button opens the Query Editor, allowing you to enter specific criteria relating to your 
search.

You may also specify what level in percentage terms of the maximum stock should be considered as being “out of 
stock..” Here's an example over 1 month:

Day of
month 

1 2 3 4 5 6 7 8 9 10

stock on
hand 

20000 20000 20000 2000 1000 500 300 200 30000 25200

Out of
stock with
5% stock
out level

(i.e. 1500) 

  

11 12 13 14 15 16 17 18 19 20

20200 18000 18000 18000 10000 5000 5000 2000 2000 800

21 22 23 24 25 26 27 28 29 30

800 20000 20000 20000 20000 20000 20000 20000 20000 20000

Item usage...
This report gives you a breakdown of item usage for the last few months, with summaries for the last 2 years, It also 
includes stock on hand and stock on backorder for each item in the report.

The report produced is very useful for forecasting or for seeing a list of items that need to be ordered.

When you choose the menu item you are shown a window like this:

You can choose whether to carry out an item usage report, a suggested ordering amount report, or to auto generate a 
tender from the drop-down list at the top. This form is used for all 3 functions. For now, leave this as it is.

If you want to report on all items, leave the item name field blank:
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otherwise enter an item name or code. For example, to report on amoxycillin stocks, you could enter “amox” into the 
field.

Depending on the entry in the first field, further options are available in the following two fields, but these will vary 
according to the entry in the first field. Among the options, he first field allows you to make your selection from the 
names given to custom item fields in the Preferences if this feature has been used.

If you wish to use shelf locations, then select the shelf location option and specify the desired shelf.

You can use the drop-down list to find Items with a particular code, or to use the values you have entered into one of the
custom user fields. If this isn't powerful enough, use the complex find button to display the full query editor.

Click the refresh button  to calculate the number of items these basic parameters will find. This screenshot 
shows that 17 items meet the parameter specified, i.e. items whose names begin with 'pro';

Only include items whose stock cover is less than....
If you want only to report on items whose stock is low, enter the threshold for days of stock on hand into the second 
field. For example, entering 90 into this field will only include items in the report whose stock is not sufficient to cover 
average usage for the next 90 days.

Enter “0” (zero) for this field to report on items with any amount of stock remaining.

Include items with no usage in the last 12 months
If this box is checked, items with no usage over the last year will be included. This check box will have no effect if the 
previous “days cover” field is filled in, as an item with no usage will have “infinite” cover- any stock you do have is 
going to last you forever!
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Include usage for build ingredients
If you manufacture items, you can choose whether the use of ingredient lines in manufacturing is included in the report 
or not.

Open report in Excel
Checking this box opens Excel (or any installed spreadsheet) and displays the report directly. If you want to save the 
report, choose File > Save as… in your spreadsheet program.

Item Usage Report Preview

Suggested Ordering Report
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 When in the Item usage report dialogue box, select the 'Suggested ordering report' option from the drop down box at 
the top left. Note the extra options for including item usage when calculating item ordering quantities. Also note the 
option to include ordering for build items. See item builds for more on built items.

Suggested Ordering Report Preview

 This report gives analysis per item and the final column provides a suggested quantity to order. It is then the 
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responsiblity of the Purchaser to make the final decision on how much stock to order.

Item usage with outstanding Purchase Orders
The window that appears when you choose this report is the same as the previous one; with exactly the same options 
available; the report produced differs only in that any lines having outstanding Purchase Orders have the relevant details
of the Purchase Order displayed.

Item slow movers...
You will be shown a window to enter the item details:
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Enter your search criteria in the top section.

Item name field

• If you want a report for all items, leave this field blank. Otherwise enter some text to reduce the report to just a few items (e.g. 
entering “am” will produce a report of just the items whose name starts with “am” (Amitriptylline, Amoxycillin, etc….)

Category and Department
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• Use the drop down boxes as appropriate to select Category and/or Department if required.

Days stock

• Enter the number of days stock to report on. Items with more than this number of days stock on hand will be included in the 

report. The correct figure to enter here depends upon your desired stock turn. In general, if you are turning over your stock 3 or 4 
times a year, you would want to know about items which have more than 240 days stock on hand.

• The report is calculated using the last 12 months usage as a guide to the average monthly usage.

You can check the Open report in Excel box to open the report in Excel, or any installed spreadsheet.

The report produced is very useful for managing under-performing inventory. It allows you quickly to obtain a list of 
items where a reduction in stock is desirable.

Expiring items...
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This report will ask you to enter a date, and will then give a report of all item lines in stock whose expiry date is before 
the date you have entered.

For example, entering 31/8/11 will display all items with expiry dates before 31st August 2011 (Enter the date in short 
format in the way your computer is set to handle dates (DD/MM/YY or MM/DD/YY or YY/MM/DD).

Three report type options are offered; select as appropriate. You may refine the search by using the Name filter and/or 
the Item filter..

Donor Reporting
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mSupply provides the feature of printing the Donor name on the Expiring Items report so that organisation donating the 
goods can be identified and tracked. This can help with disposing of or return goods to the Donor 

Expiring items vs cover
This is a versatile report which allows you to see at a glance the amount of any stock items, and the number of days' 
cover provided by that amount of stock you have. Note: The cover calculation uses the last 12 months of usage data to 
calculate your rate of consumption.

Many filters may be applied in the drop down lists, which are the same as described under Item usage… above.
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Note that If the field you are searching is a boolean field, e.g.Essential Drug List, “false” appears as the default entry, 
which you may change to “true”.

Cover Calculation

This allows the user to include or exclude specific categories to be used in calculating coverage. Clicking the 
magnifying glass to the right lists categories to be chosen.

If you wish mSupply to remember the criteria which you have entered, click on the paperclip icon, and your selections 
will appear the next time you open the report.

Once you have selected your required criteria, click on the Refresh icon to show the number of items which match your 
criteria, and which will, therefore, feature in the report.

Item Ledger
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Ledger entries may be viewed in this report; formats of report are available in addition to several filter options from the 
drop down lists, so the report may be designed to meet your specific requirements.

Previous: Next: 

ATC based reports

ATCs and DDDs

“ATC” stands for “Anatomical, Therapeutic, Chemical”, and is a method of classifying chemical entities, and 
identifying them by category.

“DDD” stands for “Defined Daily Dose”, and provides a means of comparing the utilisation of different drugs in a 
meaningful way. - e.g. if a dispensary has issued 10,000 x doxycycline 100mg and 20,000 x amoxycillin 250mg, a 
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greater number of amoxycillin capsules has been used; but according to the DDD method, a greater number of patients 
have received doxyxcycline.

Thanks to the help of the WHO Collaborating Centre on Drug Statistics and Methodology, we are able to offer a starting
drugs file with their codes; we have plans (not yet implemented) to maintain on our website an up-to-date list of ATC 
and DDD codes for essential drugs.

Reports using ATC and DDD codes

mSupply is designed for the ATC code to be entered in the Category field for each item, and is then able to report on 
supply transactions, giving a breakdown according to the different levels of the ATC code.

The DDD Factor field is intended to store the item's number of dose units in its DDD; for example, if an item's DDD is 
1,000mg, and the supply is made using 250mg units, the DDD factor is 4. When designing a report, the total quantity of 
this item used should be divided by the DDD factor to obtain the number of DDDs supplied.

Should you wish to store an item's DDD value (1,000mg in the above example), it is suggested that you record it in one 
of the available user fields. The DDD value should not be recorded in mSupply's DDD factor field

The category analysis report is designed to be used in conjunction with the “category” field and the “DDD factor” field 
for each item.
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When you produce a report, only some simple criteria are entered in the form. It is a simple matter to create reports 
giving, for example:

• A level one ATC summary for all items supplied to a specific hospital during a 12 month period

• A level two ATC summary for all items in ATC category “J” supplied to customers who are coded as “h” (for hospital) for a 
particular month.

• A level three ATC summary for all essential drugs supplied to all customers for a particular quarter.

The report provides you with the number of DDDs supplied for each category at the level requested, presuming you 
have “DDD factor” values entered correctly. Only the totals for each category are shown (not each individual 
transaction). The report may be printed, or exported for use in another application.

Let's run through the different options in the window… summary level…- enter the summary level. The category field 
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is then evaluated based on the ATC coding system. Note that the code is “broken down” as follows

level position 

1 character 1 (A-Z) 

2 characters 2 & 3 (01-99) 

3 character 4 (A-Z) 

4 character 5 (A-Z) 

5 characters 6 & 7 (01-99) 

So, for example the code for “caffeine” is N06BC01. “N” is the level 1 code, “06” the level 2 code, “B” the level three 
code, “C” the level four code, and “01” the level 5 code.

Note that if you choose “level 3”, you will also be shown the summary values for “level 1” and “level 2” as well.

Which type of item?

You can report on all items, or you can report on just a certain category. For example, you can enter “J” here to report 
only on items whose ATC code starts with “J”. Note that you need to set the summary level to “level 2” or your report 
will only report the total for category “J” without any further breakdown of data.

Only report on essential drugs

Check this if you only want to analyze items whose essential drug check box is checked. 

Transaction type?

- Normally we will be interested in supply to customers. However, we might also be interested in “what percentage of 
purchases from IDA (a supplier) are aniti-infectives?”, in which case we would click on the “items received from 
suppliers”

Date range...

Enter a starting date and an ending date. Only transactions whose confirm date was within the range will be analyzed. 
The default range is the last 90 days. Note that the dates you enter are included in the range (that is the “from” date is 
“on or after” and the “to” date is “on or before”)

Which customers/suppliers...

Leave this value blank to report for all customers. Otherwise, choose “code” or “category” from the popup menu, and 
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the appropriate comparison from the second popup menu. For example, if you want to report on a certain group of 
hospitals, you could enter those hospitals as having a category “h”, and then report on “names whose category starts 
with 'h'”

Previous: Next: 

Customer Ordered Shortfall Report
When you choose Report> transactions and then select Customer ordered short fall report , the transaction report like 
the one below will be produced. This report is used only for sales to customers.

Note that for this report to make sense the preference Allow placeholder lines on customer invoices must be checked, 
and the preference Delete placeholder lines when confirming invoices must be un-checked.
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From the report window, select the desired parameters and click OK . An example report is shown below.

Previous: Next: 

Setting up mSupply to use the Customer Ordered Shortfall report
For this report to be used, you need to do the following
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• Choose File > Preferences > Invoices2 and ensure “Delete placeholder lines when confirming invoices” is not checked.
• Staff must enter requested amounts on invoices as placeholder lines. 

• For example, a customer orders 1000 x Paracetamol syrup 60ml. You have 800 in stock, so you add 800 to the invoice, and you

also add a placeholder line for 200 bottles.
• You need to decide whether to (and if yes, how) to use the backorder system. If customers can rely on you to record shortfalls as 

backorders, then they will no need to re-order the shortfall in subsequent ordering cycles, as they know you will deliver it when 
available.

Purchasing

Purchasing reports (focused on what you have ordered and what you have received and what you want to order) are 
available at Report > Purchasing. The following report types are available:
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Select the required report type by clicking on it.

Purchase Orders...
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Types of report

There are seven reports currently available:

• The Ordered Item Report will list items that are on Purchase Orders according to criteria specified.
• The Goods Received date vs Order date report lists each Goods Receipt for a particular Purchase Order and the number of lines 

received, then follows with details of the number of lines and date of the original Purchase Order, as in the example below. This is 
useful for tracking supplier delivery performance.

• The Goods Received date vs Order date - Show items report:

Note that the number of lines received may not match the number ordered as a single Purchase Order line may be 
supplied in split deliveries, as in example shown, or an ordered line may not be supplied at all.

• The Outstanding Purchase Order Lines report, which will display all Purchase Order lines for Purchase Orders provided that
 (1.) delivery is incomplete, and 
 (2.) the Purchase Order has a Confirmed (“cn”) status.

• Note that Purchase Orders whose status is Finalised (“fn”) will be ignored when producing this particular report.
• The Goods Received date vs Order date - show Delivery days report shows the number of days taken to deliver items.
• The Purchase order vs goods received broken down by batches report shows the dates particular batches were received.
• The Purchase order cashflow planning report shows you the values and times of expected deliveries.
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Date range and date type

A date option, for selecting which items/purchase orders to include in the report must be selected; options are:

• creation date - the date purchase orders were created
• sent date - the date purchase orders were confirmed
• expected delivery - the expected date of delivery for items
• actual delivery - the actual date that items were delivered

The report will include items/purchase orderswiht the selected type of date falling between two specified dates entered 
in the From and To fields. The dropdown list on the right affords many quick-choose preset date range options such as 
“today”, “yesterday”, “this week”, “last week”, “this month” etc.

Report on names...

The report may be confined to suppliers meeting specific criteria by selecting one of several supplier properties 
(“Name”, “Name code”, “analysis”, “category”, “Price code” etc.) in the left dropdown list, “equals”, “starts with” or 
“contains” in the centre dropdown list and making an appropriate entry in the field on the right. If this field is left blank,
the report will include purchase orders from all suppliers within the chosen date range.

Report on items...

Similarly the report may be confined to items meeting specific criteria; you choose an item's property to filter on in the 
left dropdown list followed by the comparator in the centre dropdown list and finally making an appropriate entry is 
made in the field on the right. Again, leaving this field blank will produce a report on all items within the chosen date 
range.

You can also report on items that have a certain category and/or department. By default these options are set to “Don't 
care”, which means the item categories and departments will be ignored.

Note that only reports that report on invoice lines will produce meaningful results when you choose item criteria. 
Reports that report on whole transactions (e.g. “Each invoice grouped by name” or “Each invoice grouped by date”) 
will not produce meaningful data, as any one invoice can contain multiple items. Choose reports that report on invoice 
lines (e.g. “Each invoice line by item” or “Totals for each item grouped by month”) for these filters to have an effect.

Report on purchase orders...

In the same way you can also filter you reports on properties of the purchase orders involved: category, status and both 
purchase order custom fields.

Purchases...
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This report finds all purchasing transactions over a certain value within a specified time period

You should enter:

• The date range of transactions on which to report
• Four filters are available to refine the report - a name filter, and three item filters; all are optionally and will be ignored if nothing 

is entered in the textbox or drop down lists are left at “Don't care”.
• The value of a transaction line above which the report will cover.

It may be good for your organisation to have a purchasing policy that stipulates that transactions over a certain value 
must be authorised by a second party (that is, someone other than the purchaser). This report allows you to monitor such
a policy easily.

Suggested order quantities
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Use this report for mSupply to analyse your current stock and, based upon a required number of days stock cover which
you enter, suggest how much of each stock item you should consider ordering. You'll see this window:

If you want to report on all items, leave the item name field blank, otherwise enter an item name or code. For example, 
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Passwords are case sensitive- make sure you 
don't have Caps Lock on. If you forget your 
password you must ask the user who is either 
first or second in the user list to change your 
password for you.

to report on amoxycillin stocks, you could enter “amox” into the field.

The drop down list, after the item name and code choices, lists several other fields, including any user defined fields, 
where the names that you have defined for custom item fields in the Preferences are displayed.

If you wish to use item categories, then use the Item category list to choose the one on which you want to report.

You can use the drop-down list to find Items with a particular code, or to use the values you have entered into one of the
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custom user fields. If this isn't powerful enough, use the Complex Find button to display the full query editor.

Click on the refresh button (double orange arrows) to show the number of items these basic parameters will find.

Only include items whose stock cover is less than…: If you want to report only on items whose stock is low, enter the
threshold for days of stock on hand into the second field. For example, entering 90 into this field will only include items
in the report whose stock is not sufficient to cover average usage for the next 90 days.

Enter “0” (zero) for this field to report on items with any amount of stock remaining.

Expected delivery: Enter an appropriate date based on previous delivery times.

Include usage for build ingredients: If you manufacture items, you can choose whether the use of ingredient lines in 
manufacturing is included in the report or not.

Basis of analysis: Enter the number of days' usage data mSupply should check.

Exclude transfers from calculations: Check this box if you wish transfers within your organisation to be excluded 
from the calculations.

Include items with no usage in the last 12 months: If this box is checked, items which have not been used over the 
last year will be included. This check box will have no effect if the previous “days cover” field is filled in, as an item 
with no usage will have “infinite” cover- any stock you do have is going to last you forever

Order quantity for X months stock cover: In this field, enter the number of days stock cover you want to have 
available. The report will automatically take into account any stock you already have, so all you need to do is enter how
many days cover you want, starting from right now, in this box.

Open report in Excel: Checking this box opens Excel (or any other installed spreadsheet application) and displays the 
report as a spreadsheet. If you want to save the report, choose File > Save as… in your spreadsheet application.

Report output
Cover column: if the column prints “»»” this means you have no usage of that item, so you have “infinite” cover (i.e. if
you don't have any usage your current stock with last forever, from a usage point of view, if not from an expiry date 
point of view!)

Suggest order quantities with prices and price extension
This report is an extension of the previous one, allowing you to see what the suggested order will cost. The filter 
choices you have are the same as for the suggested order quantities report.

Previous: Next: 

Transactions reports
All these reports summarise supplier or customer transactions in many different formats. Many different filters have 
been incorporated, allowing filtering on transactions, names, prescribers, items, categories and departments. The filters 
that do not apply to different reports are hidden as required. Feel free to mix and match and experiment with the filters 
and different reports to see the different views of information that you can get. You get to the transaction reports from 
the menu item Reports > Transactions or from the Transactions item on the Reports tab of the Navigator

Standard transaction reports
This is the window you will see: 
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Type of report
Choose from several formats for displaying transaction information by:

1. selecting the report type in the Report list on the left, and
2. choosing the required radio button under Transaction type

The following table lists the available report names, and gives brief details of the information provided by each report .

Report name What it does 

Each invoice grouped by name The report will sort each invoice in the date range 
according to the name (Supplier or Customer) and give 
totals for each name. 

Each invoice grouped by date As above, but totals given for each day. 

Each invoice line by item Lists each item supplied or received, and the transactions 
for that item. This report can be very long 

Each invoice showing profit The cost and selling price totals for each invoice are 
displayed. 

Each invoice line grouped by item department then item The invoices are grouped by the item department assigned 
to each item. Each item department is then sorted in 
alphabetical order by items 

Each invoice line grouped by name The total value of items received/supplied from/to each 
name 

Each invoice line grouped by item and then name Invoice lines are all displayed, grouped by item and then, 
within those groups, by name. 

Totals for each item category The total value for each category will be displayed - each 
transaction will not be shown. 

Totals for each item Each item that has been received (or issued) will be shown 
with the total quantity and value received/issued 

Totals for each item - Net Inventory adjustment Each item on which an inventory adjustment has been 
made is shown; the net adjustment is displayed, with both 
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quantity and value shown. 

Totals for each name The invoice lines for the chosen date range are grouped 
together for each name. This report allows you to see 
quickly what has been issued to a customer or customers. 

Totals for each item broken down by name Lists all items, showing their distribution to recipient 
customers or delivering suppliers 

Totals for each name broken down by item As above, but listing customers or suppliers and items 
received by or delivered by them 

Totals for each item department The total value supplied/received for each item department
is shown 

Totals for each item grouped by day The total quantity and value of each item is shown for each
day. 

Totals for each item grouped by month. The total quantity and value of each item is shown for each
month. 

Totals for each item grouped by item description. First the report is sorted by item then the total quantity and 
price of each item is shown. It also provides a grand total 
for the item quantity and price columns. 

2 period comparison by item category User selects two periods, and the transactions for each 
period form a column. The rows are determined by the 
item category. This is a special report that has different 
input options. See entry below. 

Prescriber report This report allows you to view the total value, mean item 
value and item count for prescriptions dispensed for each 
prescriber 

Cross tab: items in rows, names in columns, quantity in 
cells 

These reports are like Excel pivot tables. Warning: they 
can be slow to produce if you have a lot of data. Start with 
small date ranges until you are comfortable your machine 
can handle the load. Note that reports that produce a lot of 
columns won't print well - it is better to export them to a 
spreadsheet and print from there. 

Cross tab: items in rows, names in columns, value in cells See above 

Cross tab: items in rows, days in columns, quantity in cells See above 

Cross tab: items in rows, days in columns, value in cells See above 

Cross tab: items in rows, months in columns, quantity in 
cells 

See above 

Cross tab: items in rows, months in columns, value in cells See above 

Cross tab: names in rows, months in columns, quantity in 
cells 

See above 

Cross tab: names in rows, months in columns, value in 
cells 

See above 

Distribution of quantities issued First the report is grouped by item name and then by the 
pack size issued. It displays the total quantity and total 
count for each item. 

Totals for each item grouped by transaction category then 
item 

The report is grouped by each item's transaction category 
first and then by each item.The report shows the total 
count, total quantity and total value for each item. Lastly it 
also calculates a grand total of the items count, quantity 
and value columns. 

Each invoice sorted by Name >Address1 field then by 
name 

The invoices are firstly sorted by the address1 field, and 
then by the name they were supplied to. This groups 
invoices together by whatever you entered in the 
“Address1” field for each name - e.g. you might enter the 
region or province. 

Each invoice sorted byName >Address2 field then by 
name 

As above, but the first sort is by the entry in “Address2” 
field. 

721



Customer ordered short fall report Where there has been a short fall, this report shows the 
short fall of each item and of each item category by 
quantity and percentage. It shows what demand from 
customers has been met and what has not. It applies only 
for issues to customers. 

Customer transaction report 1 This report and the following three are, in fact, templates, 
and are the starting point for designing reports on specific 
criteria not covered in any of the existing reports. 

Customer transaction report 2 

Customer trans line report 1 

Customer trans line report 2 

Order processing time If you are filling out the order written date and order 
received date for incoming customer orders, then this 
report will show you how long it is taking for orders to 
reach the store, and how long it is taking to process orders 
from receipt to order entry and to order dispatch 

Transaction type
You can choose to report on:

• Sales to customers (customer invoices: type “ci”)
• Sales to and credits from customers (customer invoices & credits: type “ci” & “cc”)
• Purchases from suppliers (supplier invoices: type “si”)
• Purchases from and credits to suppliers (supplier invoices & credits: type “si” & “sc”)
• Inventory adjustment - Add stock: All inventory adjustment transactions that resulted in stock additions (e.g. when you did a 

stock take of an item and counted more on the shelf than the total shown in mSupply).
• Inventory adjustment - Reduce stock: All inventory adjustment transactions that resulted in stock reductions (e.g. discarding 

stock due to it being expired). Note that using a report that shows the total for each transaction category can give totals for 
expired/damaged etc.

• Inventory adjustment - Net movement: Taking into account both reductions and additions, the nett change in inventory due to 
adjustment transactions.
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Date range
Enter the date range of transactions to report on, having selected Confirmed date or Shipping date. Note that the date 
used may differ from the original entry date, depending on how your system is configured in the Preferences.
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• Note the popup menu to the right of the date entry fields that allows you to choose quickly from a list of common date ranges:

• Note that “last year” refers to the year preceding the current year (that is, if the current year is 2012, choosing “last year” will set 
the dates from 1st Jan 2011 to 31st Dec 2011).

Transaction Category Filter
Assuming you have set up transaction categories, your report may be filtered by category. For help setting up 
Transaction categories click this link.

Name filter
You can enter a particular customer code or category of transactions to be displayed.

• You can choose from either equals for an exact match or starts with to search for all names whose code or category starts with the 
entered text.

• Each name has a category that can be used to group certain kinds of names together.
• If you want to report on transactions for a single name, you can find their code by looking up their details using Supplier > Show 

suppliers or Customer > Show customers .
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Item filter
Here you can specify the items to include in the report.

Note that sometimes the item choice options will be hidden because the chosen report is reporting on transactions, not 
on transaction lines:

Donor filter
If you have donor tracking turned on in the preferences, and choose a report that bases it's data on invoice lines, then 
you will be given the option to filter the report for a particular donor or group of donors.

Which mode?
If you are using mSupply in both store and dispensary mode, you might want to report only on transactions in store 
mode (items distributed to customers) or in dispensary mode (items distributed to patients). You can do this by checking
Store mode or Dispensary mode radio button depending on your requirements.

Exclude transfers from calculations
This checkbox enables you to choose whether you include stock transfers (where stock is transferred from one store to 
another in mSupply) in the report calculations. If you want stock transfers to be included in your report then uncheck 
this checkbox. If you want stock transfers to be left out of the report then check this checkbox.

The 2 period comparison by item category report
This report allows you quickly to compare sales or purchases for 2 periods of your choice based on item categories.

When you choose this report a different set of options is shown.
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Set the date range for each of the columns and then choose a summary level. It should be noted that if no data is present 
for the first period defined, this report will not run.
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Dot notation and summary levels

The summary level is based on the item category field. If you have set up item categories using dot notation, then you 
can summarise categories.

To set up item categories, choose Items > Show item categories

Take the following simple example of categories that have been set up as follows:
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The rules for dot notation are

• Separate each level of your hierarchy with a period (dot).
• Within a level you can have as many characters as you like
• You can use any characters, as long as you don't use a period or a space within one level; e.g. “surgical.gloves.small” is a valid 

entry. (Level one is “surgical”, level two is “gloves” etc.).
• When the hierarchy part of the category name is finished enter a space character. You can then enter a description for that level of 

the hierarchy.
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If we run the report with a summary level of “none” each category is shown

If we run the same report with level one chosen, only the first level of the hierarchy is shown. Items with categories 1.1 
and 1.2 and 1.1.1 have all been summarised under “1 Antibiotics”
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And with level two chosen, items with category 1.1.1 and 1.1.2 are summarised under the heading “1.1 Penicillins”

Note that if you have items to which no category has been assigned, they are shown under the heading `none“ at the top 
of the report.

The categories are printed in the order that you have specified by drag-and-dropping in the window shown by choosing 
Item > Show item categories….

Transaction filter: Filters the report for given category

Prescriber filter: Reduces the found transactions to those for the given prescriber only, depending upon the selection 
made (equals, starts with, contains, is not equal to).

• Obviously only useful in dispensary mode.
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Exclude transfers from calculations: The check-box Exclude transfers from calculations when checked will ignore 
transfers between stores within the organisation.

Exclude Ad Hoc and non stock items: The check-box Exclude Ad hoc and non stock items is displayed accordng to 
the type of report selected. By default, it is checked.

When checked, the transaction report generated will not include any Ad Hoc items or non stock items (items you don't 
normally keep in stock).

Custom transaction & trans lines reports
These four reports should be regarded as templates for you to design your own report .

Having decided whether you wish to report on transactions or transaction lines, you need to design the report according 
to your specific needs. Coose Reports > Manage Reports :
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You are presented with the Report management window. In this example, our report will be on transactions, so you 
should highlight custom_transaction_report_1 , and click onthe Duplicate report button:

Choose an appropriate name for your report, and any comment you wish, and click OK. You are returned to the Report 
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management window, where you should scroll down until you reach the report you have created; note that the name you
gave the report will appear in the Custom name column; highlight the row and click Edit report .

This brings up the Edit report window. Creating custom reports is described in detail earlier in this chapter. See the 
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Previous: Next: 

Other Reports

ABC analysis...
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This report will rank the items based on the value sold in the period specified. Sometimes such a report is referred to as 
an “ABC” analysis or a “pareto” analysis. Statistics show that 20% of the items supplied by an organisation usually 
generates 80% of the total value of sales. Therefore, it is useful (and wise!) to concentrate first on the 20% of items that 
are most important. This report makes it easy to do just that.

You might be interested in what Wikipedia has to say about ABC analysis

You need to enter the following information:
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Number of items to include in report: Enter the number of items to be included in the report.

Date range: Enter the dates you wish here. Each item will have its “analysis” field updated with the total value of sales 
during the period specified.

Filters: Should you wish to apply filters to the report, three are available - for items, categories and departments.

Which mode: You can choose store mode, dispensary mode or both modes of transactions for inclusion in the report.

Exclude Ad Hoc and non stock items: If you check this box then Ad Hoc and non stock items will not feature in the 
report.

The report lists the number of items specified, ranked by value of sales, starting with the highest. The value of sales and 
the percentage of the total value are also shown. Note that the total value is the total for the items in the report, not the 
total sales for all items. If you want to report on the total for all items, set the Number of items to report on to a number 
greater than the number of items in your data file (Note that this may make the report very long, but you can choose just
to print the first few pages if you wish).

Management summary...
This report is designed with line managers in mind, or other people who want to “keep their finger on the pulse” of their
organisation but are not interested in the fine detail!

You'll be shown a window where you can choose a date range for the report:

The report provides the following information:

• The total value of stock on hand
• The 10 items with the largest stock value
• The 10 items with the largest value of supply to customers in the date range chosen.
• The 10 suppliers from whom you have purchased the most in the date range chosen.
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• The 10 customers to whom you have supplied the most in the date range chosen.
• If you check the “Include section on expiring items” checkbox, a section

will be included that lists:
• The cumulative liability for expiring items for each of the next 12 months.
• The 12 most valuable expiring items (or at least batches of particular items)
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Preview on screen before printing

Check this box if you want to view your report on screen first.
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Open report in Excel

Check this box to view the report directly in your chosen Spreadsheet program.
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Quotation Summary...
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There are two options in Report on section, namely: All quotations and Preferred quotations , and there are two options 
in Group together by section, namely Supplier and Item

All quotations shows the quotations in which Preferred is set to “true or false”.

Preferred quotations shows only those quotations in which Preferred is set to “true”.

Supplier option displays the quotation report on the basis of supplier.The quotations for the items related to a particular 
supplier are listed along with that supplier.

Item option displays the quotation report with the items arranged in alphabetical order along with the corresponding 
supplier's name.

In addition there are filters allowing you to narrow your search further by:

• limiting the report to suppliers meeting your specified criteria - e.g. the supplier's name code may be entered, so the resulting 
report will display only quotations from that particular supplier.

• specifying criteria relating to the item by choosing from the many options in the drop-down boxes as shown below:

There is an additional filter, the Date filter, allowing you to specify the dates on which the Quotations you are 
examining were created or modified, and the radio button toggles display of the quotations' expiry date ( Quotation 
valid date ) on or off.

Debtors Creditors
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The following reports are available:

Select the required report by clicking on it.

Debtors...
This report will produce a list of all debtors. mSupply uses an open-invoice system of accounting for debtors, so the 
outstanding amount for each debtor is displayed; for debtors with more than one invoice outstanding, the amount 
displayed is the cumulative total of all outstanding invoices.

Note that the total outstanding on invoices is not reduced for any previous overpayment by a customer, but this is listed 
in a separate column in the report.

To remove overpayment amounts from the system, choose customer | new payment… and enter the name of the 
customer with an overpayment. You will be asked if you want to use the overpayment amount for this payment. Choose 
use, then allocated the overpayment to outstanding invoices.

Creditors

Aged debtors

Customer statements...
You will be presented with a window to find customers.
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If you want a report for all customers, leave the entry field blank. Click OK and a report will be produced for any 
customers who match the criteria entered. Note that customers with no amount outstanding will not have a statement 
printed for them.

Transport Report
This report allows you to print information about the transport details for a range of invoices.

First you are shown a window where you can select a date range and choose to report on only invoices supplied by a 
particular method, by a particular responsible officer, or to a particular name or names.

Click “OK” to run the report.
 Note that transport details can only be entered on customer invoices if you have checked the “We use box numbers” 
option in the Preferences

Prescriber Report
This report (v1.93 onwards only) allows you to view the total value, mean item value and item count for prescriptions 
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dispensed for each prescriber.

You will be shown a window with the normal date range options, and the option to report only on prescibers whose type
field is set to a certain type….

Click OK to proceed.

The window that appears is the Transactions report, but you will see that the Prescribers report is highlighted.
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As usual, the report options window is shown where you can choose the destination and set headers and footers.

User transaction totals
This report was initially made for use in dispensing situations where you want a quick count of the number of 
prescriptions and items issued in a day. However, it is also useful for getting a quick view of workload for a month or a 
year in store mode. This report gives the number of supplier invoices (or prescriptions) and the number of stock lines on
them, reported by user.

Choosing this menu item shows a window like this (but without any user names and totals)

Date range

You can either enter dates manually or choose from the drop-down list to the right of the date fields.

Time range

Enter times here in 24 hour format (e.g.. 9:00 in the “from” field and 17:00 in the “to” field. Leaving these fields on 
00:00:00 will calculate for the whole day.
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To calculate totals, click the Show button. If there are a lot of transactions to evaluate, a progress bar will be shown.

Click the OK button to close the window when you are finished.

Backorder report
This report shows a list of Items that are not available or insufficient stock is present to meet the requirements of the 
order placed by the customer. Information about the item code, item name, current stock, customer code, b/ord quantity 
is displayed.

If you are running a backorder system this gives you a quick way to check if backordered items are now in stock so they
can be supplied to customers.

Suggest price list additions...
Note: the price list menu items are for those organisations that produce a price list or price indicator. (It is useful to call 
your publication a “price indicator”, as it implies the published price is a guide, and not a fixed price). You are asked to 
specify the number oftransactions and the number of months (e.g. 2 transactions in the last 3 months) that would make 
an item eligible for inclusion in the price list. A search is performed using the criteria you enter, and a list of items is 
shown that meet the criteria but are marked as not being in your price list. You can double-click on items in the list and 
click their “price list” check box to add them to the price list.

Update price list...
This item updates the prices of items from the item line on hand that has the most stock.

Only items whose “price list” check box is checked are updated.

Each line of stock is evaluated to determine which stock line you have the most of. That line is used as the indicator 
price for its item.

Note that if an item has no stock, then the price for that item will not be altered.

It is a good idea to run the “suggest price list additions” report first.

Price list...
All items that are marked as included in the price list are placed in a report. If you wish to export to a text file, choose 
“save to disk” in the report options dialog that is shown. Note: items that are in stock, but that are marked as not in price
list will not be included.

The exported file has fields separated by tabs and records separated by returns. The field order is:

• Item
• pack size
• price.

If you wish to include different information, you can create a custom report to do this.

Location report...
This report is available in version 1.96 and later.

This report lists the location description, type, capacity, used volume and percentage available. Choosing this menu item
shows you the location report filter options widnow as below:
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The report may be restricted to certain locations by using specific search criteria. Choose either “Code” or “Volume” 
from left drop-down list is . The centre drop-down list allows you to choose a comparitor.

You have to make an appropriate entry on the right-hand field. Leaving the field blank means no filter will be applied.

Location type

It allows you to choose a location type. You can select the one from the drop-down list on the right side. The graphic of 
location type is shown below.

For example, you can specify the location type“COOL” to show only refrigerated locations.

Check the “open in Excel” checkbox if you wish to directly open the saved report in Excel (or any installed 
spreadsheet).

Click the OK button to run the report.

Manage Reports...
Choosing this item shows a list of built-in reports and any custom reports which have been designed:
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The built-in reports may well be sufficient for your needs, but mSupply's versatility allows you to manage the reports to 
meet any specific requirements you have.
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Options in the Report Management window:

Delete selected reports

Report(s) no longer required may be selected and deleted from mSupply

Duplicate report

Should one of the built-in reports not quite meet your needs, you have the opportunity to create a duplicate of that 
report, and then modify it to meet your needs. The first step is to select the closely matching in-built report; in our 
example we'll use the expiring_items_date report, then click on the Duplicate report button;
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the window that appears has already selected a name for your report, using the name of the in-built report prefixed by “ 
my_ ”; you may change this name should you wish. The Permissions drop down list allows you to specify users having 
access to your report; the options are All users , or Only me . Should you wish your report to become the default one 
rather than the in-built report, then check the Make default checkbox. When you click on OK, the report you have just 
created now appears at the foot of the list of reports from the item on the menu Report>Manage reports.

Edit report

The editing of reports using the powerful editor has been extensively covered earlier in this section.

Using the report editor is complex, but it has the potential to produce a wealth of useful information. Contact 
Sustainable Solutions for a link to download a separate manual on the subject.
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Note that in a multi-user installation, changes you make to a report will affect all users, so don't change a report without 
some forethought….

Add report

Click on this button, and the following window appears

Revert selected reports

This button allows intrepid souls to save face by undoing the damage they have done to a particular report! The report 
that was installed with mSupply will be reloaded from the disk, and any changes you have made to the version stored 
with the data will be discarded.

Revert All

This button returns all in-built reports to their original state when you installed mSupply; exercise caution when using it.
Custom reports which you have designed are not affected.

Save selected reports

All reports are automatically saved by mSupply in the default folder. There may be occasions when you wish to save 
one or more reports on a removable storage medium - e.g. a pen drive - and this button allows you to do this; a window 
appears allowing you to specify the location in which you wish to save the selected reports.

Previous: Next: The mSupply Web Server

Backup
Choose File > Backup 

This function allows a backup of your datafile to be made to the specified location in your computer.

• The backup path can be set from File> Preferences> Backup.
• You can perform a backup manually and/or automatically.
• It is not necessary to quit the database before performing a backup.
• Automatic backup settings are configured in the Preferences chapter. See the section Backup

“Backup” function works both in single user as well as multi-user mode. Under multi-user mode, this command 
performs a backup of the server data. A progress window will show how the backup is proceeding.
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Note:- In multi-user mode, you can't run “Backup” and “Restore” function from the client. This should always be run 
from the server computer.

Backup: Best practice
We recommend you set up your mSupply backups in the following manner

Disk configuration

Use RAID 1 or 5

• RAID 1: two disks mirrored, so data is written to each disk
• Advantages

• if one disk fails you continue work from the other disk
• if the RAID controller fails, you can directly connect one disk and continue work.

• RAID 5: 3 or more disks, with one disk containing checksum information so that if any disk in the set fails, the set can be rebuilt.
• Advantages:

• The disk set can be easily expanded by adding disks if needed.
• Disadvantages

• You are reliant on the RAID controller, as disks can not be used without the controller. For critical data we recommend you 
have a spare RAID controller of exactly the same model you have installed in the server available.

Use a hot spare
This is a spare disk that the RAID controller will use if a disk in the RAID set fails.

Add another single disk to receive backup data
This disk is not part of the RAID

Backup your live data

• Configure mSupply server to 
• Use the single disk as it's backup location
• backup your data nightly
• use a log file. A log file (journal) records each database action as it happens. In the event of a power failure or other adverse 

event, all changes can be recovered from the log file.

Configure a secondary backup location in mSupply
mSupply can be configured to copy every Xth backup from the backup folder to another volume. The destination can be
on the same machine, or elsewhere on the network

Configure off-site backup
Use Spideroak™ or Dropbox™ to backup your secondary location to their internet servers If needed configure an off-
site computer to also synchronise with the backup service provider so you have an off-site copy as well as the “cloud” 
copy.

Mirrored servers
We have the technology to provide mirrored servers when very high availability is required. Contact us if interested. A 
charge will apply for implementation

Restoring your data
Choosing this item allows you to choose a backup data file, uncompress it and start using it as your main data file.

• Log in to msupply with an old data file or by creating a new data file and click menu File > Restore…
• Locate your backup file in the Open dialog that appears. Your backup file has file extension .4BK, eg. mSupply.4BK. Hit OK.
• Clicking on the small red down arrow next to the data file name will show the current destination location to where the data file 

will be restored. You are being prompted for a folder where the data file will be restored to. Change the destination location of the 
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data file by clicking on the … button. Once you are happy with the destination location, hit the Restore button.
• After the file is restored, the file location is then displayed using your computer's default file manager. You can close this window.
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• Now go back into mSupply and click menu File > Open data file…
• Locate the newly restored data file in the Open dialog that appears. Your data file has file extension .4dd, eg. mSupply.4dd.
• Select the data file and hit the OK button.
• You may be prompted for a log file. Click on the Create button. Select the suggested location, which is the same as your new data

file location, and click on the Save button.
• You will be prompted to do a backup. It is not necessary to do this at this stage. It will take a few moments to open this new data 

file, particularly if it is a large data file.

755



• mSupply should open your restored data file and you should be presented with the log in screen to the new data file.

In client/server usage this command will have no effect.

Be very careful about restoring. We suggest you consult Sustainable Solutions before attempting a restore.

Previous: Regimen data recording Next: Changing users and Passwords
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If more than one user is sharing your computer, choose this item before you leave the computer so that the next user 
will have to log in with their user name & password before gaining access.

If you find yourself on this page accidentally and if you do not have sufficient permissions to change to another store or 
user then you will have to close and restart mSupply by clicking Quit or the red X at the top right of the screen and 
launching the program again.

Switch
This menu item lets a user (whose permissions allow) switch stores and/or login mode without the need to re-enter their 
password. Note that this screen does not allow a change of user; pressing Cancel reverts to the current store/login mode,
so caution in using this feature should be exercised, and this screen should not be displayed when the computer is left 
unattended.

Change Password
You can change your password by choosing the Change Password… option from the File menu.
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Passwords are case sensitive- make sure you 
don't have Caps Lock on. If you forget your 
password you must ask the user who is either 
first or second in the user list to change your 
password for you.

You need to enter the new password twice to make sure you have typed it correctly.

Edit users
See 

Previous: Backup Next: Diagnostics

Diagnostics
Note: This feature is primarily intended for use by our technical staff when there is reason to believe that there may be 
some errors in the database; it is unlikely to be of practical use to users of mSupply . A brief description follows.
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Pack size integrity: Each item's pack size is examined by batch number to confirm that stock in balances with stock 
out.

Store integrity: Each customer invoice is examined to confirm that each transaction has been applied to the appropriate
store.

Purchase Order integrity: A check is performed to confirm that Purchase Order quantities and Goods Received 
quantities tally.

Miscellaneous check: This check is performed to confirm that any repacked items have not resulted in negative 
amounts being recorded

Look for ledger problems: This report presents you with a list of items whose ledger balances (total in minus total out)
does not equal the difference between the opening stock and the actual stock on hand.

The report was originally created as a check that the stock on hand was being accurately updated with all the different 
transactions in mSupply. It has been left as a menu option as it is also useful to pinpoint unauthorized adjustment of 
stock values.

Previous: Change user Next: Field descriptions

Field descriptions
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The following tables list the main tables in mSupply (There are some others, but we're not telling you about those!). 
This information will help you if you are building your own reports.

Note that if a field is indexed, finding information (querying) using that field will be very quick.

Main tables
Table Description 

Transactions A transaction record is stored for each invoice 

Transaction lines one transaction line record is created for each line on an 
invoice 

Items An item record is created for each product or service 
purchased or supplied 

Item lines Each batch of stock at a particular location has one 
item_line record 

Names Each patient, customer or supplier has one name record 

Purchase Orders One record is created for each purchase order to a supplier 

Purchase Order Lines Each record is an order for one item on a purchase order 

Quotes and Quote Lines Quotations submitted by suppliers 

Tenders Tenders created to invite quote submissions from suppliers 

Customer stock history Tables that store customer submitted stock and order data 

Store Information about a particular virtual store 

Drug_Register Drug Registration records (for use in the Drug Registration
module) 

Foreign Keys
Get your Foreign Keys here.

Other tables
Table Description 

Abbreviations Stores abbreviation codes and their expansion for 
dispensing directions 

Account_code Stores account codes associated with each item 

Backorders One record for Customer backorder. 

Bill of Materials One record for each mSupply user 

Contacts One record for each contact 

Currency One record for each curency 

Drug interactions Drug interactions and Drug interaction groups 

Item Categories One record for item category 

Labels Miscellaneous labels 

Log Each record contains one event recorded by mSupply 

Users One record for each mSupply user 

Item Departments The departments that an item can be assigned to 

Item Directions The default directions that are assigned to items 

Item notes The notes that are attached to items 
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Item Warning Link A join table that stores which items have which warnings 

Name category tables Tables that store the categories that can be assigned to 
names (customers, suppliers, donors, manufacturers etc.) 

Prescribers One record for each prescriber 

Regimen records, Regimen and Regimen Lines Everything to do with storing ARV regimen records 

Reminders A reminder is an event with a due date- like a to-do 

Stores Stores and join tables that control access per-store 

Warnings The warnings which can be attached to items 

Custom stock 5 Holds the details of the values that are selectable in the 5th 
user field when receiving stock 

Custom stock 6 Holds the details of the values that are selectable in the 6th 
user field when receiving stock 

Custom stock 7 Holds the details of the values that are selectable in the 7th 
user field when receiving stock. 

Custom stock 8 Holds the details of the values that are selectable in the 8th 
user field when receiving stock 
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Tables used internally that you most likely shouldn't be interested in
Table Description 

Number and Number re-use Stores serial numbers such as invoice numbers 

Preferences The data for each preference is in binary format. You're not
interested. 

Item store join 

Field name Description Type Length Ind 

Note that records are created for each item- there should always be one record for each item in each store

id Long 

store_ID Long 

item_ID Long 

inactive true means item is not 
visible in this store. 
False means it is 
visible 

bool 

Name store join 
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Field name Description Type Length Ind 

Note that records are only created as needed- that is a missing record implies the name is invisible for that store

id Long 

store_ID Long 

name_ID Long 

inactive true means name is not
visible in this store. 
False means it is 
visible 

bool 

Name group 

Field name Description Type Length Ind 

key Long 

name Alpha 40 
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Name note 

Field name Description Type Length Ind 

note_type Alpha 3 

entry_date Date 

note Text 

name_key Alpha 8 

key Long 

Permissions 

Field name Description Type Length Ind 

item_dept_key Long 

name_group_key Long Ind 

Permissions 

Field name Description Type Length Ind 

name_group_key Stores which name 
groups have 
permission to be 
supplied which item 
departments 

Long 

item_dept_key Long 

Prefs 

Field name Description Type Length Ind 

item Internally used: storing
preferences of text 
type(Now deprecated 
in favour of pref blob) 

Alpha 20 

value Alpha 60 

Reports 

Field name Description Type Length Ind 

report_name Alpha 80 

report_blob BLOB 

owner_key Long 

key Long 

last_updated Date 

Ship method 
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Field name Description Type Length Ind 

key Long 

method Alpha 80 

Transaction category 

Field name Description Type Length Ind 

key Long 

category Alpha 80 

type Alpha 3 
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Transaction Notes 

Field name Description Type Length Ind 

key Long 

note Text 

Units 

Field name Description Type Length Ind 

key Long 

units Alpha 60 

comment Text 

Web favourites 

Field name Description Type Length Ind 

name_key Alpha 8 

Item_key Alpha 8 

type Alpha 3 

Web messages 

Field name Description Type Length Ind 

key Long 

active Boolean 

show_until_date Date 

headline Text 

message Text 

Previous: Diagnostics Next: Finalising transactions
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Finalising is controlled by user permissions. 
If you are not able to finalise invoices, you 
likely don't have the user permission to 
perform the operation. There is more 
information on permissions here

Finalising transactions
There are three methods of finalising invoices:

47. The method described here.
48. By highlighting transactions in the transaction list and clicking Finalise
49. By checking the Finalise checkbox when viewing a particular invoice and clicking OK to close the window.

Finalise customer invoices
All invoices that have status “cn” (i.e. confirmed invoices) may be finalised. 

If you have the export option turned on in the Preferences, finalised invoices will also be exported to allow import into 
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an accounting program. They can also just be “exported” to a printed list.

Once an export is done, invoices can no longer be edited. (They have status “fn” for finalised).

Each time a group of invoices is exported, they are all assigned a common “batch” number. You can use this batch 
number to export an invoice again, should your export file become lost or damaged.

On choosing File > finalise customer invoices you will be shown a window displaying all the customer invoices that 
have not been finalised.

Note that if “export invoices when finalising” is turned on in the Preferences, invoices that have been finalised but not 
yet given an export batch will also be included in the list. If any such invoices exist you will be alerted to the fact.
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The first screen advises you of the folder to which your file will be saved. The next screen displays a list of invoices not
yet finalised. 

Follow these steps:

• Hold down the control key (Windows) or command key (Mac) while clicking on the lines you wish to finalise. The lines you have
selected will be highlighted.

• To reverse a choice click on the line again.
• If you want to choose all the transactions displayed, type control “a” (Windows)/ command “a” (Mac)
• Once you are satisfied with the records you've selected, click the OK button. (In fact, don't just be satisfied, be extra sure- you 

can't reverse a finalisation. It really is final).
• The transactions will be marked as “finalised” (status “fn”), and they may no longer be edited.

You will be given the opportunity to print the list of finalised invoices.

If you have specified the option in the Preferences, a text file called “cust_invoice_expt.txt” will be created on the disk 
(& in the folder) you have specified in the Preferences.

Each time you finalise a group of invoices, they are given an export batch. This is a unique number that allows you to 
recall those invoices.
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Finalise supplier invoices... .
As for the finalise customer invoices…. section above, but for supplier invoices

The export file created is called “supp_invoice_expt.txt”

Finalise inventory adjustments...
You need to finalise inventory adjustments so that they can be purged from mSupply at a later date. Also, you will not 
be able to set the start of year stock at the beginning of the next financial year until all inventory adjustments have been 
finalised.

On choosing item | finalise inventory adjustments … you will be shown a window displaying all the inventory 
adjustments that have not been finalised. Follow these steps:

• Hold down the control key (Windows) or command key (Macs) while clicking on the lines you wish to finalise. The lines you 
have selected will be highlighted.

• To reverse a choice click on the line again.
• If you want to choose all the transactions displayed, type control “a” (Windows)/ command “a” (Macs)
• Once you are happy with the records you've selected, click the OK button. (In fact, don't just be happy, be extra sure - you can't 

reverse a finalisation. It really is final).

The transactions will be marked as “finalised” (status “fn”), and they will no longer be able to be edited.

Moneyworks exports
If you are using “Moneyworks” accounting software, you can export invoices directly to Moneyworks.

If you have turned this option on in the Preferences, rather than exporting a text file to disk, mSupply will attempt to 
connect to Moneyworks, and directly send the invoice data to Moneyworks, where a debtor invoice is created for each 
invoice in mSupply. You can then use Moneyworks superb statement production (with full control over the form design)
along with it's open item handling of debtor and creditor payments to take over the handling of payments and receipts. 
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Contact info@sussol.net if you would like more information.

Finalising. Note that if “export invoices when finalising” is turned on in the Preferences, invoices that have been 
finalised but not yet given an export batch will also be included in the list. If any such invoices exist you will be alerted 
to the fact. A text file called “supplier_invoice_expt.txt” will be created at the location you have specified in the 
Preferences.

Note: if you are using mSupply in Client/Server mode, exports will be sent to the “export” folder located in the same 
folder as the 4D client application.

Finalise builds...
You need to finalise builds so that they can be purged from mSupply at a later date, or to disallow any further editing of 
particular builds. Also, you will not be able to set the start of year stock at the beginning of the next financial year until 
all builds are finalised.

See the sections above for the details of how to finalise transactions. The process is just the same for builds.

Export a batch again...
Choosing this item presents you with a window where you can choose a batch number to export again:

771



Invoice batch numbers are shown on the right hand side of invoice lists.

Previous: Field descriptions Next: Managing data files

Managing Data Files

Creating a New Data File
This command will present you with a standard open/save window where you can choose the name and location of a 
new data file: If you click the OK button, mSupply will close the data file currently in use (saving any changes made 
automatically), and then open the new data file. The new data file will contain no items, names or transactions. You can 
either enter these manually or use the import commands (see later in this chapter) to import items, names and stock.

Open an existing data file
This command will present you with a standard open/save window where you can select an existing data file to open. If 
you click the OK button after successfully selecting a valid mSupply data file, mSupply will close the data file currently
in use (saving any changes made automat- ically), and then open the new data file. Note that if you regularly use more 
than one data file, use the “About mSupply…”. Command from the help menu (mSupply menu on Macintosh), where 
the data file currently in use is displayed. Warning:: Do not try to open the same data file from 2 or more single user 
copies of mSupply at the same time. You will corrupt your data. If you require multi-user access, buy a multi-user 
licence!

Previous: Finalising transactions Next: mSupply Client/Server installation

mSupply Client/Server installation

Recommend Hardware
The following table lists recommended hardware for an mSupply server
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Item Recommendation 

OS Windows 2008 / 2011 / 2012 or Win 7 / 8 prof with latest 
service packs 

Processor Dual core Xeon or equivalent. For greater than 15 users: 
Quad core Xeon 

Memory ECC memory Minmum 8Gb +1Gb per user over 8 users. 

Hard disks 3 SSDs to run RAID 1 Array + Hot Spare. 1 seperate HDD
for primary back up 

Network card Single Gigabit 

RAID controller RAID 1: Onboard RAID controller is fine 

Power supply Dual power supply, Hot swap 
Indicative pricing in a Western country: USD3000 to USD5000

For a Terminal server, the general specification changes in that

• More RAM is needed.
• Hard disks are less important, as no data is stored on the server.

Item Recommendation 

OS Windows 2008 / 2011 / 2012 or Win 7 prof with latest 
service packs 

Processor Dual core Xeon or equivalent. For greater than 15 users:
Quad core Xeon 

Memory ECC memory 8Gb plus 1Gb per connected user 

Hard disks 3 SATA or SAS disks. RAID 1 or 5 with hot spare 

Network card Single Gigabit 
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RAID controller RAID 1 plus Hot spare, or RAID 5 with hot spare 

Power supply Dual power supply 
Indicative pricing in a Western country: USD3000 to USD5000

Installation pre-checks

Remotely store mSupply data

• If you are upgrading from a previous version of mSupply, first perform a data backup. With mSupply server open as an 
application click on File> Backup…. This will generate a backup file of your current data with file extension .4bk. 

• Copy this file to a remote location, e.g. USB drive, a cloud service such as Dropbox.
• Continue only when the .4bk file has completed transfer to the remote location.
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UPS (Interruptible power supply)
Unless you have very reliable power we suggest you install a UPS with external batteries that will provide several hours
run time

• External battery
• External battery voltage: 12 to 36 volts
• e.g. Eaton EDX1000HXL model or K-Star 36V models
• The UPS must be able to communicate with the server (usually with a USB cable) to initiate a shutdown and run a batch file in 

advance of shutdown. This is usually achieved with a serial or USB cable.

Installer files and privileges

• Log in with administrator privileges to the computer on which mSupply will be installed.
• Copy the relevant installer file(s) to the desktop. Installer file(s) may be and upgrade or a full installer.

Installing mSupply server
If you are using the client/server version of mSupply you will be supplied with 2 installers. One installer, 
mSupply_server_installer.exe is used to install the server software on a single server computer. The other, called 
installer mSupply_client_installer.exe is used to install the client software on as many computers as you wish. You will 
be limited in how many clients can connect at any one time by the server licence you have purchased.

The installers are available in two formats: downloaded or on CD. To run the installers do the following:

• From CD: Insert the mSupply CD, open Windows Explorer and double-click the installer file on the CD that you wish to run.
• From download: Locate the downloaded file and double click it to install.
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You must be logged on as administrator to 
install mSupply with the correct permissions. 
Please consult your IT support staff if you 
require assistance to achieve this.

Run the installer
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What is installed where:
We strongly recommend you do not change the default installation directories, which are as follows:

mSupply Server: c:\Program files\mSupply\mSupply Server

mSupply Client: c:\mSupply Client

(The volume may have a name other that “C” depending on how your system is configured)

mSupply server installer also installs the following files and folders:

A folder called “report” containing mSupply reports. This folder may be used to apply customised reports.

Starting the Server for the first time
The first time you start the server, double-click the “Start mSupply Server” icon on the desktop

You can also start the server by choosing Start > mSupply Server > mSupply Server
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You will be shown a welcome window where you should choose the “I would like to activate 4th Dimension” radio 
button.

Then click “Next”
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You must have Foreign Currencies 
configured in mSupply if you are using this 
feature; you can set them up now using and 
once you have done this, performing the 
steps below.

In the next window you should read the agreement.Click on the “I agree” check box, and then on the “Next” button“

Then the activation mode window is shown.

Choose “Offline activation” then click “Next”
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As an example for the guide, our store 
operates with Australian dollars (AUD) as 
the local currency, and is making a purchase 
from a European supplier which uses the 
Euro (EUR) 

You will then be shown the window to generate a file.
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The columns headed 'Price FC' and 
'Extension FC' in box 2 above show the cost 
price of goods to you in Euros - i.e. the 
Foreign currency which the supplier uses, 
while the figures in the columns on the right 
show the prices in Australian dollars - i.e. 
your local currency. 

In our example, the supplier uses Australian 
dollars (AUD), and is creating an invoice for 
Highland Health Centre which uses Solomon 
Islands dollars (SBD).

Do not enter information here- just click the “Next” button.

Click the “Choose File” button and choose the file sent to you by Sustainable Solutions.

Once you have chosen the file, it will show in the box in the window:
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Then click the “Next” button and at the final screen click button Go to 4D. The next window states that a data file is 
required to run mSupply 

782



If you change the customer on an invoice 
that has item lines, the following message 
will appear. Check the currency is correct for 
the new customer and adjust it if necessary.

Click button Open and choose or create a new data file. The below image shows an existing data file.
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If you create a new data file we suggest you 
create a folder called “mSupply data” inside 
your “My Documents” folder. You can create 
the data file anywhere you like, but make 
sure you have read/write access to the 
directory or there will be problems.

In our example, the supplier, International 
Dispensary, uses Euros (EUR), while we use 
Australian dollars (AUD).

Once you have clicked the Save or Open button you may be shown a window like the one below, simply click convert 
and wait for the data file to be updated to work with the latest version of mSupply.

Then you will be showm a message stating that your data file has been updated with new Preferences.

You will have to connect with the client software to configure the Preferences for mSupply and to enter the mSupply 
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In our example, the supplier uses Australian 
dollars (AUD), and is creating a credit note 
for Highland Health Centre which uses 
Solomon Islands dollars (SBD).

registration number. You will then be shown the 4D server admin interface:

Congratulations!

If you get a Windows Security alert
If you are running WIndows XP with SP2 or later installed you may get this alert:
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While invoices can be edited after 
authorisation, once authorised, Goods 
Reciept Lines cannot be unauthorised to fix 
mistakes! Any authorised errors can only be 
fixed using stock adjustments.

Make sure you click the Unblock button or the server will not function properly.

About the backup scheduler window
The new version based on 4D 2004 server has an integrated backup scheduler. Please request detailed documentation 

from Sustainable Solutions regarding its use.

Setting the server to run as a service on Windows
The server should now be set to start automatically when the machine is turned on. This can be accomplished by setting 
the server to run as a service. Choose File > Register Current Database as Service. 
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When invoices have to be authorised, it 
means that they cannot be confirmed until 
they have been authorised i.e. invoices 
without authorisation are held at status 'sg' or 
suggested. This means the official invoice 
can not be printed (and goods taken out of or 
receipted into stock) until the invoice has 
been authorised.

If the option is greyed out you need to quit the server and choose run as administrator. 

Quit the Server admin window by clicking the close box on the top right (or choose File > Quit from the menus). You 
will then be shown a disconnect window:

Type “0” into the box, and click OK . The server will quit.

Now open the services administrative interface by choosing Start > (Settings) > Control Panel > Administrative Tools 
> Services .
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Right-click on the Services icon and choose S end to > Desktop (as shortcut). This will provide quick access this area in
the future.

Double-click on Services in the list. You will be shown this window.

Double-click on 4DServer:mSupply - fortunately it is usually the first item in the list!

You will be shown the 4D service properties window. Change the Startup type in the drop-down list to automatic .
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On the “Log On” tab, the settings should be shown below:
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• Make sure “Log on as” is set to “local system account”
• Make sure “Allow service to interact with desktop” is checked.
• You can now start the service by clicking the little play button (right facing triangle) on the toolbar with the 4D service 

highlighted.
• Click OK to return to the list of services.

Scroll down the list of services until you see Interactive Services Detection. Double click this and then chnage 
“Manual” to “Automatic”. Then click on the Log on tab and tick the box, “Allow service to interact with desktop” Click
OK at the bottom of the window and then click the Start Service button (see the button in the red box above). At this 
point the status should start reporting either “started” or “running”. Click the red X to close the box.
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If clicking the Start Service buttom results in 
an error a registry edit is necessary. Please 
only do this if you are confident and familiar 
with editting the registry. mSupply Support 
can help with this. Edit registry value:
  Hive: HKLM
  Path: 
SYSTEM\CurrentControlSet\Control\Windo
ws
  DWORD: NoInteractiveServices
Change value “1” to “0”

Once finished editting the registry. Return to the list of services and start the ISD service. It should now start!

From now on the 4D server will start automatically when the machine is turned on. There is no need to log-on to the 
machine.

On the desktop, we suggest you delete the Start mSupply server shortcut, as this will not start the 4D server as a service,
and should not be used.

Should you need to manually stop and start the server in future:

• To start, double-click the “Services” shortcut you made on the desktop, highlight the 4D server service, and click the “start” 
button (looks like a “Play” button on a VCR )

• To stop the server, make sure clients are not connected, then choose File > Quit on the server.

Next steps: install mSupply client then register mSupply.
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Entering Extra 4D serial numbers

When you registered 4D server the licence allowed 2 concurrent connections. If you have purchased extra connections, 
you should enter the serial number(s) now.

Choose Help > Update licence. This window is shown:

Click the Add button to enter additional licences.
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Creating a new data file or choosing a different data file
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From this point there should be no need to revisit any of the about procedures to operate mSupply. However, if you are 
testing, or starting a data file for a second organisation, you may wish either to change the data file mSupply is using or 
to create a new file.

The mSupply program (the files named “mSupply.4DC” and “mSupply.RSR”) store the path to the last data file used, 
and the next time mSupply is started, the previous data file that was open is opened again unless there is user 
intervention or the “old” data file has been moved to a new location.

To intervene, hold down the “alt” key as the 4D server starts up.

You will be shown the standard open/save window:
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The Windows operating system uses the 
Control key and the Mac operating system 
uses the Command key to activate keyboard 
shortcuts. For clarity's sake we've used the 
control key in the table below. If you're using 
a Mac just substitute Command for Control.

To create a new data file, click the “New” button.

To select an existing data file, navigate to the file's location then click the “Open” button.

Installing mSupply Client
To run the installer, insert the mSupply CD, open Windows Explorer and double-click the mSupply_client_installer.exe 
file on the CD. Once the installation is completed, double-click the “start mSupply Client” shortcut on your destop. The 
following window will appear:
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User Access Control, a feature of Windows 
7, requires that the undernoted steps are 
followed when you are upgrading mSupply

The window lists available mSupply servers on your network. Click on the server you wish to connect to. Once you 
have connected successfully, the “Recent” tab will be shown first, and you can choose the server there. If for some 
reason network settings have been changed, and you cannot connect from the “Recent” tab, remember to look at the 
“TCP/IP” tab as well.

Clicking the “OK” button will take you to the mSupply password entry window. For new data files, the password is 
“user1” for the first user in the list. Click on the first user, then enter the password and click “OK”

Firewalls and the like
To make it easy for you to connect, mSupply publishes details about available servers on a specific port. It is quite 
possible that products such as “Zone Alarm” and “Norton Personal Firewall” will block access to this port and stop 
discovery of the servers. Contact your system administrator if the list of available servers is blank.

Registering mSupply
The procedure is described earlier in “Preferences” chapter of the mSupply manual. See The Register button

You will either have to phone or email the information to Sustainable Solutions to obtain a registration code.

Note that the code is keyed to your organisation name and the MAC address of the server. Changing either of these will 
require a new code, which we shall willingly provide.

Configuring mSupply
Once registered, you may want to systematically to go through the mSupply Preferences and choose appropriate 
settings.

Your installation of mSupply may have customisations made specifically for your work scenario. Please contact our 
support staff on support'at'msupply.org.nz to manage these customisations.

Saving your data file
At this point you should have a “clean” data file that is registered and is set up ready to use, but does not have other data
in it.

mSupply client installer also installs the following files and folders:

• A folder called “\4D\Network” in the Windows folder on the startup volume, which contains network component files that need to
be present for 4D to communicate over a TCP (and othe types of) network(s).

• Note that no reports are installed on 4D client. Each time 4D client connects to the Server, reports that have been added or 
modified on the server are automatically copied to the client.

• Note that the installers have been set up to overwrite existing files, so reinstalling the software will restore any potentially 
corrupted files to their original state. The installer will not overwrite your data files, unless you have been wise enough to name 
your data file “example data” and put it in the “example data” folder.

Upgrading to a newer version of mSupply

1. In Windows 7 click Start Menu> Control Panel> User Accounts
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Any user in 'Supervisor - All stores' mode will only see the stores they are 
allowed to log into in the list of stores to select from.

2. Click 'Change User Account Control Settings'
3. In the window that appears move the slider to the bottom and hit OK
4. You will be requested to restart the computer - do so(!)
5. If you copied the files already (which wont work as the pseudo copy occurs) these copied files should now automatically work

Graceful shutdown in the event of a power failure
Your mSupply server should be attached to a UPS. The UPS should be fited with a control cable (serial, USB or 
network cable) that allows control software to detect a low power situation and shut down the server.

In the UPS control software set the shutdown to start at least two minutes before the power will fail.

Set it to run a batch file at that point. The file should contain the single line “net stop Service name” where the service 
name is the name displayed in the properties when you double-click the service name in the services window. In the 
example below the service name is “4DS mSupply.4DC” (not to be confused with the display name)

You may wish to test your typing skills by opening a command prompt:

Previous: Managing Data Files Next: Configure Dispensary mode

mSupply Server Administration
mSupply server provides a number of administrative features that enable fine-tuning and robust management of the 
system.

Server Monitor
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The server monitor tells us our computer hardware specification, datbase engine version, and license information 
including maximum connections 

Users
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The Users tab shows us connected users with LAN information, IP address, machine name and Windows logon user 
name 

Processes

The processes window shows system resource consumption for each process. This is a useful screen to analyse slow or 
otherwise unresponsive systems. 

Maintenance
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The maintenance tab is where data info and actions can be retrieved and performed. The window shows when tasks 
were last performed and provides the settings to perform verification, data compacting and log recording. 

Backup
The Backup tab provides settings to manage the way your data is backed up and where the backup file resides. This is a 
critically important section to manage properly as your data is a key asset of your system.
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After changing sync settings for a store you 
will have to restart the mSupply application 
on the primary server for the changes to be 
applied.
In a normal environment, setting up a server 
is a one-off event, so this requirement will 
not affect you unless you are adding stores to 
an existing environment.

Schedule a backup: 
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Even if a sync store has sync type = none, it 
can still receive incoming sync records from 
outside. These incoming records will trigger 
the code to see if the records need to be 
forwarded on elsewhere.
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Configure content and destination of the backup: 
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Backup & Restore: Decide how many backups to store in your destination folder. You may also set the system to retry 
backups if a backup is not possible at the scheduled date and time. Eg. if the system is not running. 

Application Server
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Application Server: The application server provides settings to manage the structure (.4DC file) and data (.4DD) files. It
also provides information about LAN and system memory. 

Web Server
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Web Server: The Web server tab shows the web server status and running ports. The web server can be started or 
stopped form this tab. 

mSupply file extensions and types
This information is just for reference and to help your understanding.

On both Macintosh and Windows OS - five files.

• A structure file (.4DC suffix)
• A structure resource file (.rsr suffix)
• An executable file (.exe suffix)
• A data file (.4DD suffix)
• A data resource file (.4DR suffix)

File arrangement
It is easiest to keep all relevant files in the same folder, in a reasonably accessible place on your hard drive. (For 
example, directly on your “C” drive.)

If you make copies, don't leave them in the same folder, or you'll just get confused!

There are several folders to store reports and queries that need to be in the same folder as your structure file. Note that 
these folders are automatically created when you unzip the program files the first time. They are mentioned here so 
those of you with an inquisitive streak won't unknowingly do damage!

• A reports folder. This stores reports that are used by the program. Leave this folder alone- store your own reports in the custom 
reports folder.

• A custom reports folder. Store the reports you create here.
• A custom queries folder. Store the queries (searches) you create here.
• A custom labels folder. Store any label templates you create here.
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Note that on Windows or Macintosh the run time application (that is, the database engine- “4Drun.exe” file on 
windows) can reside anywhere on your hard disk, and does not need to be regularly backed up (although you should 
have one backup copy somewhere!)

Getting the right data file when you open mSupply
Important! If you open mSupply by double-clicking the “start mSupply” icon on the desktop (Mac users- by double-
clicking the structure file), mSupply will try to open the same data file that was last opened. It will open the same file 
each time if you repeat the same procedure. If you make a copy, and then double-click the copy of the structure file, 
mSupply may still open using the data file from the original if it can find it.

To choose the data file manually do this: 

Mac: hold down the option key as you click the OK button in the password window. You will then be given an 
open/save box to choose the correct data file.

Windows: Launch the program and then quickly hold down the Alt button until you see a box come up. It will give you 
an option to Select another data file.

If you are not sure which structure and data file you are currently using, on a pc logged into the correct datafile, choose 
about mSupply… from the help menu (Windows) or the apple menu (Mac).

Previous: Managing Data Files Next: Dispensary Installation

mSupply Dispensary Installation
mSupply provides a fully featured Pharmacy Dispensary module. The following steps describe how to configure 
mSupply for Dispensary use. This document specifically applies to Pharmacy Dispensary staff.

Users

• Set up users to log in in dispensary mode

Permissions

Misc

• Show direction entry: checked
• Item codes must be unique: checked
• Service items: can be set to “allowed” if recording non-stock charges- like a dispensing fee.
• Show direction entry: checked

Invoices 2

• Allow placeholder lines: checked

Handling stock on hand
You may want to consider setting stock to a very large number for each item. This will mean that stock is effectively 
ignored. Experience tells us it is very (very) hard to accurately track stock in a busy dispensary, and most likely 
unnecessary if you are tracking issues to the dispensary from another virtual store.

Per store preferences

Preferences in the dispensing store
Go to Special > Stores > Double-click the dispensary store and set these preferences (and maybe others)

• Patients created in this store not visible in other stores: checked
• Names created in this store not visible in other stores: checked (may vary depending on situation)
• Your training will have to take into account the setting for stock transfers that you choose here.
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If your dispensary store is hosted on a Sync 
Client, then you will not see the Visibility 
tab. These settings need to be done while 
logged in to the Sync Server.

Pack to one
As dispensing is invariably in mulitples of single tablets etc, you will want incoming stock converted to packs of one. 
You can do this on a per-item basis, but the better way is to go to Special > Stores > Double-click the store you're 
logged in to, and you'll see a visibility tab. On that tab click “Set pack to one for all visible items in this store”

Abbreviations
Choosing a set of abbreviations should be a colloborative activity with staff. Note you can import abbreviations

If more than one language is used, you might want to make the same abbreviation with a suffix for the less common 
language. eg

Abbreviation Expansion Comment 

tid dinko tin palta In your common local language (in this
case Neplish) 

tide three times a day add a suffix “e” to the same 
abbreviation when using for the 
English expansion 

Latin abbreviations are universal

Abbreviation Expansion 

od once a day 

bd (or bid) twice a day 

tid three times a day 

qid four times a day 

hs at bedtime 

nocte at night 

pr in the rectum 

po orally (by mouth) 

pv into the vagina 

qqh every four hours 

q6h every six hours 
It is important to be consistent with choosing abbreviations so people can remember them. e.g.

Abbreviation Expansion 

1t Take one tablet 

2t Take two tablets 

3t Take three tablets 

ht Take half a tablet 

1c Take one capsule 

2c Take two capsules 

wtf with tasty food 
Users should be trained that you can mix abbreviations and normal text- whereever an abbreviation is encountered it 
will be expanded. It is important not to make an abbreviation that is a normal word in the language, else the expansion 
will happen when the word is typed.
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Item abbreviation shortcuts
This is important. See here The aim should be that every common item has all common directions saved as a shortcut. 
Pay attention to having the most common shortcut at the top of the list.

Patients
In a dispensary, your customers are the patients. Their details need to be recorded. This can be done prior to 
implementing dispensing through importing of patients - refer Patients. In many cases, you will find that there is no 
accessible database of patient names and that you will need to enter patients 'on-the-fly'. A New Patient button is on the 
Prescription entry window for this purpose. This will slow down the dispensing process, but over time, as more and 
more prescriptions are for 'existing' patients (e.g. for inpatients and chronic patients), this will become less of an issue.

Patient Code
Each new patient requires a patient code. This patient code can be applied automatically be ticking File > Preferences 
> Dispensary Mode > Auto-generate patient code. You also have the option here to prefix the codes with a string of 

text. This is particularly helpful in a multi-facility installation where patients may be referred from one facility to the 
next and you would like to know in which facility they first entered into the system.

Prescribers
mSupply allows prescribers to be recorded against each prescription. This can be made a requirement by ticking File > 
Preferences > Dispensary Mode > Prescriber must be entered. Making the recording of the prescriber mandatory will 
obviously slow down data entry during the dispensing process. In order to record prescribers with prescriptions, 
prescribers must be entered into the system - refer Prescribers.

Printing
Set printing to be on by default for new entries, and off by default for edits.

Train users on changing printers using Special > Printing preferences

It is important that printers have a static IP address. You can do this in two ways:
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With a Zebra GK 420 you can hold the front 
button until it flashes once, release it, then it 
will print out the IP address. Read all about it

To prevent administrators having their 
permissions accidently reduced mSupply 
does not allow the first 2 users in the user list 
to be added to groups.

1. Set a static IP address on the printer. Log on to http://printer_ip_address to do this. It's under network settings. The default IP for 
Zebra printers is 192.168.254.254

2. Use the DHCP server on your network to set a Static DHCP mapping. This is preferred, as it's much easier to change.

Previous: mSupply Client/Server installation Next: Restricting user access

Managing users
Updated: Version 3.13

About users and groups
As of version 3.13, mSupply has important improvements to its user management:

1. User permissions are now per-store, so a user can have different permissions when logged into one store from another store.
2. You can create and use user groups. Once a group is set up and permissions for the group assigned, any users that are assigned to 

the group will inherit the group's permissions, rather than having to set permissions for each user individually. When you change 
a group's permissions, you change the permissions for all users who belong to that group. Very useful if you have a lot of users.

Adding and editing users and groups
mSupply has a comprehensive system of controlling user access, allowing you to manage individual user's level of 
access and the information within your system available to them. User access is managed by choosing File > Edit users.

You are presented with a list of current users:
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The list shows you the following information:

• User The user's name.
• Job title The user's job title, as entered on the details tab of the user's details form.
• Group The group the user belongs to. Will be blank of the user does not belong to a group.
• Active Checked if the user is allowed to login to the system. 

To view groups rather than users, choose Groups from the Show Drop-down list at the top-right of the window. The list
changes slightly to look like this:
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 Now the list shows you slightly different information:

• Group The name of the group
• Active Checked if the group is active. If the group is active then all users in the group are allowed to login to the system. If the 

group is inactive, all users in the group are inactvie and are not allowed to login to the system. 

Double-click a user (or group) to edit their details or delete them. Click the New User button to add a new user. 

To get a list of all current user permissions, click the Permission Report button in the toolbar. An Excel spreadsheet 
will be generated; it will have one worksheet for each store showing all the users and groups and what permissions they 
have in that store.

Double-clicking an entry in the list gives you this window (same for a new user, but all entries are blank):
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To create a new user do this:

1. Enter the user name
2. Assign a password
3. Enter the password again in the Confirm password text box
4. Go to the permissions tabs and set up permissions (3 tabs)
5. Go to the Log-on modes tab and set up log-in modes. For a normal store user, set up like this:
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1. The Is disabled column is read only and shows which stores are disabled in the system.
2. The Name column contains the names of all the stores in your datafile (Supervisor mode is a special mode which gives you 

access to all stores for reporting and is for administrators only)
3. The Default store column defines which store the user will be selected by default for the user on the login screen. You can only 

check one checkbox in this column
4. Store mode and dispensary mode columns: These define which modes a user will be able to login to for each store. Store mode is

for warehouses and store rooms, dispensary mode is for dispensaries. All stores (except Supervisor) have both modes available. 
You can check more than one checkbox in each of these columns.

5. The HIS mode column defines whether the user can login in HIS mode. The checkbox in the Hospital Info System row is th 
eonly one that can be checked. If it is checked then the user will be able to login in HIS mode and use the Hospital Information 
System in mSupply.

6. The Default mode column defines which mode will be selected by default for the user for that store on the login screen.
7. Click OK when you're done.
8. The user should now be able to log on.
9. After the user logs in, they may want to change their password by choosing File > Change password. Note also that “user 1” and

“user 2” are the designer and administrator- these two users have access that overrides the grouping scheme. You cannot delete 
these users, and they always have level 1 access. If you only want one person to have full access, set the administrator password 
to be the same as the designer password.

Passwords are case sensitive, so when you enter a password you have to enter exactly the same text into the second 
field. Be careful to make sure caps lock is not on when you type your password.

Note: `Access group' was an option up to version 1.96 but was removed for version 2, as users found the combination of
access group and individual user permissions too confusing. Now all access options are controlled by user.

The General tab
Active: If “Active” checkbox is checked, then that user has access to use the system . But the access ability changes 
with the Access Group level.

Can be responsible officer : If this box is checked, the name of that user will appear in “Responsible Officer” in 
“Transport Details” section.

Language: Allows you to view mSupply according to the language selected. Curently, mSupply is available in two 
versions, English and French.

User initials should be entered in the User initial field.

The Permissions tabs
Here you can set access for many features and functions on a user-by-user basis. There are presently three Permissions 
windows. 

Let us know if there is a particular function in mSupply that you want restricted in this way and we shall consider 
adding it to the next version of mSupply.

Notes

• The screen shots below may not be up to date - view the table below for a full list of permissions.
• there are three windows of permissions
• newly created users do not have their permissions turned on - you have to turn each permission on manually.
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Add/import customer budgets: If this is checked the user can import or add budgets for a customer, if unchecked they 
cannot.
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Edit/delete customer budgets: If this is checked the user can edit or delete budgets for a customer, if unchecked they 
cannot.

The Log-on modes tab
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From the mSupply Navigator click File menu and click menu option Edit users…. In the list that appears select the user 
you want to give access to the store and in the window that appears click tab Log-on modes. This is the section where 
the user's login mode/modes for each store are set. Your list of stores with any newly created stores appears in this tab. 
 
  
 
 Now select the logon mode/modes for the store that you want the user to log on as and click button OK to confirm your
changes.

The Details tab

Here some personal details including job title, address and email address of the user can be recorded. The job title will 
appear in the list of users.

Adding and using groups

Adding a group
Show the list of groups by opening the “Edit user” window and then choosing “Groups” from the “Show” Drop-down 
menu
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To add a group, click the Add Group button. You will be shown a window where you add the group name. You then set
permissions for the group in the same way as you set permissions for a user (above)
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Note that you will only be able to set checkboxes which can have different settings in different stores. Anything that is 
not a checkbox and that applies across all stores cannot be set in a group's permissions. These items will all be disabled 
when creating or editing a group.

Using groups
Groups are a quick way of setting and managing permissions for many people at a time. Users belonging to a group take
the permissions of that group: when a user is a member of a group you cannot edit their permissions directly, you must 
edit the group's permissions. And if you edit the group's permissions, you edit the permissions for every user in the 
group. To assign a user to a group, do the following:

1. Go to File > Edit users
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Note: Not applicable when running mSupply 
in single user mode

2. Double click on the user you want to edit

3. On the general tab of the window which opens, use the Is a member of drop down list to select the group the user is to belong to:
4. Click on the OK button to save you changes.

Previous: Configure Dispensary mode Next: Set start of year stock

Set start of year stock
This command from the Special menu reveals this window:sets the start of year quantity for each item, and records the 
start date. The starting stock date and stock quantity are used when printing a ledger.

The idea is that you reset your starting stock on the first day of each new financial year. Then, at the end of the year, the 
item ledger will print the starting value, all transactions for the year, and your ending stock quantities.

Using this command does not change any stock-on-hand values or archive any transactions.

You are not required to use this command, but if you do not, you will not be able to archive transactions, and you will 
get very long item ledger printouts!

Previous: Restricting User Access Next: Show connected users

Show connected users
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To display a list of users currently logged on to mSupply, select this option.The window below is displayed.

Messaging other users
By highlighting one or more users (use control on Windows/ command on Mac to highlight multiple users), a message 
typed into the Message box will immediately appear on the selected user(s) mSupply window when you click on the 
Send button. 

Such messages are not stored on the system.

Previous: Set start of year stock Next: The Help Menu

The Help Menu

823



Help > About mSupply
Choosing this item displays information about the version of mSupply in use, and provides details of the location and 
size of your data file.

You can click the blue arrows icon to retrieve the current version number from the internet. (This will not download a 
new version- it will only advise whether a newer version is available for download).

Authorisation
The Authorisation button is provided largely for developers' use. Its purpose is to assist our technical staff to resolve 
clients' problems. It is recommended that you ignore it.

Updating mSupply
For single user versions of mSupply, you can see if you have the latest version by choosing Special > Check for 
updates

Choosing this item from the Special menu will connect to the mSupply web site and compare your current mSupply 
version with the version you are now using.

If an update is available, you will be shown a window where you can click to download the latest version.
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Previous: Show connected users Next: The log

The log
The log contains records of who did what and when in the system. It's a useful place to look to find out what happened 
to certain records and when certain things were done. To view the log choose View log from the Special menu. You will 
be asked how many days history to view (the default is 7 days)

It displays a list of significant events, along with the date, the time and the user. Some events are always logged by 
mSupply but others can be chosen in the preferences.

825



Double-clicking a log entry will bring up a 
small window with the full item details. You 
can not edit this information.

Buttons in the window:

• OK - exit the window
• Order by - sort the log
• Search - find particular records in the log.
• Export- allows you to export the log for use in another application

Period for review:
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• Appropriate dates may be entered in the From and To fields
• Several periods are available from the drop down list (the default entry is Today):

Choose a specific event:

• A second drop down list allows a choice to be made from a number of specific events (the default entry is All):

See this section for a complete description of which events are recorded in the log.

Previous: The Help Menu Next: How to correct wrong packsizes
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E-mail
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Choosing this command from the Special menu reveals this window:
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The email window allows you to compose and then send an email from directly within mSupply.

The inbuilt email sending functions of mSupply allow you to:

• Send invoices to customers that they can print (using the “export HTML invoice” command)
• Send orders to suppliers (using either the “Email” or “Email pdf” menu item when editing an order)
• Send electronic invoices to customers that they can automatically import into their copies of mSupply.
• Send an email as you would using another email application. If you use mSupply, the advantage is that the email can be linked to 

the name, and easily viewed from the Email tab of the name details window.

To compose an email

• Enter the recipient email address in the to field. If you have email addresses entered for names in mSupply, type the start of the 
name, and click the find button to automatically insert the address. To enter more than one address, separate the addresses with 
commas.

• Enter a subject in the subject field
• If you want to enter addresses in the “CC” or “BCC” fields, or want to attach a document to the email, then click the small “plus” 

icon on the left to show those fields. (See below for how to attach documents). To enter more than one address in the “CC” or 
“BCC” fields, separate the addresses with commas.

• Type the text of your message.
• Click the OK button to queue your message.
• To send your message, click the Send button in the message list window, or choose Send queued mail… from the special menu.

Notes:

• Make sure you have set a return address and a mail server in the Preferences.
• If you are using a dial-up connection, you must close the connection when you have finished sending.

Attachments

• mSupply allows you to attach documents to an email.
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• To attach a document, simply click the “attach” button. You will be presented with the standard window to find a file.
• There is no limit to the number of attachments you can add to a email. (Well, actually it's a few thousand. Let us know if this isn't 

enough.)
• To delete an attachment, click the attachment in the list you want to delete, then click the delete button.

Previous: The Web Stocktake module Next: 
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Currencies...
Choosing Currencies from the Special menu opens a window with a list of currently entered currencies. The

home (default) currency always has a rate of 1, and the entry in the rate column of additional currencies is the number 
of units of the default currency equivalent to 1 unit of the other currency. In the screenshot below, the home currency is 
the Australian dollar (AUD) and the Rate of the Euro is 1.3317, so, at the time of writing, 1.3317 Australian dollars (the 
default currency) was equivalent to 1 Euro, 0.7485 Australian dollars was equivalent to 1 New Zealand dollar, etc.

Buttons in the currency list window :
New: To add a new currency.

Get internet rates: Providing you have an internet connection, clicking this button will update the rate of exchange 
from the Yahoo website.

Update mSupply rate: The refreshed rates will only become active when you click this button.

OK: Click OK to close the Currencies window when you have finished editing currencies.

Editing a currency entry:
Double click a currency to edit it manually. Note that your “home” currency should be entered with a value of “1”, and 
all other currencies should be entered with a rate relative to your home currency. A window with the currency code and 
the current rate will appear.
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You must have Foreign Currencies 
configured in mSupply if you are using this 
feature; you can set them up now using and 
once you have done this, performing the 
steps below.

You can edit the rate. Note that doing so will automatically update quotes that use that currency.

To change your default currency

50. Double-click on your default currency in the list
51. Click the padlock icon
52. Choose a different home currency.

Note that all other currencies will have to have their rate entered relative to the new default currency

Buttons in the Edit currency window :
Delete: Click to delete the currency. If the field is dimmed, the currency is in use by quotations, and cannot be deleted.

Cancel: Click to exit the window without saving changes.

OK: Click this button when you are finished editing currencies.

Previous: Next: 

Using Foreign Currencies in Transactions

 
 The foreign currency feature enables you to receive stock from suppliers in the suppliers own foreign currency and also
distribute goods to customers in their own currency.

Set up Foreign Currencies for Customers and/or Suppliers

 Set the Store to use foreign currency

1. From the Navigator click drop down menu Special> Show Stores… double click to select the store in which you want foreign 
currencies to be used and in the window that appears hit tab Preferences.

2. Check Store mode: Able to issue in foreign currency.
3. Click OK and return to the mSupply Navigator.

Set the currency of the Customer or Supplier
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As an example for the guide, our store 
operates with Australian dollars (AUD) as 
the local currency, and is making a purchase 
from a European supplier which uses the 
Euro (EUR) 

1. From the Navigator choose Customers > Show Customers.
2. Locate the Customer and double-click it. In the window that appears click the General tab and in Currency drop-down list (top-

right) select the appropriate currency for that Customer.
3. Click OK to return to the Navigator and do the same for the Supplier if required.

Using the Foreign Currencies

• Generating an invoice for goods (either from a Supplier or to a Customer):
• receive goods from a Supplier in a foreign currency
• issue goods to a Customer in a foreign currency

• Generating a credit for returned or unwanted goods (either from a Customer or to a Supplier):
• receive returned goods from a Customer in a foreign currency
• send/return goods to a Supplier in a foreign currency

Supplier invoices

• From the Navigator choose Suppliers > New Supplier Invoice
• In the Supplier Invoice window that appears select your supplier and view its details by double-clicking.
• Click the Price tab and change the currency (as highlighted in box 1 below) to the currency in which the supplier provides the 

items to you.
• Return to the General tab and click button New line to add a new item line.
• In the window that appears type the details of the item you are receiving and hit button OK & Next to add further items.
• Once all items are added, again click the Price tab and review the item prices as highlighted in 2 below:
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The columns headed 'Price FC' and 
'Extension FC' in box 2 above show the cost 
price of goods to you in Euros - i.e. the 
Foreign currency which the supplier uses, 
while the figures in the columns on the right 
show the prices in Australian dollars - i.e. 
your local currency. 

• Click OK to save the Supplier invoice and introduce the items to stock.

Customer invoices

• Ensure Foreign Currencies are active as per the instructions at the top of this page.
• From the Navigator choose Customers > New Customer Invoice.
• In the Customer Invoice window that appears select your Customer in field Name and note the currently set currency and its rate 

as highlighted in box 1 below.
• Now click the New Line button to add a new item line.
• In the window that appears type the details of the item you are issuing and hit button OK. Repeat as needed.
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